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AS Series Operation Manual

1.1 Overview

This manual introduces the AS Series CPU functions, devices, module tables, troubleshooting, and so forth.

1.1.1 Related Manuals

The related manuals for AS Series programmable logic controllers are listed below.

AS Series Quick Start

This guides you in how to use the system before reading the related manuals.

AS Series Programming Manual AS Series Programming Manual

This introduces programming for the AS Series programmable logic controllers, basic instructions, and
applied instructions.

ISPSoft User Manual

This introduces the use of the ISPSoft software, programming language (Ladder, IL, SFC, FBD, and ST),
POUs, and tasks.

AS Series Hardware Manual

This introduces electrical specifications, appearances, dimensions, and so forth.

AS Series Operation Manual

This introduces CPU functions, devices, module tables, troubleshooting, and so forth.

AS Series Module Manual

This introduces special /0 modules such as network modules, analog I/O modules, temperature
measurement modules, motion control modules, and so forth.

1.1.2 Models Descriptions

Classification Model Name Description

Power supply

module

Input: 100-240 VAC, 50/60 Hz
AS-PS02
Output: 24VDC/2A, 48W (for PLC internal use)

Input: 100-240 VAC, 50/60 Hz
AS-PS02A Output: 24VDC/1.5A, 36W (for PLC internal use)

Output: 24VDC/0.5A, 12W (for external use)

CPU module, PNP output, 1x Ethernet port, 2x RS-485
ports, 1x USB port, 1x Micro SD interface, 2x function cards
AS332P-A (optional), supporting 32 1/0s (16DI+16DO) and up to 1024
1/0s. Program capacity:128K steps, high-density terminal

blocks

AS300 Series CPU module, NPN output, 1x Ethernet port, 2x RS-485

CPU module ports, 1x USB port, 1x Micro SD interface, 2x function cards

AS332T-A (optional), supporting 32 1/0Os (16DI+16DO) and up to 1024
1/0s. Program capacity:128K steps, high-density terminal

blocks

CPU module, NPN differential output, 1x Ethernet port, 2x
AS324MT-A

RS-485 ports, 1x USB port, 1x Micro SD interface, 2x
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Classification

Model Name

Description

function cards (optional), supporting 24 1/Os (12DI+12D0O)
and up to 1016 1/Os. Program capacity:128K steps,

high-density terminal blocks

AS320P-B

CPU module, PNP output, 1x Ethernet port , 2x RS-485
ports, 1x USB port, 1x Micro SD interface, 2x function cards
(optional), supporting 20 1/Os (8DI+12DO0O) and up to 1024
I/Os. Program capacity:128K steps, removable terminal

blocks

AS320T-B

CPU module, NPN output, 1x Ethernet port, 2x RS-485
ports, 1x USB port, 1x Micro SD interface, 2x function cards
(optional), supporting 20 1/Os (8DI+12DO0O) and up to 1024
I/Os. Program capacity:128K steps, removable terminal

blocks

AS300N-A

CPU module, no I/Os, 1x Ethernet port, 2x RS-485 ports, 1x
USB port, 1x Micro SD interface, 2x function cards
(optional), and supporting up to 1024 1/Os. Program
capacity:128K steps

AS200 Series
CPU module

AS228P-A

CPU module, PNP output, 1x Ethernet port , 2x RS-485
ports, 1x USB port, 1x Micro SD interface, CAN
communication port, supporting 28 1/0s (16DI+12DO) and
up to 1024 I/Os. Program capacity: 64K steps, removable

terminal blocks

AS228T-A

CPU module, NPN output, 1x Ethernet port , 2x RS-485
ports, 1x USB port, 1x Micro SD interface, CAN
communication port, supporting 28 1/0s (16DI+12DO0O) and
up to 1024 I/Os. Program capacity: 64K steps, removable

terminal blocks

AS228R-A

CPU module, Relay output, 1x Ethernet port , 2x RS-485
ports, 1x USB port, 1x Micro SD interface, CAN
communication port, supporting 28 1/0s (16DI+12DO0O) and
up to 1024 I/Os. Program capacity: 64K steps, removable

terminal blocks

AS218PX-A

CPU module, PNP output, 1x Ethernet port , 2x RS-485
ports, 1x USB port, 1x Micro SD interface, CAN

communication port, supporting 18 1/0s
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Classification

Model Name

Description

(8DI+6DO+2AI+2A0) and up to 1024 I/Os. Program

capacity: 64K steps, removable terminal blocks

AS218TX-A

CPU module, NPN output, 1x Ethernet port , 2x RS-485
ports, 1x USB port, 1x Micro SD interface, CAN
communication port, supporting 18 1/0s
(8DI+6DO+2AI+2A0) and up to 1024 I/Os. Program

capacity: 64K steps, removable terminal blocks

AS218RX-A

CPU module, Relay output, 1x Ethernet port , 2x RS-485
ports, 1x USB port, 1x Micro SD interface, CAN
communication port, supporting 18 1/0s
(8DI+6DO+2AI+2A0) and up to 1024 I/Os. Program

capacity: 64K steps, removable terminal blocks

ASO08AM10N-A

24VDC
5mA
8 inputs

Spring-clamp terminal block

ASO08ANO1P-A

5-30VDC
0.5A/output, 4A/COM
8 outputs

Sourcing output

Spring-clamp terminal block

Digital
input/output

module

ASO08ANO1R-A

240VAC/24VDC
2A/output, BA/COM
8 outputs

Relay

Spring-clamp terminal block

ASO8ANO1T-A

5-30VDC
0.5A/output, 4A/COM
8 outputs

Sinking output

Spring-clamp terminal block

AS16AM10N-A

24VDC

5mA
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Classification

Model Name

Description

16 inputs

Spring-clamp terminal block

AS16ANO1P-A

5-30VDC
0.5A/output, 4A/COM
16 outputs

Sourcing output

Spring-clamp terminal block

AS16ANO1R-A

240VAC/24VDC
2A/output, BA/COM
16 outputs

Relay

Spring-clamp terminal block

AS16ANO1T-A

5-30VDC
0.5A/output, 4A/COM
16 outputs

Sinking output

Spring-clamp terminal block

AS16AP11P-A

24VDC

5mA

8 inputs

5-30VvDC
0.5A/output, 4A/COM
8 outputs

Sourcing output

Spring-clamp terminal block

AS16AP11R-A

24VDC

5mA

8 inputs
240VAC/24VDC
2A/output, BA/COM
8 outputs

Relay
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Classification Model Name Description
Spring-clamp terminal block
24VDC
5mA
8 inputs
5-30VDC
AS16AP11T-A

0.5A/output, 4A/COM
8 outputs
Sinking output

Spring-clamp terminal block

AS32AM10N-A

24VDC
3.2mA
32 inputs

MIL connector

AS32ANO2T-A

5-30VDC
0.1A/output, 3.2A/COM
32 outputs

Sinking output

MIL connector

AS64AM10N-A

24VDC
3.2mA
64 inputs

MIL connector

AS64ANO2T-A

5-30VDC
0.1A/output, 3.2A/COM
64 outputs

Sinking output

MIL connector

Analog
input/output ASO04AD-A

module

4-channel analog input module

Hardware resolution: 16 bits

0-10V, 0/1-5V, -5 to +5V, -10 to +10V, 0/4-20mA,
-20—+20mA

Conversion time: 2 ms/channel
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Classification

Model Name

Description

ASO8AD-B

8-channel analog input module
Hardware resolution: 16 bits
0 to +10V, 0/1-5V, -5V to +5V, -10V to +10V

Conversion time: 2 ms/channel

AS08AD-C

8-channel analog input module
Hardware resolution: 16 bits
0/4—-20mA, -20mA—+20mA

Conversion time: 2 ms/channel

ASO4DA-A

4-channel analog output module
Hardware resolution: 12 bits
-10 to +10V, 0—-20mA, 4-20mA

Conversion time: 2 ms/channel

ASO6XA-A

4-channel analog input
Hardware resolution: 16 bits

0-10V, 0/1-5V, -5 to +5V, -10 to +10V, 0/4-20mA, -20 to
+20mA

Conversion time: 2 ms/channel
2-channel analog output
Hardware resolution: 12 bits
-10 to +10V, 0—20mA, 4—-20mA

Conversion time: 2 ms/channel

Temperature
measurement

module

ASO4RTD-A

4-channe, 2-wire/3-wire RTD

Sensor type: Pt100 / Ni100 / Pt1000 / Ni1000 / JPt100 /
LG-Ni1000 / Cu50/ Cul100 / 0-300(2 /0-3000(2 input
impedance

Resolution: 0.1°C/0.1°F (16 bits)

Conversion time: 200ms/channel

ASO6RTD-A

6-channe, 2-wire/3-wire RTD

Sensor type: Pt100 / Ni100 / Pt1000 / Ni1000 / JPt100 /
LG-Ni1000 / Cu50 / Cu100/0-300() /0-3000(2 input
impedance, Resolution: 0.1°C/0.1°F (16 bits)

Conversion time: 200ms/channel

ASO4TC-A

4-channel thermocouple
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Classification

Model Name

Description

Sensortype: J, K, R, S, T, E, N, B and -100 to +100 mV
Resolution: 0.1°C/0.1°F (24 bits)

Conversion time: 200ms/channel

AS08TC-A

8-channel thermocouple
Sensor type: J, K, R, S, T, E, N, B and -100 to +100 mV
Resolution: 0.1°C/0.1°F (24 bits)

Conversion time: 200ms/channel

Load cell

module

ASO02LC-A

2-channel, 4-wire/6-wire load cell sensor

Eigenvalues for a load cell: 1, 2, 4, 6, 20, 40, 80 mV/V
Highest precision 1/10000 @ 50ms of conversion time
ADC Resolution : 4 bits

Conversion time: 2.5-400ms (nine options to choose from)

Positioning

module

ASO02PU-A

2-axis motion control,

5-24 VDC, 1 differential input,

maximum high-speed frequency at 200 k Hz
24 VDC, 5 mA, 5 inputs

5 VDC, 2-axis, 4 differential outputs,

maximum high-speed frequency at 200 k Hz

ASO04PU-A

4-axis motion control

24 VDC, 5mA, 6 inputs

5-30 VDC, 0.1A, 4-axis, 8 outputs, maximum high-speed
frequency at 100 kHz

Network

module

ASO0SCM-A

Serial communication module, 2x communication ports for

communication cards, supporting MODBUS protocols

ASO1DNET-A

DeviceNet communication port, functioning as master or

slave

Remote I/O

module

ASO0SCM-A

+

AS-FCOPM

For AS-FCOPM function cards

ASO0SCM-A

+

AS-FENO2

For AS-FENO2 function cards
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Classification Model Name Description

DeviceNet remote IO slave, its right side connectswith AS
ASO1DNET-A (RTU) Series extension modules, including digital modules, analog

modules, temperature modules, etc.

Serial communication port, RS232, functioning as master or

AS-F232
slave
Serial communication port, RS422, functioning as master or
AS-F422
slave
Serial communication port, RS485, functioning as master or
AS-F485
slave
CANopen communication port, supporting DS301, AS
AS-FCOPM
series remote modules and Delta servo systems
Function cards
2-channel analog input
AS-F2AD 0-10V (12 bits), 4-20mA (11 bits)
Conversion time: 3ms/channel
2-channel analog output
AS-F2DA 0-10V, 4-20mA (12 bits)
Conversion time: 2ms/channel
2x Ethernet ports, supporting MODBUS TCP, EtherNet/IP
AS-FENO02
Adapter, AS Series remote control, and DLR function
UC-PRGO015-01A Used for the connection between a PLC and a PC via a mini
(1.5M) USB port, use for AS Series CPU modules
Use for the connection between a PLC and a PC with a mini
Programming UC-PRGO030-01A (3M)
USB port, use for AS Series CPU modules
cable
Use for the connection between a PLC and a PC with a
UC-PRGO030-20A (3M) RJ45 port, use for AS Series CPU modules and AS-FENO02
function card
UC-ET010-24B (1M) MIL connector, 40Pin <> 40Pin, shielded, use for
UC-ET020-24B (2M) AS32AM10N-A, AS32AN02T-A, AS64AM10N-A and
I/0 extension UC-ET030-24B (3M) ASB4ANOZT-A
cable UC-ET010-24D (1M) MIL connector, 40Pin<> 2x 20Pin, shielded, use for

UC-ET020-24D (2M) AS332T-A, AS332P-A, AS324MT-A, AS32AM10N-A,
UC-ET030-24D (3M) AS32AN02T-A, AS64AM10N-A, and AS64ANO2T-A
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Classification Model Name Description
16 inputs/outputs, 20-Pin MIL connector, use for AS332T-A,
UB-10-ID16A AS332P-A, AS324MT-A, AS32AM10N-A, AS32ANO02T-A,
AS64AM10N-A and AS64AN02T-A
32 inputs, 40-Pin MIL connector, use for AS32AM10N-A and
UB-10-ID32A
AS64AM10N-A
Terminal block (spring clamp/MIL connector), MIL connector
External
UB-10-1032D to 40-Pin spring clamp terminal block, use for AS332T-A,
terminal
AS332P-A, AS324MT-A, AS32AM10N-A, AS32ANO2T-A
module
16 relay outputs, 20-Pin MIL connector, NPN, use for
UB-10-OR16A
AS332T-A, AS32ANO2T-A and AS64ANO2T-A
16 relay outputs, 20-Pin MIL connector, PNP, use for
UB-10-OR16B
AS332P-A
32 transistor outputs, 40-Pin MIL connector, NPN, use for
UB-10-OT32A

AS32ANO02T-A and AS64AN02T-A

Network cables

UC-CMC003-01A (0.3M)

CANopen communication cable, use for AS-FCOPM series

UC-CMC005-01A (0.5M)

CANopen communication cable, use for AS-FCOPM series

UC-CMC010-01A (1M)

CANopen communication cable, use for AS-FCOPM series

UC-CMCO015-01A (1.5M)

CANopen communication cable, use for AS-FCOPM series

UC-CMCO020-01A (2M)

CANopen communication cable, use for AS-FCOPM series

UC-CMCO030-01A (3M)

CANopen communication cable, use for AS-FCOPM series

UC-CMCO050-01A (5M)

CANopen communication cable, use for AS-FCOPM series

UC-CMC100-01A (10M)

CANopen communication cable, use for AS-FCOPM series

UC-CMC200-01A (20M)

CANopen communication cable, use for AS-FCOPM series

UC-EMCO003-02A (0.3M)

Ethernet communication cable, use for AS Series CPU

modules and AS-FENO2 function card

UC-EMCO005-02A (0.5M)

Ethernet communication cable, use for AS Series CPU

modules and AS-FENO2 function card

UC-EMCO010-02A (1M)

Ethernet communication cable, use for AS Series CPU

modules and AS-FENO2 function card

UC-EMCO020-02A (2M)

Ethernet communication cable, use for AS Series CPU

modules and AS-FENO2 function card

UC-EMCO050-02A (5M)

Ethernet communication cable, use for AS Series CPU
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Classification Model Name Description

modules and AS-FENO2 function card

Ethernet communication cable, use for AS Series CPU
UC-EMC100-02A (10M)
modules and AS-FENO2 function card

Ethernet communication cable, use for AS Series CPU
UC-EMC200-02A (20M)
modules and AS-FENO2 function card

1.2 Overview

An AS series CPU module is an advanced controller with built-in 6 high speed counters for inputs, up to 6-axis
(pulse), and can optionally work with a total of 8-axis (CANopen) position outputs. It provides a strong network
function for users, and users can create connection among devices on the network through software. An AS
series CPU module also provides structured programming. Users can assign programs to different tasks, and
write a program which is frequently executed in a function block. Besides, users can choose different
programming languages ladder diagrams (LD), structured texts (ST), sequential function charts (SFC), and
continuous function chart (CFC) dealt with by IEC 61131-3 according to their needs when writing programs.
They can create the AS series hardware configuration by means of hardware configuration software. They can
also restore or back up a system rapidly through the built-in SD interface in an AS series series CPU module.
This manual introduces the basic operation of an AS series system, and help users familiarize themselves with

the AS series system.

1.3 Characteristics
Characteristics of the AS series CPU module:
(1) High efficiency

® The AS Series CPU module uses a 32-bit high-speed processor. The module executes basic
instructions at 25 ns each and moving instructions at 150ns each. The module executes instructions
at a speed of 40k steps/ms (40% of the instructions are basic instructions, and 60% of the instructions

are applied instructions).

® The CPU of the AS Series uses the Soc architecture, built with six (or 3) high speed counters. The
maximum frequency is 200 kHz for each counter (differential output models can reach 4 MHz);

six-axis high speed position output at 200 kHz (differential output models can reach 4 MHz).
(2) Supporting more inputs and outputs

® The AS series CPU module supports up to 1024 digital I/Os or 32 1/0O modules (any type) or 16 analog

1/0 modules.
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® The AS series works with SCM/DNETcommunication modules (AS-FCOPM, and AS-FENO2 included)

to create a remote connection, and you can connect up to 15 remote modules.

Note: For the connections between the CPU modules and the remote modules, the 1/O points cannot

exceed 1024 1/0s, 32 I/O modules (any type), or 16 analog I/O modules.

(3) Multiple I/O modules

® The AS series CPU module supports the following I1/0 modules: digital input/output modules, analog

input/output modules, temperature measurement modules, network modules, and function cards.

Module Description
ASO8AM10N-A, ASO8ANOLT-A, ASO8ANO1P-A, ASOSBANO1R-A,
Digital
AS16AM10N-A, AS16ANO1T-A, AS16ANO1P-A, AS16ANO1R-A,
input/output
AS16AP11T-A, AS16AP11P-A, AS16AP11R-A, AS32AM10N-A,
module
AS32AN02T-A, AS64AM10N-A, AS64ANO2T-A
Analog
input/output
module AS04AD-A, ASO8AD-B, ASO8AD-C, ASO4DA-A, ASO6XA-A, ASO4RTD-A,
(Temperature ASO6RTD-A, AS04TC-A, AS08TC-A
measurement
module)
Positioning
ASO02PU-A, ASO4PU-A
module
Network module ASO0SCM-A, ASO1DNET-A
Communication
AS-F232, AS-F422, AS-F485, AS-FCOPM, AS-FENO02
card
Function card AS-F2AD, AS-F2DA

(4) Larger program capacity and memory

® The AS300 Series advanced CPU modules have 128k steps of program capacity. 60000 general
registers (30000 for specific use and 30000 for programming editing), and 64k words of memory (that
can be used for storing parameters).

® The AS200 Series advanced CPU modules have 64k steps of program capacity. 60000 general
registers (30000 for specific use and 30000 for programming editing), and 64k words of memory (that
can be used for storing parameters).

(5) Supporting IEC 61131-3
® The AS series CPU module supports IEC 61131-3.

® Supported programming languages are ladder diagrams (LD), sequential function chart (SFC),
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(6)

structured text (ST), and continuous function chart (CFC).

Create Program E\
POU Name [Task
Frog Cryelic Task () -
| Active
Protection (4-12 Characters)—| ~Languag;
Enter Password Ladder Diagram (LI
Sequential Funection Chart (3FC)
Confirmation
Stracture Text (5T)
+' Continuous Function Chart (CFC)

POU Comment

QK | Canicel |

® You can select a programming language according to your preference. Programming languages
support one another so that programs written by different users are compatible.

Strong function block

® Both standard IEC61131-3 function blocks and convenient functions blocks provided by Delta
Electronics, Inc. are supported. You can use function blocks for frequently used programs for greater

structure and convenience.

® The symbol for a function block in a ladder diagram is similar to an integrated circuit (IC) in a circuit
diagram. Because the ladder diagram is based on the traditional circuit diagram, the operation of a
function block is similar to the function of an integrated circuit. You only need to send the signal to the
corresponding input of the function block. You do not need to consider the processing procedure

inside the function block.

CTU_W

Eno
oL
i)

]
T7av

® Afunction block is a program element equipped with the operation function. It is similar to a subroutine,

and is a type of POU (Program Organization Unit). It cannot operate by itself, and must be called
through the main program POU. The function defined by the function block is executed after being
called with the related parameters. The final result can be sent to the device or variable in the superior

POU after the function block completes.

® You can set passwords in ISPSoft to provide function block security. The program inside a function

block cannot be read, and business patents cannot be compromised.
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)

®

©

(10)

Task

® You can assign 283 tasks at most to a program. Among these tasks, 32 are cyclic, 32 are 1/0
interrupts, 4 are timer interrupts, two are communication interrupts, one is an external 24 V

low-voltage interrupt, and 212 are user-defined tasks.

® You can enable and disable a task when running a program by using the TKON and TKOFF

instructions.

Increasing hardware configuration efficiency through a USB cable and ISPSoft

® The AS Series CPU module provides a standard USB 2.0 interface. USB 2.0 increases the data
transfer rate and decreases the time it takes to download the program, monitor the program, and
configure the hardware. You do not need to buy a special communication cable for the CPU module.

You can use a general USB cable to connect to the AS Series CPU module.

Serial control interface with multiple functions

® AS Series CPU modules provide two RS-485 serial control interfaces, COM1 and COM2, which can

be set as a either master or slave.

® You use the communication cards to work with two extension serial communication ports and to set

the port as a master or slave.

High-speed Ethernet communication interface

® AS Series CPU modules are equipped with a 10/100 M Ethernet communication interface and support

email, web, and socket services.

® System error messages can be sent to your email immediately. You do not need to be on location to

understand the problem.
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(11) Memory card

® The memory card has the following functions.
System backup: user program, CPU parameters, module table, and the device setting values
System recovery: user program, CPU parameters, module table, and device setting values
Parameter storage: device value
Log storage: system error log and system status log
(12) 1/0 module installation

® The AS Series PLC supports slide-and-lock installation on 1/O modules when the power is off. After the
PLC is powered off, you can remove the defective module and replace it with a new one without

removing other modules.

(13) Supporting on-line debugging mode

® You can use the on-line debugging mode in the AS series CPU module after a single instruction step

completes, or after a breakpoint is specified, to find bugs in the program.

® The CPU module must be running to enter the debugging mode. After enabling the on-line monitoring

function, click . The debugging screen varies from programming language to programming

language, but the same operation applies to these programming languages. For the AS series PLC,
structured text does not support debugging mode, and sequential function charts supports debugging

mode during the action and the transition.
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Step 1: Set the PLC to RUN
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Step 3: Enter debugging mode

(14) On-line editing mode

® You can use the on-line editing mode when the system is running to update the program without

affecting the system operation.

® When the system is in the on-line monitoring mode, enter the on-line editing mode by clicking .
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® After the program is modified and compiled, you can update the program in the CPU module by

[
clicking to download it to the CPU.
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Chapter 2 Specifications and System
Configuration
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2.1 General Specifications

Item Specifications

Operating temperature | -20 to 60°C

Storage temperature -40 to 80°C
5-95%
Operating humidit
P 9 Y No condensation
5-95%

Storage humidity No condensation

Work environment No corrosive gas exists.
Installation location In a control box
Pollution degree 2

Ingress protection

. 1P20
(IP ratings)

EMC (electromagnetic

N Refer to Chapter 7 for more information.
compatibility)

Tested with:
5Hz < f £ 8.4 Hz, constant amplitude 3.5 mm;

. . . 8.4 Hz < f < 150 Hz, constant acceleration 1g
Vibration resistance

Duration of oscillation: 10 sweep cycles

per axis on each direction of the three mutually perpendicular axes
International Standard IEC 61131-2 & IEC 60068-2-6 (TEST Fc)

Tested with:

Half-sine wave:

Strength of shock 15 g peak value, 11 ms duration;

Shock direction: The shocks in each in direction per axis, on three mutually
perpendicular axes (total of 18 shocks)

International Standard IEC 61131-2 & IEC 60068-2-27 (TEST Ea)

Safety Conforms to IEC 61131-2, UL508

Ambient air
temperature-barometric
pressure-altitude

Shock resistance

Operating: 1080 ~ 795hPa (-1000 ~ 2000 m)
Storage:1080 ~ 660hPa (-1000 ~ 3500 m)

2.2 CPU Module Specifications

2.2.1 Functional specifications

AS228T-A | AS228P-A
o ASB2AMT-A I ASSS2ZT-A T goo8R-A | AS218TX-A Remark

(SRR AS218PX-A | AS218RX-A

Execution The program is executed cyclically.

The inputs and
Regenerated inputs/outputs outputs can be
Input/Output control . ) controlled through the
Direct inputs/outputs ) .
direct inputs and

direct outputs.

IEC 61131-3

Programming language Ladder diagrams, continuous function charts,
structured text, and sequential function charts

Instruction execution speed | 40K steps/ms
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Item

AS228T-A [ AS228P-A
AS228R-A [ AS218TX-A
AS218PX-A / AS218RX-A

AS324MT-A [ AS332T-A/
AS332P-A

Remark

Number of instructions

Approximately 666 instructions

Constant scan cycle (ms)

1-32000

(The scan cycle can be increased by one
millisecond.)

Setting the parameter

Program capacity (step)

128K steps (256K bytes)| 64K steps (128K bytes)

Installation

DIN rails or screws

Installation of a module

No backplane installation; only module after module

Maximum number of
modules which can be
installed

32 modules

Number of tasks

283 tasks (32 cyclic tasks; 16 1/O interrupts; four
timed interrupts, etc.)

Refer to the AS Series
Operation manual for
more information.

Number of
Number of inputs/outputs 1024 g‘cF::L:sti(i)tl)JlteE)ltJ;San actual
input/output module
Input relays [X] 1024
Output relays [Y] 1024

Internal relays [M]

8192 (M0-M8191)

Timers [T]

512 (TO-T511)

Counters [C]

512 (CO-C511)

32-bit counter [HC]

256 (HCO-HC255)

Data register [D]

30000 (D0-D29999)

Data register [W]

30000 (W0-W29999)

Stepping relay [S]

2048 (S0-S2047)

Index register [E]

10 (EO-E9)

Special auxiliary relay [SM]

2048 (SM0-SM2047)

Special data register [SR]

2048 (SR0-SR2047)

Serial communication port | 2x RS-485
Ethernet port Refer to the section 9.3
10/100 M for more details on
Ethernet specificaitons
USB port Mini USB

Storage interface

SD Card (Micro SD); maximum storage: 32G

Real-time clock

Years, months, days, hours, minutes, seconds and
weeks

*Batteries (CR1620) are
not included.

Function card interface

2x function cards,
supporting
communication card,
AD/DA analog function
cards

None

CANopen DS301 (Master)

Maximum node: 64; maximum bytes: 2000

*A function card
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AS228T-A [ AS228P-A
AS324MT-A [ AS332T-A/ AS228R-A | AS218TX-A

o Remark
AS332P-A AS218PX-A [ AS218RX-A

AS-FCOPM is required

CANopen DS301 (Slave) Maximum PDO: 8; maximum bytes: 8 for AS300 Series.

2.2.2 Electrical specifications

Model

ﬁgggggﬁ AS320T-B/ | scanon.a | AS228T-A/ | AS218TX-A/| AS228R-A/
ASaaMT.A | AS320P-B AS228P-A | AS218PX-A | AS218RX-A

Item

Supply voltage | 24 VDC (20.4 VDC-28.8 VDC) (-15% to +20%)

Power
consumption (W) 36 3.6 3 3.4 4.9 43/5.3
Weight (g) 260 285 235 285 290 325/310

® Electrical specifications for the inputs on digital input/output module. The signals passing through
the inputs are 24 VDC signals.

Model AS332T-A AS320T-B
ltem AS332P-A AS320P-B AS3ZAMT-A
Number of inputs 16 (X0.0-X0.15) 8 (X0.0-X0.7) 12 (X0.0-X0.11)
Connector type MIL connector Removable terminal blocks MIL connector
Input type Digital input
X0.0+-X0.3+/X0.0- to
. o . X0.3-: differential input
Input form Direct current (sinking or sourcing) .
X0.4-X0.11: Direct current
(sinking or sourcing)
| t voltage/ 24 VDO X0.0+-X0.3+/X0.0- to X0.3-:
nput voltage 5VDC, 5 mA
current 5 mA
X0.4—-X0.11: 24 VDC, 5 mA
X0.0+-X0.3+/X0.0- to X0.3-:
OFF—ON >15VDC >0.2VvDC
Action X0.4-X0.11: >15VDC
level X0.0+-X0.3+/X0.0- to
ON—OFF <5VDC X0.3-: <-0.2VDC
X0.4-X0.11: <5VDC
X0.0-X0.11: < 2.5 X0.0+-X0.3+/X0.0- to
.0~X0.11: < 2.5ps )
OFF—ON X0.12~X0.15: < 50ps X0.3-: <0.125 ps
Response X0.4-X0.11: < 2.5us
time O.0-X0.11: < 2.5 X0.0+-X0.3+/X0.0- to
.0~X0.11: < 2.5ps )
ON—OFF X0.12~X0.15: < 50ps X0.3-: <0.125 us
X0.4-X0.11: < 2.5us
Maximum input X0.0~X0.11: 200KHz §82+_X2|?/|4|-—/|XO0- to
- <
frequency X0.12~X0.15: 10KHz ~ z
X0.4-X0.11: < 200 kHz
Input impedance 5.6 kQ

Voltage input
Input signal Sinking: The inputs are NPN transistors whose collectors are open collectors.
Sourcing: The inputs are PNP transistors whose collectors are open collectors.
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Model AS332T-A AS320T-B
e AS332P-A AS320P-B ASIZAMT-A
Electrical isolation Optocoupler
Input display When the optocoupler is driven, the input LED indicator is ON.
Note: AS300N-A does not come with inputs/outputs.
® Electrical specifications for the outputs on AS300 Series.
Model AS332T-A AS320T-B
Item AS332P-A AS320P-B AR
Number of outputs 16 (Y0.0-Y0.15) 12 (Y0.0-Y0.11) 12 (Y0.0-Y0.11)
Connector type MIL connectorMIL Re.movable MIL connector
connector terminal blocks
. L Y0.0+-Y0.3+/Y0.0- to YO0.3-: differential
Transistor-T (sinking) .
Output form Transistor-P (sourcing) nput
g Y0.4-Y0.11: Transistor-T (sinking)
Y0.0+-Y0.3+/Y0.0- to Y0.3- : 5 VDC
Voltage 5-30 VDC
Y0.4-Y0.11: 5-30vDC
Y0.0+-Y0.3+/Y0.0-Y0.3- : 20mA/output
Resistance 0.1A/output, 0.1A/output, (+ anq —as a group, e.g. Y0.0+ and
Maximum 1.6A/COM 1.2A/COM Y0.0- is a group)
load Y0.4-Y0.11:0.1A/output, 0.8A/COM
Inductance N/A
Bulb N/A
. Y0.0-Y0.11: 200 KHz Y0.0+-Y0.3+/Y0.0- to Y0.3- : 4 MHz
Maximum | Resistance ] )
Y0.12-Y0.15: 100 Hz Y0.4-Y0.11: 200 KHz
output ., |Inductance N/A
frequency
Bulb N/A
Maximum
Y0.0~Y0.11: 2.5us Y0.0+-Y0.3+/Y0.0- to Y0.3-: 0.125 us
Response |OFF—ON H H
time Y0.12~Y0.15: 0.5ms Y0.4-Y0.11: 2.5 ps

® Electrical specifications for the inputs on AS200 Series. The signals passing through the inputs are
24 VDC signals.

Model AS218PX-A/AS218RX-A/
tem AS228P-A [ AS228R-A [ AS228T-A AS218TX-A
Number of inputs 16 (X0.0-X0.15) 8 (X0.0-X0.7)

Connector type Removable terminal blocks

Input type Digital input

Input form Direct current (sinking or sourcing)

Input voltage/ current 24 VDC, 5 mA
OFF—ON >15VDC
Action level
ON—OFF <5VvDC
X0.0-X0.7: < 2.
OFF—ON 0.0-X0 ops
. X0.8-X0.15: < 50us
Response time X0.0X0.7- <25
ON—OFF TS 20HS
X0.8-X0.15: < 50us
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Model
Item

AS228P-A | AS228R-A / AS228T-A

AS218PX-A / AS218RX-A /
AS218TX-A

Maximum input frequency

X0.0—X0.7: 200 KHz
X0.8-X0.15: 10 KHz

Input impedance

3.9kQ

Input signal

Voltage direct input

Sinking: The inputs are NPN transistors whose collectors are open collectors.
Sourcing: The inputs are PNP transistors whose collectors are open

collectors.

Electrical isolation

Optocoupler

Input display When the optocoupler is driven, the input LED indicator is ON.
Analog inputs N/A 2

Analog input resolution N/A 12bits

FEN A
Analog linearity error N/A +1% (full scale)
Analog input impedance N/A =1 MQ (Voltage mode)

250 Q (Current mode)

® Electrical specifications for the outputs on AS200 Series.

Model AS228R-A

Iltem

AS218RX-A

AS228T-A
AS218TX-A

AS228P-A
AS218PX-A

Number of outputs

AS228 Series: 12 outputs (Y0.0-Y0.11)
AS218 Series 6 outputs (Y0.0-Y0.5)

Connector type

Removable terminal blocks

Output form Relay Transistor-T (sinking) TranS|s.tor-P
(sourcing)
Voltage / current 240 VAC / 24 VDC 5-30 vDC 5-30 VDC
Leakage current OuA <10uA
AS228| 2A/output, 8A/COM 0.5A/output, 2A/COM  |0.5A/output, 2A/COM
Resistance 0.5A/output
AS21 2A M . 1. M ’
Maximum S218 /output, 6A/CO 0.5A/output, 1.5A/CO 1 5A/COM
load Inductance Life cycle curve*! N/A N/A
20W (24vDC)
Bulb 100W (230VAC) N/A N/A
e Resistance 1Hz 200kHz 200kHz
output Inductance 0.5Hz N/A N/A
frequency |gyp 1Hz N/A N/A
Maximum |OFF—ON
Response 10 us 2.5 s 2.5 s

Analog outputs

AS218 Series: 2 outputs

Analog output resolution

AS218 Series: 12bits

Analog output mode

AS218 Series: -10V~10V (voltage mode) or OmA~20mA (currentmode)

*1: Life cycle curve
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3000 L 120VAC R:esis}ive
w7 [30VDC Inductive(t=7/ms)
2000 / ¢ 240VAC Inductive(cos ¢ =0.4)
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© 500 e
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X 300
& 200 3
©
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2.2.3 CPU Module Profiles

® AS324MT-A/AS332T-A/AS332P-A/AS300N-A
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Number Name Description
Power LED indicator Indicates the power status of the CPU module
Operating status of the module
Run LED indicator ON: the module is running.
OFF: the module is stopped.
Error status of the module
o ON: a serious error occurs in the module.
1 Error LED indicator OFF: the module is normal.
Blinking: a minor error occurs in the module.
BAT.LOW LED Indicates the battery status of the CPU module.
indicator (Enable/Disable this display in HWCONFIG in ISPSoft)
COM1 LED Indicates the com_mur.lication status of the COM port.
COM?2 LED Ol_:F:. no communl.catl_on over the COM port
Blinking: communication over the COM port
2 Model name Shows the model name of the CPU module.
RuN/Stop RUN: execute the programs
STOP: stop the programs
3 USB port Mini USB communication port
SD card slot Provides an interface for an SD card
VRONVR1 VRO: use the flag SM166 to activate the values in SR166
VR1: use the flag SM167 to activate the values in SR167
4 Input/Output LED If there is an input signal, the input LED indicator is ON.
indicator If there is an output signal, the output LED indicator is ON.
5 Ethernet port Provides an interface for a n Ethernet communication
6 COomM1/COM2 Provides an interface for RS-485 communication
7 DIN rail clip Secures the DIN ralil
8 Extension card slot Provides an interface for an extension card
9 MIL connector Connects the module and the wiring module
Note: AS300N-A does not come with inputs/outputs; there is no MIL connector for AS300N-A.
10 Grounding clip For grounding
11 Power supply For power supply
12 Label Nameplate
13 External module port | Connects the modules
. Connects the module and the wiring module
14 ;ir:k(;vable terminal Note: AS300N-A does not come with inputs/outputs; there is no MIL
connector for AS300N-A.
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® AS200 Series (AS218PX-A/AS218RX-A/AS218TX-A/AS228R-A/AS228T-A/AS228P-A)

5! Ir=an 1
o I ) -
o =F
TR T 1= : I
© Lo i -
TN el 5t 1D
<t_wﬂ 88 \ | 95'575 —
Unit: mm
Number Name Description
Power LED indicator Indicates the power status of the CPU module
Operating status of the module
Run LED indicator ON: the module isf running.
OFF: the module is stopped.
Blinking: the module is detecting an error.
Error status of the module
1 Error LED indicator ON: a serious errgr occurs in the module.
OFF: the module is normal.
Blinking: a minor error occurs in the module.
BAT.LOW LED Indicates the battery status of the CPU module.
indicator (Enable/Disable this display in HWCONFIG in ISPSoft)
COML1 LED Indicates the communication status of the COM/CAN port.
COM2 LED OFF: no communication over the COM/CAN port
CAN LED Blinking: communication over the COM/CAN port
2 Model name Shows the model name of the CPU module.
RuN/Stop RUN: execute the programs
STOP: stop the programs
3 USB port Mini USB communication port
SD card slot Provides an interface for an SD card
VRONVR1 VRO: use the flag SM166 to activate the values in SR166
VR1: use the flag SM167 to activate the values in SR167
4 Input/Output LED If there is an input signal, the input LED indicator is ON.
indicator If there is an output signal, the output LED indicator is ON.
5 Ethernet port Provides an interface for a n Ethernet communication
6 COM1/COM2 Provides an interface for RS-485 communication
7 DIN rail clip Secures the DIN rail
8 CAN port Provides an interface for CAN communication
9 ;ir:kosvable terminal Connects the module and the wiring module
10 Grounding clip For grounding
11 Power supply For power supply
12 Label Nameplate
13 External module port | Connects the modules
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® MIL connector, extension cable, and wiring modules (for AS332T-A/AS332P-A/AS324MT-A)

1. Extension Cable UC-ET010-24D (1M) / UC-ET020-24D (2M) / UC-ET030-24D (3M)

Length |

ST
R
0%%%2%%%|

2122

~—500+£10m m—
Unit: mm
Number Name Description
. . Connects a digital input/output module and an external terminal
1 IDC 40-pin terminal 9 P P

module.

Connects the external terminal modules

IDC 20-pin terminal ;5 1 5 |p16A/UB-10-OR16A/UB-10-OR16B

2. AS332T-A/AS332P-A/AS324MT-A and the external terminal module UB-10-ID16A

67.0 !
@ T )| 2
D[] —T]
. ] @
87.0 [

‘esceo\\\\\n\x

N — 53.6

— [

Unit: mm
Number Name Description

1 20-pin MIL connector | Connects the external terminal module and a wiring module
2 Terminals Input/Output terminals for wiring
3 Clip Hangs the external terminal module on a DIN rail
4 Set screw Fixes the base

3. AS332T-A and the external terminal module UB-10-OR16A/AS332P-A, and UB-10-OR16B

| 113 |

° 59

©,

[o¢]

0000 O0OOO O0OOO OO0 H %
7
] :

pervrprrr || 0—O—>e
(=i

55.3

Unit: mm
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Number

Name

Description

1

20-pin MIL connector

Connects the external terminal module and a wiring module

2 Terminals Input/Output terminals for wiring

3 2-pin power input terminal | Power input terminal for wiring

4 Output LED indicator If there is an output signal, the output LED indicator is ON.
5 Relay output Relay output

6 Clip Hangs the external terminal module on a DIN rail

7 Set screw Fixes the base

® Spring clamp/MIL connector terminal block UB-10-1032D for AS332T-A/AS332P-A/AS324MT-A

UUUUUTUUUU

101

UUjUUUUUUUE

Unit: mm

Number

Name

Description

Terminal block for output

Terminal block

40-pin MIL connector

Connects the module and the wiring module
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2.2.4 CPU Module Input/Output Terminals

AS332P-A AS332T-A
S/S S/S SIS S/S
X0.15 | X0.14 X0.15 | X0.14
X0.13 | X0.12 X0.13 | X0.12
() X0.11 | X0.10 () X0.11 | X0.10
el W == X0.9 | X0.8 oo g | X0.9 | X0.8
S oo ? X0.7 | X0.6 Smon ? X0.7 | X0.6
S e ] X0.5 | X0.4 S5 s ] X0.5 | X0.4
— X0.3 | X0.2 oo &+ X0.3 | X0.2
[ == X0.1 | X0.0 [gg ol = L X0.1 | X0.0
PUL ‘[2; == co co PUL > '[2:2;; —— s - -
T § § oo ¥ co | co
[g; o 0 Y0.15 | Y0.14 = [21 2, ' Y0.15 | Y0.14
E] [ - Lg Y0.13 | Y0.12 g] ngg;; ] LQ Y0.13 | Y0.12
[ os on =l oo = . .
o7 o1 ’% = Y0.11 | Y0.10 % = Y0.11 | Y0.10
T Y0.9 | Y038 T Y0.9 | Yo.8
Y0.7 | Y0.6 Y0.7 | Y0.6
Y0.5 | Y0.4 Y0.5 | Y0.4
Y0.3 | Y0.2 Y0.3 | Y0.2
Y0.l1 | Y0.0 Y0.l1 | Y0.0
AS324MT-A AS320T-B/AS320P-B
SIS SIS SIS | SIS
X0.11 | x0.10 X0 | X1
X0.9 | X0.8 X2 | X3
X0.7 X0.6 = X4 X5
() X0.5 | X0.4 X6 | X7
S Anea SGO_| SGO oo, Aean co_| €0
o ow ol =] X0.3- | X0.3+ O ow YO | Y1
oo ASERANT ,—E X0.2- | X0.2+ ocom s30T Y2 | Y3
00 o6 X0.1- | X0.1+ reoe Y4 Y5
I-gg o) e X0.0- | X0.0+ Y6 | Y7
PuLL > '[222 — s co co PuLL > Y8 | Y9
oo | Y0.11 | Y0.10 Y10 | Y11
=2, . Y09 | Y08
Ej LQJ Y07 | Y06 E]
i [ — =1 Y05 | Y0.4
oo || g (]
= SG1 | SG1
Y0.3- | Y0.3+
Y0.2- | YO.2+
Y0.1- | YO.1+
Y0.0- | Y0.0+
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AS218RX-A/AS218TX-A/AS218PX-A

L) 7 AlO DIO
oo AAemra Vi+ | V2+ SIS Co
§°W 11+ 12+ X0.0 | Y0.0
- VI1- | VI2-  X0.1 | YO.1

- - X0.2 | Y0.2
VOl | VO2 X0.3 -
01 | 102 X0.4 | C1
AG | AG X05 | Y03
- - X0.6 | Y0.4
X0.7 | Y0.5

PULL > " 04 o1

-

IN ouT
SIS SIS Co C1
X0.0 | X0.1 YO0.0 | Y04
X0.2 | X0.3 YO0.1 | Y05
X0.4 | X0.5 YO0.2 | YO.6
X0.6 | X0.7 YO0.3 | YO0.7

O POWER

ORUN A AELTA
O ERROR

O BAT. LOW

O comi
o come

Qo0 08
o1 09
©2 010
N 03 O11
PULL D> || o4 o2

05 013

©6 014
=07 015

00 08 X0.8 X0.9 - -
=P X0.10 | X011 - | C2
5] oo X0.12 | X0.13 Y0.8 | Y0.9

-0701

L X0.14 | X0.15 YO0.10 Y0.11

) MIL connector and the external terminal module UB-10-ID16A for AS332T-A/ AS332P-A/
AS324MT-A
- =
[T
o yal

FRARAAAAAA

SSSISLS8S
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AS332T-A
“ TB1 Y0.0 Y0.2 Y0.4 Y0.6 Y0.8 | Y0.10 | Y0.12 | Y0.14 Co -
TB2 Y0.1 Y0.3 Y0.5 Y0.7 Y0.9 | Y0.11 | Y0.13 | Y0.15 Co -
TB1 X0.0 X0.2 X0.4 X0.6 X0.8 | X0.10 | X0.12 | X0.14 SIS -
"2 TB2 X0.1 X0.3 X0.5 X0.7 X0.9 | X0.11 | X0.13 | X0.15 SIS -
AS332P-A
“ TB1 Y0.0 Y0.2 Y0.4 Y0.6 Y0.8 | Y0.10 | Y0.12 | Y0.14 - Co
TB2 Y0.1 Y0.3 Y0.5 Y0.7 Y0.9 | Y0.11 | Y0.13 | Y0.15 - Co
TB1 X0.0 X0.2 X0.4 X0.6 X0.8 | X0.10 | X0.12 | X0.14 SIS -
#2 TB2 X0.1 X0.3 X0.5 X0.7 X0.9 | X0.11 | X0.13 | X0.15 SIS -
AS324MT-A
” TB1 | Y0.0+ | Y0.1+ | Y0.2+ | Y0.3+ | SG1 Y0.4 Y0.6 Y0.8 | Y0.10 Cco
TB2 | Y0.0- | YO.1- | Y0.2- | Y0.3- | SG1 Y0.5 Y0.7 Y0.9 | Y0.11 Cco
TB1 | X0.0+ | X0.1+ | X0.2+ | X0.3+ | SGO X0.4 X0.6 X0.8 | X0.10 SIS
"2 TB2 | X0.0- | X0.1- | X0.2- | X0.3- | SGO X0.5 X0.7 X0.9 | X0.11 SIS

® Spring clamp/MIL connector terminal block UB-10-1032D for AS332T-A/AS332P-A/AS324MT-A

40

38

36

34

32

30

28

26

24

22

20

18

16

14

39

37

35

33

31

29

27

25

23

21

19

17
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2.3 Digital Input/Output Module Specifications
2.3.1 General Specifications

® Electrical specifications for the inputs on digital input/output modules
(The signals passing through the inputs are 24 VDC signals.)

Module name 08AM10ON| 16AM10N| 32AM10N| 64AM10N| 16AP11R| 16AP11T| 16AP11P
-A -A -A -A A -A -A
Number of inputs 8 16 32 64 8 8 8
Connector type Remove;l)tl)(l)il:ermmal MIL connector Removable terminal block
Input type Digital input
Input form Direct current (sinking or sourcing)
Input voltage/ current 24VDC - 5mA 2342\/22 24VDC * 5mA
Action level OFF—ON >15 VDC
ON—OFF <5VDC

Response OFF—ON 10 ms+x10%
time ON—OFF 15 ms+10%
Input impedance 4.7 kQ 7.5kQ 4.7 kQ

Voltage input

Sinking: The inputs are NPN transistors whose collectors are open
Input signal collectors.

Sourcing: The inputs are PNP transistors whose collectors are open

collectors.

Electrical isolation Optocoupler
Input display When the optocoupler is driven, the input LED indicator is ON.
Weight 100 g 117g 100 g 140 g 138 ¢ 120 g 120 g

® Electrical specifications for the outputs on a digital input/output module

Model |0BANO1 16AN01/16AP11 08BANO1 16ANO1 16AP11/08ANO1 16ANO1 16AP11

Item R-A R-A R-A T-A T-A T-A P-A P-A P-A
Number of outputs 8 16 8 8 16 8 8 16 8
Connector type Removable terminal block
Output type Digital output
Output form Relay-R Transistor-T (sinking) | Transistor-P (sourcing)
Voltage/ current 240 VAC/24 VDC 5-30 VDC 5-30 VDC ™
Leakage current OuA <10uA <3i832 Eg\ﬁggﬁg
Resistance 2A/output, BA/COM 0.5A/output, 4A/COM 0.5A/output, 4A/COM
Maximum |Inductance Life cycle curve™ 12 W (24 VDC) 12 W (24 VDC)
load 20 W (24 VDC)
Bulb 2 W (24 VDC) 2 W (24 VDC)
100 W (230 VAC)
e Resistance 1Hz 100 Hz 100 Hz
output Inductance 0.5Hz 0.5Hz 0.5Hz
frequency™ /g 1Hz 10 Hz 10 Hz
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Model |08ANO1/16ANO1 16AP11 08ANO1 16ANO01 16AP11 0BANO1 16ANO1 16AP11
Iltem R-A R-A R-A T-A T-A T-A P-A P-A P-A
OFF—ON 10 ms 0.5ms 0.5ms
ON—OFF 10 ms 0.5ms 0.5ms
Weight 120 g ‘ 158 g ‘ 1389 | 100g ‘ 122¢g ‘ 1209 | 100g ‘ 1239 ‘ 120 g
Model 32ANO2T-A 64ANO2T-A
Item
Number of outputs 32 64
Connector type MIL connector
Output type Digital output
Output form Transistor-T (sinking)
Output voltage 5-30 VDC
Leadage current <10uA
. Resistance 0.1A/output, 3.2A/COM
Maximum
load Inductance N/A
Bulb N/A
Maximum | Resistance 100 Hz
output Inductance N/A
frequency™ g, N/A
Maximum | OFF—ON
0.5ms
RESPonse  HN_oFF
time
Weight 100 g 142 g

*1: The scan cycle affects the frequency.

*2: The life cycle curve is shown below.

Operation(X10°%)

3000 L 120VAC Resistive
N 30VDCInduct|ve(t 7ms)

2000 [ / . 240VAC Inductlve c0s¢=0.4)
1000 NN 120VAC Inductive(cos¢=0.4)
500 < -

300 :

200

100 30vDC

Inductive

50 (t=40ms)

30

20

0.1 0.2 0.3 05 0.7 1 2

Contact Current(A)
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2.3.2 Digital Input/Output Module Profiles

® ASO8AM1O0N-A/ASO8ANO1P-A/ASOS8ANO1R-A/ASO8ANOLT-A

28.2 | 89 -
! — ’
— ——z 08A! @
==
Moo @ o
[e0] [oe]
(e}
»(3)
—>®
(e« 3 »(G) &
v
= fiina=end BRGNS 75 S
25 I [
(— ()
] 08AN \ﬂ g 08AN

[N

IAARIANEL

PWR
out
oo
10
20
30
El=]
sO
6O
a

Number Name Description

1 Model nhame Model name of the module

5 Input/output LED If there is an input signal, the input LED indicator is ON.
indicator If there is an output signal, the output LED indicator is ON.

3 Removable terminal| The inputs are connected to sensors.
block The outputs are connected to loads to be driven.
Arrangement of the

4 input/output Arrangement of the terminals
terminals

5 Terminal block clip | Secures the terminal block

6 DIN rail clip Secures the DIN rail

7 Ez)(:ternal module Connects the modules

8 Label Nameplate
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® AS16AMI10N-A/AS16ANO1P-A/AS16ANO1R-A/AS16ANOLT-A/AS16AP11P-A/AS16AP11R-A/
AS16AP11T-A

38.2 I 95
H [ )
T 16AM @
n_j] = E‘ —
i Ec_m
iy @] a o
1f © e
il g
i i1k
n;] Eim
e Lls] ml
12
ﬂ 75
[ - () ()
0 16AN 0 16AN g 7 16AP 7 16AP
= = = 2
L [u Jﬂ i oo o v
Number Name Description
1 Model name Model name of the module
5 Input/Output LED | If there is an input signal, the input LED indicator is ON.
indicator If there is an output signal, the output LED indicator is ON.
3 Removable terminal| The inputs are connected to sensors.
block The outputs are connected to loads to be driven.
Arrangement of the
4 input/output Arrangement of the terminals
terminals
Terminal block clip | Secures the terminal block
DIN rail clip Secures the DIN rail
External module
7 Connects the modules
port
8 Label Nameplate
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® AS32AMION-A

:‘

@) 3

pannepent

88
o

o
I

98.3

= e E 0 | 75 E
25 !
Unit: mm
Number Name Description
1 Model name Model name of the module
2 XO/.Xl LED . Switches the LED indicators to their represented inputs.
Indicator switch
3 ML connector For the external 1/0O connecting cables UC-ET010-24B, UC-ET020-24B,
UC-ET030-24B
4 _Poyver LED Indicates the power status of the module
indicator
5 Input LED indicator | LED indicator is ON during input.
6 DIN rail clip Secures the DIN rail
7 External module Connects the modules
port
8 Label Nameplate

® AS32ANO02T-A

- Y

O4— 1
@

pannengnt

= >

88
°

o
I
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Number Name Description

1 Model name Model name of the module
YO0/Y1 LED ) - .

2 . O/_ ) Switches the LED indicators to their represented outputs.
indicator switch

3 ML connector For the external 1/0 connecting cables UC-ET010-24D, UC-ET020-24D,

UC-ET030-24D

4 F’oyver LED Indicates the power status of the module
indicator

5 .Ou.tput LED LED indicator is ON during output.
indicator

6 DIN rail clip Secures the DIN rall

7 External module Connects the modules
port

8 Label Nameplate

® AS64AMI10N-A

J

x| o @ a
2||ee oo =
il H o
158

88

— [
= (=T —1p(7) | 75
35 :
Unit: mm
Number Name Description

1 Model name Model name of the module

2 LE_D indicator Switches the LED indicators to their represented inputs.
switch 1
LED indicator . - . .

3 ) Switches the LED indicators to their represented inputs.
switch 2

4 ML connector For the external I/0O connecting cables UC-ET010-24B, UC-ET020-24B,

UC-ET030-24B

5 Poyver LED Indicates the power status of the module
indicator
Input LED indicator | If there is an input signal, the input LED indicator is ON.
DIN rail clip Secures the DIN rail
E I |

8 xternal module Connects the modules
port

9 Label Nameplate
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® AS64ANO2T-A
| 92

:‘

—g —
ﬂ

5

98.3
88

i

: QE
T

T’ﬁ

n
H [ »(7) | 75 g
35 !
Unit: mm
Number Name Description
1 Model nhame Model name of the module
2 LEP indicator Switches the LED indicators to their represented outputs.
switch 1
LED indicator . - .
3 . Switches the LED indicators to their represented outputs.
switch 2
4 ML connector For the external /0 connecting cables UC-ET010-24D, UC-ET020-24D,
UC-ET030-24D
5 _Poyver LED Indicates the power status of the module
indicator
Output LED . . - .
6 . u_pu If there is an output signal, the output LED indicator is ON.
indicator
7 DIN rail clip Secures the DIN rail
E | I
8 xternal module Connects the modules
port
9 Label Nameplate

® ML connector, extension cable, and wiring modules

1. Extension Cable UC-ET010-24D (1M) / UC-ET020-24D (2M) / UC-ET030-24D (3M)

| Length |

RERRRRA
KOSKRRRAA
[sossessssosess!

[226%0%%%6%5%|

Unit: mm

Number Name Description

Connects a digital input/output module and an external terminal

1 IDC 40-pin terminal
module.

Connects the external terminal modules

2 IDC 20-pinterminal |- ;5 1 1516A/UB-10-OR16A/UB-10-OR168B
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2. 1/O connecting cables UC-ET010-24B (1M) / UC-ET020-24B (2M) / UC-ET030-24B (3M)
Length

Number Name Description
. . Connects an external terminal module and a wiring module
1~ | IDC40-pinterminal 5 16.1p32A, and UB-10-0T32A

3.  AS32AMI10N-A/AS64AM10N-A and the external terminal modules UB-10-ID16A, UB-10-ID32A

L 2 UB-10-ID16A
1 67.0 |

O—prcE=Esm]

Unit: mm

4 UB-10-ID32A

| 113

87

EHHHHHHHHHHHHHHHHH}‘ m ’J}‘ W
®_->E§ % | [HEAAAASAAARAEER AR~
| : %4_@—»@ 53.6
O |

={a

T
LL

Unit: mm
Number Name Description
1 UB-10-ID16A: 20-pin ML connector | Connects the external terminal module and a wiring
UB-10-ID32A: 40-pin ML connector | module
Terminals Input/Output terminals for wiring
Clip Hangs the external terminal module on a DIN rail
Set screw Fixes the base
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AS332T-A/AS64ANO2T-A and the external terminal modules UB-10-ID16A, UB-10-OR16A, and
UB-10-OT32A.

4 UB-10-ID16A

67.0 |

@

@

e\

[ ]

4 UB-10-OR16A

6,

=
}

0000 0000 0000 0000

mmmmmmmmmﬁ

4 UB-10-OT32A

Unit: mm

| 113
@ ‘ 87
EHHHHHHHHHHHHHHHHH}‘ /_ﬂ ’—E‘ W
@-}@@@@@@@@@@@@@@@@@% - |[FREEsEeoARPEREEEEAl
S FN | || & = loe——Q@—>»®'53.6
i - D i =
®
Unit: mm
Number Name Description
UB-10- ID16A /OR16A:
1 20-pin ML connector Connects the external terminal module and a wiring
UB-10-OT32A: 40-pin ML module
connector
2 Terminals Input/Output terminals for wiring
3 2-pin power input terminal Power input terminal for wiring
4 Output LED indicator LED indicator is ON during output.
5 Relay output Relay output
6 Clip Hangs the external terminal module on a DIN rail
7 Set screw Fixes the base

2-24




AS Series Operation Manual

® Spring clamp/MIL connector terminal block UB-10-1032D for AS32AM10N-A/AS32AN02T-A

UUUUUT‘UUUU

UUjUUUUUUUE

-—33.7 —
Unit: mm
Number Name Description
1 Terminal block for output Terminal block
2 40-pin MIL connector Connects the module and the wiring module
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2.3.3 Digital Input/Output Module Terminals

ASO8AM10N-A ASO8ANO1P-A

= ]ﬂ[@% — @
0= | i@
1oy - = IO
I3y = o
IO - o 10
I8 - = @
Io - ™ IO
IO - 10| -
IS - o) -
G| - 0 -

E" b=

ASO8ANO1R-A ASO8ANO1T-A

— ]@co = H@
]@coo‘i H@
< N e
O g 19
G o i,
Qs = e
S il
0 - ) -
@s u@6
ol ol

i
f
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AS16AM10N-A

AS16ANO1P-A

;

i

% :
>
<

e e
[Sileisisisis]slisis)e}

ig:

16AN

silsiis]lei=leiisiisisile]

AS16ANO1R-A AS16ANOLT-A
[ [

16AN

106

% 3
>
z

— coﬂm co
co @ﬂm co
0 ﬂm 1
2 @ﬂm 3
< S ig -
s O i) -
8 @ﬂm 9
10 @ﬂm 11
12 13

ouT @ ouT

OO OO OO O[O

(=)i=]/slslmlmle s

fe
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AS16AP11P-A AS16AP11R-A

;

ouT

fid
P z
%%% 5
oo 5

o
o

H
=
@)
-
n
a
-

i

N
O
o
O

.
O
0

CopICEeEg
Sooooooo

[@%%%%%%
%%ﬁ%ﬁ@

IK.

L ® o B
=)
AS16AP11T-A AS32AM10N-A
=== SIS S/s
= 1.15 1.14
16AP 1.13 1.12
- 1.11 1.10
= 1.9 1.8
=~ %‘OUT 17 16
= »Qllg - 15 14
T%ﬁ%? c',“z | oo 13 1.2
1 M@ 1 i ==l o5 11 1.0
30
= 30 s olE 4O
2 %% a4 L= sis sis
3 I 3 oelH
. M@ . o ool 7w 0.15 0.14
Bl - our = 0.13 0.12
. ﬂﬂ@ . = o] wo 0.11 0.10
Silisk = 2ol eo 0.9 08
= g o 0.7 0.6
6 ,
% 70 i 0.5 0.4
1= ﬂ %ﬂ 0.3 0.2
=) 01 00
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AS32AN02T-A AS64AM10N-A
- - - - |20 22
Co Co SIS | sis | 22 | 23
1.15 1.14 115 | 1.14 | 2.4 | 25
1.13 1.12 113 | 1.12 | 266 | 2.7
1.11 1.10 111 | 1.10 | 2.8 | 2.9
1.9 1.8 1.9 | 1.8 | 210 2.11
1.7 1.6 S 1.7 | 1.6 | 212 | 213
1.5 1.4 el el W 15 | 1.4 | 214 | 2.15
od
1.3 1.2 xajfe =]l = e 0 1.3 | 1.2 | SIS | sIs
1.1 1.0 =oll==|] = | 11 ] 10| - -
- - el R = - - 130 | 31
Co Co colllleall 5l | sis | sis| 32 | 33
0.15 0.14 wllo ol 55l o 015|014 | 34 | 35
0.13 0.12 j o2l | 013012 | 36 | 37
0.11 0.10 e lFl e e AOES 0.11 | 0.10 | 3.8 | 3.9
0.9 0.8 ",g, ,gfﬁg 09 | 08 310311
0.7 0.6 %& 07 | 06 | 3.12 | 3.13
0.5 0.4 05 | 0.4 | 314 | 3.15
0.3 0.2 L~ 03 | 02 | s/Is | s/s
0.1 0.0 01| 00 | - -
AS64ANO2T-A
() - - 20 | 21
co | co | 22| 23
Iy
64AN 115 | 1.14 | 2.4 | 25
=i || &N @) 113 | 1.12 | 26 | 2.7
= 5 111 | 1.10 | 2.8 | 2.9
= F’E’ 19 | 18 210 | 211
= 20/ | o o o o
o o 1.7 1.6 | 2.12 | 2.13
ealllas 15 | 1.4 | 214 | 215
vijlee ]| 13 | 12 | c1 | cC1
collllas 1.1 | 1.0 - -
il - - | 30 | 31
aollllas Co | co | 32 | 33
vol|==a||||=allwen| | 015|014 | 3.4 | 35
j ol 013012 | 36 | 3.7
cel@l==ll “OJ | 0411010 | 3.8 | 3.9
2o e oo 49'13EI
g g =0 09 | 0.8 | 310 3.11
150 07 | 06 | 312|313
L Y 05 | 04 314 315
) 0302 cC1 | c1
01| 00 | - -
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) ML connector and the wiring module
1. AS32AM10N-A/AS64AM10N-A

¢  The wiring module: UB-10-ID16A
==

(TR 1]

0SSO SH

SIS

]
R
KOCXXCXXX

AS32AM10N-A/ AS64AM10N-A
TB1 X0.0 X0.2 X0.4 X0.6 X0.8 | X0.10 | X0.12 | X0.14 SIS -
TB2 X0.1 X0.3 X0.5 X0.7 X0.9 | X0.11 | X0.13 | X0.15 SIS -

#2

€  The wiring module: UB-10-ID32A

FEEGEEEEEEEEEIEEEEEE

IEIEISIEIEICIECIEISISISIsEsEsI=I=IE]

@@@@@@@@@@@@@@@@@Qﬁ
| S|
L

m
L4

AS series terminals:
Upper
row
Lower
row

X0.0 [X0.2 |X0.4 |X0.6 | X0.8 X0.10(X0.12X0.14(X1.0 | X1.2 |X1.4 | X1.6 |X1.8 X1.10X1.12[X1.14|S/S|S/S

X0.1 [X0.3 |X0.5|X0.7 | X0.9 X0.11X0.13)X0.15(X1.1 | X1.3|X1.5 X1.7 |X1.9 X1.11X1.13[X1.15|S/S|S/S
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2. AS32AN02T-A/AS64ANO2T-A and the wiring modules:

¢ UB-10-ID16A

[TEEFEFPERE ]|

— TB1
—>TB2

9999888

[ %!
B
5t 0005

AS332T-A
TB1 Y0.0 | Y0.2 | YO4 | Y0.6 | YO0.8 | Y0.10 | YO.12 | YO.14 Co -
TB2 Y0.1 | YO.3 | YO5 | YO.7 | YO.9 | Y011l | YO0.13 | Y0.15 Co -

#1

4 UB-10-OT32A

[Fisizisi=lzlzlzlalzizlzl=Nzl=lzl=lxi

(SN NNV NN ES TS IS TSN Isi=i=i=i=i=i=E=I=i=i=zi=i=i=i=i=i=|

1 S S|

T
LU

AS series terminals:

Upper
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row Y0.1 [ Y0.3 | Y0.5 | Y0.7 | Y0.9 |Y0.11 |Y0.13|Y0.15| Y1.1 | Y1.3 | Y1.5 | Y1.7 | Y1.9 |Y1.11|Y1.13|Y1.15| CO | CO
2 UB-10-OR16A
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'mﬁm‘
Terminals:
GND| +24
\Y

'co|vo vl v2|v3|c1|va|y5]|v6|Y7|c2]|yio]vi1|v12|v13| c3 |v14|v15]|v16]|Y17

AS series terminals:

GND | +24V

€0 [¥0.0/v0.1/¥0.2v0.3| C1 [¥0.4)¥0.5)v0.6/¥0.7| C2 [Y0.8]¥0.9/Y0.10 | Y0.11 | C3 |¥0.12Y0.13|Y0.14 |Y0.15
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3. AS32AM10N-A/AS32ANO02T-A and the wiring modules:

4 UB-10-1032D

UUUUUFUUUU

UUjUUUUUUUE

2.4 Analog Input/Output Module Specifications
2.4.1 General Specifications
® AS04AD-A

Electrical specifications

Module name ASO04AD-A
Number of inputs Four
?cr)l:\lloe?:i(;-ndlgltal Voltage input/Current input
Supply voltage 24 VDC (20.4 VDC-28.8 VDC) (-15% to +20%)
Connector type Removable terminal block
Conversion time 2 ms/channel
An analog circuit is isolated from a digital circuit by a digital integrated circuit/an
optocoupler, but the analog channels are not isolated from one another.
Isolation Isolation between a digital circuit and a ground: 500 VDC
Isolation between an analog circuit and a ground: 500 VDC
Isolation between an analog circuit and a digital circuit: 500 VDC
Isolation between the 24 VDC and a ground: 500 VDC
Weight 1459
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Functional specifications

Analog-to-<_j|g|tal Voltage input
conversion
Rated input range| -10 Vto +10V ov-10V 5V oOvV-5V 1V-5V
Digital K-32000 K-32000
Conversion ~ KO ~ K32000 ~ KO ~ K32000 KO ~ K32000
Range K+32000 K+32000
i -10.1Vto -0.1Vto -5.05V to -0.05V to

Hardware input 0.95 V_5.05
range +10.1V +10.1V +5.05V +5.05V
Error rate (Room +0.2%
temperature)
Error rate (Full
temperature +0. 5%
range)
Linearity error
(Room +0.02%
temperature)
Linearity error
(Full temperature +0.06%
range)
Har i

a dwa_lre 16 bits
resolution
Input impedance 2 MQ
Absolute input +15V
range

Analog-to-q|g|tal Current input

conversion

Rated input range +20 mA 0 mA-20 mA 4 mA-20 mA
Digital
Conversion K-32000 ~ K+32000 KO ~ K32000 KO ~ K32000
Range
?a"’:]rg:'are nput -20.2 mAto +20.2 mA -0.2 mMAto +20.2 mA 3.8 MA-20.2 mA
Error rate (Room +0.2%
temperature)
Error rate (Full
temperature +0.5%
range)
Linearity error
(Room
temperature) (Full +0.04%
temperature
range)
Linearity error +0.10%
H :

ardwa_lre 16 bits
resolution
Input impedance 250 Q
Absolute i

bsolute input +32 MA
range
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® ASO8AD-B

Electrical specifications

Module name ASO08AD-B
Number of inputs Eight
Supply voltage 24 VDC (20.4 VDC-28.8 VDC) (-15% to +20%)
Connector type Removable terminal block
Conversion time 2 ms/channel
An analog circuit is isolated from a digital circuit by a digital integrated circuit/an
optocoupler, but the analog channels are not isolated from one another.
el Isolation between a digital circ_uit gnd a ground: 500 VDC
Isolation between an analog circuit and a ground: 500 VDC
Isolation between an analog circuit and a digital circuit: 500 VDC
Isolation between the 24 VDC and a ground: 500 VDC
Weight 1459

Functional specifications

Analog-to-c.jlgltal Voltage input
conversion
Rated input range| -10 V to +10 V ov-10V 5V OvV-5V 1V-5V
Digital K-32000 K-32000
Conversion ~ KO ~ K32000 ~ KO ~ K32000 | KO ~ K32000
Range K+32000 K+32000
Hardware input -10.1Vto -0.1Vto -5.05Vto -0.05Vto 0.95 V_5.05 V
range +10.1V +10.1V +5.05V +5.05V
Error rate (Room +0.2%
temperature)
Error rate (Full
temperature +0. 5%
range)
Linearity error
(Room +0.02%
temperature)
Linearity error
(Full temperature +0.06%
range)
Hardwe.lre 16 bits
resolution
Input impedance 2 MQ
Absolute input +15V
range
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® ASO08AD-C

Electrical specifications

Module name ASO08AD-C
Number of inputs Eight
é\g:\l/(;?:i(;-ndlgltal Current input
Supply voltage 24 VDC (20.4 VDC-28.8 VDC) (-15% to +20%)
Connector type Removable terminal block
Conversion time 2 ms/channel
An analog circuit is isolated from a digital circuit by a digital integrated circuit/an
optocoupler, but the analog channels are not isolated from one another.
. Isolat?on between a digital circ.uit énd a ground: 500 VDC
Isolation between an analog circuit and a ground: 500 VDC
Isolation between an analog circuit and a digital circuit: 500 VDC
Isolation between the 24 VDC and a ground: 500 VDC
Weight 1459

Functional specifications

Analog-to-q|g|tal Current input
conversion

Rated input range +20 mA 0 mA-20 mA 4 mA-20 mA
Digital
Conversion K-32000 ~ K+32000 KO ~ K32000 KO ~ K32000
Range
:'airgl"are nput -20.2 mA to +20.2 mA -0.2 mAto +20.2 mA 3.8 MA-20.2 mA
E R

rror rate (Room +0.2%
temperature)
Error rate (Full
temperature +0.5%
range)
Linearity error
(Room
temperature) (Full +0.04%
temperature
range)
Linearity error +0.10%
Hardware 16 bits
resolution
Input impedance 250 Q
Absolute input 132 MA
range
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® ASO04DA-A

Electrical specifications

Module name ASO04DA-A
Number of outputs Four
':::\IIZ?;(;;]dlgltal Voltage output/Current output
Supply voltage 24 VDC (20.4 VDC-28.8 VDC) (-15%—+20%)
Connector type Removable terminal block
Conversion time 2 ms/channel
An analog circuit is isolated from a digital circuit by a digital integrated circuit/an
optocoupler, but the analog channels are not isolated from one another.
el Isolation between a digital circ_uit gnd a ground: 500 VDC
Isolation between an analog circuit and a ground: 500 VDC
Isolation between an analog circuit and a digital circuit: 500 VDC
Isolation between the 24 VDC and a ground: 500 VDC
Weight 1459

Functional specifications

Analog-to-digital

. Voltage output
conversion

Rated output
range

Digital K-32000 K-32000
Conversion ~ KO ~ K32000 ~ KO ~ K32000 | KO ~ K32000
Range K+32000 K+32000

10V ov-10V BV oOvV-5Vv 1v-5V

Hardware output -10.1V to -5.05V to -0.05V to
-0. +10. . —9.
range +10.1V 01V +10.1VI ¢ oy +5.05V 0.95V-5.05V

Error rate (Room

+0.2%
temperature)

Error rate (Full
temperature +0. 5%
range)

Linearity error
(Room +0.05%
temperature)

Linearity error
(Full temperature +0.05%
range)

Hardware
resolution

Input impedance 21kQ 2500 Q

12 bits

Analog-to-digital

. Current output
conversion

Rated output
range

0 mA-20 mA 4 mA-20 mA

Hardware output
range

-0.2 mAto +20.2 mA 3.8 mA-20.2 mA
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Analog-to-digital
conversion

Current output

Error rate (Room
temperature)

+0.2%

Error rate (Full
temperature
range)

+0.5%

Linearity error
(Room
temperature) (Full
temperature
range)

+0.03%

Linearity error

+0.03%

Hardware
resolution

12 bits

Input impedance

<550 Q

® ASO06XA-A

Electrical specifications

Module name

ASO6XA-A

Number of
inputs/outputs

Inputs: four; Outputs: two

Analog-to-digital
conversion

Voltage input/Current input; Voltage output/Current output;

Supply voltage

24 VDC (20.4 VDC-28.8 VDC) (-15% to +20%)

Connector type

Removable terminal block

Conversion time

2ms/channel

An analog circuit is isolated from a digital circuit by a digital integrated circuit/an
optocoupler, but the analog channels are not isolated from one another.
Isolation between a digital circuit and a ground: 500 VDC

Isolation Isolation between an analog circuit and a ground: 500 VDC
Isolation between an analog circuit and a digital circuit: 500 VDC
Isolation between the 24 VDC and a ground: 500 VDC
Weight 145¢g

A/D Functional specifications

Analog-to-digital

Voltage input

conversion

Rated input range -10V to +10V ov-10v +5V ov-5v 1V-5V
Digital Conversion K-32000 K-32000

9 ~ KO ~ K32000 ~ KO ~ K32000 | KO ~K32000
Range K+32000 K+32000

i -10. -0.1V to -5. -0.05Vto

Hardware input 10.1Vto 5.05V to 0.95V_5.05V
range +10.1V +10.1V +5.05V +5.05 V
E R

rror rate (Room +0.2%
temperature)
Error rate (Full +0. 5%

temperature range)
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Analog-to-digital
conversion

Voltage input

Linearity error

range

+0.02%
(Room temperature) i
Li it Full
inearity error (Fu +0.06%
temperature range)
Hardware resolution 16 bits
Input impedance 1 MQ
Absolute input +15V

Analog-to-digital

Current input

Range

conversion
Rated input range +20 mA 0 mA-20 mA 4 mA-20 mA
Digital Conversion
K-32000 ~ K+32000 KO ~ K32000 KO ~ K32000

Hardware input

-20.2 mA-20.2 mA

-0.2 mA-20.2 mA

3.8 mA-20.2 mA

range

range

Error rate (Room +0.2%
temperature)

Error rate (Full +0.5%
temperature range)

Linearity error

Room temperatur

(Room temperature) +0.04%
(Full temperature

range)

Linearity error 0.10%
Hardware resolution 16 bits
Input impedance 2500
Absolute input +32 mA

D/A Functional specifications

Digital-to-analog

Voltage output

conversion
Rated output range +10V ov-10v 5V ovV-5V 1v-5v
Digital Conversion K-32000 K-32000
9 ~ KO ~ K32000 ~ KO ~ K32000 | KO ~ K32000
e K+32000 K+32000
-10. -0.1V to -5. -0.05Vto
Hardware output 10.1Vto 5.05V to 0.95V_5.05V
range +10.1V +10.1V +5.05V +5.05V
Error rate (Room 10.2%
temperature) e
Error rate (Full +0. 5%
temperature range)
Linearity error
+ 0
(Room temperature) *0.05%
Linearity error (Full
+ 0
temperature range) *0.05%
Hardware resolution 12 bits
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Digital-to-analog
conversion

Voltage output

Input impedance

>1kQ >500 Q

Analog-to-digital
conversion

Current output

Rated output
range

0 mA-20 mA 4 mA-20 mA

Digital
Conversion
Range

KO ~ K32000 KO ~ K32000

Hardware output
range

-0.2 mAto +20.2 mA 3.8 mA-20.2 mA

Error rate (Room
temperature)

+0.2%

Error rate (Full
temperature
range)

+0.5%

Linearity error
(Room
temperature) (Full
temperature
range)

+0.03%

Linearity error

+0.10%

Hardware
resolution

12 bits

Output
impedance

<550 Q

2.4.2 Analog Input/Output Module Profiles

) AS04AD-A/AS08AD-B/AS08AD-C/AS04DA-A/ASO6XA-A
38.2 | 95
- 1 (]
— 1 —»0
e i T e >0
m_% =3 %_n
i% Moo +@ %:
£l |
® 2 >0
LIA] [§IE
i —>(D i,
Oy >
[k I
] (=4 = 75
J 35 @ !
Unit: mm
Number Name Description
1 Model name Model name of the module

2 POWER

Indicates the status of the power supply

LED indicator .
ON: the power is on
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Number Name Description
OFF: no power
Error status of the module
- ON: a serious error occurs in the module.
ERROR LED indicator .
OFF: the module is normal.
Blinking: a minor error occurs in the module.
. Indicates the analog to digital conversion status
Analog to digital L L :
N Blinking: conversion is taking place
conversion indicator .
OFF: stop conversion
3 Removable terminal The inputs are connected to sensors.
block The outputs are connected to loads to be driven.
Arrangement of the .
4 . 9 . Arrangement of the terminals
input/output terminals
5 Terminal block clip Removal of the terminal block
6 DIN rail clip Secures the module onto the DIN rail
7 Module connecting set | Connects the modules
8 Ground clip
9 Label Nameplate

2.4.3 Analog Input/Output Terminals

ASO4AD-A AS08AD-B AS0BAD-C
(1) EE=aSR ()
ﬂf d 7 08AD
04AD 08AD
2 g z vuﬂ ﬂ@vy = ﬂ ﬁ e
= vi+(] Hﬂ[ Oljva+ = = = L=
Il+% ﬁm V1_E ﬂ@vz- 'kﬂ @'2'
vu-ﬂ ﬁ\nz- ERRC] V3+E E@ Var AE_F:EE ol ﬂ @ Of1a+ AE_F:ES
v3+©ﬂ ﬁ@vu Arem V3'E ﬂ@ v4- |3-©ﬂ @ 14-
I3+ ﬂ ﬁ O) 14+ V5+ E E@ v+ |5+©ﬂ @ ?’j 16+
ws—@E ﬁ@ Via- vl E E@ Ve IS-E @ J) e
SLDE ﬁ@sm V7+E E@V& '7+E @'8“'
. @ﬂ ﬁ@ . V7'E E@VB- |7-©ﬁ @I&—
Aq@ﬂ ﬁ@m aclC ﬂ@uv R @i @24\/
S IC~ SO IO QI IO
C|
FL [ E Mt £ [
') ey =
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ASO6XA-A

+
N

T T
111111

ASO04DA-A

@ 24V

I

- 10l

<0 IO
SEE

2.4.4 Analog Input/Output Device Settings

(1) ASO4AD-A
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(2) ASO8AD-B

(3) ASO8AD-C
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(4) ASO4DA-A

(5) ASO6XA-A

Refer to the AS Series Module Manual for further information on device settings.
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2.5 Temperature Measurement Modules Specifications
2.5.1 General Specifications
® ASO04RTD-A / ASO6RTD-A

Electrical specifications

Number of analog
inputs

ASO04RTD-A: four ; ASO6RTD-A: six

2-WIRE & 3-WIRE Pt100/Ni100/Pt1000/Ni1000/
JPt100/LG-Ni1000/Cu50/Cu100/0-300 ©/0-3000 Q

Pt100 : DIN 43760-1980 JIS C1604-1989 ; 100 Q 3850 PPM/°C
Pt1000 : DIN EN60751 ; 1 kQ 3850 PPM/°C

Ni100/Ni1000 : DIN 43760

JPt100 : JIS C1604-1989

Applicable sensor

LG-Ni1000

Cu50/Cul100
Supply voltage 24 VDC (20.4 VDC-28.8 VDC) (-15% to +20%)
Connector type Removable terminal block

25°C/77°F: The error is £0.1% of the
input within the range.

-20 to +60°C/-4 to +140°F: The error is
+0.5% of the input within the range.

25°C/77°F: The error is £0.2% of the

Pt100/Ni100/Pt1000/Ni1000/JPt100

LG-Ni1000 . -
Ozl EEErrEe) I input within the range.
25°C/77°F: The error is 4°C of the
Cu50 . -
input within the range.
Cul00 ?5 C/7? F The error is 2°C of the
input within the range.
Conversion time Two-wire/three-wire configuration: 200 ms/channel

An analog circuit is isolated from a digital circuit by a digital integrated circuit/an
optocoupler, and the analog channels are isolated from one another by
optocouplers.

Isolation Isolation between a digital circuit and a ground: 500 VDC

Isolation between an analog circuit and a ground: 500 VDC

Isolation between an analog circuit and a digital circuit: 500 VDC

Isolation between the 24 VDC and a ground: 500 VDC

Weight ASO4RTD-A: 115¢g ; ASO6RTD-A: 1259
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Functional specifications

Analog-to-digital
conversion

Centigrade (°C)

Fahrenheit (°F)

Input impedance

Rated input range™

Pt100: -180°C to +800°C
Ni100: -80°C to +170°C
Pt1000: -180°C to +800°C
Ni1000: -80°C to +170°C
JP1100: -180°C to +500°C
LG-Ni1000: -50°C to +180°C
Cu50: -50°C to +150°C
Cul00: -50°C to +150°C

Pt100: -292°F to +1,472°F
Ni100: -112°F to +338°F
Pt1000: -292°F to +1,472°F
Ni1000: -112°F to +338°F
JPt100: -292°F to +932°F
LG-Ni1000: -58°F to +356°F
Cu50: -58°F to +302°F
Cul00: -58°F to +302°F

0-300 Q
0-3000 Q

Average function

Range: 1-100

Self-diagnosis

Disconnection detection

*1: If the measured temperature exceeds the upper limit, it only shows the maximum value. If the
measured temperature is below the lower limit, it only shows the minimum value.

® ASO04TC-A/ASO8TC-A

Electrical specifications

Number of analog
inputs

ASO04TC-A: four ; ASO8TC-A: eight

Applicable sensor

Type J, K, R, S, T, E, N and B thermocouple; input impedance: £100mV

Supply voltage

24 VDC (20.4 VDC-28.8 VDC) (-15% to +20%)

Connector type

Removable terminal block

Overall accuracy

25°C/77°F: The error is £0.5% of the input within the range.
-20 to +60°C/-4 to +140°F: The error is £1% of the input within the range.

Conversion time

200 ms/channel

An analog circuit is isolated from a digital circuit by a digital integrated circuit,
and the analog channels are isolated from one another by optocouplers.
Isolation between a digital circuit and a ground: 500 VDC

Isolation between an analog circuit and a ground: 500 VDC

Isolation Isolation between an analog circuit and a digital circuit: 500 VDC
Isolation between two group circuits: 500 VDC
Isolation between the 24 VDC and a ground: 500 VDC
Isolation between the analog channels: 120VAC

Weight AS04TC-A: 115¢g ; ASO8TC-A: 1259

Functional specifications

Analog-to-digital
conversion

Centigrade (°C)

Fahrenheit (°F)

Input impedance

Rated input range™

Type J: -100°C~1200°C
Type K: -100°C~1,350°C
Type R: 0°C~1,750°C
Type S: 0°C~1,750°C
Type T: -150°C~400°C
Type E: -150°C~980°C
Type N: -150°C~1,300°C
Type B: 200°C~1,800°C

Type J: -148°F~2,192°F
Type K: -148°F~2,462°F
Type R: 32°F~3,182°F
Type S: 32°F~3,182°F
Type T: -238°F~752°F
Type E: -238°F~1,796°F
Type N: -238°F~2,372°F
Type B: 392°F~3,272°F

+100mV

Average function

Range: 1~100

Self-diagnosis

Disconnection detection

*1: If the measured temperature exceeds the upper limit, it only shows the maximum value. If the
measured temperature is below the lower limit, it only shows the minimum value.
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2.5.2 Temperature Measurement Module Profiles

® ASO04RTD-A/ASO6RTD-A

38.2 | 95
H [ )
iy
E P
q 1[[n 3 E‘ o,
%0’) 0] Bl
a 0P| I
.l [ :]]cD I:_
e o % %Jﬂ
u i
: LAl e
I o—s —»(6) 75
J 35
Unit: mm
Number Name Description
1 Model name Model name of the module
Indicates the status of the power supply
POWER LED indicator | ON: the power is on
OFF: no power
Error status of the module
- ON: a serious error occurs in the module.
2 ERROR LED indicator )
OFF: the module is normal.
Blinking: a minor error occurs in the module.
L Indicates the analog to digital conversion status
Analog to digital L L .
L Blinking: conversion is taking place
conversion indicator )
OFF: stop conversion
3 Removable terminal The inputs are connected to sensors.
block The outputs are connected to loads to be driven.
A t of th .
4 ) rrangement . © Arrangement of the terminals
input/output terminals
5 Terminal block clip Removal of the terminal block
6 DIN rail clip Secures the module onto the DIN rail
7 Module connecting set | Connects the modules
8 Ground clip
9 Label Nameplate
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® ASO4TC-A/AS08TC-A

38.2 [ 95
= [
I oatc _H*@ L
— i % E‘ﬁ
! % %j.. -
: j]m E’ﬁ
Bl EI
1]l E_n
o[ 5
] ui E,"
i g
o[ o
I
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35
Unit: mm
Number Name Description
1 Model name Model name of the module
Indicates the status of the power supply
POWER LED indicator | ON: the power is on
OFF: no power
Error status of the module
- ON: a serious error occurs in the module.
2 ERROR LED indicator .
OFF: the module is normal.
Blinking: a minor error occurs in the module.
o Indicates the analog to digital conversion status
Analog to digital L Co :
N Blinking: conversion is taking place
conversion indicator .
OFF: stop conversion
3 Removable terminal The inputs are connected to sensors.
block The outputs are connected to loads to be driven.
Arrangement of the .
4 . 9 . Arrangement of the terminals
input/output terminals
5 Terminal block clip Removal of the terminal block
6 DIN rail clip Secures the module onto the DIN rail
7 Module connecting set | Connects the modules
8 Ground clip
9 Label Nameplate
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2.5.3 Temperature Measurement Module Dimensions

ASO4RTD-A ASO4TC-A
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Unit: mm
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2.5.4 Temperature Measurement Module Device Setting
(1) ASO4RTD-A

(2) ASO6RTD-A
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(3) ASO04TC-A

(4) ASO08TC-A

Refer to the AS Series Module Manual for further information on device settings.
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2.6 Positioning Module Specifications

2.6.1 General Specifications

Electrical specifications for the inputs

® AS02PU-A

Model
Item

Differential inputs on both ends 24VDC COM on one end

Number of inputs

3 (A+HB+Z+A-IB-IZ-) 5 (X0.0-X0.4)

Connector type

Removable terminal blocks

frequency

Input type Digital input

Input form Connected by an independent terminal Direct current (sinking or sourcing)
Input current 5-24 VDC, 5 mA 24 VDC, 5 mA

Action OFF—ON - >15VDC

level ON—OFF - <5VvDC

Response time 25ps <0.5ms

Maximum input 200 KHz 1 KHz

Input impedance

4.7 kQ

Input signal

Voltage input
Sinking: The inputs are NPN transistors
whose collectors are open
- collectors.
Sourcing: The inputs are PNP transistors
whose collectors are open
collectors.

Electrical isolation

Optocoupler

Input display When the optocoupler is driven, the input LED indicator is ON.
Weight 120 g
® AS04PU-A
Model AS04PU-A
Iltem
Number of inputs Six

Connector type

Removable terminal blocks

Input type Digital input

Input form Direct current (sinking or sourcing)
Input current 24 VDC, 5 mA

Action OFF—ON >15VDC

level ON—OFF <5VvVDC

Response time <0.5ms

Input impedance 4.7 kQ
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L B AS04PU-A

Iltem

Voltage input
Input signal Sinking: The inputs are NPN transistors whose collectors are open collectors.
Sourcing: The inputs are PNP transistors whose collectors are open collectors.

Electrical isolation Optocoupler

Input display When the optocoupler is driven, the input LED indicator is ON.
Weight 12049

Electrical specifications for the outputs

Model
ASO02PU-A ASO04PU-A

Item
Number of outputs Four Eight
Connector type Removable terminal blocks
Output form differential output Transistor-T (sinking) (NPN)
Output current 5VDC, 20 mA 5-30 VDC, 0.1A

) Resistance 20 mA 0.1A
Maximum Inductance N/A
load

Bulb N/A

s Resistance 200 KHz 100 KHz
output Inductance N/A
frequency™ Bulb N/A
Maximum
Response |OFF—ON 25upus 5us
time
Weight 120g

2.6.2 Positioning Module Profiles

® ASO02PU-A/ ASO04PU-A
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Number Name Description
1 Model name Model name of the module
Indicates the status of the power supply
POWER LED indicator | ON: the power is on
OFF: no power
Operating status of the module
. ON: the module is running.
Run LED indicator .
2 OFF: the module is stopped.
Blinking: the module is detecting an error.
Error status of the module
o ON: a serious error occurs in the module.
Error LED indicator .
OFF: the module is normal.
Blinking: a minor error occurs in the module.
3 Removable terminal The inputs are connected to sensors.
block The outputs are connected to loads to be driven.
4 Arrangement of the Arrangement of the terminals
input/output terminals
5 Terminal block clip Removal of the terminal block
6 DIN rail clip Secures the module onto the DIN rail
7 Module connecting set | Connects the modules
8 Ground clip
9 Label Nameplate

2.6.3 Positioning Module Terminals

i

ASO02PU-A ASO04PU-A
[ =
7 02PU 7 04PU
= A+§E@A = %@ﬁ@co
Jelliss %Il [ -
“OLID = QUG- e
0 ®11]11 & LR Jeijisk [
oo |E i
SO . S OIliDe |2
geinjieg { deilio R
1+@E@1 ig 5@@@@5 ;’S
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~QII0 - oo GLIg - e
il E
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2.7 Network Module Specifications

2.7.1 General Specifications

® RS-485/RS-422/RS-232 communication interface

Iltem

Specifications

Connector type

European-style terminal block, spring-clamp terminal block

Transmission speed

300, 600, 1,200, 2,400, 4,800, 9,600, 19,200, 38,400, 57,600, 76,800,
115,200, 230,400bps

Communication
format

Stop bit: 1 stop bit or 2 stop bits
Parity bit: none, an odd parity bit, or an even parity bit
Data bit: 7 data bits or 8 data bits

Communication
protocol

Modbus ASCII/RTU
UD Link

® CAN communication interface

Iltem

Specifications

Connector type

RJ-45

Transmission speed

10K, 20K, 50K, 125K, 250K, 500K, 1000 Kbps

Communication
protocol

AS special remote mode (for RTU mode)
CANopen (available for models with firmware V2.0 or later)

® Ethernet communication interface

Iltem

Specifications

Connector type

RJ-45

Transmission speed

10M, 100 Mbps

Communication
protocol

MODBUS TCP, EtherNet/IP (available for models with firmware V2.02 or later)

® Electrical specifications

consumption

Item Specifications
Supply voltage |24 VDC
Electric energy 06W

Weight

Approximately 169 g
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2.7.2 Network Module Profiles

® ASO0SCM-A

(=T 1
—— Q= ==
. @ -
[ m.
| @< 3|3
(v
: oo 1 [
@ = / Chm 75
Unit: mm
Number Name Description
1 Model name Model name of the module
Indicates the status of the power supply
POWER LED indicator ON: the power is on
OFF: no power or the power is low
Error status of the module
OFF: The module is normal.
) ERROR LED indicator Blinking:
® Module setting or communication error (blinks every 1 second)
® Hardware or low power error (blinks every 0.2 second)
Extension card 1 indicator, Blinking: communication is taking place in card 1
(orange) OFF: No communication in card 1
Extension card 2 indicator, Blinking: communication is taking place in card 2
(orange) OFF: No communication in card 2
3 ?:t(;:]egssk:;ssfunctlon 2 sets for setting up the address and function in card 1 and 2
Slot for function card 1 Available for AS-F232/AS-F422/AS-FA485/AS-FEN02
4 ) Available for AS-F232/AS-F422/AS-FA485/AS-FCOPM
Slot for function card 2
AS-FENO2 (only for RTU mode)
5 Mode switch COM: communication mode ; RTU: remote control mode
6 DIN rail clip Secures the module onto the DIN rail
7 Module connecting set Connects the modules
8 Ground clip
9 Label Nameplate
10 Input for supplying power | Power supply for the remote module
to remote modules
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® ASO1DNET-A

382 84.00
H H
1E8ET -0
8 ol
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5 =5 ————= (0
35
75
Unit: mm
Number Name Description
1 Model name Model name of the module

Master/slave mode:

® NSLED

OFF: no power or duplicate ID check has not been
completed.

Green light blinking every 0.5 seconds: the connection
to the DeviceNet network failed.

Green light ON: online; the connection to the DeviceNet
network is normal.

Red light blinking every 0.5 seconds: communication
error

Red light ON: Network trouble, duplicate node ID, no
network power or Bus-OFF.

® MSLED
OFF: no power
Green light blinking every 0.5 seconds: no module is
configured.
Green light ON: input and output data are normal.
Red light blinking every 0.5 seconds: when ASO1DNET
works as the master, the slave in Scan List can not work
normally. When ASO1DNET works as the slave, an error
occurs in the configuration.
Red light ON: hardware error

2 State LED indicator

® Combination of NS LED and MS LED
NS LED OFF & MS LED OFF: no power
NS LED OFF & MS LED green light ON: duplicate ID
check has not been completed.
NS LED red light ON & MS LED green light ON: duplicate
ID check failed or Bus-OFF.
NS LED red light ON & MS LED red light blinking every
0.5 seconds: no network power
NS LED red light ON & MS LED red light ON: hardware
error
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Number

Name

Description

RTU mode:

® NSLED
OFF: no power or duplicate ID check has not been
completed.
Green light blinking every 0.5 seconds: the connection
to the DeviceNet network failed.
Green light ON: online; the connection to the DeviceNet
network is normal.
Red light blinking every 0.5 seconds: 1/0O connection
timeout between ASO1DNET (RTU) and DeviceNet master
Red light ON: Network trouble, duplicate node ID, no
network power or Bus-OFF.

® MSLED
OFF: no power
Green light blinking every 0.5 seconds:
- ASO1DNET (RTU) is waiting for the I/O data from
DeviceNet master.
- No I/O data transmission between ASO1DNET(RTU) and
DeviceNet master
- The PLC connected to DeviceNet master is in STOP state.
Green light ON: normal transmission of /0O data between
ASO1DNET (RTU) and DeviceNet master
Red light blinking every 0.5 seconds: no network power
supply; configuration error; module alarms.
Red light ON: hardware error

Address switch

Setting up the address

Function switch

Setting up the funcitons, including the work mode and baud rate of
DeviceNet network

DeviceNet communication
port

Connects the modules via DeviceNet communication.
Use ASO1DNET-A connector for wiring.

Mode switch
(RTU/DNET;
Master/Slave)

Master/Slave mode: the port does not need an external
24VDC power supply connected

RTU mode: the power input port of the network module is
required to connect an external 24VDC power supply only.
You can connect

Left-side extension port

Connects the modules

Label

Nameplate

Right-side extension port

Connects the modules

10

Input for supplying power
to remote modules

Power supply for the remote module
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2.7.3 Network Module Device Setting

® ASO0SCM-A

Refer to the AS Series Module Manual for further information on device settings.
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2.8 Load Cell Module Specifications

2.8.1 General Specifications

® AS02LC-A

Load cell module

Voltage output

Rated supply voltage/Power
consumption

24 VDC (-15 to +20%) / 5W

Minimum/maximum voltage 18~31.2VvDC
Maximum current consumption | 150 mA

Input signal range +40mVDC
Sensibility +5 VDC +/-10%
ADC resolution 24 bits

Highest precision 0.04%

Applicable sensor type

Four-wire or six-wire load cell

Expanding a temperature
coefficient

<+ 50 ppm/Kv. E

Reducing a temperature
coefficient to zero

<+0.4 pv/iK

Linearity error

<0.02%

Response time

2.5, 10, 16, 20, 50, 60, 100, 200, and 400ms

Eigenvalue applicable to a load
cell

0-1, 0-2, 04, 0-6, 0-20, 0—40 and 0-80 mV/V

Maximum distance for
connecting a load cell

100 meters

Maximum output current

5VDC * 160 mA

Allowable load 40-4,010 Q
Common-mode rejection ratio

>
(CMRR @50/60 Hz) 100 dB
Dynamic range K1-K5
Averaging weights K1-K100

Between a digital circuit and the ground: 500 VAC

Isolation Between an analog circuit and the ground: 500 VAC
Between an analog circuit and a digital circuit: 500 VAC
Weight 140 g
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2.8.2 Load Cell Module Profiles

® ASO02LC-A
95
:1

o = e =
1 % E—

[l ﬂ;,

i g

1 Il

[i]al E_m

[l % %7

o &1

L v
[T —(6) | 75
35 I
Unit: mm
Number Name Description
1 Model name Model name of the module

Indicates the status of the power supply
POWER LED indicator | ON: the power is on
OFF: no power

Error status of the module

ON: a serious error occurs in the module.
OFF: the module is normal.

Blinking: a minor error occurs in the module.

2 ERROR LED indicator

Indicates the analog to digital conversion status
Blinking: conversion is taking place
OFF: stop conversion

Analog to digital
conversion indicator

3 Removable terminal The inputs are connected to sensors.
block The outputs are connected to loads to be driven.
4 ;Ar\mrp:itn/gﬁigﬁ?:eorfn:?neals Arrangement of the terminals
5 Terminal block clip Removal of the terminal block
6 DIN rail clip Secures the module onto the DIN rail
7 Module connecting set | Connects the modules
8 Ground clip
9 Label Nameplate
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2.8.3 Load Cell Module Dimensions

® AS02LC-A
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Unit: mm

2.8.4 Load Cell Module Device Setting
(1) ASO02LC-A

Refer to the AS Series Module Manual for further information on device settings.
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2.9 Extension Card Specifications

2.9.1 General Specifications

® AS-F2AD

Two analog signal input channels:

Characteristic
curve

Digital Value Output

10V

Voltageinput

Digital Value Output

Item Voltage Input Current input
Analog Signal DC 0-10V DC 4-20 mA
Resolution 12-bit 11-bit
Input impedance =1 MQ 250 Q
Conversion time 3ms/CH

4000 2000

Currentinput

Digital value
output

Cardl

SR168 (CH1)

SR169 (CH2)

Card2

SR170 (CH1)

SR171 (CH2)

You can use the program to read the values in SR to obtain the corresponding A/D conversion value for the

channel.

) AS-F2DA

Two analog signal output channels:

Digital Value Input

Item Voltage output Current output
Analog Signal DC 0-10V DC 4-20 mA
Input impedance >1kQ 2500 Q
Resolution 12-bit 12-bit
Conversion time 2ms/CH

5 10V _
gy a
=} —
o 3
Characteristic o =
[@)] (]
curve I ; =
g : (@)
0 4000

Digital Value Input

Digital value output

Cardl

SR172 (CH1)

SR173 (CH2)

Card2

SR174 (CH1)

SR175 (CH2)

You can use the instruction MOV to move the value to the SR to obtain the corresponding voltage output value.
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° AS-F232

The AS series PLC is built with COM1 (RS-485), and COM2 (RS-485). You can use this extension card for
communication with different interfaces such as RS-232 and a PC. The Communication functions are the same
as the built-in ones. You can set the communication port as a slave or a master node. After installing the
extension card, go to the HWCONFIG in the ISPSoft for communication setup.

B Wiring example

AS-F232

+ Superior
(DB9female)

machine

DB9 male to DB9 female (standard cable)

[ AS-FCOPM

With its own standalone communication port, the module can work independently and can be set as a slave or
a master node. After installing the extension card, go to the HWCONFIG in ISPSoft to set up the
communication.

B Wiring example

Master node Slave node Slave node

CAN_H|CAN_L| GND| |CAN_H|CAN_L| GND/ st [GND [CAN_H|CAN_L

| I N
)
° 1 1 1
_ ! | _
Terminal \,-’ Terminal
resistor Shielded resistor
(120 ohm)L— & cable ﬂ,_o_[l](lzo ohm)
®  AS-F422

You can use this extension card for communication with Delta HMI series or other devices through the RS-422
communication port. The Communication functions are the same as the built-in ones. You can set the
communication port as a slave or a master node. After installing the extension card, go to the HWCONFIG in
ISPSoft to set up communication.

B Wiring example of the communication with Delta HMI DOPA series via COM2

AS-F422 Delta HMI DOPA series

1R+  Tx+|3 |RTS-
2 | R- TX- |4 7IRTS+
3/ T+ Rx+l2 gl |
4 T- Rx-|q1 9|CTS+
CTS-
COM2/DB-9
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° AS-F485

With its own standalone communication port, the module can work independently and can be set as a slave or
a master node. After installing the extension card, go to the HWCONFIG in ISPSoft to set up communication.

B Wiring example

Master node Slave node Slave node
D+|D-|SG D+| D-|SG| s (SG(D+| D-
Terminal ¢1—e | A N l A | ! Terminal
resistor - [ A resistor
(120 ohm) |l L (120 ohm)
\ Shielded ‘¢ Shielded
cable cable

° AS-FCOPM

With its own standalone communication port, the module can work independently and can be set as a
MODBUS TCP server, Client or EtherNet/IP Adapter. After installing the extension card, go to the HWCONFIG
in ISPSoft to set up the communication.

B Wiring example

) Linear Topology

) Star Topology

) Ring Topology

ADLR function is required to create a ring topology. ~ When a switch is needed for topology, the switch
should support the DLR function. If not, the

connection might fail.
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2.9.2 Extension Card Profiles

[ AS-F2AD/AS-F2DA/AS-F422/AS-F485

m M
[FH--F]
[ a
™| o
ol o j
0| ©
37 23.9
Unit: mm
Pin no. AS-F2AD AS-F2DA AS-F422 AS-F485
1 V1+ Vo1 R+ -
2 11+ 101 R- -
3 V2+ VO2 T+ D+
4 12+ 102 T- D-
5 COM COM SG SG
®  AS-F232/AS-FCOPM
AS-F232 AS-FCOPM
8 1
_ I !
0 q 0 ]
™M™ i MM
— o) © ‘A‘ ol -l [
0 et q | © 0 rls)| | 0| ©
4 - 1 [
\ \
37 23.9 37 23.9
Unit: mm
Pin no. AS-F232 AS-FCOPM
1 - CAN_H
2 X CAN_L
3 RX GND
4 . B
5 GND i
6-9 - -
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) AS-FENO2

@
®

"B

| ——|
61.5 “~—®

T
ml

Number Name Description

Indicates if the module has been set

ON: the setting is complete

Blinking: the setting is not complete

OFF: no power

Indicates the status of Ethernet connection

Green lignt ON: a CIP connection is established

Green lignt BLINKING: a CIP connection is not established
2 NS indicator Red light ON: duplicated IP address

Red light BLINKING: communication timeout / DLR conection
lost / IP address change
OFF: no power / network cable is not connected

1 MS indicator

3 RJ-45 port X1/X2 Use for network connections

Indicate the status of Ethernet connection

4 LINK indicator X1/X2 Green light ON: a network connection is established
OFF: a network connection is not established
Indicate the status of Ethernet communication

5 ACT indicator X1/X2 Orange BLINKING: data transmission

OFF: no data transmission

6 Clip ring Secures AS series

RJ-45 Pin Definition

1TX+ 2 TX- 3 RX+ 4 N/C Eﬂm—mﬂ

5N/C 6 RX- 7N/C 8 N/C

2.9.3 Function Card Weights

AS-F2AD AS-F2DA AS-F422 AS-F485 AS-F232 | AS-FCOPM | AS-FENO2

Weight 3049 30¢g 229 29¢ 269 29¢ 51¢g
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2.10 Power Supply Module Specifications

2.10.1 General Specifications

® AS-PS02/AS-PS02A

Iltem

Specifications

Supply voltage

100-240 VAC (-15% to +10%)
50/60 Hzt5%

Action
specifications

If the input power supply is larger than 85 VAC, the power supply module can
function normally.

Allowable
instantaneous
power failure time

If the instantaneous power failure time is less than ten milliseconds, the power
supply module keeps running.

Fuse

2.5A/250 VAC

Inrush current

<70A@115 VAC

24 VDC output

AS-PS02: 2 Afor internal use: the CPU and the modules.
AS-PS02A: 1.5 A for internal use: the CPU and the modules;
0.5 A for external use.

Power protection

The 24 VDC output is equipped with the short circuit protection and the
overcurrent protection.

Surge voltage
withstand level

1,500 VAC (Primary-secondary), 1,500 VAC (Primary-PE), 500 VAC
(Secondary-PE)

Insulation voltage

Above 5 MQ
The voltage between all inputs/outputs and the ground is 500 VDC.

Ground

. AS-PS02
Weight
AS-PS02A

The diameter of the ground should not be less than the diameters of the cables
connected to the terminals L and N.

270 g
310g

2.10.2 Power Supply Module Profiles

® AS-PS02

H
=] e
. I

o

g 0
0 ),
=) IR
5 ]
91.5 _
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® AS-PS02A
[ A
= ] &
(@) rower =
—>Q . ]
PSOZA——»@
™
CD. g || r2av ouTpPuTHEER >@ E|o
@ i »@ o |
bl G,
oy | ks
LG@AWARNING @ %2 : © »@
Risk of electrical shock. Hl
pover e servng |55 = =
(=] =
70 75 .
B 74.2 91.5
- 77.9
Number Name Description
POWER LED .
1 o Indicates the status of the power suppl
indicator (green) P PRl
Model name Model name of the power supply module
3 Terminal Terminal for wiring
+24V: connecting external 24VDC +
4 Arrangement of the | 24G: connecting external 24G
terminals LG: Line ground
L/N: AC power input
5 Power output Connected with AS series

2.10.3 Power Supply Module Terminals
® AS-PS02

—

] =5
POWER
PS02
® L/N: AC power input
° LG: Line ground
O
——
Risk of electrical shock.
Wait 5 seconds after removing
power before servicing. %

L")
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® AS-PS02A

—

POWER
PS02A
24V
ouTeuT NN
G
q =
‘ L NPUT
| N - ]
L | LG@AWARNING
Risk of electrical shock.
Wait 5 seconds after removing
pewer before servieing. %

=)

+24V: connecting external 24VDC +
24G: connecting external 24G

L/N: AC power input

LG: Line ground
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MEMO
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Before developing an AS Series system, install ISPSoft and COMMGR. ISPSoft is a software platform for integrating

the hardware, network configuration, and program development for a system. COMMGR functions as middleware

between a computer and devices. It functions as a communication management interface between ISPSoft and AS

Series hardware.

3.1 Installing and Uninstalling ISPSoft

® System requirements

Item

System requirement

Operating system

Windows XP / VISTA/7/8/10

CPU

Pentium 1.5 G or above

Memory

256 MB or above (512 MB or above is recommended.)

Hard disk drive

Capacity : 500 MB or above

CD-ROM drive This is optional for installing ISPSoft.
Resolution: 800x600 or above
Monitor
(suggested setting: 1024x768/96 dpi)
Keyboard/Mouse A general keyboard/mouse or devices compatible with Windows
Printer A printer with a driver for Windows. This is needed to print projects.
RS-232 port For connecting to a PLC
One of them is used, but a PLC that is
USB port For connecting to a PLC

Ethernet port

connected must have a corresponding port. (*1)
For connecting to a PLC

Communication

software

COMMGR, a communication manager, must be installed. (*2)

Supported Models

AH500 series PLCs/DVP series PLCs (exclusive of DVP-PM series PLCs)/ AS series, AC

motor drives: VFD with PLC built-in series, and Text panel HMI with PLC built-in series.

*1. ISPSoft supports several ways to connect a computer to a PLC. Make sure the port and the mode supported by

the PLC are correct before you connect a computer to the PLC.

*2. Please refer to section 3.2 for more information about COMMGR.

*3. The functions and specifications mentioned above are only applicable to ISPSoft version 3.00 or above. The older

versions are not equipped with complete functions.
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3.1.1 Installing ISPSoft

If an older version of ISPSoft has been installed on a computer, uninstall it before you install ISPSoft. Refer to section

3.1.2 for more information about uninstalling ISPSoft. The following are the steps to install ISPSoft.

(1) Start the Windows operating system and then install ISPSoft. You may need administrative privileges to install the

software.

(2) Put the ISPSoft CD in the CD-ROM drive, or download the installation program from

http://www.delta.com.tw/ch/index.asp. Before you install the installation program downloaded from the website,

you must decompress the file.

(3) Click Start, and then click Run... to open the Run window. Specify the path to the file called setup.exe in the

Open box, and then click OK. You can also double-click the setup icon to execute the installation program.

OR

Q@ '\@

(4) After the ISPSoft x.xx — Install Shield Wizard window appears, click Next.

i 1SPSoft 2.00 - InstaliShield Wizard X
welcome to the InstallShield wizard for
1SPSoft 2.00

The InstallShield{R) Wizard will install ISPSoft 2,00 on your
computer. Ta continue, click Mext.

WARNING: This program is protected by copyright law and
international treaties.

< Mext = ; Cancel
N
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(5) Type the necessary information in the User Name and Organization boxes, and then click Next.

(6) Leave the default path unchanged, or click Change... to change the path. Click Next.

-

(7) Check the installation information, and then click Install.

{1z ISPSoft 2.00 - InstallShield Wizard

Ready to Install the Program

The wizard is ready to begin installation.

If you want to review or change any of your installation settings, click Back. Click Cancel ko
axit the wizard,

Current Settings:

Setup Type:

Destination Folder:

Ci\Program Files\Delka Industrial Automation\ISPSoft 2,001
User Information:

Mame: User

Company: Delta TABU

< Back q] Instal D{ Cancel
e
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(8) After ISPSoft is installed, the install program creates shortcuts on the desktop and the Start menu. Click Finish to

complete the installation.
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3.1.2 Uninstalling ISPSoft

(1) There are two methods to uninstall ISPSoft.

® Method 1: Open the Control Panel window, and click Add or Remove Programs. Inthe Currently

installed programs dialog box, click ISPSoft x.xx, and then click Remove.

O\@

® Method 2: Start>Programs>Delta Industrial Automation>PLC>ISPSoft x.xx>Uninstall

(2) Click Yes to remove ISPSoft.

Q@
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3.2 Installing and Uninstalling COMMGR
3.2.1 Installing COMMGR

If an older version of COMMGR has been installed on a computer, uninstall it before you install COMMGR. Refer to

section 3.2.2 for more information about uninstalling COMMGR. The following are the steps to install COMMGR.

(1) Start the Windows operating system and then install ISPSoft. You may need administrative privileges to install the

software.

(2) Put a COMMGR CD in the CD-ROM drive, or download the installation program from

http://www.delta.com.tw/ch/index.asp. Before you install the program downloaded from the website, you must

decompress the file.

(3) Click Start, and then click Run... to open the Run window. Specify the path to the file called setupComm.exe in
the Open box, and then click OK. You can also double-click the setup Comm icon to execute the installation

program.

OR

—g &

(4) After the COMMGR x.xx — Install Shield Wizard window appears, click Next.

InstallShield Wizard

COMMGR 1.00 Setup is preparing the InstallS hield Wizard which
will guide you thraugh the program setup process. Please wait.
e

Checking Dperating System Yersion

NENAEENNAERNEEE

>
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(5) Type the necessary information in the User Name and Organization boxes, and then click Next.

(6) Check the installation information, and then click Install.

5. COMMGR 1.00 - InstallShield Wizard

Ready to Install the Program ~

The wizard is ready to begin installation,

IF wou want to review or change any of vour installation settings, click Back. Click Cancel to
exit the wizard,

Current Settings:

Setup Type:

Destination Folder:

Ci\Program FilesiDelta Industrial Automationt COMMGRY,
User Information:

Mame; User

Company: Delka TABL

< Back q Install ])[ Cancel
N—

(7) After you install COMMGR, the installation program creates a shortcut to the program on the Start menu. Click

Finish to complete the installation.
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3.2.2 Uninstalling COMMGR

(1) There are two methods to uninstall COMMGR.

® Method 1: Open the Control Panel window, and click Add or Remove Programs. In the Currently installed

programs box, click COMMGR x.xx, and then click Remove.

—

® Method 2: Start>Programs>Delta Industrial Automation>Communication>COMMGR>Uninstall

(2) Click Yes to remove COMMGR.

COMMGR 1.00
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4.

1 Installation

4.1.1 Installing a Module

If th

Press the clip rings if they are out as the image 1 shown. Push the module to the desire position
until you hear a click to finish installation.

Link the I/O modules on the right side of the PLC and make sure they are hooked together. Push the
modules into the DIN rail until you hear a click.

After you installed the module, fasten the screws on the modules to secure the module on the DIN rail.

@@
=)

L Sj

] 00000000 00000000 O RARARAARIH

ere is a vibration source near the installation site, install anti-vibration baffles on the sides of the AS Series

modules for better stabilization, such as the gray baffles show below.
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) Install the baffles:

| Hook the baffle onto the DIN rail and press it down as the directional arrow shows below.

i |ﬂ|ﬂ|ﬂ|ﬂ|ﬂnﬂwﬂwﬂwﬂnﬂm

gggggggggg

24VDC N
24V v

[ | Use screws to secure the baffle.

d hf hi hd hi hd hi hi hd &

weweseny

24VDC IN
4V ©
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[ | The completed baffle installation is shown below.

]
)

000000

MFUFTAURR AL

C PULL >

[[®
B

00000000 OO0O000O0O

== u

=JI:IIJI:II:IIJI:II:ID oooooooo o MARF

(| pEREE,

i

4.1.2 Installing a Removable Terminal Block

Install the removable terminal block on the module as shown below.

® Installation

1. Align the terminal block at the printed circuit board, and press it into the module.

® Removal

1. Pull the clips down in the direction shown by the arrow, and then pull the terminal block up

as shown below.
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4.2 Wiring
4.2.1 Wiring a Power Supply Module

A power supply module supplies direct current to a CPU module and 1/0 modules.

o Connecting an AC power cable

Control Box
PS02A ASSeries 06XA
+24V
24G
|-_° L
o=
- LG
100~240V i
oV

® The alternating-current input voltage is either 100 VAC or 240 VAC. Connect the power supply to the
terminals L and N. If the 110 VAC or the 220 VAC power supply is connected to the input terminals +24V
and 24G, the PLC will be damaged.

® If power is interrupted for less than 10 milliseconds, the PLC keeps running without being affected. If a
power interruption lasts for longer, or if the voltage of the power supply decreases, the PLC stops running,
and there is no output. When the power supply returns to normal, the PLC resumes. Notice that there are

latched auxiliary relays and registers in the PLC when you write the program.

® Use single-wire cables or two-wire cables in a diameter of 22 AWG~18 AWG and with less than 2 mm

pin-typed terminals. Only use copper conducting wires with a temperature of 60/75°C.

i 4
+—

<2mm 11-12mm 22-18AWG

4.2.2 Wiring I/0 Modules

The I/O modules include digital input/output, analog input/output, and network modules. Follow the directions
for the wiring of I/O modules in Chapter 5 of the AS Series Hardware Manual.
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5.1 Introduction of Devices

This section describes the values and strings processed by the PLC. It also describes the functions of devices
that include input, output, and auxiliary relays, as well as timers, counters, and data registers. The PLC
simulates external devices in the PLC’s internal memory, so the word “device” is a generic name that refers to

all the internal memory locations in the PLC. A device can be a bit device or a word device. Bit devices simulate

coils, contacts and flags, while word devices simulate registers.

5.1.1 Device Table

Type Device name Number of devices Range
Input relay X 1024 X0.0-X63.15
Output relay Y 1024 Y0.0-Y63.15
D | 48,0000 D0.0-D29999.15
Data register
W | 48,0000 W0.0-W29999.15 **
Auxiliary relay M 8192 M0-M8191
Bit device
Special auxiliary relay SM | 4096 SM0-SM4095
Stepping relay S 2048 S0-S2047
Timer T 512 TO-T511
Counter C 512 C0-C511
32-bit counter HC | 256 HCO0-HC255
Input relay X 64 X0-X63
Output relay Y 64 YO0-Y63
D | 30000 D0-D29999
Data register
W | 30000 WO0-W29999 *4
Special auxiliary relay SR | 2048 SR0-SR2047
Word device File register FR | 65536 FRO-FR65535
Timer T 512 TO-T511
Counter C 512 C0-C511
32-bit counter HC | 256 (512 words ) HC0-HC255
10 EO-E9
Index register E
5 E10-E14 *
16 bits: -32768 to 32767
Constant*! Decimal system K
32 bits: -2147483648 to 2147483647
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Type Device name Number of devices Range

16 bits: 16#0—-16#FFFF

Hexadecimal system 16#
32 hits: 16#0—-16#FFFFFFFF

Constant*?
Single-precision
F 32 bits: #1.1754943538 to +3.40282347+38
floating-point number
String*3 String “$” | 1-31 characters

*1: Constants are indicated by K in the device lists in Chapter 5 and Chapter 6 in the AS Series Programming

Manual. An example when “K50” appears in the AS Series Programming Manual, enter only the number 50 in

ISPSoft.

*2: Floating-point numbers are indicated by F/DF in the device lists in Chapter 5 and Chapter 6 in the AS Series

Programming Manual, but they are represented by decimal points in ISPSoft. For example, for the floating-point

number F500, enter 500.0 in ISPSoft.

*3: Strings are indicated by “$” in Chapter 5 and Chapter 6 in the AS Series Programming Manual, but they are

represented by quotes (“ ") in ISPSoft. For example, for the string 1234, enter “1234"in ISPSoft.

*4: This is used for editing in ISPSoft only.

5.1.2 Basic Structure of I/0 Storages

Access by | Access by Modify by
Device Function Force the bit ON/OFF
bits words ISPSoft
X Input relay OK OK OK OK
Y Output relay OK OK OK OK
M Auxiliary relay OK - OK -
Special auxiliary
SM OK - OK -
relay
S stepping relay OK - OK -
T Timer OK OK OK -
C Counter OK OK OK -
HC 32-bit counter OK OK OK -
D Data register OK OK OK OK
SR Special data register - OK OK -
FR File register - OK*! - -
E Index register - OK OK -

*1: Use an instruction for writing to an FR.
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5.1.3 Relation Between the PLC Action and the Device Type

Device type Non-latched area Latched area
PLC action Device Y Other devices File register Other devices
Power: OFF—ON Cleared Cleared Retained Retained
Restore to defaults Cleared Cleared Cleared Cleared

This clears the

non-latched area Cleared Cleared Retained Retained
STOP
state.
l
This retains the
RUN*L
non-latched area Retained Retained Retained Retained
state.

This clears the
RUN Cleared Retained Retained Retained
device Y state.

l
This retains the
STOP*! Retained Retained Retained Retained
device Y state.

SM204 is ON.This clears all
Cleared Cleared Retained Retained
non-latched areas.

SM205 is ON.This clears all
Retained Retained Retained Cleared
latched areas.

*1: For state setups, see HWCONFIG in ISPSoft. The PLC STOP->RUN default is “clear the non-latched area
state”. The PLC RUN->STOP default is “clear the state of device Y".

5.1.4 Latched Areas in the Device Range

Device Function Device range Latched area
X Input relay X0-X63 All devices are non-latched.
Y Output relay YO0-Y63 All devices are non-latched.
M*1 Auxiliary relay M0-M8191 The default range is M6000—-M8191.

Some devices are latched and cannot be

changed.
SM Special auxiliary relay | SM0-SM2047
Refer to the list of special auxiliary relays for

more information.

Sl Stepping relay S0-S1023 The default range is S512-S1023

T Timer TO-T511 All devices are non-latched.
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Device Function Device range Latched area
c4 Counter C0-C511 The default range is C448—-C511
HC*! 32-bit counter HCO0-HC255 The default range is HC128—-HC255
D0-D29999 The default range is D20000-D29999
D*! Data register
WO0-W29999 Use this for editing in ISPSoft only.
FR File register FRO-FR65535 All devices are latched.

Some are latched and cannot be changed. Refer

SR Special data register SR0-SR2047 to the list of special data registers for more
information.
EO-E9 All devices are non-latched.
E Index register
E10-E14 Use this for editing in ISPSoft only.

*1: For the latched area setups, see HWCONFIG in ISPSoft. Setting the latched area means the other areas
show as non-latched areas. The range of latched areas cannot exceed the device range. For example, if

you set the M600—M7000 as latched areas, M0-M5999 and M7001-M8191 become non-latched areas.

5.2. Device Functions

Procedure for processing the program in the PLC:

® Regenerating the input signal

1. Before executing the program, the external input signal

state is read into the memory for the input signal.

Input terminal X 2. When the program is executed, the state in the

l Regenerating the input signal memory location for the input signal does not change

even if the input signal changes from ON to OFF or

Device memory

from OFF to ON. The input signal is not refreshed until

Processingthe program the next scan begins.

® Processing the program

Alowauw adinag

Device memory After the input signal is refreshed, the instructions in the

l program are executed in order from the start address of the

Regenerating the output signal program. The results are stored in the device memories.

and sending itto the output terminal
® Regenerating the state of the output

After the instruction END is executed, the device memory
state in the device memory is sent to the specified output

terminal.
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5.2.1 Values and Constants

Name Description
Bit A bit is the basic unit in the binary system. Its state is either 1 or 0.
) A nibble is composed of four consecutive bits (for example b3—-b0). Nibbles can
Nibble represent 0-9 in the decimal system or 0—F in the hexadecimal system.
A byte is composed of two consecutive nibbles (i.e. 8 bits, b7—b0). Bytes can
Bye represent 00—FF in the hexadecimal system.
A word is composed of two consecutive bytes (i.e. 16 bits, b15-b0). Words can
Word represent 0000—FFFF in the hexadecimal system.
A double word is composed of two consecutive words (i.e. 32 bits, b31-b0).
Double word Double words can represent 00000000—FFFFFFFF in the hexadecimal
system.

The relation among bits, nibbles, bytes, words, and double words in the binary system is shown below.

DW <«— Double word
_g— N —
w1 wWo
A~ A~ <+— Word
- o~ S
BY3 BY2 BY1 BYO . Byte

NB7 NB6 NBS NB4 NB3 NB2 NB1 NBO

—_— -~~~

<— Nibble

b31b30b29b28b27b26b25b24b23b22b21|b20b19b18bl7b16b15b14b13blell b10| b9| b8[b7[b6 [b5[b4|b3|b2|b1|b0| *—— Bit

The PLC uses four types of values to execute the operation according to different control purposes. The
following illustrates the values of these functions.:

1. Binary number (BIN)
The PLC uses the binary system to operate the values.
2. Decimal number (DEC)
The PLC uses decimal numbers for;

® The setting value of a timer (T) or the setting value of a counter (C/HC); for example, TMR CO 50
(constant K).

® The device number; for example, M10 and T30 (device number)

® The number before or after the decimal point; for example, X0.0, Y0.11, and D10.0 (device
number).

® The constant K: used as the operand in an applied instruction. For example, MOV 123 DO
(constant K).
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3. Binary-coded decimal (BCD)

A decimal value is represented by a nibble or four bits, so that sixteen consecutive bits represent a
four-digit decimal value.

4. Hexadecimal number (HEX)
The PLC uses hexadecimal numbers for;

® the constant 16#: used as the operand in an applied instruction; for example, MOV 16#1A2B DO
(hexadecimal constant).

The following table shows the corresponding values.

Binary Number Decimal Number Binary Code Decimal Hexadecimal Number
(BIN) (DEC) (BCD) (HEX)
Constant K, Instant 16#,
PLC internal execution BCD related instruction
Device number Device number

0000 0 0000 0

0001 1 0001 1 g
0010 2 0010 2

0011 3 0011 3

0100 4 0100 4

0101 5 0101 5

0110 6 0110 6

0111 7 0111 7

1000 8 1000 8

1001 9 1001 9

1010 10 - A

1011 11 - B

1100 12 - C

1101 13 - D

1110 14 - E

1111 15 - F
10000 16 0001 0000 10
10001 17 0001 0001 11
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5.2.2 Floating-point Numbers

The floating-point numbers are represented by decimal points in ISPSoft. For example, the floating-point
number of 500 is 500.0. Refer to Section 2.2.2 in the AS Series Programming Manual for more information.

5.2.2.1 Single-precision Floating-point Numbers

Floating-point numbers are represented by the 32-bit register. The representation adopts the IEEE754
standard, and the format is as follows.

_— 8-bit — 23-bit ——_

S Exponent Mantissa
D31 bo
|—> Sign bit
0: Positive
1: Negative

cquation: (—1)° %25 x1M;B =127

The single-precision floating-point numbers range from +2-126 to +2+128, and correspond to the range from
+1.1755x10-38 to +£3.4028%10+38.

The AS series PLC uses two consecutive registers to form a 32-bit floating-point number. Take (D1, DO) for
example.

|¢——— D1(b15~b0) ———>|——DO(b15~b0) —»|

P = g =
| s [E7]E6]E5] § | E1] E0 [A22]A21][A20] G G [AB | A5 | A4 | A3 [A2[AL] AD]
b31 b30 b29 b28 b24 b23 b22 b21 b20 b6 b5 b4 b3 b2 bl bo

lecPle—=Exponent (8 bits) =pj¢=————— Mantissa (23bitS) ——p|

The position where the decimal point is hidden

Mantissa sign bit (0: Positive; 1: Negative)
When b0~b31are zeros, the contentis zero.

Example 1:

23 is represented by a single-precision floating-point number.

Step 1: Convert 23 into the binary number, i.e. 23.0=10111.
Step 2: Normalize the binary number, i.e. 10111=1.0111 x24 (0111 is the mantissa, and 4 is the exponent.).
Step 3: Get the value of the exponent.
* E-B=4—E-127=4 ", E=131=100000112
Step 4: Combine the sign bit, the exponent, and the mantissa to form the floating-point number.

0 10000011 011100000000000000000002=41B8000016
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Example 2:
-23 is represented by a single-precision floating-point number.

Converting -23.0 into the floating-point number uses the same steps as converting 23.0 into the floating-point
number, except that the sign bit is 1.

110000011 01110000000000000000000.=C1B8000016

5.2.2.2 Decimal Floating-point Numbers

-23 is represented by a single-precision floating-point number.

Converting -23.0 into the floating-point number uses the same steps as converting 23.0 into the floating-point
number, except that the sign bit is 1.

110000011 011100000000000000000002=C1B8000016

5.2.2.2 Decimal Floating-point Numbers

° Single-precision floating-point numbers and double-precision floating-point numbers can be converted
into decimal floating-point numbers so people can read them. However, the PLC uses single-precision

floating-point numbers and double-precision floating-point numbers internally.

o A 32-bit decimal floating-point number is represented by two consecutive registers. The constant is
stored in the register whose number is smaller while the exponent is stored in the register whose number

is bigger. Take (D1, DO) for example.

[Exponent D1]
Decimal floating-point number=[Constant DO]* 10

Base number DO=+1,000 to +9,999
Exponent D1=-41—+35

The base number 100 does not exist in DO because 100 is represented by 1,000x10. 32-hit decimal

floating-point numbers range from £1175x10*! to +402x10*35,
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5.2.3 Strings

The PLC can process strings composed of ASCII codes (*1). A complete string begins with a start character
and ends with an ending character (NULL code). Strings can be a maximum of 31 characters, and the ending
character 16#00 is added automatically in ISPSoft.

1. No string (NULL code) is moved.

NETWORK 1

Mo Mo

| En
I

D0=0 (NULL)

2. The string has an even number of characters.

NETWORK 1
Mo FMOY
| I En
"abcd" {5 Dl po
DO 16#62 (b) 16#61 (a)
D1 16#64 (d) 16#63 (b)
D2 0 (NULL)

3. The string has an odd number if characters.

NETWORK 1
MO oy
' .
"abcde" |5 Dl-Do
DO 16#62 (b) 16#61 (a)
D1 16#64 (d) 16#63 (b)
D2 0 (NULL) 16#65 (e)
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*1: ASCII code chart

Hex 0 1 2 3 4 5 6 7 8 9 A B C D E F

ASCII

X
xI
X
X
xI
X

Hex 10 11 | 12 | 13 | 14 | 15 | 16 | 17 | 18 | 19 | 1A | 1B | 1C | 1D | 1E | 1F

ASCII

Hex 20 21 | 22 | 23 | 24 | 25 | 26 | 27 | 28 | 29 | 2A | 2B | 2C | 2D | 2E | 2F

ASCIl| SP | v |l # L $  w & | | () e e

Hex 30 31 | 32 | 33 | 34 | 35 | 36 | 37 | 38 | 39 | 3A | 3B | 3C | 3D | 3E | 3F

ASCII 0 1 2 3 4 5 6 7 8 9 : ; < = > ?

Hex = 40 | 41 | 42 | 43 44 | 45 | 46 | 47 | 48 49 | 4A | 4B | 4C | 4D @ 4E | 4F

ASCII @ A B C D E F G H | J K L M N o

Hex 50 51 | 52 | 53 | 54 | 55 | 56 | 57 | 58 | 59 | A | 5B | 5C | 5D | 5E | 5F

ASCII P Q R S T U \Y w X Y 4

Hex 60 61 | 62 | 63 | 64 | 65 | 66 | 67 | 68 | 69 | 6A | 6B | 6C | 6D | 6GE | 6F

ASCII X a b c d e f g h i j k I M n 0

Hex 70 71|72 | 73 |74 |75 |76 | 77| 78|79 | 7A | 7B 7C | 7D T7E | 7F

ASCII p q r s t u % w X y z { | } ~

Note: XI represents an invisible character. Please do not use it.

5.2.4 Input Relays (X)

® Input function

The input is connected to the input device (external devices such as button switches, rotary switches, and
number switches), and PLC reads the input signal. You can use input contact A or contact B several times

in the program, and the ON/OFF input state varies with the ON/OFF input device state.
® Input number (the decimal number):

For the PLC, the input numbers start from X0.0. The number of inputs varies with the number of inputs on
the digital input/output modules. The inputs are numbered according to the order in which the digital
input/output modules are connected to the CPU module. The maximum number of inputs for the PLC is

8192, and the input number range is between X0.0 and X511.15.
® Input type
Inputs are classified into two types.

1. Regenerated inputs: PLC reads the state of a regenerated input before the program is executed. For

example, LD X0.0.
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2. Directinput: The state of a direct input is read by the PLC during the execution of the instructions. For

example, LD DXO0.0.

5.2.5 Output Relays (Y)

® Output function

The output sends the ON/OFF signal to drive the load connected to the output, such as an external signal
lamp, a digital display, or an electromagnetic valve. There are four types of outputs: relays, transistors
(NPN and PNP), and TRIACs (thyristors). You can use the output contact A or contact B several times in
the program. Use output Y only once in the program; otherwise, according the PLC’s program-scanning
principle, the state of the output depends on the circuit connected to the last output Y in the program.

® Output number (the decimal number)

For the PLC, the output numbers start from Y0.0. The number of outputs varies with the number of outputs
on the digital input/output modules. The outputs are humbered according to the order in which the digital
input/output modules are connected to the PLC. The maximum number of outputs on the PLC is 1024, and
the range is between Y0.0 and Y63.15.

An output that is not used as an output device can be used as a general device.

® Output types
Outputs are classified into two types.

1. Regenerated output: The state of a regenerated output is not written until the program executes the
instruction END according to the states of the outputs. For example, OUT Y0.0.

2. Direct output: The state of a direct output is written by the PLC during the execution of the instructions
according to the states of the outputs. For example, OUT DYO0.0.

5.2.6 Auxiliary Relays (M)

The auxiliary relay has contact A and contact B. It can be used several times in the program. You can combine
the control loops with the auxiliary relay, but you cannot drive the external load with the auxiliary relay. You can

use the auxiliary relays in either of two ways.

1. For general use: In general use, if an electrical power interruption occurs when the PLC is running,
the auxiliary relay is reset to OFF. When the power is restored, the auxiliary relay

remains OFF.

2. For latched use: In latched use, if an electrical power interruption occurs when the PLC is running,
the state of the auxiliary relay states for latched use is retained. When the power

supply is restored, the state remains the same as before the power interruption.
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5.2.7 Special Auxiliary Relays (SM)

Every special auxiliary relay has its own specific function. Refer to section 2.2.7 in the AS Series Programming

Manual for more information.

5.2.8 Stepping Relays (S)

You can easily see the stepping relay in industrial automation to set the procedure. It is the most basic device in
sequential function chart (SFC) programming. Refer to the ISPSoft User Manual for more information on using

sequential function charts.

There are 2048 stepping relays, (S0-S2047). Every stepping relay is like an output relay in that it has an output
coil, contact A, and contact B. You can use it several times in the program, but the relay cannot directly drive
the external load. You can use the stepping relay as a general auxiliary relay when it is not used in a sequential

function chart.

5.2.9 Timers (T)

e 100 millisecond timer: The timer specified by the instruction TMR takes 100 milliseconds as the timing unit.
e 1 millisecond timer: The timer specified by the instruction TMRH takes 1 millisecond as the timing unit.

e The accumulative timers are STO-ST511. If you want to use the device-monitoring function, these timers

can monitor TO-T511.

¢ If you use the same timer repeatedly in a program, including in different instructions TMR and TMRH, the

timer setting value is the one that the timer matches first.

¢ If you use the same timer repeatedly in a program, the timer is OFF when one of the conditional contacts is

OFF.

¢ If you use the same timer in a program as the timer for a subroutine’s exclusive use and an accumulative

timer in the program, it is OFF when one of the conditional contacts is OFF.

¢ When the timer is switched from ON to OFF and the conditional contact is ON, the timer is reset and

counts again.

e When the instruction TMR is executed, the specified timer coil is ON and the timer begins to count. When
the value of the timer matches the timer setting value (value of the timer > setting value), the contact state

is ON.
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A. General-purpose timer

When the instruction TMR is executed, the general-purpose timer begins to count. When the value of the

timer matches the timer setting value, the output coil is ON.

) When X0.0=0ON and the timer takes 100 ms as the timing unit, the output coil TO is ON when the

value of the timer = setting value100.

) When X0.0=0OFF or the power is off, the value of the timer is 0 and the output coil TO is OFF.

NETWORK 1
0.0 TMR
| |
1 I En
T0 —51
100 —52
NETWORK 2
TO Y0.0
N )

B. Accumulative timer

When the instruction TMR is executed, the accumulative timer begins to count. When the value of the
timer matches the timer setting value, the output coil is ON. As long as you add the letter S in front of the
letter T, the timer becomes an accumulative timer. When the conditional contact is OFF, the value of the
accumulative timer is not reset. When the conditional contact is ON, the timer counts from the current

value.

) When X0.0=ON and the timer T250 takes 100 ms as the timing unit, the output coil T250 is ON

when the value of the timer = timer setting value100.

) When X0.0=0OFF or the power is off, the timer T250 stops counting, and the value of the timer stays
the same. When X0.0=0N, the value of the timer is accumulating value When the accumulated

value = timer setting value 100, the output coil T250 is ON.
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NETWORK 1
X0.0 TMR
| |
| | En
ST250 —51
100 52
NETWORK 2
T250 ¥0.0
N )
T1 T2 T1+T2=10sec
<> ;

'sv: K100

T250(PV) !
|

Y0.0

C. Timer used in the function block

Use the T412-T511 timers for the function block or the interrupt.

When the instruction TMR or END is executed, the timer used in the functional block begins to count.

When the value of the timer matches the timer setting value, the output coil is ON.

If you use the general-purpose timer is used in the function block or the interrupt, and the functional or
interrupt is not executed, the timer cannot count correctly.

5.2.10 16-bit Counters

® Characteristics of the 16-bit counter

Item 16-bit counter
Type General type
Number C0-C511
Direction Counting up
Setting value 0-32,767

Specificying the counter setting value

The setting value can be either the constant or the value in the data

register.

Change of the current value

The counter stops counting when the value of the counter matches

the setting value.
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Iltem 16-bit counter

Output contact

The contact is ON when the value of the counter matches the setting

value.

When the instruction RST is executed, the current value is cleared to

Reset
zero, and the contact is reset to OFF.
Action of the contact After the scan completes, the contact acts.
® Counter function

Each time the input switches from OFF to ON, the value of the counter is the same as the output coil. Use

either the decimal constant or the value in the data register as the counter setting value.

® 16-bit counter:

1. Setting range: 0-32,767. The setting values 0 and 1 both mean the same thing in that the output contact is
ON when the counter counts for the first time.

2. For the general-purpose counter, the current value of the counter is cleared when there is a power
interruption. If the counter is latching, the current value of the counter and the state of the contact before
the power interruption are retained. The latched counter counts from the current value when the power
supply is restored.

3. If you use the instruction MOV or ISPSoft to transmit a value bigger than the counter setting value to the
current value register CO, the contact of the counter CO is ON and the current value becomes the same as
the counter setting value next time X0.1 switches from OFF to ON.

4. Use either the constant or the value in the data register as the counter setting value.

5. The counter setting value can be a positive or negative value. If the counter counts up from 32,767, the
next value is 0.

Example:

METWORK 1
X0.0 co
| | (r)
METWORK 2
X0.4 CNT
|| e
o —51
5_|s2
METWORK 3
o Y0.0
N <)
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When X0.0=0N, the instruction RST will be executed and the current value of CO will be reset to zero and

the output contact of the counter CO will be FF.

When X0.1 is from OFF to ON, the value of the counter increases by one increment.

When the value of the counter CO reached the setting value 5, the contact of the counter CO will be ON (the

current value of CO = the setting value = 5). After that the trigger from X0.1 will not be accepted by CO and

the current value of CO will stay at the value 5.

X0.0

Y0.0,CO | |

5.2.11 32-bit Counters (HC)

) Characteristics of the 32-bit counter

Item 32-bit counter

Type Up/down counter Up counter High-speed counter
Number HCO0-HC63 HC64-HC199 HC200-HC255
Direction Counting up/down Counting up Counting up/down

Setting value

-2,147,483,648 to +2,147,483,647

Specification of the

setting value

The setting value can be either the constant or the value occupying two data

registers (32-bit).

Change of the current

value

The counter keeps counting even after the value of the counter matches the setting

value.

Output contact

The contact is ON when the value of the addition counter matches the setting value.

The contact is reset to OFF when the value of the subtraction counter matches the

setting value.

Reset

When the RST instruction is executed, the current value is cleared to zero, and the

contact is reset to OFF.
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Iltem 32-bit counter

Action of the contact | After the DCNT instruction scan is complete, the contact activates.

32-bit general-purpose addition/subtraction counter

Setting range: -2,147,483,648 to 2,147,483,647

The switch between the 32-bit general-purpose addition counters and the 32-bit general-purpose
subtraction counters depends on the states of the special auxiliary relays SM621-SM684. For example,
the counter HCO is the addition counter when SM621 is OFF, but HCO is the subtraction counter when
SM621 is ON. Use either the constant or the value in the data registers as the setting value for the counter,
and the setting value can be a positive or a negative number. If you use the value in the data registers as

the setting value of the counter, the setting value occupies two consecutive registers.

For the general-purpose counter, the current value of the counter is cleared when there is a power
interruption. If the counter is latched, the current value of the counter and the state of the contact before
the power interruption are retained. The latched counter counts from the current value when the power

supply is restored.

If the counter counts up from 2,147,483,647, the next current value is -2,147,483,648. If the counter counts

down from -2,147,483,648, the next current value is 2,147,483,647.

32-bit high speed addition/subtraction counter

Refer to the DCNT instruction description (APl 1004) in the AS Series Programming Manual for more details.

Example:

NETWORK 1
X10.0 SM621
— | ¢
NETWORK 2
X11.0 HCO
— | (R)
NETWORK 3
x12.0 ¥0.0
|| ¢
DCMT
En
HCo —S1
. =)
NETWORK 4
HCO ¥0.0
— | ¢
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1. X10.0 drives SM621 to determine counting direction (up/down) of HCO.

2. When X11.0 goes from OFF to ON, RST instruction executes, the PV in HCO is cleared to 0, and its

contact is OFF.
3. When X12.0 goes from OFF to ON, PV of HCO counts up (plus 1) or down (minus 1).

4. When PV in HCO changes from -6 to -5, the contact HCO goes from OFF to ON. When PV in HCO changes

from -5 to -6, the contact HCO goes from ON to OFF.

5. If you use the MOV instruction in ISPSoft to designate a value bigger than SV to the PV register of HCO,
then the next time the X12.0 goes from OFF to ON, the contact HCO is ON and PV of HCO equals SV.

Accumulatively - Accumulatively
X10.0 increasing Progressively increasing
decreasing

x11.0 [ | ! ! [

xizo TR

HCO contact

5.2.12 Data Registers (D)

The data register stores 16-bit data. The highest bit represents either a positive sign or a negative sign, and the
values that you can store in the data registers are between -32,768 to +32,767. Two 16-bit registers can be
combined into a 32-bit register, that is, (D+1, D) in which the register whose number is smaller represents the
lower 16 bits. The highest bit represents either a positive sign or a negative sign, and the values that you can
store in the data registers are between -2,147,483,648 to +2,147,483,647. Four 16-bit registers can be
combined into a 64-bit register; that is, (D+3, D+2, D+1, D) in which the register whose number is smaller
represents the lower 16 bits. The highest bit represents either a positive sign or a negative sign, and the values
which can be stored in the data registers are between -9,223,372,036,854,776 to +9,223,372,036,854,775,807.
You can also use the data registers to refresh the values in the control registers in the modules other than
digital I/O modules. Refer to the ISPSoft User Manual for more information about refreshing the values in the

control registers.
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The registers can be classified into two types according to their properties.

1. General-purpose register: when the PLC begins to run or is disconnected, the value in the register clears
to zero. To retain the data when the PLC begins to RUN, refer to the ISPSoft User Manual for more

information. Notice that the value still clears to zero when the PLC is disconnected.

2. Latched register: if the PLC is disconnected, the data in the latched register is not cleared. In other words,
the value before the disconnection is still retained. To clear the data in the latched area, use the RST or

ZRST instruction.

5.2.13 Special Data Registers (SR)

Every special data register has its definition and specific function. Refer to section 2.2.14 in the AS Series

Programming Manual for more information.

5.2.14 Index Register (E)

The index register is a 16-bit data register. Like the general register, you can read data from it and write data
into it. However, it is mainly used as the index register. The index registers range from EO-E9. Refer to section

4.4 in the AS Series Programming Manual for more information about using index registers.

5.2.15 File Registers (FR)

The AS Series PLC provides you with file registers for storing larger numbers of parameters. You can edit,
upload, and download the system parameters with ISPSoft. You can read the values in a file register can be
read while operating the PLC. Refer to the MEMW instruction (API 2303) in the AS Series Programming

Manual for more information about how to write to a file register.
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6.1 Quick Start

This chapter provides a simple example showing you how to create a traditional ladder diagram in ISPSoft.
Because you may not be familiar with IEC 61131-3 and may not understand the functions provided by ISPSoft,
the chapter does not introduce programming concepts related to IEC 61131-3. For example, the chapter does

not include POUs, function blocks, variables, and so on.

6.1.1 Example

When the equipment in this example operates, the parts on the conveyor move from left to right. If a sensor
senses that a part is under an injector, the PLC sends a trigger signal to the injector, and the injector injects the
glue. The injection length is set externally and is not controlled by the PLC program . However, the PLC
program must be able to turn the trigger signal OFF so that the trigger signal can be sent next time. There are

two injectors above the conveyor, and the two injectors inject glue in the same way.

There is a sensor at the left side of the conveyor. When a part passes the sensor, the sensor value increases
by one increment. When the sensor value is 100, the internal completion flag is set to ON. The flag state can be

used by other procedures later. However, this example does not introduce the use of flag states.

6.1.2 Hardware

In this example, the AS series CPU module used is the AS332T-A.

Type ID Description
Digital input X0.0 START button
Digital input X0.1 STOP button
Digital input X0.2 In position sensor 1
Digital input X0.3 In position sensor 2
Digital input X0.4 Counting sensor
Digital output Y0.0 Conveyer
Digital output Y0.1 Trigger signal for injector 1
Digital output Y0.2 Trigger signal for injector 2
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6.1.3 Program

1)

@)

®)

(4)

When the START button (X0.0) switches from OFF to ON, the internal operation flag is set to ON, and the
conveyor (Y0.0) starts. When the STOP button (X0.1) switches from OFF to ON, an error occurs (the error

flag is ON), the operation flag is reset to OFF, and the conveyor stops.

When the in position sensor 1 (X0.2) is ON, the trigger signal for injector 1 (Y0.1) is set to ON. When the in

position sensor 1 is OFF, the trigger signal for injector 1 is reset to OFF.

When the in position sensor 2 (X0.3) is ON, the trigger signal for injector 2 (Y0.2) is set to ON. When the in

position sensor 2 is OFF, the trigger signal for injector 2 is reset to OFF.

When the counting sensor (X0.4) switches from OFF to ON, the sensor value increases by one increment.

If the sensor value is larger than or equal to 100, the internal completion flag is set to ON.

6.2 Procedure for Creating a Project in ISPSoft

This section shows you the procedure for creating a project in ISPSoft. You can adjust the procedure according

to your needs.

Hardware configuration

You set the parameters such as a range of latched devices and a port number in a PLC. You configure the

modules with an AS Series CPU module, and set the parameters in these modules.

Network configuration

If a system uses a network architecture, or devices need to exchange data, use the network configuration

tool NWCONFIG in ISPSoft to configure a network and exchange data with COM as well as Ethernet.

Programming

After you write a program in ISPSoft, compile the program. If the compiling is unsuccessful, messages in

the Compile Message page show where the errors occur.

Testing and debugging

Download the compiled program, the hardware configuration, and the network configuration to a PLC. You

can then test and debug the program online with the functions provided by ISPSoft.

Because the example introduced in this chapter does not discuss a network configuration, you only perform the

following procedure.

Ha_rdwarg Programming > Test &
Configuration Debugging

A 4
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6.3 Creating a Project

After you start ISPSoft, on the File menu, point to New, and then click New to create a new project. You can

also create a new project by clicking on the toolbar after you start ISPSoft.

File | Edit Wiew Compile

Herw VO e cwen | (E)# % @
Open Cteled e OR = = B =

ﬁ ’ Group Project
Save Ctel+g \
T3] save s Ctoleslies
E& Close Project
& Print ChbP
Project Print
&g Prnter Setup
Exit AT

In the Create a New Project dialog box, type a project name in the Project Name box and a path in the

Drive/Path box, select a PLC in the PLC Type drop-down list box, and then click OK. The PLC in this example
is the AS332T.

After you create the project, a project management area appears at the left side of the main screen. The
relation between the items listed in the project management area is represented by a hierarchical tree structure.

If the project management area does not appear, on the View menu, click Workspace , or click on the
toolbar.

AN
@ OR He =& N2 €

6-4



Chapter 6 Writing a Program

6.4 Hardware Configuration

After you double-click HWCONFIG in the project management area, the HWCONFIG window appears.

£

]iject‘

o s HWCONFIG
E Project [CGlung Systern CW3
i Dieviee Corument & Uzed Dn

HWCONFIG
B AL Jthty

M LHCPUSI0-EN (G1

M Llotion Modulk

[ Tasks

P Glohal Syrrhols

B Programs

g5 Function Blocks

[ Device Wondtor Tahle
45 APls

6.4.1 Configuring a Module

In the HWCONFIG window, the default setting is with a CPU module. Refer to Chapter 8 for more information.

6.4.2 Setting the Parameters

After you double-click the CPU module or the extension module, the Device Setting dialog box appears with

the module information.
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Click the setting tabs for specific parts of the setup at the top of the window and then select the setting items on
the left for configuration.

When the hardware configuration is complete, download the configuration and the settings to the CPU module.

Save the configuration and settings, and you can download them with the program later in the project.

On the File menu, click Save or on the toolbar to save the configuration and settings, and then close the

HWCONFIG window.

Edit Cption Help

& Brint ‘\ Cial+P

Fack Information List

Input/Chatpat Device Bearrange

*. Refer to Chapter 8 for more information about HWCONFIG.
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6.5 Creating a Program

The following sections show you how to create a traditional ladder diagram in ISPSoft. The sections include

creating a POU, editing a traditional diagram, and compiling a program.

6.5.1 Adding a Ladder Diagram

(1) Right-click Programs in the project management area, point to POU (program organization unit), and then
click New....

Y A

(2) Inthe Create Program dialog box, type a program name in the POU Name box, select Ladder Diagram
(LD) in the Language section, and keep the other default values. Click OK after the setting is complete. A

new program organization unit (POU) appears under Programs in the project management area.
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(3) After you add the POU, a program editing window appears in the main working area.

‘ @ Prog0

Local Symbols
Class Identifiers Address

[E=H Eol =

Type... TInitial Value (Active w... Identifier Comment....

Local symboltable

Network 1

Program editing area

After the program editing window opens, the corresponding toolbar appears in the window. The list below

describes the functions.

EEOE 2% b it k- {] & ~F4+ -0

Icon Keyboard shortcut Function
Shift+Ctrl+C Display/hides the comments on the networks
ﬁ None Displaying/hides the commands on the devices
Shift+Ctrl+A Activates/deactivates the selected network
Adds a bookmark to the selected network selected or
Shift+Ctrl+B
deletes a bookmark from the selected network
"gl Shift+Ctrl+P Goes to the previous bookmarked position
“u Shift+Ctrl+N Goes to the next bookmarked position
it Ctrl+l Puts a network above the selected network
|t} Shift+Ctrl+I Put a network under the selected network
ESC Selects an item
Typing an instruction Inserts a contact
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Icon Keyboard shortcut

Function

Typing an instruction

Inserts a coil

Typing an instruction

Inserts a comparison contact

B
&) =]
o

Typing an instruction

Selects a type of comparison contact

Typing an instruction

Inserts a block logic instruction

(NP/PN/INV/FB_NP/FB_PN)

Typing an instruction

Selects a type of block logic instruction

(NP/PN/INV/FB_NP/FB_PN)

Shift+Ctrl+U

+)
o

Inserts an instruction or a function block

*. Refer to Section 6.5.3 for more information about typing an instruction.

6.5.2 Basic Editing — Creating a Contact and a Coil

(1) Click on the toolbar, and then move the mouse cursor to the red frame in Network 1. The mouse

cursor changes to a contact when the mouse cursor is moved to the left, right, or bottom of the red frame.

Decide where to insert a contact. If you edit a ladder diagram, the mouse cursor must be near a position

you want to edit. The system automatically arranges an inserted object; you cannot move the object.

In this example, you do not need to decide where to insert the contact. Place the mouse cursor near the

red frame and click the left mouse button.

ERO % % it K[ R®e -3+ -0

Hetwork 1
&
(S E— |
S S 1
Hetwork 1

e
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(2) Click IEI on the toolbar, or press Esc on the keyboard. After you double-click the contact, a list appears.
The items on the list are Normally Open, Normally Close, Rising-edge Trigger, and Falling-edge
Trigger. In this example, click Rising-edge Trigger.

B 2 2 % mmg{{]& B

24

HMetwork 1
2R
7% / @

= b Hormally Cpen
{4+ Hormally Clase

[[i1+ Rising edge Trigger
{ U} Falling-edee Trizzer \.

Metwork 1

"

| 7] I

(3) Click the line at the right side of the contact, click on the toolbar, and then move the mouse cursor to
the red frame. The mouse cursor changes to a coil when the mouse cursor is above or under the red frame.

Decide where to insert the coil.

In this example, you do not need to decide where to insert the coil. Place the mouse cursor near the red

frame and click the left mouse button.

Hetwork 1

Gl

[ 5 0 20 % % W& -F4 -0
N

@
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(4) Click on the toolbar, or press Esc on the keyboard. After you double-click the coll, a list appears. The

items on the list are Out, Set, and Reset. In this example, click Set.

[ 5% B 21 %l %l Illlllli([%\'--[]& x4 -4

Hetwork 1

e

(5) Click ??? above the contact, type a device address in the box, and then press Enter on the keyboard to

jump to the next box in the network. After you type a device address in the box, press Esc on the keyboard

to complete the editing. In this example, type X0.0 in the box for the contact, and type MO in the box for the

coil.

Hetwork 1

G

Hetwork 1

200 4¢— « 292
277 (=)
O Press the [ Enter] key
Hetwork 1
H0.0 M| €—
Iq\l 777 —
& Press the [ESC] key
Hetwork 1
o 0
|| =)
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Additional remark

After you click a network and press Enter on the keyboard, you can edit a box. Press Enter on the keyboard to
edit the next box in the network. Press Tab on the keyboard to select the next network. Use the keyboard to edit
boxes. After you finish the editing, press Enter on the keyboard to jump to the next box. Press Esc on the

keyboard to exit editing.

If you have declared symbols, click ﬂ in a box, or press Page Down on the keyboard when you edit the box.
The symbols on the drop-down list are the symbols that you can assign to the object. Select a symbol with the
mouse or the up/down key on the keyboard. Refer to Chapter 6 in the ISPSoft User Manual for more

information about symbols.

MO

6.5.3 Basic Editing — Inserting a Network and Typing an Instruction

Click on the toolbar to select a network. Click on the toolbar to place another network above the

selected network. In this example, Network 2 is under Network 1.

M50 % )R @e -%E2 -0

Hetwork 1
panln} M0
| ()
Hetwork 2

Create a contact and a coil by clicking and on the toolbar or by typing instructions.

(1) Click the line in Network 2.

Hetwork 1
200 ]
Il )
Hetwork 2
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(2) Type the IL instruction “LD MO”. This instruction is not case-sensitive. As soon as you type the IL instruction,

a box which you can edit appears. After you finish typing the IL instruction, press Enter on the keyboard or

click OK at the right side of the box.

LD 10 €— | oK Cancel

Hetwork 1
0o il
|| (s)
Hetwork 2

& ,

(3) Type the IL instruction “OUT Y0.0”, and write the program shown below.

|OUT 00| — | oK Cancel

Hetwork 1
0o a0
XN (s)
Hetwork 2
M0 Yoo
| |
11 )

Additional remark

You create a contact and a coil by typing simple instructions. Refer to the description below. The instructions

typed are not case-sensitive.

® To Insert a normally-open contact (contact A), type “A <device address>"

[a 1100 | ok | Cancel

24

MI100
| |
| S
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® To insert a normally-closed contact (contact B), type “B <device address>"

|BM11D | oK | Cancel

® To insert an output coil (OUT), type “O <device address>"

|o 1120 | K Ctancel
| M110 1100 W10
—11 | | D

6.5.4 Basic Editing — Selecting a Network and Operation

Before you select an object in a network, press Esc on the keyboard, or click on the toolbar. After the

cursor appears as a small arrow, click the object in the network. The basic selection shows below.

MO M1

1 {
T_@ T_@ T_e WMo <_@

._0 Dof D} _Di

@ select the network

@ Select the input contact
© select the network

@ Select the output coil
© select the block

To select a group of devices, click a device and drag it to draw a frame around the group of devices. You can
also select the group of devices by clicking the first device, pressing Ctrl+B on the keyboard, clicking the last
device, and then pressing Ctrl+B on the keyboard. You must draw a frame around devices that are in the same
network, and the devices must be adjacent to one another. Input and output devices cannot be in the same

frame.
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MO M3

L) N

—
Tt

To select several networks, press and hold the Ctrl key on the keyboard and click the networks. You can also

select a range of networks by pressing and holding Shift on the keyboard, clicking the first network within the

range, and then clicking the last network within the range.

Hetwork 1
0 L1
N *
Hetwork 2
M0 12
11 )
Hetwork 3
M2 M3
I ——()

Right-click an object after selecting it to show the context menu.

Iltem Function
Undo the last action.

Undo
You can undo up to 20 previous actions.

Redo You can redo an action that has been undone.

Cut Cut a device, block, or network.

Copy Copy a device, block, or network.

Paste Paste an object that has been copied or cut into the present position.
Paste an object at the right side of the selected position.

Paste right

The object is connected in series to the selected position.

Paste under

Paste an object under the selected position.

The object is connected in parallel to the selected position.

Delete

Delete a device, block, or network.

Activate/Inactivate

Network

Activate or deactivate the selected network.

The deactivated network is ignored when you compile the program.
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Proceed with the steps in the example below.

(1) Select Network 1, then right-click Network 1, and then click Copy.

Hetwork 1
\ .P ( !5/’
N y Cut CtaltX
| O | @
@ Copy 7 Ctrl+C |I
Hetwork 2 \
M0 Yoo
| | ¢ )
b & Delete Del

E ActivateDeactivate Natwork  Shift+Ctal+d

(2) Select Network 2, right-click Network 2, and then click Paste. A copy of Network 1 is put above Network 2,

and Network 2 becomes Network 3.

6.5.5 Basic Editing — Connecting a Contact in Parallel

Metwork 1 Metwork 1
00 il 0.0 0
il (=) 1 ()
\ 2 HMetwork 2
KO
‘ id Y ot P 0.0 0
@ . Il [———— p
] Cop. Chal+ 1T}  E—— (3)
IFy e cony | e
[ §E]s.
Faste Right \ Ctl+E
Paste to OR Ct:hD Mo oo
& Dekts Dal | | ¢ )
[ ictivateDeactivate Hetwork  Shift+Cirl+d

(1) Click on the toolbar, and then move the mouse cursor to the input contact in Network 2. The mouse
cursor changes to a contact. Move the mouse cursor to the input contact in Network 2. After the mouse

cursor changes to I-| |-I click the left mouse button. This connects a contact in parallel with the input

contact in Network 2.

Hetwork 1 Hetwork 1
paji} 0 =00 M0
o () il ()
Hetwork 2 Hetwork 2
00 IO o IO
T (s) I (s)
Hetwork 3 e
I
0 ¥o.0
I I { ) Metwork 3
IO ¥o.0
N )
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(2) Write the program in Network 2 shown below.

Hetwork 1
00 M0
I (s)
Hetwork 2
H01 0
It (%)
12
Hetwork 3
0 Yoo
N <

Additional remark

After you select a group of contacts, connect a contact to the group of contacts as described above.

6.5.6 Basic Editing — Editing a Comment

(1) Press on the toolbar. Click the position above a device name, type a comment in the box, and then

press Enter on the keyboard.

=
E@ﬁ Q rreme
MO MO MO

(2) Press on the toolbar. Click the position under a network number, and then type a comment in the box.

To start a new line of text, press Shift+Enter on the keyboard. Press Enter on the keyboard after the you

complete the editing.

E Metwork 1 HMetwork 1
START] =
o
¢ poali}
—n— 7
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(3) Write the program shown below.

Hetwozk 1
START

START _BUTTON
oo

RUNNING
jul

I}

Metwork 2
ATOP

STOF_BUTTON

H01
B

(53

RUNNING
jul

ERROR
M2
Metwork 3

CONVEVER CONTROL

RUNNING
jul
| |

(R)

CONVETER
Yoo

{ )

Metwork 4
STATION I
RUNNING IN_FOSITION |

& 0.2
| |1 | ]

TRIG_STGNAL I
Y01

Metwork 5
STATION 2
RUNNING IN_FPOSTTION 2

L0 203
| | | |

{)

TRIG_STGNAL 2
¥z

O

6.5.7 Basic Editing — Inserting an Applied Instruction

Add Network 6 under Network 5, and then write the program shown below. Insert an applied instruction in one

of the three ways described below.

Hetwork 6
RUNNING CNT_SENSOR
] 204
| | |11 |
LI I/]\ I |

® Method 1

Click the position where you want to insert an instruction, type the instruction (INC in this example), and

then press Enter on the keyboard.

!—L\ |

| —— |

Hetwork 6
RUNNING CNT_SENSOR
0 04
| | |~
|| I/I\I
[INC ¢—

| oK Cancel
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Method 2

Click APIs in the project management area and find the instruction type.

Bl Project [C:\ProgramData'Delta Industrial Antomation

.t Device Comment & Used Device
& HWCONFIG

- B CARD Utility

T AS33ET (AS3ET)

o] Tasks

CF:': DUT

- Global Symbels

&M Frograms
w88 Progl [PRG,LDY]

gy Function Blocks

Device Menitor Table

Loop Control

Transmission Comparison
Four Anthmetic Operations
Data Conversion

Data Transfer

Handy Instructions

[l Logical Operation

P T = B W W
[l - - [ [

Click the instruction (INC in this example) that you want to insert, and then drag it to the desired position.

m— ’@’

~-—————

Method 3

Click the position where you want to insert an instruction, click @ on the toolbar, select the instruction

(INC in this example) to insert in the API/FB dialog box, and then click Insert.

Hetwork 6
RUNWING CNT_SENSCR
10 puik:)
| ] || |
11 I/I\I | —— |

BB %l [R]+{"= %4 @)

24

APIFB X
~Type Clags——— | AFLFB
Al Tppes INC

Comparison Instruction

DINCP a
Dp

Function Block F-
F*
F*p
Classification

SALL>
Loop Control

Diata Transfer
Handy Instructions

v Auto Close
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After you insert the instruction, assign a device address to the operand, and write the program shown

below.
RNV CNT. SENSOR
MO 304 TC
| | I/]\I N En
11 1T ]
RN CNT SENSOR
MO 304 TC
| | BN E:
1 [T g
—-[p1] -~ £
Metwork &
PARTS COUNT
RUNNING CNT_SENSOR
M0 04 e
| 1 J.1-]
| { T —— [
Do —D

6.5.8 Basic Editing — Creating a Comparison Contact and Typing a
Constant

You can insert a comparison contact with the following steps. Add Network 7 under Network 6, and write

the program shown below.

Hetwork 7
RUNNING CNT_SENSOR
0 X4
| | (| |
| LI |/]\ I 1

(1) Click on the toolbar, and then select a operator (>= in this example).

BRB Q% e b+ OE- JEs -0

(2) Click on the toolbar, and then move the mouse cursor to the position where you want to insert the
comparison contact. The mouse cursor changes to a comparison contact when you move the mouse to the
left, right, or bottom of the red frame. Decide where to insert the comparison contact, and then click the left

mouse button to insert the comparison contact.
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EERE < %l % Uit i l:wr{] -x 2 -0

RUNNING CNT_SENSOR

0 0.4 C . )

| ] || 3 |
LI I/]\ I I—%l 1

~

Hetwrork 7
RUNNING CNT_SENSOR
0 204 =
| | J-1-]
LI I/]\I Q
777 51
7 2

Write the program shown below. In ISPSoft, K precedes a decimal value and H precedes a hexadecimal value.
To type a decimal value in ISPSoft, type it directly. To type a hexadecimal value in ISPSoft, type “16#” and the

hexadecimal value; e.g. 16#7FFF. In ISPSoft, 8# precedes an octal value, and 2# precedes a binary value.

Hetwork 7
COMPLETED FLAG
RUNNING CNT_SENSOR COMFLETE
0 H04 == 1
| | |1~ (
Ul 1Tl E — (s)
Do —{31
100 32

6.5.9 Writing a Program

The previous sections introduced creating a traditional ladder diagram in ISPSoft. Write the program shown
below. Because the program is not yet compiled for the PLC, the mother line at the left side of the ladder
diagram is colored red while you write the program. The following sections show how to compile and download

the compiled program for testing.

6-21



AS Series Operation Manual

Metwork 1
START

START BUTTON RUNNING
M0

00
o (s)

Hetwork 2
STOP

STOF_BUTTON RUNMNING
jul

0.1
1| (Rr)
ERROR

M2
Hetwork 3

CONFEVER CONTROL

RUNMNING CONVETER
M0 ¥o.0

|| )

Hetwork 4
STATION 1

RUNNING IN_FOSITION 1 TRIG _SIGMNAL I
jul Hn2 Y01

|| | | <)

Hetwork 5
STATION 2

RUNNING IN_FOSTION 2 TRIG SIGMAL 2
W0 H03 Y02

|| | | )

Hetwork 6
PARTS COUNT
RUNNING CNT_SENSOR
0 X4
| | |1~
| I/]\I o
oo —D

INC

Metwork 7
COMPLETED FLAG
RUNNING CNT_SENSOR COMPLETE
Mo 04 P M1

| ] -] ¢

| { T Q (3)
Do —31
100—fs2

*1. The program above saves in the folder ... \ISPSoft x.xx\Project\Example\Gluing_System_C.

*2. Refer to Chapter 8 in the ISPSoft User Manual for more information about creating a ladder diagram.

6.5.10 Checking and Compiling a Program

After you write a program, check the syntax of the programming language or compile the program. The syntax
and structure in the present window are checked after you run the Check function. The system checks the
entire project after you run the Compile function. If the system does not find any errors in the project, it
automatically generates execution code. After you successfully compile the program, the mother line at the left

side of the ladder diagram becomes black.
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® Check

From the Compile menu, click Check, or on the toolbar.

Compile | PLC Toolk W
Ble Check  alt+F7 OI E

Ey Compile Ct:l+F7 \

® Compile

From the Compile menu, click Compile, or on the toolbar.

Compile | PELC  Tools W

B2 Check  alteF7 OR
L2 compila  Ctel+F?

After you complete the check, the Compile Message page shows the check result. If there are any errors in
the project, the Compile Message window shows the related message. After you click the message, the
system automatically shows you where the error occurs. You can run the Check function or the Compile

function after you correct the error.
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6.6 Testing and Debugging a Program
6.6.1 Creating a Connection

Before you download a program and parameters to a PLC or monitor them online, connect ISPSoft to the PLC.
In this example, connect ISPSoft to the CPU module AS332T-A with a USB cable. Refer to Section 2.4 in the
ISPSoft User Manual for more information about connecting ISPSoft to a PLC in other ways. Refer to the AS

Operation Manual for more information about wiring.

You can skip this section if you have connected ISPSoft to a PLC successfully as described in Section
2.4in the ISPSoft User Manual.

(1) Install the modules on the main backplane to match the hardware configuration in HWCONFIG. Make sure

that the wiring is correct, and then power on the CPU module.

(2) Connect the CPU module to the computer with a USB cable. If the USB driver for the AS series CPU
module is installed on the computer, Delta PLC appears in the Device Manager window, and a port

number is assigned to Delta PLC. Refer to Appendix A for more information about installing a USB driver.

(3) Make sure that COMMGR is started and the icon representing COMMGR is displayed on the system tray.
If the icon representing COMMGR is not displayed on the system tray, start COMMGR by clicking the
shortcut on the Start menu (Start > Programs > Delta Industrial Automation > Communication >

COMMGR).

=

(4) Double-click the icon representing COMMGR on the system tray to open the COMMGR window. Click Add

in the COMMGR window to create a driver.

Qp, ,
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(6)

(6)

(@)

Set the parameters in the Driver Properties dialog box, and then click OK.

(1) Type a driver name in the Driver Name box.
(2) Select USB (Virtual COM) in the Type list in the Connection Setup section.

(3) Select a communication port in the COM Port list. If the first two steps are complete, the connected

PLC and its communication port display in the COM Port list.

@) Select the number of times to retry the sending of a command if a connection error occurs in the Time

of Auto-retry box, and select a retry interval in the Time Interval of Auto-retry box.

After you finish the setup, USB_Driver appears in the COMMGR window. When the connection is normal,
OK appears in the Status column.

B H COMMGR

Name Description af
=% USB_Driver USB, COM2, Retrv=3, TimeOut=3000ms @

Configure
Delete

About

Click the driver you created in the COMMGR window, and then click Start. Start ISPSoft, and then on the
Tools menu, click Communication Settings.... In the Communication Setting dialog box, select the
driver you created in the Driver list, select 0 in the Station Address list, and then click OK. The driver

information displays in the ISPSoft status bar.
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131040 Steps Diriver], [USE: COM4 AR3R2T

————————

(8) On the PLC menu, click System Information. ISPSoft retrieves related information from the PLC. If the
computer communicates with the CPU module normally, the related information retrieved from the PLC

displays in the System Information dialog box.

B
||

—CPU- Scan Time (ms)——————————
Oy e i
Labe -
v S
Station Address 1

roac

Program:

Capnty

Lo

6.6.2 Downloading a Program and Parameters

If ISPSoft is correctly connected to a PLC, you can download the parameters and program in the project to the
PLC. First, start ISPSoft and open the project you created in the previous sections. In this example, you

download two types of parameters to the CPU module: hardware configuration and the program itself.
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Downloading the hardware configuration

(1) Double-click HWCONFIG in the project management area to open the HWCONFIG window.

5 NWCONFIG
(% Praject [C:\GIning_System_Ci3luing System_Clisp]
6 Device Comment & Used Dievice

Th AHCPUSI0-EN (M Tler)
A Motion Module
- [@) Tasks
& Global Syrdbols
=l Programs
&4 MAIM [PRO,LD]
a5 Function Blocks
& Device Monitor Tahle
+-- T8 APls

Project

(2) The hardware configuration displays in the window. Before you download the hardware configuration

to the CPU module, make sure the actual hardware configuration is the same as the hardware

configuration in the window.

(3) On the Options menu, click Download, or E7 on the toolbar. The Transfer Items dialog box

appears. Click OK to download the hardware configuration to the CPU module.

5 G@:’

0
<

A

(4) After you successfully download the hardware configuration to the CPU module, the BUS FAULT LED
indicator on the CPU module is OFF. Close the HWCONFIG window. If the BUS FAULT LED indicator
on the CPU module is still ON or blinking, the CPU module is in an abnormal state. Make sure the
actual hardware configuration is the same as the hardware configuration in the HWCONFIG window,
and refer to the operation manual for more information about eliminating the error. Refer to Chapter 8

for more information about HWCONFIG.
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® Downloading the program

After the program compiles, on the PLC menu point to Transfer, and then click Download. You can also
click on the toolbar after the program compiles. In the Transfer Setup dialog box select the
Program checkbox and the Comments checkbox so that you can upload the program in the CPU module

later, and then click OK.

PLC | Tools Window Help Transfer Setup X

B v | B3 Uplead  CtsFw PC => PLC (Download)
System Security 4 E*; Download ChlFE | Memory Remainn 261875 Steps

¥ Rm Ctrl+F11 /

@ stop Ctrl+F12 Transfer Selection on

&7 Online Mode Ctrl+Fa e o~

(& Mew Devices Table Comments | -

g8 Format PLC Memory... Bynchronize Project and PLC Password
System Log Initial Value

= System Infonmation.. Cteledlt+] RTC

6.6.3 Connection Test

After you download a program to a PLC, you can monitor the execution status of the PLC through ISPSoft.

ISPSoft provides two monitoring modes; device monitoring mode and program monitoring mode.

Monitoring mode Description

You can monitor the status of the devices in the PLC through the monitoring

LE' table. In this mode, ISPSoft updates only the status of the devices. The
Device monitoring mode current program in ISPSoft does not have to be the same as the program in
the PLC.

E In this mode, the operating status of the program is displayed in the program

Program monitoring mode

editing window. The present program in ISPSoft must be the same as the

program in the PLC.

*. You can enable the device monitoring function without program monitoring; however, if you enable the program

monitoring function, the device monitoring function is also enabled.

On the PLC menu, click Online Mode, or on the toolbar, to enable the online monitoring function. The

system also enables device monitoring mode and program monitoring mode.
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E

i

W

LC | Tools Window Help

Transfar ]
System Security 3
Fan Ctrl+F11
Stop Cirl+F12

Omline Mode

CHl+F4 ||\

& w0 Qo

Hewr Dievives Tahle
Format PLC Memory...
System Log

System Information...  Ctrl+ A1+

ol=[=]

o=

In the online monitoring mode, you can view the present scan time, the communication status, and the status of

the PLC in the status bar in ISPSoft.

Foan Time: 10600 ma| 307262128 Steps

D STOP

Drv_USE_AH, [USE: COMB]

The present status of the devices display in the original program editing window after you enable the program

monitoring function.

Hetwork 6
PARTY COUNT

D=0

IHC

You can change the operating state of a PLC with the RUN/STOP switch on the PLC. You can also change the
operating status of a PLC with the functions provided by ISPSoft. On the PLC menu, click Run or @I on the
toolbar to start the PLC. On the PLC menu, click Stop or on the toolbar to stop the PLC.

PLC | Tools Window Help

=
3

e?

Transfer

. OR

Swstem Semurity ]

CHl+F11 ||

% [ 0G]

V\ Chl+F12

COmline Mode

System Log

System Information...

Chl+F4

Hewr Dievices Tahle

Ctrl+dlt+1

In the online monitoring mode, you can select a device, then right-click the device, and the click a command on

the context menu. During a test, you can change the status of a device or the value in a device by clicking an

item on the context menu.
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A Before you change the status of a device, make sure the operation does not cause damage to

equipment or personnel.

Wetwork 3

Metwork 3
ONVEYER CONTROL CONVEYER CONTROL
CONVEYER R?Ij}%{? CONVETER
| IO ¥o.0
Sat On || . O
St OFF : \\,/
\ @ Metwork 4
STATION I | STATION ]
RUMNMNI Force Device List RUNMNING IN_POSTTION 1
Mo - ) M0 02
|[]l Rising-edge Trigzer L |ll| I
Falling-edze Trigger

The table below describes the items in the context menu. The Force command only applies to input and output

contacts.
Item Description
Set On Set the contact selected to ON
Set Off Set the contact selected to OFF

Rising-edge Trigger

OFF, and then sets it to ON.

No matter what the state of the selected contact is, the system sets the contact to

Falling-edge Trigger

ON, and then sets it to OFF.

No matter what the state of the selected contact is, the system sets the contact to

Force

Force an input contact or output contact ON or OFF

Force Device List

Force several input contacts or output contacts in the tables ON or OFF

To change the value in a device, right-click the device, click Change Present Value, and set a present value in

the Enter Present Value dialog box.

N

i3

Hetwozk &
FPARTE COUNT
RUNNING CNT_SENSOR
I 04
|
il I
Hetwozk 7
COMPLETFD FLAG
RUNNING CNT_SENSOR
0 4 ==
|-
il o
D=0 —51
100 —=2

Change Present Vahie ||

\ COMPLETE
Force Device List @ LIl

2 —(3)
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The list below describes the Enter Present Value dialog box.

Enter Present Value Pz|

Walue Ranges

> Decimal: -32768 ~ 32767
o Hexadecimal: 16#0 ~ 16#FFFF
Binary: 280 ~ 281111111111111111

@ =P Present Value i |

Device Name Do 0]:4
00— —— |+ @

Symbol Name Cancel
Bits
O - = faemiyaoed | 4— @)
o1z
D023
@ >0z
B4E1Z 1100 8 cena 3300
@ g  EEEEEEEE (T 7 (]
© Message

@ Type a value in the Present Value box.

© Type the name of a device or a symbol whose present value you want to change

O Type a 16-bit or 32-bit value.

© Value change history (Format: Device name Value)

@® In binary mode, use the mouse to set the bit states.

@ Click OK to apply the setting values. Click Cancel to close the window without applying the values.
@ Display or hide binary mode.

In this example, X0.0-X0.15 and Y0.0-Y0.15 are input and output devices assigned to the digital /O module
AS332T-A. After you download the hardware parameters to the CPU module, the states of X0.0—X0.15 are the
same as the states of the inputs on the actual module. Even if you set X0.0—X0.15 to ON or OFF in the program

editing window, the actual input signals update the states of X0.0—X0.15.

Metwork 1 Metwork 1
START _BUTTON RUNMNING START (i RUNNING
pali] W0 paili} IO
Set On | | \LSD
Sat Off
@'\Oﬂi 2 @ T Metwork 2
=lOF BT @ STOF_BUTTON RUNNING
Faf| Foree i’ 0.1 0
_Ej Fowne Davice List _|ml | D)
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However, you can force an input contact ON or OFF during a test. Click an input or output contact to set,
right-click the contact, point to Force, and click On (X/Y), Off (X/Y), Release (X/Y), or Release All. If you force

an input or output contact ON or OFF, a lock symbol appears at the left side of the contact.

Metwork 1 Metwork 1
START _EUT Set On START _BUTTON
0.0 Set OFF
@ & ® Faorce 3 I| On (Z) | Hetwork 2
OF _BUTI Force Device List \ OFF (X \ . STOP_BUTTON
=01 Risingeedge Triggar @ Release (/Y] <04
T Fatieedes T Release A [T I
Force Description
On (X/Y) Force the selected input or output contact ON
Off (X/Y) Force the selected input or output contact OFF

Release (X/Y) Release the contact from the locked state

Release All Release all the contacts from the locked states

If you force an output contact in the program ON or OFF, the program execution result does not affect the

output state of this contact.

*.If you disable the online monitoring function, the contacts are not automatically released from the locked states.

You must check whether the contacts need to be released from the locked states after you complete the test.

You can create a monitoring table online or offline.

® Method 1

On the PLC menu, click New Devices Table, or on the toolbar.

PLC | Tools Window Help
Transfer » Ol E

System Security 3

il

Fan

Stop

Omline Made

Cirl+F11
Ctrl+F12

Ctrl+Fa

Hewr Devices Table

ERlw 0%

System Log

System Information...

R

Format FLC Memory...

Cirl 1+
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® Method 2

Right-click Device Monitoring Table in the project management area, and click New.

B Project [C:\ProgramData'Delta Indnstrial Antomation
--------- 68 Device Comment & Used Device

--------- & HWCONFIG

--------- B CARD Utility

......... T AZ332T (ASIRT)

-8 Tasks

......... & DUT

- Global Symbols

B Frograms

-[68] Progl [FRG,LD]
Function Blocks

Type a table name in the Add Monitor Table dialog box, and then click OK. An item appears under Device
Monitor Table in the project management area. Double-click the item to open the monitoring table. You can

create several monitoring tables in the project, and the monitoring tables are saved with the project.

\Project 1 x

......... T AS332T (AS332TH
{88 Tasks
......... CE‘= DUT
[ .@ Global Symbols
=g Frograms
[ Prog0 [PRG,LD]
--------- g Function Blocks
A& Device Monitor Table
........ able

After you double-click the item, a item monitoring window appears. You can add items to be monitored to the
window. To add an item to the window, double-click the blank space in the monitoring table, type a device name,
type a start address, and the number of devices to be monitored in the Device Monitor Input dialog box. You

can add up to 100 items to a monitoring table.

6-33



AS Series Operation Manual

Cbject Identifiers | Devwice Hame  Status Data Type | Value (16bi omment...
MO | | | , , : NG
Il Bigned L w |COMPLETE

Press Insert on the keyboard to switch between inserting and replacing an item in the monitoring table. The

selected mode displays in the status bar in ISPSoft.

If you select insert mode, the new item is added above the selected item in the monitoring table. If you select

replacement mode, the new item overwrites the selected item in the monitoring table.

To hide certain columns in the monitoring table, right-click the monitoring table, point to Set the Fields, and

Scan Time: 9.700 ms 300262128 Steps RIOH

clear certain items. After you clear an item, the corresponding column disappears.

% Table_1 B
COihject Identifiers = Device Name Status Data Type  Value (16bits) | Value (32hits) Float Radix Comment. ..
b Delete Del
1 Signed [ v |COMPLETE
M2 Select 411 Cirl+d Signed [ v [ERROR
Select Symbols
“ Set the felds v [ ] oteat
v | Identifiers
@ Z Diata Type
(] Bit States
(o] vaerLobits)
(o] vaber3zvits)
(V] WabeFloat)
Comment
The following describes the columns in the monitoring table.
Column Description
Source Source of a symbol
Identifier Identifier of a symbol

Device name

Name of a monitored device

Status

State of a monitored bit device or a contact (ON or OFF).
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Column

Description

Data type

Data type of a monitored symbol.

Value (16 bits)

In online mode, displays a 16-bit value.

Value (32 bits)

In online mode, displays a 32-bit value.

Float In online mode, displays a 32-bit floating-point number.
Radix Select a format to represent a value.
Comment Display the comments on a device or on a symbol.

After you create the monitoring table, you can monitor the items in the monitoring table in online mode.
Right-click an item in the monitoring table in online mode to display a context menu which is the same as the
context menu in the program editing window. You can change the item state or the item value by clicking an

item in this context menu.

“® Table_1

=]

Object | Identifiers| Device Name Value (16bits)  Walue (32bits) | Float
4 Signed Decimal v [AlSIIie
Signed Decimal v |COMFLETE
M2 St OFF Signed Decimal v |ERROR
Do i Signed Decimal  w
0o Signed Decimal
W01 Risingsdgn Triggar Signed Decimal ¥ |STOP_EUTTON
X02 _ _ Signed Decimal v |IN_POSITION 1
3 Fallng eder Trigeer Signed Decimal v |IN_POSITION 2
X0 4 & Dekte Dl Signed Decimal v |CHT_SENSOR
¥on Bigned Decitmal  w
Y01 Select Symbols Signed Decimal v |TRIG_SIGHAL 1
Y02 Signed Decimal v |TRIG_SIGNAL2
Set the fields

You can text and debug the program you created in this chapter through the monitoring table you created in this

section. Refer to Chapter 17 in the ISPSoft User Manual for more information about testing and debugging a

program.
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6.7 Setting a Real-time Clock

After you connect an AS Series CPU module to a computer, you can set the real-time clock in the CPU module

through ISPSoft.

(1) On the Tools menu, click Set RTC.

(2) Select Computer, and then click Synchronize to complete setting the real time clock.

i
PLC 20001174 | [oo:57:02 | Wednesday |
EEE N S

) Custom  [2016/ 9126 =l {16446 | [Monday |
Svnchronize Cancel |
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7.1 Overview of Memory Cards

The AS Series CPU modules support standard MicroSD cards that meet the specifications in this chapter. This

chapter describes the specifications and usage for the MicroSD cards supported by the AS series CPU

modules.

7.1.1 Appearances of Memory Cards

SD cards are classified into three types according to size: SD cards, MiniSD cards, and MicroSD cards. AS

Series CPU modules support MicroSD cards.

7.1.2 Memory Card Specifications

SD cards are also classified into three types according to capacity: SD cards, SDHC cards, and SDXC cards.

The AS Series currently only supports a maximum of 32GB in FAT32 format. SD card families are shown in the

table below. The Micro SDHC in the SDHC column indicates the specifications supported by the AS Series. Be

sure to purchase products that meet these specifications.

® SD card families

Type SD SDHC SDXC
Capacity 32 MB~2 GB 4 GB~32 GB 32GB~2TB
File
FAT16/FAT32 FAT32 exFAT (FAT64)
system
Size SD SDHC Mini SDHC Micro SDHC SDXC Micro SDXC
CLASS 2 (Min. 2 MB/Sec.) CLASS 2 (Min. 2 MB/Sec.)
Speed
CLASS 4 (Min. 4 MB/Sec.) CLASS 4 (Min. 4 MB/Sec.)
class N/A
" CLASS 6 (Min. 6 MB/Sec.) CLASS 6 (Min. 6 MB/Sec.)
rating

CLASS 10 (Min. 10 MB/Sec.)

CLASS 10 (Min. 10 MB/Sec.)
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7.2 Before using a Memory Card
7.2.1 Formatting a Memory Card

You may need to format a new SDHC memory card with the FAT32 file system before you use it for the first

time. You cannot use an unformatted SDHC memory card in an AS Series CPU module.

The following example introduces the most common way to format an SDHC card: formatting an SDHC card

through a card reader. Also carefully read the documents provided by the SDHC card manufacturer.

When you format a memory card, you also delete all the data in the memory card. Verify whether you
need to back up the data in a memory card before you format the memory card.

(1) Insertthe SDHC card into a card reader. The operating system detects a new storage device.
(2) Right-click the new storage device, and then click Format.

(3) You must format the memory card with the FAT32 file system. Do not change any other default settings.

Click Quick Format, and then click Start.

(4) After you click OK in the warning window, the SDHC card formats.

7.3 Installing and Removing a Memory Card
7.3.1 Memory Card Slot in a CPU Module

The memory card slot is on the front side of the AS Series PLC.

Memory Card Slot

7-3
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7.3.2 Installing a Memory Card

Insert a memory card into the CPU module memory card slot and push it in until it clicks. Be sure the memory
card is fixed firmly in the slot; if the memory card is loose, it is not installed correctly. The memory card can only
be inserted in one direction. Do not force the memory card or you may damage the CPU module. The correct

way to insert the memory card is shown below.

7.3.3 Removing a Memory Card

You can remove a memory card by pushing it in. The card then springs from the slot.

7.4 Memory Card Contents
7.4.1 Initializing a Memory Card

When you insert an SDHC card into a CPU module that is powered on, and use ISPSoft -> CARD Utility to back
up a project, the system initializes the SDHC card, and creates a default folder named according to the model
of the CPU module. (If the folder is already existed, the system does not create a second folder for the same

model.)

When the system initializes an SDHC card, it automatically adds any missing folders to the directory structure.
However, if the initialization of a SDHC card fails, you cannot initialize the SDHC card again until you reformat

it.

When you initialize a memory card, the SYSTEM indicator in the software blinks.
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7.4.2 Folder Structure in a Memory Card

The image below shows the default folder group created by an AS System. The folder name is AS200/300.
Several subfolders are contained inside the AS200/300 folder. Related files created by you and the AS system

are stored in the subfolders.

SDCard PLC CARD AS300 Firmware
Log
SysDup
DevMem
Setup
UserProg
Folder Description
Firmware Stores firmware files (.ext)
Log Stores Log files (.log)
SysDup Stores backup files (.dup)
UserProg Stores device memory files (.txt, .dmd, .csv)
DevMem, Setup Reserved for the system use

(N
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7.5 Introduction to the CARD Utility

The AS Series CPU modules include SDHC slots, and you can back up and restore module data with a
memory card. ISPSoft includes the CARD Ultility for the AS Series CPU modules. With this utility, you can back
up and restore data in an AS Series CPU module or backup and restore an ISPSoft project. The backup can
include the program code, parameter settings, hardware configuration, and network configuration, as well as
the values in the devices in an AS series CPU module. Refer to Section 7.7.1 in the Operation Manual for more

information about the specifications and usage of SDHC cards with AS Series CPU modules.

The list below describes the functions supported by the CARD Utility, including a flowchart.

® If you export data from an AS Series CPU module as a backup file (*.dup), you can save the exported data
in the memory card in the module or in a folder on the computer. You can also decide whether to back up the

values in the devices in the AS Series CPU module.

® If you export an ISPSoft project for an AS Series CPU module as a backup file (*.dup), you can only save the
exported ISPSoft project in a folder in the computer. You can see data such as register editing (*.dvl), device
status editing (*.dvb), file register editing (*.wft) for the AS Series as values in the device and back them up.
You can put a memory card with the backup file into the AS series CPU module. You can copy a backup file
(*.dup) saved on the computer into the AS series CPU module connected to the computer, or restore the
backup file to an ISPSoft project. If you choose to restore the backup file to an ISPSoft project, the system

automatically skips the values in the devices and the hardware configuration in the backup file.

® If you restore the backup file (*.dup) from the PC to an ISPSoft project for an AS Series CPU module, you
can also restore data such as register editing (*.dvl), device status editing (*.dvb), and file register editing

(*.wft) for the AS Series.
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Double-click CARD Utility in the project management area to open the CARD Utility wizard. After selecting

the controller type, click “Next” to proceed.

I:I\@
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7.6 Backing Up a Project

If the backup source or backup destination is an AS Series CPU module or memory card, make sure that
ISPSoft is connected to the AS Series CPU module. During backup, the CPU LED and Error LED blinks
alternatively and SM452 flag is ON. After the backup is done, the CPU LED and Error LED stops blinking and

SM452 flag is OFF. Refer to Section 2.4 in the ISPSoft User Manual for more information.

(1) Select the Backup (To DUP File) option button in the CARD Utility wizard and then click Next.

(2) Select a backup source, and then click Next.

a. If you select the CPU (Need Connection), the backup file is stored in the memory card.
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®3)

b. If you select the ISP Project (Compiled and saved), the backup file is stored in your computer. Click
J and select an isp file in the Open dialog box. If the program in the isp file selected is not compiled, a
message appears when you back up the isp file. Open the isp file with ISPSoft, compile the program in the

isp file, and then save the isp file. After the program in the isp file is compiled, you can back up the isp file.

After you select CPU (Need Connection) / ISP Project (Compiled and saved), click Next,
a. If you select the CPU (Need Connection), a prompted window appears. And you need to decide

whether to back up the values in devices on the AS Series CPU module that is connected to ISPSoft.

7-9
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b. If you select the ISP Project (Compiled and saved), the backup file is stored in your computer. Click
J and select an isp file in the Open dialog box and then decide the file path where you'd like to store

the backup file in your computer and then define its file name.

(4) Select a backup destination. If the backup source is an ISPSoft project, the backup destination must be a

computer.

a. If you select Memory Card (PLC Side), the filename of the backup file is AUTOEXEC.dup, and the
backup file paths for AS200 and AS300 are shown below.
AS200: Root directory of the memory card\SDCard\PLC CARD\AS200\SysDup\AUTOEXEC.dup
AS300: Root directory of the memory card\SDCard\PLC CARD\AS300\SysDup\AUTOEXEC.dup

N
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b. If you select PC (DUP File), click J select a folder in the Save in list in the Save As dialog box, and
type a filename in the File name box. When you select the backup source for the ISPSoft Project, set
the PLC password. You can set the password to be the same as the Project password, set a new PLC
password, or not set a PLC password. If you do not set a password for the Project, the PLC password
is also not set. When you select Setting new PLC password, the wizard looks like the following

image. And you can set new PLC password and number of the attempt times.

(5) After that you can see the summary. Make sure that the summary in the CARD Utility wizard is

consistent with the data backup you want to perform, and then click Execute.

(N
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(6) The AS Series CPU module still performs the data backup even if you click Cancel. You can turn off the
AS Series CPU module to stop the data backup; however, the backup file produced is not a complete

backup file, and you must delete the backup file from the memory card.

If you select Memory Card (PLC Side), the filename of the backup file is AUTOEXEC.dup, and the
backup file path is Root directory of the memory card\AS300\SysDup\AUTOEXEC.dup. If there is an
old backup file in the memory card, the Warning message appears. Click Replace, Archive, or Cancel in

the Warning message.

Warning *

AUTOEXEC.dup.dup already exists. Please select a way to deal with the problem.

L
1. Replace: The data in the existing file is overwritten directly.

2. Archive: After the original AUTOEXEC.dup file is archived, the current backup data is saved as the AUTOEXEC.dup file.
(The file archived is named yymmddnn.dup. yy is the year, mm is the month, dd is the data, and nn is the serial number on that day)

3. Cancel: The system backup is cancelled.

Archive | Cancel |

If the backed up data is protected by passwords, these passwords are also backed up.

Data backup Description

The backed up data includes the PLC ID and the PLC password set
CPU module > Memory card

in the CPU module.

The backed up data includes the program ID and the project
ISPSoft project > Computer

password set in the ISPSoft project.

(7) Atfter you perform the data backup, click Home or Close in the CARD Utility wizard.

N
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7.7 Restoring a Project

If the restoration source or restoration destination is an AS Series CPU module or memory card, make sure that
ISPSoft is connected to the AS Series CPU module. During restoration, the CPU LED and Error LED blinks
alternatively and SM452 flag is ON. After restoration is done, the CPU LED and Error LED stops blinking and

SMA452 flag is OFF. Refer to Section 2.4 in the ISPSoft User Manual for more information.

(1) Select Restore (From DUP File) in the CARD Utility wizard and then click Next.

(2) Select a restoration source, click J and then select a backup file to be restored.

a. If you select Memory Card (PLC side) (Need Connection), the backup files in the memory card

display in a window after you click J Double-click a backup file in the window to choose it.

7-13
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B x
Name Size | Type Modified Time
AUTOEXEC.dup 202KB DUPFile 2000/1/1 2 4F 03:13:16
4] | []

b. If you select PC (Need Connection), the backup files in the PC display in a window after you click J

Double-click a backup file in the window to choose it.

N

B x
Name Size | Type Modified Time
AUTOEXEC.dup 202KB DUPFile 2000/1/1 2 4F 03:13:16
4] | []
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®)

a.

b.

Select a restoration destination, and then click Next.

To put the selected backup file into the AS Series CPU module, select CPU (Need Connection). If the
restoration source is the CPU (Need Connection), the restoration destination must be the AS Series

CPU module.

If you select ISP Project, click J and then specify a filename and a path. If the path specified point

to a file that already exists, the file is overwritten when you restore the data.

7-15
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(4) Make sure that the summary in the CARD Utility wizard is consistent with the data restoration you want

to perform and then click Execute.

If you click Cancel in the process of restoring data to the AS Series CPU module, the data is not
completely restored. The AS Series CPU module still performs the data restoration even if you click
Cancel in the process of restoring a backup file in the memory card. You can turn off the AS Series CPU
module to stop the data restoration from being performed. To prevent the AS Series CPU module from
operating incorrectly, restore the AS Series CPU module to the factory setting, or perform the data

restoration again.

The restoration source or restoration destination may contain a password and an ID. The following table

describes the password and the ID process.

Data restoration Description

a. The ID in the backup file must be the same as the ID in the CPU module;
otherwise the data is not restored.
b. If there is a PLC password in the CPU module, the password in the backup file
Memory card must be the same as the PLC password in the CPU module. Otherwise the
- PU module data is not restored.
c. If there is no PLC password in the CPU module, and there is a password in the
backup file, the system restores the data, and the password in the backup file

becomes the PLC password in the CPU.
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Computer-> The ID and the password in the backup file become the program ID and the

ISPSoft project project password in the ISPSoft project.

(5) After you perform the data restoration, click Home or Close in the CARD Utility wizard.

7.8 Restoration Starts Once CPU is supplied with Power

When the backup file in the memory card is consistent with the specific path and file name, the CPU can
perform restoration once it is supplied with power. During restoration, the CPU LED and Error LED blinks
alternatively and SM452 flag is ON. After restoration is done, the CPU LED and Error LED stops blinking and
SM452 flag is OFF.

(N

Operation Steps:

(1) Set up the backup file path and file name for the memory card backup file. The filename of the backup file
is BACKUP.dup and the backup file paths for AS200 and AS300 are shown below.
AS200: Memory card root directory\SDCard\PLC CARD\AS200\SysDup\AS300 BACKUP.dup

AS300: Memory card root directory\SDCard\PLC CARD\AS300\SysDup\AS300 BACKUP.dup

Insert the memory card into the card slot when the CPU power is off.

(2) When the CPU power is on, it automatically checks if the memory card data is consistent with the PLC data.
If not, the restoration begins. The data check is specifically on the data in CPU programs and HWCONFIG
parameters.

(3) During the restoration, the CPU LED and Error LED blinks alternatively. Once the restoration is done, the

blinking stops.
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7.9 CPU Error Log

The system stores CPU error messages in the memory card whenever the quantity of the error messages

reached to 20. You can also use special flag SM36 and special device SR36 to read the CPU error messages

and state change logs. If there is error logs recorded in the memory card, the memory card keeps storing the

error logs. You can change the file path to store other error logs or change the file name to store other error

logs.

Special Device

Function Code Description

SR36

a. when the value is 0, it indicates there is no recording.
b. when the value is 1234, it indicates the logs are stored in the memory card.
c. when the value is 3456, it indicates the error logs and state change logs are stored in

the memory card.

Operation Steps to read CPU error logs and state change logs:

Make sure the memory card is in the slot before reading the CPU error logs and state change logs.

(1) Set SM36 to ON and the value in SR36 to 1234 or 3456 to read the CPU error logs and state change logs.

(2) The root directory path of the memory card for the error log is

AS200: Memory card root directory\SDCard\PLC CARD\AS200\Log\Error.log

AS300: Memory card root directory\SDCard\PLC CARD\AS300\Log\Error.log

Use ISPSoft to read the error logs. ISPSoft Tools -> Review Error Log File -> Open Log File

The root directory path of the memory card for the status log is

AS200: Memory card root directory\SDCard\PLC CARD\AS200\L0og\STATUS.log
AS300: Memory card root directory\SDCard\PLC CARD\AS300\Log\STATUS.log

(3) Use ISPSoft to read the status logs. ISPSoft Tools -> Review Error Log File -> Open Log File
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8.1 Hardware Configuration Tool for AS Series Modules -
HWCONFIG

HWCONFIG is a built-in hardware configuration tool in ISPSoft. You can configure racks, set CPU and module
parameters, download/upload parameters, detect a hardware configuration online, and make a diagnosis through

HWCONFIG.

You must download all parameters set in HWCONFIG to the CPU module for them to take effect.

8.1.1 Introduction of the HWCONFIG Environment
In ISPSoft, double-click HWCONFIG in the project management area to start HWCONFIG.

Project q %

[ T8 APIs

~/

© Product list: Available hardware is listed in the catalog.

@ System configuration area: This is the main working area. You can configure and set the entire system in this

area.

© Information list: This shows information about the present system configuration.
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The system configuration area displays the present system configuration. You configure and set up the modules in this
area. You can add extension modules to the right side of the AS Series CPU module. The CPU module also has
function card slots for more versatile solutions. For the function card settings, go through the CPU module. Refer to

Section 8.2 for function card configurations. When you modify the configuration in the system configuration area, the

information in the information list updates.

Function Cards

Extension Modules

All available hardware is listed in the product list. After you click a section in the product list, it shows all devices

belonging to that section. If you click a device, the specifications for the device appear under the product list.

Product List

= 45300 -
+ Digital I/0 Module
= Analog 1/0 Module

ASTDA K
ASI6A -
<

Specification

4 channels 16 bits analog input : | =
S10~+10V, 0~10V, -5~+5V,
0/1~5V, 0/4~20 mA, -20mA~20
mA conversion time =
2ms/channel

Delta Electronics provides you with specific configuration tools for some CPU modules. You can use tools such as
Ethernet/IP or EtherCAT to set advanced parameters for network assignments for the modules. For advanced setup,

right-click the CPU module in the system configuration area, click Communication Software, and then choose tools

such as EIP Builder for Ethernet/IP configurations. You must save the configurations in HWCONFIG before opening
the tools. Note that you cannot work in HWCONFIG while editing in the tools. Some tools require a separate

installation, and the software shows a message if a tool heeds to be installed.
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7

Refer to the manuals for the communication software tools for more information on setting up communications.

8.1.2 Configuring a Module
8.1.2.1 Adding a Module

® Method 1
Click a module from the product list and drag it to a vacant slot in the backplane in the system configuration area. The

AS Series is not a backplane design, and you can place extension modules on the right side of the CPU module. You

can only place the power module on the left side of the CPU module, and you can install only ONE power module.

|—> Position for Power Modules

—» Positions for

\ Extension Modules

\

\\~__9’/;

*When you drag a module from the product list to the system configuration area, you can only drop the module on a

vacant slot.
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® Method 2

Double-click a vacant slot with a plus sign to display the Product List window. You can also right-click the vacant slot

with a plus sign and then click Open to open the Product List window.

OR

(N>

Double-click a module to add it to the backplane from the Product List.

g

® Method 3

Double-click the empty space for the module on the Information List to show the Product List window.

Extension No Type Madule Name DDF Version Input Device Range Output Device Range
Power Module Power Module AS-P302 Mone
=|CPU Module CPU Module ASII2T 01.00.00 ®0.0" X015 0.0~ Y015
Function Card1
Function Card2
={Module Inforrmationl MNetwork Module ASO0SCh-A 00.33.00 D2aooo ~ 026019 D2B8020 ~ D26039
Function Card1
Function Card2
Module Information2 Digital 140 Module ASTEAPTIT 01.00.00 %1.0" %115 1.0~ Y115

<2
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In the Product List windows, double-click a module to add it.

G

No matter which method you use to add a module, the configuration in the system configuration area and the

information on the information list update when you add a module.

8.1.2.2 Assigning I/0 Addresses

The AS Series does not support manually assigned addresses. Addresses are automatically assigned to an
input/output module through HWCONFIG in ISPSoft. You assign a start address to the first remote module installed
on the right side of the 1/0O module slot (SCM module). The following 1/0 module is automatically assigned with the

next address. For remote module configuration, refer to Section 8.2.3 for more details.
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8.1.2.3 Editing a Comment

You can add a comment about the hardware configuration by clicking the gray area at the top of the system

configuration area. To start a new line of text at a specific point, press Shift+Enter on the keyboard. After you type the
comment, press Enter.

| Hardware Parameter For PRI_D |

T oma3

L]
After you click the Comment cell for a module on the information list, press a key on the keyboard or click ==+| to open
the Device Settings dialog box. You can type a comment about the module in the Comment box.

kv
Biiesmby Ty Meddahe  O0FYerrn | peDevieRerge Ol Diice e Cermed
meMedls  Prerlce AEIEL hiee:

S Pkl CPUnodie AT (] A ki 11}
FacinCodl |

Frcie Cvd
= ddekformston Povorkblocse ASISTNA nan
Furciz ol

[awoumy omE |

Fecir (g

\blickioneou Digel 0 Modd:  ASIEATTT L]
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8.1.2.4 Deleting a Module
There are two ways to delete a module that has been configured. You cannot delete the CPU module.
® Method 1

(1) Click the module to delete from the system configuration area or information list.

s Option  Help

Ol E ¥ oot cmex

® Method 2

(1) Right-click a module to delete from the system configuration area or information list, and then click Delete.

Extension Mo Twpe Module Name DDF Yersion Input Device Range | Output Device Range
Power Module Power Module ASPI02 Mone
= CPU Module CPU Module ASINT 01.00.00 KO0~ K015 0.0~ Y015
Function Card1
Function Card? i
IMnduIe Information” Analog [0 Module ASN4AD-A @] oo 028000~ 028019
Replace 3
X cut CtaleX
m Copy Ctrl+C

E 8.1.2.5 Replacing a Module
There are two ways to replace a module that has been added. You cannot replace the CPU module or power module.
® Method 1

(1) Right-click the module to be replaced in the system configuration area or on the information list.

-
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Or click the module to be replaced in the system configuration area or on the information list. On the Edit menu, click

Replace.

ma

- il | OR
i o . ?\

(2) A Product List window appears.

m Open(0) Enter
|g Replace(R) Ctrl+R |\

X cum Ctrl+X ‘@
9 copyi) Ctrl+C

[ Paste(®) Cirl+V

&5 Delete(D) Del

(3) Select the Replace All check box to replace multiple modules of the same type. Double-click the new module (the
module that replace the existing module). A message appears: “The replaced module setting will be restored to

the default values. Are you sure to continue?” Click Yes to replace the selected module.

|
AN 2A
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® Method 2

(1) Right-click the module you want to replace in the system configuration area or on the information list, and then

click Replace.

OR

‘\6 , W

(2) A Product List window appears.

(3) Select the Replace All check box to replace multiple modules of the same type. Double-click the new module (the
module that replace the existing module). A message appears: “The replaced module setting will be restored to

the default values. Are you sure to continue?” Click Yes to replace the selected module.
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8.1.2.6 Copying/Pasting a Module
There are two ways to copy a module. You cannot copy/paste the CPU module or the power supply module.
® Method 1

In the system configuration area or on the information list, right-click the module to copy, and then click Copy.

/ OR /’

\ v\

® Method 2

(1) Inthe system configuration area or on the information list, click the module to copy.

Extension No Type Module Mame DOF Version | Input Device Range | Output Device Range
Power Madule Power Maodule AS-P302 MNone
=1 CPU Module CPU Module ASIRT 01.00.00 K0.0™ K015 0.0~ Y08

‘ O R Function Card1
Function Card2
IMndu\e Information’| Analog /0 Module AS04AD-A k@%ﬂ a0 D28000 ™ 028019 |

(2) On the Edit menu, click Copy, or @ on the toolbar.
Option Help OR O\

There are two ways to paste a module.

® Method 1

In the system configuration area or on the information list, right-click the slot where you want to paste the module,

and then click Paste.

& o
w Y
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® Method 2

(1) Inthe system configuration area or on the information list, click the slot where you want to paste the module.

Extension Mo Type Module Name DDF Yersion Input Device Range | Output Device Range
Power Module Power Module ASP302 Mone
=1 CPU Module CPU Module AZIIZT 01.00.00 »0.0~x0.15 0.0 Y0058

OR Function Card?
. Function Carcl2
' IMDduIa Infarmation Analog 0 Module ASN4AD-A R@ED.DD [125000 ~ D28019

(2) On the Edit menu, click Paste, or click @ on the toolbar.

Option  Help O\

If the slot where you to paste a module already has a module, the pasted module is added in front of the slot where a

module already exists. As the example shows below, adding the 06 XA module in the position of the 04AD module

moves the 06 XA module in front of the 04AD module.

8.1.2.7 Cutting/Pasting a Module
There are two ways to cut a module. You cannot cut and paste the CPU module or the power supply module.
® Method 1

In the system configuration area or on the information list, right-click the module to cut, and then click Cut.

f OR /‘

'\ \
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® Method 2

(1) Inthe system configuration area or on the information list, click the module to cut.

Extension Nao Type Module Narme DDF Yersion Input Device Range | Output Device Range
Power Module Power Module AS-PS02 Nane
=|CPU Module CPU Module AS332T 01.00.00 X0.0 K018 0.0~V

Function Card1
Function Card2

IMnduIe Infiormation’ Analog /0 Module ASDAAD-A %ED o0 028000 ™~ D28019

(2) On the Edit menu, click Cut, or click x‘ on the toolbar.

:\ém Q@

There are two ways to paste a module.

® Method 1

In the system configuration area or on the information list, right-click the slot where you want to paste the module,

and then click Paste.

&/
OR .

\2/ "\@

N

® Method 2

(1) Inthe system configuration area or on the information list, click the slot where you want to paste the module.

Extension Mo Type Module Name DDFVersian | InputDevice Range | Output Device Range
Pawer badule Power Madule AS-PS02 MNone
=/ CPU Madule CPU Module AZIET 01.00.00 X000~ K015 0005

Function Card1
Function Card?

IMDdu\e Information’| Analog {0 Module ASI4AD-A W 930 0o D28000 ~ D28019
N

(2) On the Edit menu, click Paste, or click @ on the toolbar.

Option Help Q\
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If the slot where you want to paste the module already has a module, the pasted module is added in front of the slot
where a module already exists. As the example show below, adding the 06 XA module in the slot of the 04AD module

pastes the 06 XA module in front of the 04ADmodule.

Additional remarks

When you cut and paste a module, the parameters in the module are retained as follows.

@® Input/Output device range: The input/output devices assigned to the cut module are automatically assigned to

the pasted module.
8.1.2.8 Dragging a Module

You can drag all modules in the system configuration area with the mouse, except the CPU module and the power
supply module. When you drag a module from one position to another in the system configuration area, a red arrow

appears along with the direction of your mouse cursor to show where the dragged module would be placed.

\@ ¢ \9/
A9 4

E *When you drag a module, the input/output devices assigned to the module, the comment about the module, the
parameters in the module, the data registers assigned to the module, and the parameters in the intelligent module are all

retained in the dragged module.
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8.1.2.9 Show/Hide Device Name

You can show or hide the module names in the system configuration area by clicking ™ onthe tool bar.

~JOPNN

8.2 Setting the Parameters in an AS Series CPU Module
8.2.1 Opening the PLC Parameter Setting Window

After you double-click the CPU module in the system configuration area, the Device Setting dialog box appears. The

parameters you can set vary with the models of the CPU modules.

A Before you set the parameters in a CPU module, refer to the operation manual for the CPU module. To

prevent damage to the system or personnel, check the effect of the parameters on the CPU module and

the entire system.

*You must download the set parameters to the CPU module before they take effect.

--------- & Device Monitor Table
- T8 APls ¢
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The parameters are classified into several types. Click the tabs at the top of the Device Setting dialog box and then

click the setting options in the tree on the left.

The setting parameters for the selected setting option appear on the right in the Device Setting dialog box. Click the

option on the left, and then set the Value, Unit, Default, Minimum and Maximum for each parameter.
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8.2.2 Setting the Basic CPU Parameters

8.2.2.1 Options - System Information Page

In the Device Setting dialog box, click the Options tab, and then click (expand) System Information to see the
System Information, System Parameter, Device Range Setting, Input Point Filter Time, Position Control Para, and

Daylight Saving Timing.

System Information

On the System Information page, you can edit two parameters: Name and Comment. You can enter up to 15
characters in the Name section and up to 31 characters in the Comment section. You can use spaces and special
characters in these two sections, but note that a Chinese character occupies two characters. After you create an
ISPSoft project, the default project name is the name of the CPU module, and the default name of the CPU module is
attached to the model in the project management area. You can change the default name of the CPU module in the

Name box later.

B Project [C:\ProgramData'Delta Industrial Antomatic
% Device Comment & Used Device
By HWCONFIG

[ 33327 Untiteds)

-8 Global Symbols

: Cormrent
i Programs

g5 Function Blocks Q
B Device Monitor Table

&8 APls

Parameter name

=% Progect [C:\ProgramData’Delta Industrial Antomatic
&% Device Comment & Used Device
{2y HWCONFIG

-l CARD Utilit
TH AS3327 (AS_D)

- Global Symbols
.l Programs

o Function Blocks
(& Device Monitor Table
-8 APIs
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You can identify a device by means of device name. When several devices are connected on a network, you can
check whether a device connected to the computer is the device you expect with the device name. If you want to
download or upload the program, but the name of the CPU module is different from the name attached to the model in
the project management area, the system reminds you to check the name of the CPU module and the name attached

to the model in the project management area.

System Parameter

On the System Parameter page, you can set parameters by entering appropriate values or by selecting from a list.

® Clear Non-latched area when Run = Stop
This determines whether the states and values of the non-latched devices are cleared when the PLC changes
from Run to Stop.
» Disable: all the states and values in the non-latched devices stay the same.

» Enable: all the states and values in the non-latched devices are cleared and restored to defaults.

® Y keeps outputting when RUN->Stop
This determines the states of the Y devices when the CPU module begins to run or stop.
» Off: all Y devices are set to OFF.

» Retain: the states of the Y devices stay the same.

® |/O module CONFIG by Auto/Manual when Power On
This determines whether the CPU module is automatically configured, or you configure the parameters in
HWCONFIG.
» Auto: the CPU module is automatically configured.

» Manual: you configure the parameters in HWCONFIG.
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Select Action when I/0O Module parameter with manual CONFIG Different
This determines which action is taken when the actual settings are not the same as the parameters that you
manually set when the previous setting option is set to Manual.

» Auto update: the CPU module is automatically configured.

» Show error: the CPU module shows an error.

CPU module Stop when 1/0 Module No Response
This determines how the CPU module and other modules react when a connected extension module is not
responding.

» Stop: the CPU module stops running and sends an error.

» Keep Run: the CPU module and 1/0O modules keep running.

CPU module Stop when I/O Module Occurred Error
This determines how the CPU module reacts when a minor module error occurs.
» Stop: the CPU module stops running and sends an error.

» Keep Run: the CPU module keeps running and sends an error.

Setting delay time to detect I/O Module

This sets the time to detect an I/O module after powering on the CPU module.

Assign X Input Point Control Run/Stop
This assigns an input point to have the CPU module run or stop.
» Disable: run or stop the CPU module with the dip switch of the CPU module.
» Enable: run or stop the CPU module with the assigned input point, and the dip switch of the CPU module still

controls the run stop state of the CPU module.

Select X Input Point
If you select Enable in the previous option, you can select one input point to control the Run or Stop state of the

CPU module from the dropdown list.

Constant Scan Cycle Time

This sets the minimum scan cycle time.

> Disable: disables this function.

» Enable: when the actual scan cycle time is less than the setting time, the CPU module waits until the setting
time is met, and then starts the next scan. When the actual scan time is longer than the setting time,

the CPU module starts the next scan after the actual scan time completes.
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® Input Constant Time
If you selected Enable in the previous option, you set the scan cycle time here. If the actual scan time is less than
the setting time, the CPU module waits to begin the next scan until the setting time is met. If the actual scan time
is larger than the setting time, the CPU module ignores the setting time and operates according to the actual scan
time. If you set the scan time longer than the watchdog timeout set, a watchdog timeout occurs when the CPU

module operates.

® Setting Watchdog Time
This parameter sets a timeout during which the program is scanned. The CPU module sends an error if the

program execution exceeds the watchdog time.

® Show Battery Low Voltage Error
This parameter sets whether to show an alarm when the lithium battery for the real-time clock has low voltage or
is not installed in the AS Series PLC.
> Disable: disables this function.

» Enable: enables the alarm when the lithium battery has low voltage or is not installed.

® Save Error History Info
This specifies where to store the error log.
»  PLC: store error logs in the PLC. The PLC can store up to twenty error logs. If there are more than twenty
error logs, the oldest error log is overwritten by the latest error log.
» PLC & SD Card: when there are more than twenty error logs, the oldest error log is backed up to the memory

card before the oldest error log is overwritten in the PLC.

® Select Action when 24Vdc Input Unstable
»  Continue running when power stable: when the power is unstable, the AS Series pauses, and after the
power stabilizes, the PLC continues running.

E » Into Error Status: when the power is unstable, the error LED blinks and the AS Series stops running.

® Communication Module Refreshed Priority
»  Scan Time First: when there is an update, the AS Series automatically refreshes in batches to save scan
time.
» Synchronous Data First: when there is an update, the AS Series refreshes completely and automatically

to ensure data integrity. When the quantity of the data large, the scan time can be affected.

® COM Communication Error Record

This parameter sets whether to enable the error record when there is an error at the COM port.
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» Disable: disables this function.

» Enable: enables this function and starts recording COM errors in the error log.

® Select Action When 24 Vdc Input Unstable
What to do when the 24 Vdc power is unstable
» Continue Running when power stable: waits till the power is stable and then PLC begins to run.

> Into Error Status: Stops and go to the error mode

® Communication Module Refreshed Priority
Scan time first: only refresh the data that is different from the original ones to save scan time

» Synchronous Data first: scan and refresh all the data to ensure all data are synchronized.

® [601 Timer interrupt Setting Time Base

Sets the interval for triggering the 1601 timer interrupt. This function is used together with Timer Interrupt 0.

® [602 Timer interrupt Setting Time Base

Sets the interval for triggering the 1602 timer interrupt. This function is used together with Timer Interrupt 1.

® [603 Timer interrupt Setting Time Base

Sets the interval for triggering the 1603 timer interrupt. This function is used together with Timer Interrupt 2.

® 6014 Timer interrupt Setting Time Base

Sets the interval for triggering the 1604 timer interrupt. This function is used together with Timer Interrupt 3.

Device Range Setting

The parameters on Device Range Setting table are shown in the following window.
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Click +=*| to open the parameter dialog box to set the start and end address. In the dialog box, click Default to restore
the setting to the default values; click Clear to clear the set values; click OK to save the values and close the dialog

box; click Cancel to discard the setting and close the dialog box.

[=2]

Start Address 20000

End Address 235999
’ Drefault l ’ Clear l
’ ak l I Cahicel I

Input Point Filter Time

On the Input Point Filter Time page, you can set the input point filter time for each input. If the duration of the received
signal time is less than the filter time setting value, it is processed as noise and filtered out. Select an appropriate filter

time according to your needs.

® X Input Point Filter for CPU module
» Default Setting: uses the default values in the input point filter.

» Manual Setting: uses the values you enter for the filter time for each X input point.

® X0.0—X0.15 Input Point Filter Time

If you select Manual Setting for the previous parameter, you can set the filter time individually for X0.0-X0.15.
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Position Control Parameter

The parameters on Position Control Parameter table set to specify input points as the positive and
negative limits of axis 1~ axis 6 channels. 12 limit points can be set at most. Axis No. 1~6 can also be set
as Z phase triggers, home function finish points and clear output selects or positive/negative limited
position.

® Axisl (Y0.0/Y0.1) Positive/negative Limited Select~ Axis 6 (Y0.10/Y0.11) Positive/negative Limited

Select: select the rising or falling edge trigger and X input point on the drop-down list.
® Axisl (Y0.0/Y0.1) Z Phase Trigger ~ Axis6 (Y0.10/Y0.11) Z Phase Trigger:
select the rising or falling edge trigger and X input point on the drop-down list.

® Axisl (Y0.0/Y0.1) Home Function Finish and Clear Output Select ~ Axis6 (Y0.10/Y0.11) Home Function
Finish and Clear Output Select: select the rising or falling edge trigger and X input point on the

drop-down list.

® Axisl (Y0.0/Y0.1) Positive/negative Limited Position ~ Axis6 (Y0.10/Y0.11) Positive/negative Limited
Position: set up the number of pulses as the positive or negative limited position in axis 1~6; setting
range is -2147483647 ~ 2147483647
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Daylight Saving Timing

Enable or disable this function on the Daylight Saving Timing page. Set daylight saving time and the set the time zones

for daylight saving and the system acts accordingly.

® Disable/Enable D.S.T Function

Sets whether or not to use daylight saving time.

® Start Date — Month

Sets the month to start daylight saving

® Start Date — Day

Sets the day to start daylight saving

® End Date — Month

Sets the month to end daylight saving

® Start Date — Day

Sets the day to end daylight saving

® Saving time

Sets daylight saving time in minutes

® Example explanation: example from the above image and all the options are enabled.

PLC time
Date shown in SR Time shown in SR Remarks
(Real Time Clock)
3/31 23:59:58 23:59:58
Normal
3/31 23:59:59 23:59:59
4/01 01:00:00 00:00:00
4/01 01:00:01 00:00:01
: (to) : (to) : (to)
Shown after 60 minutes
9/30 23:59:59 22:59:59
10/01 00:00:00 (9/30) 23:00:00
: (to) : (to) : (to)
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10/01 00:59:59 (9/30) 23:59:59
10/01 00:00:00 00:00:00

Normal
10/01 00:00:01 00:00:01

8.2.2.2 Options - COM1 & COM2 Port Setting

The AS Series CPU module has two communication ports. There are two areas to set the parameters, one for each

communication port.

O~ —=00

O set a station address. You can identify a device on a network by the station address. The station address cannot

be the same as the station address for another device on the same network. If the communication port functions
as a slave, and there are other slaves, the station address of the communication port cannot be 0. Station address
0 broadcasts to all slaves in a communication protocol. If a master specifies in a data packet that data must be
sent to station address 0, the data is sent to all slaves. No matter what the station address of these slaves are,
these slaves receive the data packet addressed to station address 0.

@ Set when the communication port runs. Select Stop --> Run, and communication works when the CPU module
switches from Stop to Run. If you instead select Power-on, the communication starts working when you Power-on
the module.

© Select a communication speed in the Baud Rate list, or select Custom and enter a new rate.

@ Set the communication parameters for the port.

© Set the Delay Time to Reply when the AS CPU module receives communication and how long it waits before
responding to the remote modules. Received Data Timeout applies when the AS Series CPU module acts as a
server to send out communications. The timeout is how long the module waits before the received data times out.

® Set COM1 LED to show: when COM1 is selected from the drop-down list, it shows the RS485 communication

status of the COML1. If CARDL1 is selected, it shows the CARD1 communication status.

0 Set COM2 LED to show: when COM2 is selected from the drop-down list, it shows the RS485 communication
status of the COM2. If CARD?2 is selected, it shows the CARD2 communication status.
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8.2.2.3 Options - Ethernet Port Basic Setting

Click Ethernet Port Basic Setting to see the setup page. Set the communication parameters for the Ethernet port in

the CPU module on this page.

Select Static in the Mode list to specify an IP address. Select Dynamic or BOOTP in the Mode list to assign an IP
address from a DHCP/BOOTP server.

8.2.2.4 Options - Ethernet Port Advanced Setting

Click Ethernet Port Basic Setting to see the setup page. There are setups for IP Filter, NTP, Email, Socket, and RTU

mapping.
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IP Filter

Devices whose IP addresses are listed in the table are allowed to communicate with the CPU module; the CPU
module discards data packets sent from devices whose IP addresses are not in the table. Devices on a network are
filtered. This setting ensures that objects communicating with the CPU module are known devices. You can set up to 8

address ranges for allowed devices.

NTP
Click NTP to synchronize the real-time clock in the CPU module to an NTP server. Please refer to related documents
or manuals for more information about NTP.

Select the NTP Client Function Enable check box, and then set the related parameters.

0o
a—
00—

O Set the IP address of an NTP server. The CPU module corrects its internal time by connecting periodically to the

server.

@® Set a time interval for correcting the time in the CPU module. If the interval is thirty minutes, the CPU module

connects to the NTP server every thirty minutes.
© Select a time zone in the Time Zone list.

Click Email to set the email-related functions. The system sends email to the set email address after you enable the

email function. You can set up to four sets of conditions for sending email to up to four groups of email addresses.
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Dewvice Sethng
! Options Data Exchange-COk1 Data Exchange-COME Data Exchange-Ethernet

Lirnited PDintSettinE
Daylight Saving Tir
COM1 Port Setting
COMEZ Fort Setting
Ethernet Port Basic 3
=1 Ethernet Port Adwvanc
IP Filter
MNTF
-
15t Trigger Setti
1=t Trggier Reci
2nd Trigger Se
Znd Trggier Re
3rd Trigger Sett
3rd Trggier Rec
dth Trigger Setti

4th Trggier Rec
]

Drefault |

Import

Ermnall

Pararmeter name

Email Funciton Enable

“Walue

Unit

Default

kinirnurm kaxirmurm

SMTP Server

Fort

Local Email

tdail Subject
Account ldentification
User name
Passwaord

15t Remote Address
2nd Fiemote Address
drcd Remote Address
4th Remote Address

Export

19216811
z2h
AS3I00@delta.co

kessage

-

ASE00

user] @delta.co
userzi@delta.co
useri@delta.co

userd@delta.co

26

223.255.255.25
B5635

1.1.1.1
1

O Select Email Function Enable to enable the function.

® Set an |IP address of the SMTP server. Set the COM port of SMTP server at the COM port and set the sender’s

local email address. Type the Mail Subject to appear at the start of the subject of every email.

© Select Account identification checkbox to enable the function to authenticate the connection with a user name

and a password when logging into an SMTP server.

O Type the target email addresses.

Click 15t Trigger Setting and type a trigger name in Trigger Name box and a minimum interval in Trigger Min Cycle.
Then select a trigger condition in the Trigger Mode list. When the sending condition is met, the system sends an email

every designated period of time. The system does not send the same email again.
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You can set email trigger modes as follows.

® CPU Error

Trigger sending an email if an error occurs in the CPU module. Refer to the Operation manuals for more information
about errors occurring in CPU modules. After you select CPU Error, select Fatal Error Only or All Errors in the list at
the right side of the option.

a) Fatal Error Only: Send an email if a fatal error occurs in the CPU module.

b) All Errors: Send an email if an error occurs in the CPU module.

® CPU (RUN<=>STOP)

Trigger sending an email when the CPU module begins to run, or when the CPU module stops running.

® Bit Status Change

Trigger sending an email if the state of a bit device specified meets a set condition. For example, if X0.0 switches from

OFF to ON, it triggers sending an email. To set a condition, click the ***/ button in the following dialog box.

1st Trigger Bit Address (i}
15t Trigger Bit Trigger State Risinc@/ ¢ 0

15t Trigger Bit Address ®1.0
15t Trigger Bit Trigger State Rising
© Device Name: Select a device type.

® Device Number & Bit: Type a device address; if the device type selected is X/Y, you must specify a bit

number as well.

© State: Select Rising or Falling.

®Register Value Change

Trigger sending an email if the value in a device specified meets a set condition. For example, if the value in DO is

larger than 10. To set a condition, click the ™**! button in the following dialog box.

15t Trigger Reg Address oo <4 0
15t Trigger Reg Trigger State = /

15t Tricger YWalue a e @ e

1st Trigger Reg Address Do

1st Trigger Reg Trigger State >

1st Trigger Yalus 10
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O Device Name: Users can select a device type in the Device Name drop-down list.

® Device Number: Users can type a device address in the Device Number field.

© State & Value: Users can set s condition of triggering the sending of an email here.

® Periodic Timer

The system periodically sends an email. How often the system sends an email depends on the Trigger Min Cycle

interval in the Trigger Setting section.

When you set any trigger mode, the user message and error log related parameters appear.

Select the Trigger User Message Enable check box and then click the =:=| to the right side of Trigger User

Message. Type some content for the email text in the dialog box.
If you select the Error Log Enable check box, the system automatically adds the error log to the email content.

Trigger Attachment Mode determines whether to add an attachment to the email. Check the maximum size allowed
for the email file before adding an attachment. Refer to the relevant email operation manuals for more information. If

you select None, no attachment is inserted.

® File

Allows you to select an error log or the system backup file from the memory card as the email attachment.
® PLC Device

The system automatically retrieves the device states or values listed in the table as the email attachment. After you

select this option, click “*I in the following dialog box to open the Attachment dialog box. You can set a maximum of

two groups of devices. For example, if the condition is met, the values in DO-D9 are sent as an attachment.
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1st Trigger Attachment Data 1 Address | DO
1st Trigger Aftachrment Data 1 Length /

1st Trigger Aftachrment Data 1 Address D0
1st Trigger Aftachrment Data 1 Length |10

Select the receiver’s target email address for the triggered email in the Trigger Receiving table. Set the specific email

address in the Email section.
Sockets

You can set the parameters for sockets through which data is transmitted. You must use this function with specific
applied instructions. Refer to the AS Series Programming Manual for more information, as sockets are not described
here. Refer to the related documents or manuals for more information about sockets. In the Socket table, set COM
port parameters for data transmission through Ethernet; however, you should use this function only with specific API

instructions. For relevant details, refer to the AS Series Programming Manual.

Device Setting
| 7 Options Data Exchange-COk1 Data Exchange-COMZData Exchange-Ethemet

+ System Information  [&]  Sockt
COmM1 Port Setting G

COM?Z Port Setting Parameter name Yalue Unit Default Minimum Maximum
Ethemet Port Basic S = et Function Enahble
= Ethemet Port Adwvance
IP Filter

15t TCP Socket
2nd TCP Socke|
3rd TCP Socke
4th TCP Socket
15t UDP Socke
2nd UDP Socke
3rd UDF Socke

4th UDP Socke
O 7]

Default | Impart | Export

oK

The system for the AS Series module supports data transmission between the CPU module and other CPU modules
or devices through a socket as well as through TCP and UDP protocols. You can set up four connections in each of the
four groups. Select the Socket Function Enable checkbox and then select settings in the TCP and UDP setting

pages.
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The parameters in the TCP Socket Setting are the same as the parameters in the UDP Socket Setting except that

there is no Keep Alive Timer parameter in the UDP Socket Setting.

® Remote IP: Sets a remote IP address.

Remote Port: Sets a communication port used by the remote device for this TCP connection. The port number

must be between 0-65535.

® Local Port: Sets a communication port used by the local CPU module for this connection. The port number must be

between 0-65535.

Send Address: Sets an initial device in the CPU module where sent data is stored.

Send Length: Sets the length of data sent by the local CPU module. The length must be between 0-200 bytes.

Receive Address: Sets an initial device in the CPU module where received data is stored.
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® Receive Length: Sets the length of data received by the local CPU module. The length must be between 0-200
bytes.

® Keep Alive Timer: Sets a maximum time to keep the connection alive. If no data is transmitted, and the keep alive

period has elapsed, the CPU module automatically terminates the connection.

The port number used by the local CPU module and the port number used by the remote device cannot be the same,
and the devices where you store the sent data cannot overlap the devices where you store the received data. If the IP
address of the remote device is 192.168.1.100, the port number used by the remote device is 65500, the port number
used by the local CPU module is 65501, and the remote device and the local CPU module can transmit data through

this TCP connection.

If the local CPU module sends 10-word data to the remote device, the data is stored in DO—D9 before the data is sent.

If the local CPU module receives 20-word data from the remote device, the data is stored in D100-D119.

If the length of data received is larger than the setting value for the length, the first 20 words of data are stored in
D100-D119, and the remainder of the data is discarded. Likewise, if the length of data received is less than the setting
value for the length, the data is stored in the devices starting from D100, and the values in devices where no new data
is stored are unchanged.

If no data is transmitted, and 60 seconds have elapsed, the CPU module closes the socket and terminates the

connection.

In the RTU Mapping table, you can set a Delta RTU-ENOL1 slave in connection with an AS Series module. The remote
device is controlled through Ethernet and you can connect up to 4 groups of RTU-ENOL1 in the network. Refer to the

operation manual for setting and operation of RTU-ENOL1.

Select RTU Mapping Enable checkbox to enable the function of connection between RTU module and AS series
module. Set the update cycle in Cycle box and a timeout in Timeout box. It means a timeout when RTU does not give

a reply within the timeout set.
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The data mapping between each group of RTU-ENO1 and AS series module is set in the RTU Mapping section.
RTU-ENO1 and I/0 module connected to it are set via DCISoft. For more information on DCISoft, refer to the operation

manual.

O Select RTUL Enable to enable this RTU function. You can set each RTU individually.

@® Set a station address and an IP address.

© Set the RX mapping address and RX mapping length to make the digital input points for the DI module
connected to RTU and mapped to X/M devices, as well as the length for the AS Series module. Set the RY
mapping address and length to set the digital output points for the DO module mapped to Y/M devices, as well
as the length for the AS Series module.

O Set the RCR Read mapping address and RCR Read mapping length to make the analog input points for the Al
module connected to RTU and mapped to D/SR devices, as well as the length for the AS Series module. Use the
RCR Write mapping address and length to set the analog output points for the AO module mapped to D/SR

devices, as well as the length for the AS Series module.

8.2.2.5 Options - Function Card 1 Setting

Use the Function Card 1 Setting table to set the parameters for function card 1 in the AS300 Series CPU module.

Install function card 1 by inserting it into the slot in the module.

Device Setting
|~ Options | Data Exchange-COM1 | Date Exchange-COMz | Data Exchange-Ethemet

= AS3I2T Function Card 1 Setting
#- System Information
COMT Port Setting Pararneter name Walue Unit Default Miniraum Mendirmurn =
COMZ Port Setting Card 1 Detect mode J"V1ﬁ\ kanaul Auto Detect -
Ethemet Port Basic Settin Manual Select Card A5-F232 COM - None - -
=- Ethermnet Port Advance Se Card 11D Mo, h 1 1 254
1P Filter Protocol Setup Opportunity Stop—> Fun ¥ Stop—> Fun -
Baud Rate 9600 w fbps 9800
Data hit @—} 7 - [uit 7
Parity kit Even A Even
Stop hit 1 - fbit 1
MODBUS rmode ASCI - ASCI -
Delay tirme to Reply 0 s a a 3000
Received Data Timeout 200 s 200 1} 3000
F2AD Analog Input made @ — |o~1ov - 010y - -
G p g
Defeutt | Import | Export
e
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O Select Auto in Card1 Detect mode box to detect the actual card model and setting. Select Manual to manually
select the card in the Manual Select Card list and then configure the AS-F232/ F422/ F485/F2AD/F2DA function
card.

® For setting the parameters in AS-F232/ F422/ FA85 card, refer to the COM port setting in Section 3.5.2.2.

© At the bottom of the table, you can set F2AD to receive the signal of 0-10V or 4-20mA in F2AD Analog Input
Mode list and set F2AD to send the signal of 0-10V or 4-20mA in F2DA Analog Output Mode box. Set the

sampling interval for the F2AD and the average times in F2AD Sampling Time and Average Times.
8.2.2.6 Options - Function Card 2 Setting

Use the Function Card 2 Setting table to set parameters for the function card 2 in the AS Series CPU module.
Install function card 2 by inserting it into the slot in the module. For function card 2, there is an additional option
(AS-FCOPM) in Manual Select Card that does not exist for function card 1. If you select the AS-FCOPM card, set the

parameters as shown below.

Q—

— @
®©—

o>

O Select AS Remote Control, Delta ASD-A2 Control, or CANopen DS301 in the AS-FCOPM working mode list.
AS Remote Control connects the AS Series remote 1/0. Delta ASD-A2 control is exclusively for Delta servo
products. CANopen DS301 uses the DS301 standard protocol.

® When you select CANopen DS301, set the address of the station in the AS-FCOPM working mode.

© If you select Delta ASD-A2 Control in the AS-FCOPM working mode, you can set the remote 1/0 parameters.
AS remote module No. sets the number of remote I/O modules, and each one connects an extension module.

Refer to Section 3.5.3 for operation of the AS Series remote module. Select Run mode after detect remote

module determines if the connected remote module works normally or if all remote modules stop running when
the number of actual connected modules is inconsistent with the set number of modules.
AS CPU keep or Stop when slave node disconnected determines whether to show only errors or to stop
running and send an alarm when the remote I/O module is disconnected during operation.
Remote Communication Timeout sets the timeout period if the remote I/O module does not reply.
Auto Retry connection after Disconnected sets the number of times to retry the connection after a timeout
occurs.

O Set the parameters Auto Retry connection after Disconnected and AS-FCOPM Bit Rate under the three

AS-FCOPM working modes.

8-35



AS Series Operation Manual

8.2.3 Configuring AS - Series Remote Modules

You can connect remote |0 modules with the AS Series CPU module to prevent the need for wiring between a remote
device and the controller. Select Manual in the Card2 Detect Mode list and ASJ-FCOMPM in the Manual Select
Card list in the Function Card 2 Setting table. Then select AS Remote Control in the AS-FCOPM Working mode

list and the number of AS remote modules.

If you enter 2 in the AS Remote module No. box, two remote modules appear in the system configuration area after

you click OK .

You can set the remote module in the system configuration area to add, delete, copy, and move an extension module,
as shown in Section 8.1.2. As with a general controller, you can click with the mouse, drag, or right-click then click

context menu commands. You can configure all extension modules except network modules.
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Double click a module to open the Device Setting dialog box for a remote module and the extension modules

connected to it.
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Set the start of input device range for the remote module as follows. Click a remote module, then double-click Input
Device Range in the Remote Module Group 1 table and then type the device No. in the dialog box. After you click
OK, the input and output device range of the remote device and the extension modules connected to it are

automatically configured.

Femate Module Group 1

EdensionNo | Type | Module Name | DDF Version | Input Device Fa... | Output Device ... | Comment

D29040 ~ 029045

: ‘Funcllun Card2  |Function Card AS-FCOPM None
= |Mudu\e Infarmation | Analog 1/0 Module | 4504404 00.50.00 D29060 ~ D29079
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The module arrangements may affect the input and output device range, and the device range may not be in order. To
fix this, you can rearrange the input and output device ranges in an orderly sequence. On the File menu, click Input/

Output Device Rearrange to automatically arrange the device range sequence.

8.3 Data Exchange
8.3.1 Device Settings Dialog Box Descriptions

In the Device Settings dialog box, after you click the Data Exchange-COM1, Data Exchange-COM2 or Data
Exchange-Ethernet tab, you can set the parameters for the data exchange table for the communication port built into B

the AS Series module.

The AS Series module can be a master and exchange data with remote slave devices through COM1 and COM2

using the Modbus protocol, or through an Ethernet port using the Modbus TCP protocol.
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1 2 I

© When you set the start Mode to Program Control, the program in the PLC determines whether to perform the set

data exchange. PLC Run means that the set data exchange is performed automatically when PLC is in the RUN

state. Always Enable means that the data exchange is performed constantly when the PLC is powered on.

® Add a new row in the data exchange table in area ® by clicking Add. Move the selected data exchange row up or

down by clicking Move Up and Move Down. Delete the selected data exchange row by clicking Delete. Copy the

selected data exchange row by clicking Copy. You can then paste it back into the table as the last row.

© The following table explains the columns in the data exchange table.

Name Description

Item The number of the block for data exchange

Selects whether to enable the data exchange table when the data exchange is
Enable

performed.

The slave station address for the data exchange table. You can set one address for
Station Address/

multiple data exchange tables. It is a station address under the COM1 and COM2 tabs,
IP Address

and IP under the Ethernet tab.

Local Address

The device address range used by the master in the data exchange table

[<<] :Input: the data block where the master reads from a slave

<!> [>>] : Output: the data block where the master writes to a slave
This is the device address range used by a slave in the data exchange table.
Remote Address The device range is in hexadecimal if the slave in the data exchange table is a
user-defined Modbus Device.
Quantit This is the size of the data exchange table, which is consistent with the result calculated
uantity

from the device range.
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8.3.1.1 Data Exchange - COM1 and Data Exchange - COM2

On the Data Exchange-COML1 or Data Exchange-COM2 tab, double-click row in the data exchange table to set to
open the Item dialog box as shown below. Select the Enable check box to enable the data exchange table in the
mode mentioned above. Remote Address is the address of the target slave for data exchange. The Shortest Update
Cycle is the period for data exchange of the data exchange table. The connection times out if the target device does

not make any response within the time specified by Connection Timeout.

Select Support Read/write synchronization (Function code 0x17) to have the master complete reading and writing
in a single command to improve the efficiency of data exchange. This uses the specific Modbus function code. Make
sure that all devices in data exchange support the Modbus function code for read and write synchronization. Otherwise,
the attempt to read and write fails due to the failure to identify function codes after receiving the command from the

master device.

Remote Device Type is the model of a target slave including the Delta PLC and standard Modbus devices.

® Read

The AS Series module reads data from a remote device.

Local Start Address: The device type and start address of the devices where the AS Series module stores data.

Remote Start Address: The device type and start address of the remote device to be read.

8-41



AS Series Operation Manual

Quantity: This is the input data length.

® Write

The AS Series module writes data to a remote device.

Local Start Address: The device type and start address of the source data for the AS Series module.
Remote Start Address: The device type and start address of the remote device where data is to be written.
Quantity: The output data length.

8.3.1.2 Data Exchange - Ethernet

On the Data Exchange - Ethernet tab, double click a row in the data exchange table to set to open the Item dialog
box as shown below. The settings are almost the same as those for Data Exchange - COM1 and Data Exchange -
COM2, except that the target slave model option in Remote Device Type contains Delta PLC and standard Modbus
TCP equipment, as well as the IP address for remote slaves. For other settings, refer to the descriptions of Data

Exchange - COM1 and Data Exchange - COM2.

£
o\

"4

Select the Apply to all check box on the right side of The Shortest Update Cycle and Connection Timeout and then
click OK. Selecting the check box writes the settings for The Shortest Update Cycle and Connection Timeout to
other data tables on the tab Data Exchange - Ethernet. You can also set the data exchange tables separately without

selecting the Apply to all check box.
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8.4 Setting Parameters in a Module
8.4.1 Parameters in a Module

You can set the parameters in every module configured in HWCONFIG. The functions and characteristics of every
module depend on the parameter settings. To set the parameters in a module, double-click the module in the system
configuration area to open the Device Setting dialog box. This dialog box may be different for each of the various

devices.

6
<

The parameters are set according to the functions supported by the module. Before you set the parameters,

refer to the Operation Manual for more information. To prevent damage to the system or personnel, check the

effect of the parameters on the module and the entire system. There are two tabs Device Setting dialog box: the

Device Information tab and the Normal Exchange Area tab. Click the Device Information tab to display the module

information, appearance, and present DDF document version.

The number of parameters that you can set in the module and the range of setting values depend on the version of the
DDF document. The firmware and hardware version of the CPU module also appear when all the modules are

connected online.
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Click the Normal Exchange Area tab to display the corresponding functions for the input/output devices assigned to
the module. Select a parameter type at the left side of the dialog box, and then set the parameters in the table at the
right side of the dialog box. The table formats for the parameter types are the same, but the contents of the tables are

different. The number of parameters you set and the range of setting values depend on the firmware version of the

module.
= ASD4AD-A average filter
format
CH1~CH4 Made setting Parameter name Value Lnit Default Winimurm hawimum
~CHA Calibration CH1 g 1
CHZ awerage times 10 10 1 100
p CH3 awerage fimes 10 10 1 100
(hannel Detect G evmragE fmes 10 10 1 100
CHT filter Propaortion 10% hd 10% = =
CHE filter Proportion 10% - 10% = =
CH3 filter Proportion 10% - 10% = =
CH4 filter Proportion 10% hd 10% = =

The following shows the descriptions of the columns in the table. If a table cell is grayed out, you cannot edit the cell.

Parameter name

This column shows the parameter names or descriptions.

Farameter name Walue Unit Diefault Minimurm b axirnurm
CH1 average times 10 10 1 100
CHZ average times 10 10 1 100
CH3 average times 10 10 1 100
CHA average times 10 10 1 100
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Value

Set the initial parameter values in this column. When you download the parameters you set in HWCONFIG, the initial
values (setting values) are written to the module. You may type initial values for some parameter types, or select initial
values from a list for other parameter types in the Value column. Refer to the instructions for the module for more

information about the range of values you can set, as well as the processing mechanism after you download the initial

values.
Farameter name “alue Llnit Diefault Minimum Maxirnurm
CH1 average times 10 10 1 100
CHZ average times 10 10 1 100
CH3 average times 10 1a 1 100
CH4 average times 10 1a 1 100

Unit, Default, Minimum and Maximum

Refer to the unit, default, the minimum and maximum of the parameters in the following window.

Farameter name Yalue Linit Default Minimum taximurm
CH1 average times 10 10 1 100
CHZ average times 10 10 1 100
CH3 average times 10 1a 1 100
CH4 awverage times 10 1a 1 100

Click the Default button in the lower left corner of the Parameter Setting window to restore the default values of the
parameters in the module. The software asks you to confirm that you want to reset the parameters to the default

values.

r

HWCONFIG

Default AN settings will be cleared . Do o want fo continne the execntion?
S———————

Yes ] No
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8.4.2 Exporting and Importing the Parameters in a Module

You can save the parameters in the module as a CSV file. You can also import a previously exported file.

® Exporting the parameters from a module

Click Export in the Device Setting dialog box. In the Save As dialog box, select a folder in the Save in list, type a

file name in File name, and click Save.
® Importing the parameters from a file

Click Import File in the Device Setting dialog box. In the Save As dialog box, select a file to import, and click

Open. Note that the windows for importing and exporting parameters may be different for different modules.

Before importing the parameters, the system checks the file format and the module model. If the file format or the
module model is not correct, the system stops the importing process. If the data registers specified in the original
file that was exported have been used in the present configuration, the system specifies different data registers

after the file is imported.

8.4.3 Updating Parameters in a Module

You can update the parameters in a module. Make sure the software is in the Online mode. Double click the module
that you want to update. Click Update to update the parameters in the selected module. This function is limited to

digital input 1/0 and analog I/O and network modules.
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8.4.4 Setting Parameters in an SCM

Delta Electronics, Inc. provides you with specific configuration tools for some CPU modules. You can open the tools
such as CANopen network planning and SCM (Serial Communication Module) to set advanced parameters for
network assignments for the modules. For advanced setups, in the system configuration area, right-click the CPU
module, then click Communication Software, and then click SCMSoft. You must save the configurations in
HWCONFIG before opening the tool. You cannot work in HWCONFIG while editing in the special configuration tools.

Some tools require independent separate installation, and a message appears when the tool has not been installed.

Refer to configuration tool manual for the steps to set up the communication software tools.
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9.1 Introduction

9.1.1 EtherNet/IP

EtherNet/IP (“IP” stands for “Industrial Protocol”) is an industrial Ethernet network managed by ODVA, Inc. (formerly Open

DeviceNet Vendors Association, Inc.), a global trade and standards development organization.

EtherNet/IP works on a TCP/UDP/IP based Ethernet network and uses the most widely deployed collections of Ethernet
standards to provide a broad range of applications in different industries that require high-speed and stability including

Factory Automation (FA), Building Automation (BA), Process Automation (PA) and many more.

Delta covers a full range of controller and drive products supported by EtherNet/IP, including Programmable Logic
Controllers (PLC), inverters, Human Machine Interfaces (HMI) and so on. Refer to Section 9.9 for a full product list that
support EtherNet/IP. In addition, you can also use EDS files to connect to other brands of EtherNet/IP devices. You can

run Delta EtherNet/IP software (EIP Builder) through the ISPSoft software. Download the ISPSoft software at:

http://www.deltaww.com/services/DownloadCenter2.aspx?seclD=8&pid=2&tid=0&CID=06&itemID=060301&typelD=1&d

ownloadID=,&title=--%20Select%20Product%20Series%20--&dataType=8;&check=1&hl=en-US

9.1.2 Definitions of Common Network Terms

Term Definition
ODVA Open DeviceNet Vendor Association for EtherNet/IP
EtherNet/IP, an industrial Ethernet network, provides interoperability for system providers.
EIP

IP stands for Industrial Protocol. The term “EIP” (EtherNet/IP) is used in this manual.

1/0 Connection

Use the 1/0O connection to connect to EtherNet/IP and to exchange data cyclically.

Explicit Message

Connect to EtherNet/IP and to exchange data non-cyclically. Data is exchanged piece by

piece through instructions.

Requested Packet Interval, through the I/O connection to connect to EtherNet/IP to

RP! exchange data at regular time intervals.
ACD Address Conflict Detection to detect IP address duplications.
° You use TAGs for assigning and referencing memory locations for Rockwell PLCs,
the same as registers for Delta PLCs.
o Produced tag: A tag that a controller makes available for other controllers. Multiple
controllers can simultaneously consume (receive) the data. A produced tag sends
Produced/Consumed its data to consumed tags (consumers) without using logic.
TAG (P/C TAG) ° Consumed tag: A tag that receives the data of a produced tag. The data type of the
consumed tag and the produced tag must match (including any array dimensions).
) The data is transferred over Ethernet/IP. For example, PLC-A needs data from

PLC-B, so PLC-B sends the data to PLC-A. Therefore, PLC-B is the producer and

PLC-Ais the consumer.
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Chapter 9 Ethernet Specification and Operation

Electronic Data Sheets: EDS files are simple text files used by EtherNet/IP network
EDS configuration tools to help you identify EtherNet/IP products and easily commission them

on a network.

Data Mapping Exchanging data between devices
EIP Scanner The master station is called an EIP Scanner in EtherNet/IP.
EIP Adapter The slave station is called an EIP Adapter in EtherNet/IP.

Device Level Ring (DLR) provides fault-tolerant network design for daisy-chain and linear
topology. The DLR protocol provides high network availability in a ring topology. It was
DLR intended primarily for implementation in EtherNet/IP end-devices that have two Ethernet
ports and embedded switch technology, providing fast network fault detection and

reconfiguration to support the most demanding control applications.

Modbus TCP This is a Modbus variant used for communications over TCP/IP networks.

9.1.3 Ethernet Features

9.1.3.1 Delta EIP Architecture
This typical Delta EIP architecture includes an EIP Scanner and Adapters; data mapping is achieved between devices
through an I/O connection and explicit messaging. The AS Series supports single port Ethernet; thus you can install and

configure devices with embedded switch technology over EtherNet/IP.

~ - ————
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9.1.3.2 EIP Features

®  Flexibility

- Flexible topology: EIP devices may include single port Ethernet as well as dual port Ethernet, and provide
applicable networks such as linear topology, ring topology and ring topology for faster expansion and easier
management.

- EtherNet/IP works on a TCP/UDP/IP based Ethernet network, uses most widely deployed collections of Ethernet
standards, and supports Wi-fi connection. Even personnel with no IT background can build the network easily.

- Applicable networks include linear topology, ring topology, star topology, Ethernet, EtherNet/IP, one or more
LANS, etc. You can set configuration through USB or an interface.

o Simplicity

- With a connector: Delta provides a full range of products, including human machine interfaces (HMI),
programmable logic controllers (PLC), and inverter drives for application in an industrial operation. You can build
a network simply through an RJ-45 connector, saving costs on cables and other connecting tools.

- Single network: in place of the 3-tier industrial architecture, single network architecture provides 100MB/bits
high-speed cyclical and non-cyclical data mapping functions, ensuring complete network diagnosis and
effectively shortening debugging time.

- Graphical user interface software: the EIP Builder uses a graphical user interface designed for intuitive operation.
° Integration

- Data mapping: the EIP Builder provides a consistent setting interface, allowing you to reduce the time to learn
and set up configurations.

- Listed device parameters: the EIP Builder presents the device parameters in a list. Instead of looking them up
in the user manual, you can quickly check on the parameters in the list.

- EDS file: you can connect to Delta and other brands of EtherNet/IP products with EDS files.

9.2 Installation
9.2.1 EtherNet/IP Device

A Delta EtherNet/IP (EIP) device allows you to build a linear topology, ring topology, and star topology networks. A Delta
EIP device includes the EIP Builder software, EIP Scanner, EIP Adapter, EIP Tap, and an Ethernet switch. EIP Scanners
and EIP Adapters can be further divided into single port and dual port devices. The AS Series are single port devices.

Refer to Section 9.2.2.1 for the single port setup and refer to Section 9.2.2.3 for the software installation.

9.2.2 Network Cable Installation

Each EtherNet/IP device is connected to an Ethernet switch with a CAT 5e cable. Please use Delta standard cables and

the DVS series industrial switches. Refer to the Delta PLC/HMI Cable Selection Guide for more information.
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9.2.2.1. Single Port Device

You can use a single port device to build up either a linear or a star network topology. An Ethernet switch and an Ethernet

tab are required to create a star topology or a ring topology.
Linear Topology

® Linear Topology 1

® Linear Topology 2

Star Topology

9.2.2.2. Dual Port Device

You can use a dual port device to build a linear, a star or a ring network topology. A DLR function is required to create a

ring topology. Refer to Section 9.9.2 for DLR supported series.

Linear Topology
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Star Topology

Ring Topology

A DLR function is required to create a ring topology. Refer to Section 9.9.2 for AS series that support DLR.

When a switch is needed for the particular topology, the switch should support the DLR function. If not, the connection

might fail.
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9.2.2.3 EIP Builder Software

Linear and star topology

Install the EIP Builder software on your PC to monitor and configure the EIP devices. You can also connect an EIP

device to your PCs directly, or use a switch to connect to the PCs.

Ring topology
Install the EIP Builder on your PC to monitor and configure the EIP devices. Be sure to save a network connection for

your PC to connect to the EIP device.

Alternatively, you can use an EIP tap to connect your PC so that the ring topology stays intact.
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9.3 Specifications

9.3.1 Ethernet Specification

Model AS300 & AS200 Series

Communication Protocols EtherNet/IP Scanner / Adapter ~ MODBUS TCP
Protocols BOOTP, DHCP, SMTP, NTP, Socket, HTTP
Communication Speed 10/100 Mbps Auto-Detection

Communication Interface RJ-45 with Auto MDI/MDIX

Numbers of the Ethernet Port 1

Model AS-FENO2 ( work with AS300 Series)
Communication Protocols EtherNet/IP Scanner / Adapter, MODBUS TCP
Protocols BOOTP, DHCP, SMTP, NTP, Socket, HTTP
Communication Speed 10/100 Mbps Auto-Detection

Communication Interface RJ-45 with Auto MDI/MDIX

Numbers of the Ethernet Port 2

Specification
Item / per transmission
AS300 AS200 AS-FENO02
Maximum connection
quantity for Client and 32 16 8
MODBUS TCP
Server
Max. data length 100 words
Socket TCP connection quantity
(communication 4 2
) UDP connection quantity
port) N/A
SMTP (for
Emailing quantity 4 2
emailing)

* Numbering is used for connections via the communication port. You can use connection 1 in TCP mode or UDP mode

E and up to 4 connections can be made per transmission.
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9.3.2 EtherNet/IP Specification

Item AS300 Series AS200 Series Remarks
Device type Scanner / Adapter
General
Topology type Star topology
CIP connection Scanner: 32 Scanner: 16
number Adapter: 8 Adapter: 8
16 8
TCP connection
(Clients + (Clients +
number
Servers) Servers)
CIP Network 1/0
) Requested Packet
Connection 5 ms - 1000 ms
Interval (RPI)
Max. Transmission
3000 pps
Speed
Max. Data Length/per
500 bytes
transmission
Class 3 Scanner: 16 Scanner: 8
(Connected Type) Adapter: 8 Adapter: 8
UCMM
Total 16 Total 8

CIP Network Explicit

Message

(Non-Connected
Type, only uses TCP

connections)

(for all connection

types)

(for all connection

types)

CIP Objects

Identity, Message Router, Assembly,

Connection Manager, Port, TCP/IP

interface, Ethernet link, Vendor

specific

CIP Network TAG

Max. Consumed TAG

Number

32

16

Max. Produced TAG

Number

32

16

Max. Data Length

500 bytes (IO Connection)

400 bytes (Explicit Message)

Requested Packet
Interval (RPI)

5 ms — 1000 ms
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Maximum number of connections when using AS300 to connect to other devices through Ethernet/IP:

[ AS300 can act as a Scanner and an Adapter simultaneously. It can connected up to 16 devices (for example 8

Scanners and 8 Adapters).

° When AS300 acts as a Scanner, it can connect to up to 16 devices. Each device can establish up to 32
connections for data mapping. Data mapping types can be 1/0O connection and Consumed TAG. You can use

explicit message for data mapping at the same time, up to 16 explicit message connections can be created.

[ When AS300 acts as an Adapter, it can connect to up to 16 devices. Each device can establish up to 8
connections for data mapping. Data mapping types can be 1/O connection and Produced TAG. You can use explicit

message for data mapping at the same time, up to 8 explicit message connections can be created.

9.3.3 EtherNet Communication Port

9.3.3.1 Communication Port Pin Assignment

Delta EtherNet/IP devices use CAT5e industrial Ethernet cables and can be connected via RJ-45 communication port.

Pin Signal Description Pin Signal Description
1 Tx+ Transmit plus 5 - N/C
2 TX- Transmit negative 6 Rx- Receive negative
3 Rx+ Receive plus 7 - N/C 8-—1
4 -- N/C 8 -- N/C

9.3.3.2 Communication LED Indicator

LED Indicator LED Status Description
(] Communication port is connected.
ON
[ ) Connected to Ethernet
LINK Green
(] Communication port is not connected.
OFF
(] Not Connected to Ethernet
(] Packets transmitting/receiving
Blinking
(] Packets transmitting/receiving over Ethernet
ACK Yellow
(] No packets transmitting/receiving
OFF
(] No packets transmitting/receiving over Ethernet

Note: The LED indicator is at the RJ45 connection.
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9.4 EIP Builder

The Delta EtherNet/IP software, EIP Builder, is embedded in ISPSoft. You run it from the ISPSoft software (version 3.0

and above). Download the ISPSoft software at:

http://www.deltaww.com/services/DownloadCenter2.aspx?seclD=8&pid=2&tid=0&CID=06&itemID=060301&typelD=1&d

ownloadID=,&title=--%20Select%20Product%20Series%20--&dataType=8;&check=1&hl=en-US

9.4.1 Run the EIP Builder

You can call EIP Builder from Delta EIP Scanner's HWCONFIG in ISPSoft. You can also call it independently to set up
parameters for the Adapter. The Delta EIP Scanner is equipped with the EtherNet/IP communication PLC and the

EtherNet/IP module. Refer to Section 9.9.3 for a list of Delta EIP Scanner products supported by EIP Builder.

9.4.1.1 Run the EIP Builder via an EIP Scanner

®  Steps to run EIP Builder

Run EIP Builder from an EIP Scanner product. When using a Delta EIP Scanner, you set up an EIP module through

HWCONFIG in ISPSoft.

Start
Open Create Open % Download Open
ISPSoftV3.0 ISPSoft Project HWCONFIG HWCONFIG EIP Builder

N
Create

EIP Module

1. Open ISPSoft V3.0: click the Start menu and go to Programs > Delta Industrial Automation > PLC > ISPSoft
3.00
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2. Create a new project: on the File menu, click New to display the Create a New Project dialog box.

3. Selecta PLC: in the Create a New Project dialog box, select a PLC product that is supported by EIP builder.

4. Open HWCONFIG: double-click HWCONFIG in the Project window.

- Project [C:\ProgramDatay
...l Device Comment & 1

.l CARD Utiliy "™\,

- AS332T (Untitledd,

o[B8 Tasks

B DUT

[]......@ Global Svmbols

.|l Programs

s Function Blocks

- Device Monitor Tabl

&--TH AFls
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5. Save and download the settings from HWCONFIG : on the File menu click Save to save the settings and then

click the download button on the toolbar to download the file to PLC. You must save the configuration in

HWCONFIG before opening the other communication tools. While working in the communication tools, you

cannot work in HWCONFIG.

6. Open EIP Builder: right-click the CPU module in the system configuration area point to Communication

Software and then click EIP Builder.

9.4.2 Set up the IP Address

This section provides an overview of how to set up IP address for AS Series modules. Set up the IP address before

configuring the EIP related parameters or data mapping settings.
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9.4.2.1 IP Address Types

The AS Series supports 3 types of IP addressing, BOOTP, DHCP and static IP address.

Type of IP Address Definition
Uses the TCP/IP Bootstrap Protocol (BOOTP) to set up the IP address, netmask and
BOOTP gateway. A BOOTP server may require some configuration. The BOOTP protocol is
designed for a network in which each host has a permanent network connection.
Uses the Dynamic Host Configuration Protocol (DHCP) to automatically obtain IP address,
PHeP netmask, gateway, main computer name and the WINS server.
Static IP You manually set the IP address, netmask and gateway.

9.4.2.2 Set the IP Address (Static IP)

® Steps to set the IP address

When using an EIP product with a static IP address, set up the IP address in HWCONFIG in ISPSoft. The following

example uses the AS Series.

A4

Open

) S——
Create

ISPSoftProject
-

0

HWCONFIG
- @@

Setup Download
IP Address HWCONFIG

Create
EIP Module

Refer to Section 9.4.1.1 for how to set up an EIP module in HWCONFIG.

1. Configure the network parameters

4 Double-click the AS Series module in HWCONFIG to open the Device Setting dialog box.

4 On the Options tab, set the IP address on the Ethernet Port Basic Settings page, and then click OK.
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2. Save and download the settings from HWCONFIG: on the File menu click Save to save the settings and then

on the Options menu, click Download or click the Download button on the toolbar.

9.4.2.3 Set the IP Address (BOOTP/DHCP)

® Steps to set the IP address

When using an EIP product with a BOOTP/DHCP IP address, users can set up the IP address through the IP
Manager in the EIP Builder.

)

Open

EIP Builder
A\ 4

( ) Same I P assign

Create Open

MAC Address IP Manager Setup IP mode after each

- J power-on

=~ o .
Reset IP assign
mode after each
power-on
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Descriptions for the IP Manager:

@

@:
Bt

Iltem

Definition

0] Stop the Server

Stops the BOOTP/DHCP server; the IP manager does not request an IP
addresses from the BOOTP/DHCP server.

@ Network Settings

Opens a dialog box to set up the subnet mask, gateway, primary DNS,

secondary DNS, and domain name.

©) Clear List Clears the contents of the list.

® New Adds a new IP/MAC address.

® Delete Deletes the selected item from the list.

® Import Imports the IP/MAC address list; the file format is .CSV.

@ Export Exports the IP/MAC address list; the file format is .CSV.

Enable BOOTP Enables the BOOTP to assign an IP address for the selected item.
® Enable DHCP Enables the DHCP to assign an IP address to the selected item.

® Disable BOOTP/DHCP

Disables the BOOTP/DHCP on the device; the device does not request an IP

addresses from the server.
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® Steps to set the IP address:

1. MAC address: find the MAC address on the EIP device. The MAC address uniquely identifies the device.

2. Open the IP Manager

L g In EIP Builder on the Tool menu, click IP Manager.

L 2 The IP Manager can be the BOOTP/DHCP Server, receiving IP address requests from devices. The IP

Manager window is shown below.
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3. Setup the IP address

Double-click the listed MAC address for your device to open the Input Data dialog box.

*

6

L 2 Enter the IP address and click OK.

4. Disable DHCP/BOOTP

Click the device in the Mapping Table that you want to disable, then click Disable DHCP/BOOTP. The selected

device does not send DHCP/BOOTP requests. To change the IP address receiving mode, refer to Section 9.4.2.4

for more information.
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® Notes

° Enable BOOTP: when the IP address receiving mode is BOOTP (BOOTP is enabled), the IP address is

assigned, and the device sends out BOOTP requests for IP addresses during each power-on.

o Enable DHCP: when the IP address receiving mode is DHCP (DHCP is enabled), the IP address is assigned,

and the device sends out DHCP requests for IP addresses during each power-on.

° Disable DHCP/BOOTP: when BOOTP is disabled, the device does not send out any DHCP/BOOTP requests

for IP addresses during each power-on.

9.4.2.4 Re-enable BOOTP/DHCP

To enable the DHCP or BOOTP function again, use the device software to make the change. Using the AS Series as an

example: from the Start menu, start ISPSoft, then HWCONFIG, and then IP Manager. In IP Manager sets the IP address

to the receiving mode.

Download
HWCONFIG

Open Setup IP
IP Manager receiving mode

1. Refer to Section 9.4.1.1 for how to start HWCONFIG.

Setup
parameters

Open
HWCONFIG

Open
EIP Builder

® Steps to set device parameters

G

2. Set the parameters: enable the IP address receiving mode to BOOTP/DHCP.
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€ Double-click the device to open the Device Setting dialog box.

€  Make changes to the items, such as IP address receiving modes and click OK to confirm the settings.

6

3. Download the settings from HWCONFIG

L 4 Refer to Section 9.4.1.1 for more information.

4. Open EIP Builder.

L 4 Refer to Section 9.4.1.1 for more information.

5. Open the IP Manager

L 4 Refer to Section 9.4.2.2 for more information.

6. Open the IP setup page

L 4 Refer to Section 9.4.2.2 for more information.
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9.4.3 Network

EIP Builder provides a graphical user interface, and you can see the devices and their EtherNet/IP connections in the

Network View. This section provides an overview of how to add your devices to the network connections.

IP Manager

(Setup IP)

AddDevice

Create Network Set up Device

EIPBuilder (Scan Network)| $ "[(Setup Connection) Settings
AddDevices
(Manually)
Descriptions of the EIP Builder Window
— # r
(1 D |
Fl‘jn;'YU:;;d U MewworkView = ¥ | Pradurr | st '+
] M S
:‘!‘- lc.(c;r:ect&d '
5 Uil (AL 2
0 ] v "
e: ack Na. Siot Na. Par Ma i [ Mask | Nemors dame Catz Mappng Setting
Il_[ ASIZT Lot Sl - 2 13215005 255.255.255.0 - Erpty
01—
- ||
Item Definition
o Toolbar Toolbar buttons
e Network View Displays the connected devices and their connection status
(3] Configuration Area Displays the configurations and allows you to set the parameters
(4] Product List Displays the available devices that can be connected to EtherNet/IP
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© Toolbar buttons

Icon Name Definition
New Creates a new EIP Builder project
Open Opens an existing project
Save Saves the project
Help Opens the help file
Cut Cuts the selected item

Copies the selected item
Copy

Pastes the selected item
Paste

Deletes the selected item
Delete

Scan Network

Scans the network for device availability

Check Checks if the project is planed properly
On-line Mode Switches to on-line mode

Uploader Uploads from a device

Downloader Downloads to a device

Setup Button

Opens the communication setting; set up the path connecting the PC to the EIP

Scanner.
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@A Network View

Name Definition
® | Station Name Name of the station
@ | Device Name Name of the device

Displays the number of devices with Ethernet communication ports.
® | Ethernet COM Port
The last digit of the IP address is shown on the COM port.

Displays the connection status; devices on the same line indicate they are in the same
@ | Network 0
network.

(3] Configuration Area
Refer to Section 9.4.3.3 for more information.

O Product List

Product List n

(1 B .
EX o Communications Adz|

f AH10EN-3A
B CMC-EIPO1

- CMM-EIPO1
94— =-# General Device

Lo B General Device
= Programmable Logic
""" il AS324MT

""" il As332P

""" il AS332T

Name Definition

Type the module name you want to find; if no match is found, that means there is no
® | Search Bar
EDS file in the system matching the module name.

Categorizes the devices according to the EtherNet/IP definition; devices from third
@ | Product List
parties are in the Others folder.
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9.4.3.1 Scan Network

©

@
©)

Name Definition
0] Selection checkboxes Select the devices you want to add to the network view.
@ Refresh Refreshes the network view (scans the network again)
® Join Adds the selected device to the network view

® Operation Steps: Add new devices in (scan the network)

1. Click the Setup button to display the Communication Setting dialog box.

=
<

2. Once your PC is connected to the EIP Scanner, there are 3 ways to set up the network communication.
(@) Select an existing driver: Select the driver from the COMMGR Driver list.

(b) Edit an existing driver: Click the setup button in the Common Setting section to edit the driver in the

Driver Properties dialog box.

(c) Add a new driver: Click the setup button+ in the Common Setting section to add a new driver in the

Driver Properties dialog box.
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(c)

L

@+ |

3. Click the Scan Network button to scan the network and list the scanned devices in the Device List dialog box.

Vol

4. Select the devices to add to the Network View, and then click Join to add the selected devices.

] AS332T

7
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9.4.3.2 Add devices (Manually)

® Steps to add new devices manually

1. Select the devices to add from the Product List. You can also enter the module name in the search bar. Drag the

device onto the Network View.

2. Create the network

(a) Drag the Ethernet communication port of the device to the network to create a new connection.

A a-A
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(b) Create network connections for the devices.

(c) Once the connection is established, click the network line “Network_0" to see all the connected devices in this
network in the Information window.
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9.4.3.3 Set EIP parameters

Click the tabs in the Information window to view and edit the EIP Parameter and the EDS Parameter.

) Information Tab

This tab contains the Module Name, Version, Rack, Slot, Slot, IP address, Mask, Network and Data Exchange

Setting.

) EIP Parameter Tab

This tab contains parameter information from the EDS file. When offline, you can check only the connection

parameters for setting up the EDS filtering rules.
* Disable Keying: Disable key checking the product information versions.

4 Compatible Keying: Check if the product information and its master version match and check the

minor version for compatibility.

L 2 Exact Match: Check if the product information, and both the master version and minor version match.
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When the device is connected, you can click the Upload button to upload the related parameters from the device.

O

AS332T

Name Definition

° Identification: displays information regarding Vendor, Product
Type, Product Name, Revision, etc.

@ Module Status o Status: displays connection status, including Major Fault,

Minor Fault, Internal State, Configuration Status, and Module

Identity.

) Portl: indicates port 1 of the device, for editing IP Address,

Subnet Mask, Gateway Address, and Host Name.
® IP Setting
Note: when there is a Port2, that means there are 2 Ethernet

communication ports.

) EDS parameters filtering rules include Disable Keying,
® Connection
Compatible Keying, and Exact Match.

) Displays Link Status, Speed, Duplex, Negotiation Status and
@ Port Status
Hardware Fault.

® DLR ) Displays the DLR information
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AS332T

AS332T
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° EDS Parameter Tab: this is not supported for the AS Series modules; the software closes itself when this Tab

is selected.

9.4.4 Data Mapping

When the connection between devices is established, you can use data mapping to exchange data between devices.

This section provides an overview of how to create a data mapping table.

Network View Data Exchange Data Exchange Download Data Exchange
Table Setup

Descriptions for the Data Mapping:

® 6 0 ©6 o0 O O 6 ©

Name Definition

Data mapping connection count; each row represents one
independent EtherNet/IP connection. The number of connections
(1] Connection Count cannot exceed the maximum number of connections for the
Scanner. For the AS Series, the maximum number of connections

32.

e Enable Enable and disable data mapping for the connection.

Use TAG to perform data mapping with adapters.
(3] TAG After selecting this check box,

o The directional arrow points left of (<) (READ only)
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Name Definition

) Registers cannot be used in this row.

[ ] The length format is defined by the data format in the Global
Symbols; you cannot change the length format here.

[ ] You must create a Consumed TAG in the Global Symbols in

ISPSoft before using this function.

The IP address of the Adapter to connect to. After the data mapping
connection is established, the system loads the connected device’s
(4] IP Address
IP address. You can also select the device’s IP address from the list

to add and edit the connection.

Once you select the IP address, its name is displayed but cannot be

e Adapter Name modified here. Refer to Section 9.4.3 @ for more information on

how to change the device name.

CPU Address Start address of the data mapping’s register.
Scanner’s register address + Actual represented register = starting register address + address
(6] address offset (Ethernet/IP offset; you can set the starting register address in the HWCONFIG
modules) setup page.
Select the TAG check box®©. Select the Consumed TAG name from the list.
Adapter Address/Parameter Target adapter’s register address / parameters
o Input the name of the Produced TAG for other connected EIP

Select the TAG check box®.
devices. The default name is the same as the name shown in @.

Set up the IN/OUT parameters. When there is no I/O representative
(8] 1/0 Mapping Table table presented for the Adapter, the parameters cannot be opened,

for example in some PLCs.

Set the data mapping length; unit: byte, the maximum is 500 bytes.
(9] Length
You cannot change the length format here when using TAG.

(10] Property Set the advanced data mapping parameters.

@ 10 Mapping Table

E Delta EIP devices provide an I/O mapping table. You can use the table to edit the parameters if needed.

Name Definition

Select the connection from the list. Different connections may have
@ Connection

different mapping parameters.
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Name

Definition

Input mapping parameters. The No. column shows the maximum
number of mapping parameters to input. Double-click the Name

column to open the mapping table to edit the parameters.

Out

Output mapping parameters. The No. column states the maximum
number of mapping parameters to output. Double-click the Name

column to open the mapping table to edit.

Name

The parameter name; double-click the Name column to open the

mapping table to edit the parameters.

Value

Values; after editing and downloading, the scanner stores the
values. When the connection is established, the values are written

to the Adapter.
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(10) Property

Property Setting

I/O Parameter Setting

A

A

A

® ® 0 0

Connection Path Parameter

A

Input Instance

Qutput Instance

RPI (ms) 1015

Multicast

TimeQut RPIx 4 x
Trigger Mode Cyclic b

( Min. 1 ~ Max. 1000 )

(Min. 101 ~ Max. 101 )

(Min. 100 ~ Max. 100 )

< Configure Instance | 128 (Min. 128 ~ Max. 128 )
oK Cancel
Name Definition
O] Requested Packet Interval (RPI) Time interval to request packets through the 1/O connection, unit: ms
@ Multicast Communication mode setup: Multicast or Point-to-Point
Sets the timeout according to the RPI or a multiple of RPI (RPI*X).
® Timeout The minimum value is 100 ms to reduce timeout occurrence When a
value that is less than 100 ms is treated as 100 ms.
Cyclic: renews data cyclically
O] Trigger Mode Change of State: renews data once there is any change
Application: renews data according to the product setup
® Input Instance You can edit input instance, output instance and configure instance
® Output Instance in some of the EDS files. The instance number is the same as the
data mapping connection number. You can tell the mapped data is
@ Configure Instance from which corresponding device by the instance number.

® Steps to set up and download parameters

1.

L 4

Create a data mapping table (*):

Table.

Right-click the COM port on the Ethernet Scanner, and then click Data Mapping to open the Data Mapping
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/D
6

The system creates a Data Mapping Tab, shown for Network_0.

2.

*

Network_0 Data Mapping Tab

L 1

Network_0 Data Mapping Table

Set the Data Mapping Parameters
Type the parameters in the data mapping table. See below for examples

a) Reading D500-D599 from the Adapter with the IP address 192.168.1.2 to the D10000-D10099 in the

Scanner.

b) Writing D20200-D20299 from the Scanner to D100-D199 in the Adapter with the IP address
192.168.1.1

Use TAG function in data mapping

a) Create a General Device in the Network View as shown below and then set the IP address to be used

as a Produced TAG. For adding a device, please refer to Section 9.4.3.

9-37




AS Series Operation Manual

b) Start or switch to the data mapping page.

c) Once you select the TAG check box, the directional arrow is to the left with (&) (READ only)

Enable TAG IP Address
192.168.1.10 -

Adapter Address/Parameter/ TAG

input _]%

CPU Address/ TAG

H
W

Freq M

s ANk
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*You can also enter the IP address to be connected to other TAGs so that creating a General Device is not

necessary.
d) Selecting the Consumed TAG

Select the created Consumed TAG from the CPU register address /TAG column.

CPU Address/TAG

Freg v
Feg

e) Enter the name for the to-be-connected Produced TAG.

After you select the TAG, the software shows the same TAG name in the register address / parameters /

address for the Adapter. You can modify the TAG name to have the same name as the Produced TAG

name.

€  Set the properties
a) Click the ... button to set the properties.
b) In the Property Setting dialog box, enter the data mapping parameters.
Set the Requested Packet Interval (RPI) to refresh the data between the Scanner and Adapter
periodically; for example, every 20ms.
3. Download
€  Click the Downloader button on the tool bar to open the Project Downloader window.

O
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€@  Select the Scanner communication port in EIP Builder; every communication port can download a data

mapping table.

9.4.5 Diagnosis

EIP Builder can provide diagnostic information on the connection and data mapping status. For the connection status,
refer to the Adapter connection status and indicator in the Network View tab; and for data mapping status and error

codes, refer to Network_0 in the data mapping tab.

(] Steps to view network status

€ Network View (Connection Status)

a) Click the Network View tab to check the device status from the indicators: for example RUN / STOP and

Error indicators for the PLC.

Network View

Status

O
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The dotted line and the warning sign indicate a connection error, as shown below.

€  Network_0 (Data Mapping):

a) Click the On-line Mode button on the toolbar.

b) Click the Network _0 tab to check the data mapping status and the error codes for Network_0. For error

code definitions, refer to Section 9.6.2.

Connection Status

Error Codes

Connection Status I
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9.5 Programming
9.5.1 Explicit Message

All connections in EtherNet/IP can be divided into explicit messaging connections and implicit (or 1/0) messaging
connections. Explicit messaging uses TCP/IP and request/response communications or client/server connections,
requiring that the instruction include the memory location of the data to be sent to the client. Implicit messaging uses
UDP/IP, in which a server sends information from predefined memory locations to a client at a given interval, using a
requested packet interval (RPI) parameter to specify the interval. For details on using implicit messages, please refer to

Section 9.4.4. This section provides an overview of how the AS Series uses explicit messaging instructions.

When the AS Series acts a Scanner, you can use the EIPRW instruction (APl 2208) to read and write Objects. When EIP
Builder uses Objects as parameters, each Object includes various parameters. For details on the EIPRW instruction,
please refer to the AS Programming Manual. For details on Objects that are supported by the AS Series, please refer to

Section 9.8.

9.5.2 TAG

EtherNet/IP can use TAGs to exchange data. A Delta PLC can use Global Symbols to define a TAG, and then Delta HMI
and third party devices can use the TAG. There are 2 types of EIP TAGs, Produced TAGs and Consumed TAGs.

1. Produced TAG: a PLC makes Produced tags that send data to Consumed tags in other EIP Scanners for data

mapping with other EIP devices.

2. Consumed TAG: EIP Scanners make Consumed tags to receive data from Produced tags for data mapping with

other EIP devices.

You can use tags to connect to other EIP devices. Before connecting a Consumed TAG, please check the IP
address of the device to be connected and the Produced TAG name. One device can have more than one Produced

TAG and Consumed TAG. See the following example.

‘ Produced TAG 1

‘ Produced TAG 2

| Consumed TAG 1

Consumed TAG 2

Consumed TAG |

Produced TAG |

Other EIP devices
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9.5.2.1 Produced TAG

Creating a Produced TAG

1. InISPSoft, in the Project tree, expand Global Symbols to see EtherNet/IP Table (Produced Tag).

A

2. Double-click EtherNet/IP Table (Produced TAG) to create a Produced TAG.
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3. Right click in the EtherNet/IP Table (Produced Tag) window and then click Add a Symbol to open the Add Symbol

dialog box.

[ Add a Symbol

Symbols Filter
Remove Address
MMove Up Alt+Up

Move Down  Alt+Down

Undo Ctrl+Z
Redo Ctrl+Y
CtrHX
Ctr+C
Ctr+V
Delete Del
Select All Ctrl+A

4. Enter the required information in the table to create the Produced TAG.

After the settings are complete, download the TAG to the PLC. Other EIP devices can access the Produced TAG with

their Consumed TAG. For information on creating a Consumed TAG, refer to the EIP device manual.
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9.5.2.2 Consumed TAG

Creating a Consumed TAG

1. InISPSoft, in the Project tree, expand Global Symbols to see EtherNet/IP Table (Consumed Tag).

&

2. Double-click EtherNet/IP Table (Consumed TAG) to create a Consumed TAG.
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3. Right click in the EtherNet/IP Table (Consumed Tag) window and then click Add a Symbol.

[ Add a Symbol

Symbols Filter

Remove Address

Move Up Alt+Up

Move Down  Alt+Down

Undo Ctrl+Z
Redo Ctrl+Y
Cut Ctr+X
B Copy Ctr+C
J Paste Ctrl+V
Delete Del
Select All Ctrl+A

o

4. Inthe Add Symbol dialog box, enter the required information in the table to create a consumed tag.

5. You can use tags in the data mapping. Refer to Section 9.4.4 for more information.

° Descriptions for the Add Symbol dialog box

Number Name Description

O] Identifier Create Tags for a PLC; up to 40 characters.

Correspond to registers or bytes in a PLC; you can use a data register or M bit
@ Address

device.

Supports data types such as BOOL, WORD, DWORD, INT, DINT, REAL, and
® Type ARRAY (one-dimensional array linear array, up to 512 bytes).
® Initial Value Not supported
® Comment Description for the TAG; up to 128 characters.
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9.6 Troubleshooting
This section provides an overview of error codes and troubleshooting for the AS Series.

9.6.1 Error Code Classification

There are two types of error code categories for the AS Series: Configuration Errors, and Application Errors. These error

codes are defined by the ODVA for EtherNet/IP errors. Refer to the following table for AS Series error codes.

Error Code Classification

1%t Phase 2"d Phase Description

Category Iltem

Mismatched EDS files lead to I/0O connection

EDS files mismatched .
failure. *

Configuration error
Data exchange setup error lead to I/0

Data exchange setup error . 8 N
connection failure.

Application error Ethernet/IP error EtherNet/IP communication failure *

* Only the last 2 bytes of the error code are shown; for example, only 011C appears for the error code H'1101011C.

9.6.2 Error Codes & How to fix them

9.6.2.1 Configuration Errors

(EIP Builder only shows Low word error codes)

Category Error Code Description How to fix them
The Transport Class field 1. Check if the product information and the EDS file
values of the Transport Class match.
H'1101011C
and Trigger in the EDS file 2. Reload the EDS file.
are mismatched. 3. Ask the vendor of the device for the EDS file.

1. Check if the product information and the EDS
The Vender ID or the Product

file match.
H'11010114 Code in the EDS file is
EDS Files 2. Reload the EDS file.
mismatched.
Mismatched 3. Ask the vendor of the device for the EDS file.

1. Check if the product information and the EDS file

The device type parameters
match.

H'11010115 in the EDS file are
2. Reload the EDS file.

mismatched.
3. Ask the vendor of the device for the EDS file.
The revision parameters in 1. Check if the product information and the EDS file
H’11010116
the EDS file are mismatched. match.
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output parameters in the

Category Error Code Description How to fix them
. Reload the EDS file.
. Ask the vendor of the device for the EDS file.
Check if the product information and the EDS file
The direction parameters in match.
H'1101011E
the EDS file are mismatched. . Reload the EDS file.
. Ask the vendor of the device for the EDS file.
Check if the product information and the EDS file
The fixed / variable output
match.
H'1101011F flag in the EDS file is
. Reload the EDS file.
mismatched.
. Ask the vendor of the device for the EDS file.
Check if the product information and the EDS file
The fixed / variable input flag
match.
H'11010120 in the EDS file is
. Reload the EDS file.
mismatched.
. Ask the vendor of the device for the EDS file.
Check if the product information and the EDS file
The output priority in the match.
H'11010121
EDS file is mismatched. . Reload the EDS file.
. Ask the vendor of the device for the EDS file.
. Check if the product information and the EDS file
The input priority in the EDS match.
H'11010122
file is mismatched. . Reload the EDS file.
. Ask the vendor of the device for the EDS file.
Check if the product information and the EDS file
The output connection type
match.
H'11010123 parameters in the EDS file
. Reload the EDS file.
are mismatched.
. Ask the vendor of the device for the EDS file.
Check if the product information and the EDS file
The input connection type
match.
H'11010124 parameters in the EDS file
. Reload the EDS file.
are mismatched.
. Ask the vendor of the device for the EDS file.
The redundant ownership . Check if the product information and the EDS file
H'11010125

match.
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Category Error Code Description How to fix them
EDS file are mismatched. 2. Reload the EDS file.
3. Ask the vendor of the device for the EDS file.
1. Check if the product information and the EDS file
The configuration size
match.
H’11010126 parameters in the EDS file
2. Reload the EDS file.
are mismatched.
3. Ask the vendor of the device for the EDS file.
1. Check if the product information and the EDS file
The configuration path
match.
H'11010129 parameters in the EDS file
2. Reload the EDS file.
are mismatched.
3. Ask the vendor of the device for the EDS file.
1. Check if the product information and the EDS file
The EDS file does not match.
H'11010132
support Null forward open. 2. Reload the EDS file.
3. Ask the vendor of the device for the EDS file.
1. Check if the system has created the 1/0
H’12010100 1/0 connections duplicated connections.
2. Change the connection type to Listen Only.
1. Check the scanner owner.
H’12010106 | Ownership conflict 2. Reconfigure the invalid scanner.
3. Change the connection to multicast.
Target for connection not 1. Check the I/O connection status.
H'12010110 ]
configured 2. Activate the I/O connections again.
Data
H'12010111 Adapter RPI not supported Check the RPI for the adapter.
Exchange
1. Check if the number of connections exceeds the
Setup Error
H’12010113 | Out of connections limit.
2. Reduce the number of the product connections.
1. Check if the system has created the 1/0
H'12010119 Non-Listen only not opened connections.
2. Check the scanner I/O connection status.
Invalid originator to target Check the module number and the product setup file
H'12010127
Size to see if they match.
H'12010128 | Invalid target to originator Check the output size in the connection parameters.
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Category Error Code Description

How to fix them

Size

Consumed TAG does not
H'1201012D
exist.

Check if the parameters in the Consumed tag are set

correctly.

Produced TAG does not
H'1201012E

exist.

Check if the parameters in the Produced tag are set

correctly.

H'12010204 Unconnected request timeout

No response from the adapter; check if the power
and the network connection for the adapter are

working properly.

Network bandwidth NOT

1. Check the I/O connection limit between the

scanner and the adapter.

connection path

H'12010302 _
available for data 2. Increase the RPI value or reduce the number of
connections.
Invalid segment in Check the module number and the product setup file
H’12010315

to see if they match.

9.6.2.2 Application Error

Category Error Code Description

How to fix them

EtherNet/

IP Error
3.

1. Check the network connection status.
H'00010203 1/0 connection timeout 2. Check if the module is working properly.

Increase the RPI value.
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9.7 Studio 5000 Software Operation

This section provides an overview using Ethernet/IP to connect to a Delta Ethernet/IP Adapter with third party software.

For this example we use the Rockwell Automation software Studio 5000.

9.7.1 Architecture

The Rockwell Automation (RA) EIP Scanner uses Ethernet to connect to a Delta Adapter. The PC connects to the RA

Scanner through Ethernet or USB.

& Rockwell Software Studio 5000, ControlLogix, RSLogix are registered trademarks of Rockwell Automation, Inc.

(] Operation Steps:

Network View Data Exchange Data Exchange Download Data Exchange
Table Setup

9.7.2 Create a New Project

(] Open Studio 5000 and under Create, click New Project.

New
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(] Select a PLC and select the chassis. This example uses a 1756-L71.

Select PLC I

(] Click Finish to create the new project.

Select a backplane I
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(] After creating the project, Studio 5000 displays the Controller Organizer and workspace.

9.7.3 Create a Scanner

Next, add the 1756-EN2TR Ethernet/IP module, and then connect to the Ethernet/IP devices through the Ethernet/IP

module.

9.7.3.1 Create a New Ethernet/IP Module

[ Right-click 1756 Backplane 1756-A7 and then click New Module.

9-53




AS Series Operation Manual

{ Type 1756-EN2TR in the filter field, click the 1756-EN2TR module, and then click Create.

{ Type the Name, IP address and other required information, and then click OK to add the EtherNet/IP module.
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() The new 1756-EN2TR module appears in the Controller Organizer tree.

9.7.4 Connect to a Delta Adapter

This section provides an overview of connecting to a Delta Ethernet/IP Adapter with the Rockwell Automation software

Studio 5000.

9.7.4.1 Import an EDS file

® In Studio 5000, on the Tools menu, click EDS Hardware Installation Tool.
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[ Select Register an EDS file(s) and click Next.

() Select Register a single file and click Browse to find the EDS file to import.
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[ Follow the instructions in the wizard and then click Finish to complete importing the EDS file.

9.7.4.2 Create an Adapter

® In Studio 5000, in the Controller Organizer under 1756-EN2TR, right-click Ethernet and then click New Module.
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() Type the module number of the imported Delta EDS file in the filter field, click the Delta module, and then click

Create.

[ Verify that the product name and IP address are the same as the information shown in the Module Definition

section.
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[ Click Change if you need to make a change to the module definition.

[ Modify the module definition
1) Name: Click the arrow button to select a valid connection.
2) Size: Rockwell PLC supports maximum 500 bytes data size. (Data for input contains 2 bytes of Serial Number
and for output contains 4 bytes 32-bit Run-idle header and 2 bytes of Serial Number.) If using AS300, you can set

the maximum data length 498 SINT for input and 494 SINT for output.

% In general, there is no need to change the parameters from the imported EDS files which can usually be used

without modification.
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[ In the New Module dialog box, click the Connection tab to modify the Requested Packet Interval and Input Type
settings. The RPI uses the 1/0 connection to a Scanner to exchange data at regular intervals, and the units are
micro-seconds. For Input Type select either Unicast or Multicast. The Input Type selections may vary for different

products.

[ Click OK to create the adapter. The new Delta Adapter appears in the Controller Organizer tree.

9.7.5 Editing Corresponding Addresses for AS300

Refer to section 9.8.5 Assembly Object for defaults of mapping address. Refer to section 9.7.7 on how to open Program
TAG and modify the contents of TAG:C to edit the mapping addresses. Refer to section 9.8.5 Assembly Object for details

on TAG:C.
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9.7.6 Download

The next step is to download the project to the PLC and go online.

® In Studio 5000, on the Communications menu, click Who Active. To establish a connection, select the Scanner

connected to the PC, and then on the Communications menu click Download.
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[ After the connection is successfully established, the 1/0O status shows green by I/O OK.

9.7.7 Data Mapping

In the Controller Organizer, you can map data, including Configuration, Input and Output parameters. When you create a

device I/O Configuration, the tags are added automatically.

() Click Program TAGs to display the Tags window.

Controller Organizer - 0 X

=5 Controller AHI0EMC_SA
.. Controller Tags
(3 Controller Fault Handler

13

=25 Tasks
=48 MainTask
. 328 MainProgram

o) Frogram Tags

m
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[ Tags are listed in the Name column. Tag names begin with a product name and end with C or 11 or O1, separated

from the name by a colon (;), for example CMCEIP01:C, CMCEIPO01:11, and CMCEIP01:01.

Scope: [0 Example ~  Show: All Tags - 7

Name =2[ 7. | Alas For Base Tag Data Type Descrption Exemal Acoess | Condtart_| Style -
+ CMCEIPOTC _031FCMC_EIP Read/Wrie O
-+ CMCEIPOT 11 _031FCMC_EIP Read/Wie g]
-+ CMCEIPO1 01 _031FCMC_EIP Read/Wte g]
E [w]

4]+ |\ Monitor Tags MEdit Tags / 4

() Tag name : C indicates the tag contains information from the Adapter EDS file, including Input and Output

parameters. You can edit these parameters in Studio 5000.

[ Tag name : 11 indicates that the mapping starts from TAG : 11[0], and is mapped to the first parameters of the

Adapter output. The length is the output length provided by the Adapter.

() Tag name: O1, indicates that the mapping starts from TAG : O1[0], and is mapped to the first parameters of the

Adapter Input. The length is the input length provided by the Adapter.

RA EIP Scanner ) < f Delta Adapter
[ 1756-L71+1756-EN2TR | EtherNet/IP " VFD-C2000 ]
Tag:11[0] Parameter_0
Tag:I11[1] Parameter 1
Adapter
Tag:11 . P
: : Output
Tag:11[31] Parameter_31
Tag:01[0] Parameter_0
Tag:01[1] Parameter_1
Adapter
Tag:01 ) . P
: : Input
Tag:01[31] Parameter 31
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9.8 CIP Object

9.8.1 Object List

CIP requires objects (groups of related data and behaviors associated with this data) to describe a device, how it

functions, communicates, and to define its unique identity. Objects can be further defined by Class (a set of objects

representing the same type of system), Instance (a copy of an object), and Attribute (data values). An object’s instance

and class have attributes, providing services and implementing behaviors. Instance 0 contains the basic information for

every object, that is: version and length. Instance 1-N contains parameters for creating connections. You can get product

parameters from the supported service code through objects.

The supported EtherNet/IP objects are listed in the following table. Refer to Section 9.8.2 for the data type definitions.

Refer to Section 9.8.3 for object contents. Refer to Section 9.5 for object reading and writing.

Object Name Function Class ID
Identity Object Provides identification of general information about the device. 1(H01)
Provides a messaging connection point through which a client
Message Router Object | can address a service to any object class or instance residing in 2 (H'02)
the physical device.
Binds attributes of multiple objects, which allows data to or from
Assembly Object each object to be sent or received over a single connection and 4 (H'04)
can be used to bind input data or output data.
Connection Manager Provides connection and connectionless communications,
6 (H'06)
Object including establishing connections across multiple subnets.
Describes the communication interfaces that are present on the
Port Object 244 (H'F4)
device and visible to CIP, including USB, Ethernet/IP and more.
TCP/IP Interface Object | Provides the mechanism to configure a device’s TCP/IP 245 (H'F5)
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Object Name Function Class ID
network interface; examples of configurable items include the
device’s IP Address, Network Mask, and Gateway Address.
Maintains link-specific counters and status information for an
Ethernet Link Object 246 (H'F6)
IEEE 802.3 communications interface.
X Register Bit/Word Register 848 ( H'350)
Y Register Bit/Word Register 849 (H'351)
D Register Bit/Word Register 850 ( H'352)
M Register Bit Register 851 ( H'353)
S Register Bit Register 852 (H'354)
T Register Bit/Word Register 853 ( H'355)
C Register Bit/Word Register 854 ( H'356 )
HC Register Bit/Word Register 855 ( H'357)
SM Register Bit Register 856 ( H'358 )
SR Register Word Register 857 ( H'359)

9.8.2 Data Type

This section provides an overview of the data types supported by objects.

Data Type Description
BOOL False(H'00) or True(H'01)
SINT(1 byte), INT(2 bytes), DINT(4 bytes), LINT(8 bytes)
Number | 1st 2nd 3rd 4th 5th 6th 7th 8th
SINT OLSB
INT OLSB | 1LSB
SIGNED DINT OLSB | 1LSB | 2LSB | 3LSB
INTEGER LINT | OLSB | 1LSB | 2LSB | 3LSB | 4LSB | 5LSB | 6LSB | 7LSB
Example: DINT value = H'12345678
Number 1st 2nd 3rd 4th
DINT 78 56 34 12
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language

Data Type Description
USINT(1 byte), UINT(2 bytes), UDINT(4 bytes), ULINT(8 bytes)
Ex: UDINT value = HAABBCCDD
UNSIGNED
Number 1st 2nd 3rd 4th
INTEGER
UDINT DD CcC BB AA
ASCIl CODES, 1 or 2 bytes/words
STRING: 2 bytes character count + 1 byte character
Contents (Char count) Contents (String contents)
STRING 04 00 4D 69 6C 6C
STRING2: 2 bytes character count + 2 byte character
STRING
Contents (Char count) Contents (String contents)
STRING2 04 00 4D | 00 | 69 | 00 | 6C | 00 | 6C | OO
SHORT_STRING: 1 bytes character count + 1 byte character
Contents (Char count) Contents (String contents)
STRING 04 4D 69 6C 6C
BYTE (1 byte), WORD (2 bytes), DWORD (4 bytes), LWORD (8 bytes)
1st 2nd 3rd 4th 5th 6th 7th 8th
Fixed LENGTH Byte 7..0
BIT STRING WORD | 7...0 15...8
DWORD | 7...0 15...8 23..16 | 31...24
LWORD | 7...0 15...8 23...16 | 31...24 | 39...32 | 47...40 | 55...48 | 63...56
A single string consists of multiple language representation
Name Data Type Meaning
The number of internationalized character
Number USINT
strings
STRINGI
Array of: Array of individual internationalized character
Strings )
Struct of: strings
The first ASCII character of the 1ISO 639-2/T
LanguageCharl USINT
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Data Type Description
The second ASCII character of the ISO 639-2/T
LanguageChar2 USINT
language
The third ASCII character of the ISO 639-2/T
LanguageChar3 USINT
language
The structure of the character string, limited to
the Elementary Data type value OxDO
CharStringStruct USINT
(STRING), 0xD5 (STRING2), 0xD9 (STRINGN)
and OxDA (SHORT_STRING)
The character set which the character string is
CharSet UINT based on which comes from IANA MIB Printer
Code (RFC 1759).
Defined in An array of 8-bit octet elements which is the
International String
CharStringStruct | actual international character string
ISO 639-2/T language:
Language First Character Second Character Third Character
English e n G
French f r e
Spanish S p a
Italian i t a
STRUCT of: Composed of any data types.
Ex.: STRUCT of { BOOL, UINT, DINT } ={ TRUE, H'1234, H'56789ABC }
STRUCT
1st 2nd 3rd 4th 5th 6th 7th
Byte 01 34 12 BC 9A 78 56
Array of: Composed of one data type.
Ex.: ARRAY of UINTs={1-2 -3}
ARRAY
Number 1st 2nd 3rd 4th 5th 6th
Array 01 00 02 00 03 00
A path that consists of multiple segments and references the class, instance and attribute of
EPATH another object.

Example : Identity Object, Instance attribute 5 =“20 01 24 01 30 05 “
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9.8.3 Identity Object (Class ID: 01 Hex)

This object stores identity information that consists of the Vendor ID, Device Type, Product Code and Major Revision for

your device.

) Service Code

Service Att”bute
Service Name Description
code Class Attribute Instance Attribute
H01 Get_Attributes_All X \% Read all attributes
H'05 Reset X \% Resets the drive to the start-up state.
H'OE Get_Attribute_Single \% \% Read one attribute
) Class
. Class ID: H'01
) Instance
. H'00: Class Attribute
. H'01: Instance Attribute
. When Instance = 0, the Class Attributes are listed below.
Class Access
Name Data Type Values Description
Attribute Rule
H'01 Revision Get UINT H1 Revision of this object
Maximum instance number of this
H'02 Max Instance Get UINT H'1
object
Number of object instances
H'03 Number of Instance Get UINT H'1 currently created at this class level
of the device
. When Instance = 0, the Instance Attributes are listed below.
Instance Access
Name Data Type Values Description
Attribute Rule
H'01 Vendor ID Get UINT H'31F Delta Electronics, Inc.
H'02 Device Type Get UINT H'0C Communication Adapter
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Instance Access
Name Data Type Values Description
Attribute Rule
H'03 Product Code Get UINT H'4000 Product Code
Revision STRUCT - Revision of this device: Major / Minor
H'04 Major Revision Get USINT H01 Major Revision Range: H'01-H'7F
Minor Revision USINT H01 Minor Revision Range: H'01-H'FF
H'05 Status Get WORD H'00 Status, refer to the following *1 table
The last 4 characters of the MAC
H'06 Serial Number Get UDINT H'abcd
address, ab:cd
The maximum length of a product
H'07 Product Name Get STRING “AS300T”
name is 32 characters.

*] Status Description (H'05)

Bit (s) Name Description

Does the device has an owner connection?.

0 Owned 0: No
1: Yes
1 Reserved 0 - Always OFF

Is the device configured?

2 Configured 0: No
1: Yes
3 Reserved 0 Always OFF

0: Self-testing

1: Firmware update

2: At least one faulted I/O connection
3: No I/O connections established

4: Non-volatile configuration error

4-7 Extended Device Status
5: Major fault

6: At least one I/O connection in run mode

7: At least one I/O connection established, all in idle

mode.

8-15: Reserved
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Bit (s) Name Description

0: No minor recoverable fault detected
8 Minor Recoverable Fault

1: Minor recoverable fault detected

0: No minor unrecoverable fault detected
9 Minor Unrecoverable Fault

1: Minor unrecoverable fault detected

0: No major recoverable fault detected
10 Major Recoverable Fault

1: Major recoverable fault detected

0: No major unrecoverable fault detected
11 Major Unrecoverable Fault

1: Major unrecoverable fault detected

9.8.4 Message Router Object (Class ID: 02 Hex)

This object provides a messaging connection point through which a client may address a service to any object class or

instance residing in the physical device.

) Service Code

Service Support
Service Name Description
Code Class Attribute Instance Attribute
H'OE Get_Attribute_Single \% \% Read a single attribute
° Class

. Class ID: H'02

(] Instance

J H'00: Class Attribute

. H'01: Instance Attribute

. When Instance = 0, the Class Attributes are listed below.
Class Access
Name Data Type Values Description
Attribute Rule
H'01 Revision Get UINT H01 Revision of this object

. When Instance = 0, the Instance Attributes are listed below.

Instance Access
Name Data Type Values Description
Attribute Rule
The maximum number of
H'02 Number Available Get UINT H'0

connections
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Instance Access
Name Data Type Values Description
Attribute Rule
The number of connected
H'03 Number Active Get UINT H'0
connections

9.8.5 Assembly Object (Class ID: 04 Hex)

This object binds attributes of multiple objects, which allows data to or from each object to be sent or received over a

single connection and can be used to bind input data or output data.

) Service Code

Service Support
Service Name Description
Code Class Attribute Instance Attribute
H'OE Get_Attribute_Single \% \% Read a single attribute
H'10 Set_Attribute_Single X \% Edit a single attribute
° Class

. Class ID : H'04

(] Instance

. H'00 : Class Attribute

. H’64 : 1/0 Connection Output 1

. H’65 : 1/0 Connection Input 1

. H’66 : 1/0 Connection Output 2

. H'67 : 1/0 Connection Input 2

. H'72 : 1/0 Connection Output 8

. H'73 : 1/0 Connection Input 8

. H'74-H'7A Reserved

. H’80 : Configuration 1

. H’81 : Configuration 2

. H'87 : Configuration 8

. H'C : Listen-Only Connection Number
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. When Instance = 0, the Class Attributes are listed below.

Class Access
Name Data Type Values Description
Attribute Rule
H'01 Revision Get UINT H'2 Revision of this object
The maximum number of
H02 Max Instance Get UINT HC7 ]
instances
. When Instance = 64—87, the Instance Attributes are listed below. (Length of input and output is editable. The
maximum length is 250 words; supports only even bytes)
I/O Message Connection
Connection No. Function Instance Attribute Length
Input (T>0) 0x65 D1000~D1099
Connection 1 Output (O>T) 0x64 D0~D99
Configuration 0x80 Refer to the table below
Input (T>0) 0x67 D1100~D1199
Connection 2 Output (O>T) 0x66 D100~D199
Configuration 0x81 Refer to the table below
Input (T->0) 0x69 D1200~D1299
Connection 3 Output (O->T) 0x68 D200~D299
Configuration 0x82 Refer to the table below
Input (T>0) 0x6B D1300~D1399
Connection 4 Output (O->T) Ox6A D300~D399
Configuration 0x83 Refer to the table below
Input (T>0) 0x6D D1400~D1499
Connection 5 Output (O>T) 0x6C D400~D499
Configuration 0x84 Refer to the table below
Input (T>0) OX6F D1500~D1599
Connection 6 Output (O>T) OX6E D500~D599
Configuration 0x85 Refer to the table below
Input (T>0) 0x71 D1600~D1699
Connection 7
Output (0> T) 0x70 D600~D699
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Configuration 0x86 Refer to the table below

Input (T>0) 0x73 D1700~D1799
Connection 8 Output (O>T) 0x72 D700~D799

Configuration 0x87 Refer to the table below

Configure the contents of input and output to edit the mapping address.

Configuration Defaults
Data Type Contents
Address (Connection 1)

Input corresponding element

Word[0] UINT 0
0:D, 1:X,2:Y

Word[1] UINT Reserved 200

Word[2-3] DWORD Input corresponding element number 1000
Output corresponding element
Word[4] UINT 0
0:D,2:Y

Word[5] UINT Reserved 200

Word[6-7] DWORD Output corresponding element number 0

9.8.6 Connection Manager Object (Class ID: 06 Hex)

Use this object for connection and connectionless communications, including establishing connections across multiple

subnets.

) Service Code

Service Support
Service Name Description

Code Class Attribute | Instance Attribute

H'OE Get_Attribute_Single \% X Read a single attribute

H'4E Forward_Close X \% Close a connection
Open a connection; the maximum

H'54 Forward_Open X \%
data size is 511 bytes.

° Class

. Class ID : H'06
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[ ] Instance

. H'00 : Class Attribute

H’01 : Instance Attribute

. When Instance = 0, the Class Attributes are listed below.

Class Access
Name Data Type Values Description
Attribute Rule
H'01 Revision Get UINT 1 Revision of this object
Maximum instance number of this
H'02 Max Instance Get UINT 1
object
o When Instance = 1, the Instance Attributes are listed below.
Access
Attribute Name Data Type Values Description
Rule
Number of Forward Open service
H01 Open Requests Get UINT HO
requests received.
Number of Forward Open service
H'02 Open Format Rejects Get UINT H'0 requests that were rejected due to

bad format.

Number of Forward Open service
Open Resources
H'03 Get UINT H'0 requests that were rejected due to
Rejects
lack of resources.

Number of Forward Open service

requests that were rejected for

H'04 Open Other Rejects Get STRUCT H'0

reasons other than bad format or

lack of resources.

Number of Forward Close service
H'05 Close Requests Get WORD H'0

requests received.

Number of Forward Close service
H’06 Close Format Rejects Get UDINT H'0 requests that were rejected due to

bad format.
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Access
Attribute Name Data Type Values Description
Rule

Number of Forward Close service

H'07 Close Other Rejects Get STRING H'0 requests that were rejected for
reasons other than bad format.
Total number of connection
timeouts that have occurred in

H'08 Connection Timeouts Get UINT H'0
connections controlled by this
Connection Manager.

9.8.7 Port Object (Class ID: F4 Hex)

This section describes the communication interfaces that are present on the device and visible to CIP, including USB,

EtherNet/IP and more.

) Service Code

Service Support
Service Name Description

Code Class Attribute Instance Attribute
Returns a predefined listing of this

H01 Get_Attributes_All X \%
objects’ attributes
Returns the contents of the

H'OE Set_Attribute_Single \% \%
specified attribute.

[ Class

. Class ID : H'F4

([ ] Instance

H'00 : Class Attribute

. H'01 : Instance Attribute

. H’N: Instance #N Attribute, the number of the Ethernet port

. When Instance = 0, the Class Attributes are listed below.
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Class Access
Name Data Type Values Description
Attribute Rule
H01 Revision Get UINT 1 Revision of this object
Maximum instance number of this
H'02 Max Instance Get UINT 1
object
Number of object instances
H'03 Number of Instance Get UINT 1 currently created at this class level
of the device
H'08 Entry Port Get UINT 1 Communication port for EtherNet/IP
ARRAY of Port Instance information: Port Type
Port Instance Info --
STRUCT of + Port Number
H'09 Get
Port Type UINT H'04 EtherNet/IP, refer to the following *1
Port Number UINT H01 Identifies each communication port

. When Instance = 1, the Instance Attributes are listed below.

Instance Access
Name Data Type Values Description
Attribute Rule
H'01 Port Type Get UINT H'04 EtherNet/IP, refer to the following *1
H'02 Port Number Get UINT H'01 Identifies each communication port
Identifies Object attached to this
Link Object STRUCT of --
port. Path length + Link Path
H'03 Get
Path Length UINT -- Path length
Link Path EPATH -- Path segment
SHORT_
H04 Port Name Get EIP1 Name of the communication port
STRING
Port Number and Communication port number and
H'07 Get EPATH 0101
Node Address node number of this device on port.
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*1 Communication Port Type

Communication Port Type Description

1 Self-defined
2 ControlNet
3 ControlNet Redundant
4 EtherNet/IP
5 DeviceNet

201 Modbus/TCP

203 SERCOS Il

9.8.8 TCP/IP Interface Object (Class ID: F5 Hex)

This object provides the mechanism to configure a device’'s TCP/IP network interface. Examples of configurable items

include the device’s IP Address, Network Mask, and Gateway Address.

) Service Code

Service Support
Service Name Description
Code Class Attribute Instance Attribute
H'01 Get_Attributes_All X \% Read all attributes
H'OE Get_Attribute_Single \% \% Read one attribute
H'10 Set_Attribute_Single X \% Write one attribute
° Class
. Class ID = H'F5
° Instance
. H'00 : Class Attribute
. H'01 : Instance Attribute
. H’N: Instance #N Attribute, number of IP addresses that the device supported

. When Instance = 0, the Class Attributes are listed below.
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Class Access
Name Data Type Values Description
Attribute Rule
H'01 Revision Get UINT H'2 Revision of this object
Maximum instance number of this
H'02 Max Instance Get UINT H'2
object
Number of object instances
H’03 Number of Instance Get UINT H'2 currently created at this class level
of the device

. When Instance = 1, the Instance Attributes are listed below.

Instance Access
Name Data Type Values Description
Attribute Rule
H'01 Status Get DWORD H'2 IP status, refer to the following *1
Configuration Configuration capability, refer to
H'02 Get DWORD H'15
Capability the following *2
Configuration Configuration Control, refer to the
H'03 Get/Set DWORD H'0
Control following *3
Physical Link
STRUCT of -- Path to physical link object
Object :
H'04 Path Size Get UINT H'0 Size of Path
Logical segments identifying the
Path EPATH --
physical link object
Interface TCP/IP network interface
STRUCT of --
Configuration : configuration.
The device’s IP address;
IP Address UDINT H'COA80005
192.168.1.5
The device’s network mask:
Network Mask UDINT H'FFFFFFOO
H'05 Get/Set 255.255.255.0
Default gateway address:
Gateway Address UDINT H'C0A80001
192.168.0.1
Name Server UDINT 0 Primary name server
Name Server 2 UDINT 0 Secondary name server
Domain Name STRING 00 00 Default domain name
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Instance Access
Name Data Type Values Description
Attribute Rule
H'06 Host Name Get/Set STRING AS300T Device name
Encapsulation EIP device active connection time;
H'13 Get/Set UINT 120
Inactivity Timeout unit:0-3600 seconds
*1 Interface Status
Status Description
0 The Interface Configuration attribute has not been configured.
The Interface Configuration attribute contains valid configuration obtained from BOOTP, DHCP or non-
1
volatile memory.
2 The Interface Configuration attribute contains valid configuration obtained from hardware.

*2 Interface Capability Flags

Bit Description
0 BOOTP Client
1 DNS Client
2 DHCP Client
3 DHCP-DNS Update
4 Configuration Settable
5 Hardware Configurable
6 Interface Configuration Change Requires Reset

*3 Interface Configuration Control

Status Description
The device uses the interface configuration values previously stored (for example, in non-volatile
° memory or through hardware switches).
1 The device obtains its interface configuration values through BOOTP.
2 The device obtains its interface configuration values through DHCP on start-up.
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9.8.9 Ethernet Link Object (Class ID: F6 Hex)

This object maintains link-specific counters and status information for an IEEE 802.3 communications interface.

) Service Code

Service Support
Service Name Description
Code Class Attribute Instance Attribute
H01 Get_Attributes_All X \% Read all attributes
H'OE Get_Attributes_Single \% \% Read one attribute
) Class
. Class ID: H'F6
® Instance
. H'00: Class Attribute
. H'01: Instance Attribute
o H’N: Instance #N Attribute, the number of the Ethernet port
o When Instance = 0, the Class Attributes are listed below.
Class Access
Name Data Type Values Description
Attribute Rule
H'01 Revision Get UINT H'03 Revision of this object
Maximum instance number of this
H'02 Max Instance Get UINT H'021
object
Number of object instances currently
H'03 Number of Instance Get UINT H'01 created at this class level of the
device
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. When Instance = 1, the Instance Attributes are listed below.

Instance Access
Name Data Type Values Description
Attribute Rule
Interface speed currently in use
H'01 Interface Speed Get DWORD H'64 10(H'0A), 100(H’'64), 1000(H’'3ES8)
Mbps
Ethernet port status, refer to the
H'02 Interface Flags Get DWORD H'F
following *1
ARRAY of By
H'03 Physical Address Get MAC address
6 USINTs Product
Define the name of the Ethernet port
SHORT_S
Interface Label NA For example: for port 1, the definition
TRING
of the name in string is 01 31.
H'0A Get The maximum length of the name is
Length USINT NA
16 words.
SHORT_S Use ASCII characters to name the
Interface name NA
TRING Ethernet port name.
STRUCT Ethernet interface capability bits table
Interface Capability --
of: *2
H’0000000 | Ethernet interface capability bits
Capability Bits DWORD
7 definition
STRUCT Ethernet interface capability speed &
Speed/Duplex Options --
of: duplex option definition
Speed/Duplex Array Ethernet interface capability speed &
USINT H'04
Count duplex array count
H'OB Get
ARRAY of
Ethernet interface capability speed &
Speed/Duplex Array STRUCT --
duplex array contents
of:
Ethernet interface speed; ex:
Interface Speed UINT NA
H'0A: 10 bps and H'64: 100 bps
Ethernet interface duplex mode; H'00:
Interface Duplex Mode USINT NA duplex mode and H’01: full duplex

mode
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*1 Interface Flag Table

Bit (s) Name Description
0 indicates an inactive link
0 Link Status
1 indicates an active link
0 indicates half duplex
1 Half/Full Duplex
1 indicates full duplex
0 : Auto-negotiation in progress
1 : Auto-negotiation and speed detection failed
2-4 Negotiation Status 2 : Auto negotiation failed but detected speed
3 : Successfully negotiated speed and duplex
4 . Auto-negotiation not attempted. Forced speed and duplex.
5 Manual Setting Requires Reset Set to zero
0: the interface detects no local hardware fault
6 Local Hardware Fault
1: a local hardware fault is detected
7-31 Reserved 0
X2 Interface Capability Bits
Bits Item Description
Indicates if the device requires a reset when instance attribute #6
Manual Setting Requires (Interface Control attribute) changes.
0
Reset 0 indicates the device does not require a reset
1 indicates the device requires a rest
0 indicates the interface does not support auto-negotiation
1 Auto-negotiate
1 indicates the interface supports auto-negotiation
0 indicates the interface does not support auto MDIX operation
2 Auto-MDIX
1 indicates the interface supports auto MDIX operation
0 indicates the interface does not support speed/duplex setting.
3 Manual Speed/Duplex (Instance attribute #6, Interface Control attribute)
1 indicates the interface supports speed/duplex setting
4-31 Reserved Should be 0
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9.8.10 X Register (Class ID: 350 Hex)

) Service Code

Support
Service Code Service Name Instance Description
Class Attribute
Attribute
H'OE Get_Attribute_Single X \% Read one attribute
H’32 Read_Parameter X \% Read Parameter
) Class
. Class ID : H'350
° Instance
. H'01 : Instance Attribute, Bit Register
. H’02 : Instance Attribute, Word Register
. When Instance = 1, the Instance Attributes are listed below.
Instance Access
Name Data Type Values Description
Attribute Rule
H'00 X0.0 Get BOOL H'00 X0.0 bit register
H'01 X0.1 Get BOOL H'00 X0.1 bit register
H'02-H'03FE X0.2-X63.14 Get BOOL H'00 X0.2 -X63.14 bit register
H'3FF X63.15 Get BOOL H'00 X63.15 bit register
. When Instance = 2, the Instance Attributes are listed below.
Instance Access
Name Data Type Values Description
Attribute Rule
H’00 X0 Get INT H'00 X0 word register
H'01 X1 Get INT H'00 X1 word register
H'02-H'3E X2-X62 Get INT H'00 X2-X62 word register
H'3F X63 Get INT H'00 X63 word register

9-83



AS Series Operation Manual

9.8.11 Y Register (Class ID: 351 Hex)

Service Code

Service Code

Service Name

Support

Class Attribute

Instance

Description

Attribute
H'OE Get_Attribute_Single X \% Read one attribute
H’10 Set_Attribute_Single X \% Write one attribute
H’32 Read_Parameter X \% Read Parameter
H’33 Write_Parameter X \% Write Parameter
° Class
. Class ID : H'351
° Instance

o H’01 : Instance Attribute, Bit Register

. H'02 : Instance Attribute, Word Register

. When Instance = 1, the Instance Attributes are listed below.

Instance Access Data
Name Values Description
Attribute Rule Type
H'00 Y0.0 Set BOOL H'00 Y0.0 bit register
H'01 Y0.1 Set BOOL H'00 Y0.1 bit register
H'02-H'03FE Y0.2-Y63.14 Set BOOL H'00 Y0.2-Y63.14 bit register
H'3FF Y63.15 Set BOOL H'00 Y63.15 bit register
. When Instance = 2, the Instance Attributes are listed below.
Instance Access Data
Name Values Description
Attribute Rule Type
H'00 YO Set INT H'00 YO word register
H'01 Y1 Set INT H’00 Y1 word register
H'02-H'3E Y2-Y62 Set INT H'00 Y2-Y62 word register
H'3F Y63 Set INT H'00 Y63 word register
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9.8.12 D Register (Class ID: 352 Hex)

) Service Code

Support
Service Code Service Name Instance Description
Class Attribute
Attribute
H'OE Get_Attribute_Single \% Read one attribute
H'10 Set_Attribute_Single \% Write one attribute
H’32 Read_Parameter \% Read Parameter
H’33 Write_Parameter \% Write Parameter
° Class

. Class ID : H'352

[ ] Instance

H'01 : Instance Attribute, Bit Register

. H'02 : Instance Attribute, Word Register

. When Instance = 1, the Instance Attributes are listed below.

Instance Access Data
Name Values Description
Attribute Rule Type
H'00 DO0.0 Set INT H'00 DO0.0 bit register
H'01 DO.1 Set INT H'00 DO0.1 bit register
H'02-H'752FE D0.2-D29999.14 Set INT H'00 D0.2-D29999.14 bit register
H'752FF D29999.15 Set INT H'00 D29999.15 bit register
. When Instance = 2, the Instance Attributes are listed below.
Instance Access Data
Name Values Description
Attribute Rule Type
H’00 DO Set INT H’00 DO word register
H'01 D1 Set INT H’00 D1 word register
H'02-H'752E D2-D29998 Set INT H'00 D2-D29998 word register
H'752F D29999 Set INT H'00 D29999 word register
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9.8.13 M Register (Class ID: 353 Hex)

) Service Code

Service Code

Service Name

Support

Class Attribute

Instance

Description

Attribute
H'OE Get_Attribute_Single X \% Read one attribute
H’10 Set_Attribute_Single X \% Write one attribute
H’32 Read_Parameter X \% Read Parameter
H’33 Write_Parameter X \% Write Parameter
° Class

. Class ID : H'353

[ J Instance

o H’01 : Instance Attribute, Bit Register

. When Instance = 1, the Instance Attributes are listed below.

Instance Access Data
Name Values Description
Attribute Rule Type
H'00 MO Set BOOL H'00 MO bit register
H'01 M1 Set BOOL H'00 M1 bit register
H'02-H'1FFE M2-M8190 Set BOOL H'00 M2-M8190 bit register
H'1FFF M8191 Set BOOL H'00 M8191 bit register
9.8.14 S Register (Class ID: 354 Hex)
o Service Code
Support
Service Code Service Name Instance Description
Class Attribute
Attribute
H'OE Get_Attribute_Single X \% Read one attribute
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. Class ID : H'355

H'10 Set_Attribute_Single \% Write one attribute
H’32 Read_Parameter \% Read Parameter
H’33 Write_Parameter \% Write Parameter
° Class
. Class ID : H'354
° Instance
o H’01 : Instance Attribute, Bit Register
. When Instance = 1, the Instance Attributes are listed below.
Instance Access Data
Name Values Description
Attribute Rule Type
H’00 SO Set BOOL H’00 SO bit register
H'01 S1 Set BOOL H’00 S1 bit register
H'02-H'7FE S2-S2046 Set BOOL H00 S2-S2046 bit register
H'7FF S2047 Set BOOL H'00 S2047 bit register
9.8.15 T Register (Class ID: 355 Hex)
° Service Code
Support
Service Code Service Name Instance Description
Class Attribute
Attribute
H'OE Get_Attribute_Single \% Read one attribute
H’10 Set_Attribute_Single \% Write one attribute
H’32 Read_Parameter \% Read Parameter
H’33 Write_Parameter \% Write Parameter
° Class
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(] Instance

. H'01 : Instance Attribute, Bit Register

. H’02 : Instance Attribute, Word Register

. When Instance = 1, the Instance Attributes are listed below.
Instance Access Data
Name Values Description
Attribute Rule Type
H’00 TO Set BOOL H’00 TO bit register
H'01 T1 Set BOOL H’00 T1 bit register
H'02-H'1FE T2-T510 Set BOOL H'00 T2-T510 bit register
H'1FF T511 Set BOOL H'00 T511 bit register
. When Instance = 2, the Instance Attributes are listed below.
Instance Access Data
Name Values Description
Attribute Rule Type
H’00 TO Set INT H'00 TO word register
H'01 T1 Set INT H'00 T1 word register
H'02-H'1FE T2-T510 Set INT H'00 T2-T510 word register
H'1FF T511 Set INT H'00 T511 word register

9.8.16 C Register (Class ID: 356 Hex)

) Service Code

Support
Service Code Service Name Instance Description
Class Attribute
Attribute
H'OE Get_Attribute_Single X \% Read one attribute
H’10 Set_Attribute_Single X \% Write one attribute
H’32 Read_Parameter X \% Read Parameter
H'33 Write_Parameter X \% Write Parameter

) Class

. Class ID : H'356
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[ ] Instance

. H'01 : Instance Attribute, Bit Register

. H'02 : Instance Attribute, Word Register

. When Instance = 1, the Instance Attributes are listed below.

Instance Access Data
Name Values Description
Attribute Rule Type
H'00 Co Set BOOL H'00 CO bit register
H'01 C1l Set BOOL H'00 C1 bit register
H'02-H'1FE C2-C510 Set BOOL H'00 C2-C510 bit register
H'1FF C511 Set BOOL H'00 C511 bit register

. When Instance = 2, the Instance Attributes are listed below.

Instance Access Data
Name Values Description
Attribute Rule Type
H'00 Co Set INT H'00 CO word register
H'01 C1 Set INT H'00 C1 word register
H'02-H'1FE C2-C510 Set INT H'00 C2-C510 word register
H'1FF C511 Set INT H’00 C511 word register

9.8.17 HC Register (Class ID: 357 Hex)

) Service Code

Support
Service Code Service Name Instance Description
Class Attribute
Attribute
H'OE Get_Attribute_Single X \% Read one attribute
H'10 Set_Attribute_Single X \% Write one attribute
H’32 Read_Parameter X \% Read Parameter
H’33 Write_Parameter X \% Write Parameter

) Class

. Class ID : H'357
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[ ] Instance

. H’01 : Instance Attribute, Bit Register

. H'02 : Instance Attribute, Word Register

. When Instance = 1, the Instance Attributes are listed below.

Instance Access Data
Name Values Description
Attribute Rule Type
H'00 HCO Set BOOL H'00 HCO bit register
H'01 HC1 Set BOOL H'00 HC1 bit register
H'02-H'FE HC2-HC254 Set BOOL H'00 HC2-HC254 bit register
H'FF HC255 Set BOOL H'00 HC255 bit register

. When Instance = 2, the Instance Attributes are listed below.

Instance Access Data
Name Values Description
Attribute Rule Type
H'00 HCO Set DINT H'00 HCO word register
H'01 HC1 Set DINT H'00 HC1 word register
H'02-H'FE HC2-HC254 Set DINT H'00 HC2-HC254 word register
H'FF HC255 Set DINT H’00 HC255 word register

9.8.18 SM Register (Class ID: 358 Hex)

) Service Code

Support
Service Code Service Name Instance Description
Class Attribute
Attribute
H'OE Get_Attribute_Single X \% Read one attribute
H'10 Set_Attribute_Single X \% Write one attribute
H’32 Read_Parameter X \% Read Parameter
H’33 Write_Parameter X \% Write Parameter

) Class

. Class ID : H'358
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[ ] Instance

. H'01 : Instance Attribute, Bit Register

. When Instance = 1, the Instance Attributes are listed below.
Instance Access Data
Name Values Description

Attribute Rule Type

H'00 SMO Set BOOL H'00 SMO bit register

H'01 SM1 Set BOOL H'00 SM1 bit register

H'02-H'FFE SM2-SM4094 Set BOOL H'00 SM2-SM4094 hit register
H'FFF SM4095 Set BOOL H'00 SM4095 bit register

9.8.19 SR Register (Class ID: 359 Hex)

) Service Code

Support
Service Code Service Name Instance Description
Class Attribute
Attribute
H'OE Get_Attribute_Single X \% Read one attribute
H’10 Set_Attribute_Single X \% Write one attribute
H'32 Read_Parameter X \% Read Parameter
H'33 Write_Parameter X \% Write Parameter
° Class
. Class ID : H'359
) Instance
. H’01 : Instance Attribute, Bit Register
o When Instance = 1, the Instance Attributes are listed below.
Instance Access Data
Name Values Description
Attribute Rule Type
H'00 SRO Set INT H'00 SRO word register
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H'01 SR1 Set INT H’00 SR1 word register
H'02-H'7FE SR2-SR2046 Set INT H'00 SR2-SR2046 word register
H'7FF SR2047 Set INT H’00 SR2047 word register

9.9 Delta EIP Product List
9.9.1 Delta EIP Products

Positioning Product Firmware Version
AHCPU511-EN, AHCPU521-EN, AHCPU531-EN V2.00
AH10EN-5A V2.00
Mid-range AHRTU-ETHN-5A V1.00
PLC AH10EMC-5A V1.00
AS300 Series V1.00
AS200 Series V1.00
Small PLC DVP-ES2-E Series V1.00
VFD-MS300 Series (CMM-EIP01 Communication Card) V3.60

Inverter

VFD-C2000 Series (CMC-EIP01 Communication Card) V1.06

9.9.2 Delta EIP Products, DLR (Device Level Ring) supported

Positioning Product Firmware Version
Mid_range AH10EN-5A Vv2.00
PLC AHRTU-ETHN-5A V1.00

9.9.3 Delta EIP Products, SCanner supported

Positioning Product Firmware Version
Mid-range | AHCPUS11-EN, AHCPU521-EN, AHCPU531-EN V2.00
PLC AH10EN-5A V2.00
Small PLC AS Series V1.00
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9.10 Operation and Monitor on the Web
9.10.1 Getting Started

You can enter AS Series PLC IP address in the search bar of your browser to connect to your device. After that you can
set up and monitor AS Series PLC.

9.10.1.1 Exploring the webpage

After connected to the module, you can see the AS300 webpage with 5 sections as the image shown below.

Descriptions:

Section Contents
Banner Delta logo and the name of the connected device
Login Username and password

Sitemap is shown in tree diagram.

Menu (The menu shows data based on the permission of the current
user.)
Context Main contents; click an item on the menu section, its content

appears here.

Bottom Copyright information and Delta webpage information
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9.10.1.2 Using the Webpage

List of browsers that support AS300 webpage:

Provider Browser Supported versions

Microsoft Internet Explorer V10.0 and later

Microsoft Edge V20 and later
Google Chrome V14 and later
Mozilla Firefox V17 and later
Apple Safari V5.1 and later

(] Operation Steps:

a. Open your browser, enter AS300 PLC IP address in the search bar to connect to AS300 PLC.

B & O pela EOE

& = O M 192.166.1.5

A NELTA Automation for A Changing World

Smarter. Greener Together.

[ | Device information

I:I Device name AS332T
Device description AS300_PSJ 0
X Firmware version V01.04.80.00
£ Information
-1 Device information IP address 19216815
MAC address 00:18:23:13:43:db
Serial number AS332T-AWA15500012

b. After the webpage appears, enter “Admin” in the User section and click Login without entering any password.
You can set up the password after login.

B < B pelta Koo+

& = O 192,168.1.5

A MNELTA Automation for A Changing World

Smarter. Greener. Together.

Device information

o

Device name AS332T
Device description AS300 PSJ 0
X Firmware version V01.04.80.00
E-E Information
[l Device information IP address 192.168.1.5
MAC address 00:18:23:13:43:db
Serial number AS332T-AW15500012
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9.10.1.3 Login

You need to login to your account to set up.

° Operation Steps:

a. Provide the login information to login.

b. After login successfully, the user field shows your account name (read only). After setting up, you can click
Logout here to leave this webpage.

Item Description

User Your account name

Password Your password

Login: to enter the webpage

“" L H ” “ L t"
ogin® /*Logou Logout: to leave the webpage

9.10.1.4 Menu

The menu shows data based on the permission of the current user.

Permission
Nodes
Administrator Write/Read Read

Device information \% \% \Y
Account management \Y

Data monitor setup \%

Data monitor table 1 - 4 \% \% Read-only
Hardware status \% Read-only Read-only
Save configuration \%
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° Log in as an Administrator, the following nodes appear.

Password

£ Information

- [£] Device information
=H " Network configuration

. [ Account management
1 Data Monitor

[] Data monitor setup

EE} Diagnostic
- [Z1Hardware status
EH1Save Config

[ Log in with Write/Read permission, the following nodes appear.

Password
= Information
.2 Device information
=~ Data Moniter
[ Table_1
“[£] elevator

=/~ Diagnostic
i =] Hardware status

L] Log in with Read only permission, the following nodes appear.
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9.10.2 Device Information

Here provides AS Series PLC product information.

You do not need to log in to see the device information. This page is read only, not for editing.

Device information

Device name AS332P

Device description

Firmware version V01.04.30.00

IP address 192.168.1.5

MAC address 00:18:23:13:af.96

Serial number AS3IZ2P-AW16280001

Iltem Description

Device name Product name
Device description Device description that user defined in ISPsoft
Firmware version Firmware version
IP address Product IP address
MAC address Product MAC address
Serial number Product serial number

9.10.3 Network configuration

You can set network related configurations here.

9.10.3.1 Account management

You can set 3 kinds of access types for up to 8 user accounts.
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Item

Description

User ID

To name your user ID, you can use up to 16 characters from the
following characters, A through Z (case-insensitive ), 0 through 9,

_ (underscore) , (comma) and . (dot) .

® The first default user ID is “Admin” (read only).

Password

To name your password, you can use up to 16 characters from the
following characters, A through Z (case-insensitive ), 0 through 9,
_ (underscore) , (comma) and . (dot) .

® No password for the default user ID “Admin” (read only),

you can set up the password later.

Access type

Administrator: You can set up all parameters and have permission

to edit the password and permission.

Write/Read: You can open the data monitor pages and the

diagnostic page. You can also edit the parameters.

Read: You can open the data monitor pages and the diagnostic

page. But you cannot edit parameters.

® Default user is “Administrator”.

“Delete”

Use “Delete” to clear the user ID and password.

“Apply”

Use “Apply” to save the settings.

° Operation Steps:

a. After log in, double-click Account management to open the setting page.

Logout

E|'_H Information

----- [=] Device information
= .

Liata Waonitor

P Data moniter setup
E|'_H Diagnostic

=~ Save Config

----- L] Save configuration
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b. Set up the User ID, the password and the access type. After editing, click “Apply” to save the setting or click
“Delete” to clear the account.

c. Double-click Save configuration to open the setting page.

Password

Logout

= Information
[ Device information
= |Network configuration
[ Account management
=+~ Data Monitor

- [] Data monitor setup
=~ Diagnostic

- [[]Hardware status

) Save configuration

d. Click “Save” to save and download the settings to the device.
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e. After download is complete, it will be prompted with a Download successful message.

9.10.4 Data Monitoring

You can set monitoring related configurations here.

9.10.4.1 Data Monitoring Setup Page

You can set up 4 pages of monitoring data and up to 30 items can be monitored on each page.
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Item Description
To name your table, you can use up to 16 characters from the

Table name following characters, A through Z (case-insensitive ), O through 9,
_ (underscore) , (comma) and . (dot) .

Device quantity Device quantity to be monitored; default: read only

Default update cycle Set up the updated cycle time; default: 5 seconds; unit: second

«Egit® Click “Edit” to edit the table and the table name column turns

i
green. The table contents appear below.

“Delete” Click “Delete” to delete the table and its contents.

. Devices to be monitored; you can enter the following devices to

Device
monitor xX, yY, mM, sSmM, sSrR, dD, sS, tT, cC, hHcC and eE.
Positional numeral system to be shown on the monitoring page;
available formats are Signed decimal, Unsigned decimal,

Radix Hexadecimal, Octal, Binary, 32bit Signed decimal, 32bit Unsigned
decimal, 32bit Hexadecimal, 32bit Octal, 32bit Binary, 32bit Float
and 64bit Double

Read only Set up the monitored devices to read only or not.

Description Add a description here for the table.

“Apply” Click “Apply” to save the settings.

o Operation Steps:

a. After log in, double-click Data monitor setup to open the setting page.
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b. Use “Edit” to edit the table name, device quantity, and update cycle time.

c. The corresponding table contents appear below.

ITabIe name: Elevator I
No. Device Radix Read only Description
1 Signed Decima v
2 Signed Decima v
3 Signed Decima v
4 Signed Decima v
5 Signed Decima v

d. Edit the devices to be monitored, radix to be shown, read only or not and the description. After editing, click

“Apply” to save the setting.
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e. Double-click Save configuration to open the setting page.

Logout

EIE' Information

¢ [ Device information
=~ |Network configuration

¢ [ Account management
=~ Data Monitor

¢ -5 Data monitor setup

[£] Table_1

. [ Table_3

= Diagnostic

E|P|:‘ Save Config
{151 Save configuration |

f.  Click “Save” to save and download the settings to the device.

Once the download is complete, you can see the newly added table to be monitored under the Data Monitor

node.

Admin

'

Logout

EH ) Information
¢ [Z]Device information
i~ INetwork configuration
[] Account management
£l 1Data Monitor

|1 Data moniter setup
[ Table_1
-[£ Table_3
Y- Elevator
=4 Diagnostic

EIPE_' Save Config
- [=] Save configuration

Note: The data monitor table must be downloaded to the device otherwise even if the data monitor table is

created, it cannot be monitored.
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9.10.4.2 Data Monitor Table Pages

The setting results are shown as below.

Item

Description

Table name

Name of the table; read only

Monitor status

Status of the monitoring; read only

Yellow light: reading, Green light: reading complete, Red light:
reading error

Update cycle

Update cycle time; default is what you set up in data monitor
setup page; unit: second

Minus; click once to decrease 1; the minimum value is 1

“ pu

Plus; click once to increase 1; the maximum value is 60

Floating format setting

Floating point setting; round down; default: round the number
down to three decimal places

Device Devices to be monitored; read only
Positional numeral system to be shown on the monitoring page;
available formats are Signed decimal, Unsigned decimal,
Radix Hexadecimal, Octal, Binary, 32bit Signed decimal, 32bit
Unsigned decimal, 32bit Hexadecimal, 32bit Octal, 32bit Binary,
32bit Float and 64bit Double
Description Add a description here for the table; read only
Status of bit; read only
Status
Green LED: ON; No LED: OFF
Values in devices to be monitored; read only
Signed decimal: K+ Number
Unsigned decimal: K+ Number
Value

Hexadecimal: H + hex Number
Octal: O + octal Number
Binary: B + binary Number
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Item Description

32bit Signed decimal: K+ Number
32bit Unsigned decimal: K+ Number
32bit Hexadecimal: H + hex Number
32bit Octal: O + octal Number

32bit Binary: B + binary Number
32bit Float: float Number

64bit Double: float Number

“ON": the status of Bit is ON.
“OFF": the status of Bit is OFF.

® If the authority level for the logged in user is READ, this
column is read only.

“ Onn / ” Offn

Change the value for the device to be monitored

® Type the value in and click “SET” and the changed value
Set Value appears in the VALUE column as the image shown above.

® If the authority level for the logged in user is READ, this
column is read only.

Click “Set” to confirm the changed value.

“Set” ® If the authority level for the logged in user is READ, this
column is read only.

9.10.5 Diagnostic

You can set diagnostic related configurations here.

9.10.5.1 Hardware Status Page

This page displays information on hardware status, CPU module, power module, and function cards. You can set CPU to

run or stop. Here also shows the CPU running status and error codes.

° For AS300, the hardware status page looks like below.
Hardware status

Refresh cycle (1s ~ 60s): | - |10 || +

Extension No. Module name Status Error code

Power module
AS332T-A

CPU module Run T Ston Run Emr:
—-Function card 1
—-Function card 2
Module 1 AS00SCM-A
—-Function card 1 AS-F485
—-Function card 2 AS-F485
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° For AS200, the hardware status page looks like below.

Hardware status

Refresh cycle (1s ~ 60s): | - | 10 | -+

L1

Extension No. Module name Status Error code
Power module
CPU module Run |[Stop Run: Emr
Module 1 AS00SCM-A
—Function card 1
—-Function card 2
Item Description

Refresh cycle

Refresh cycle time; default: 10; unit: second

Minus; click once to decrease 1; the minimum value is 1

“ pu

Plus; click once to increase 1; the maximum value is 60

Power module name

Name of the power module; read only

CPU module name

Name of the CPU module; read only

CPU Run LED

LED of CPU running status; read only
Green light: RUN

LED Not Lit: STOP

CPU Error LED

LED of CPU Error; read only

CPU Error code

Error codes of CPU module; read only

“ Runn / “ Stopn

Click “RUN” to set the running status to RUN
Click “Stop” to set the running status to STOP

® [f the authority level for the logged in user is WRITE/READ

or READ, this column is read only.

Function card name

Name of the function card; read only

® For communication module, two extra rows for the names

of the communication function cards are shown here

Module name

Name of the module; read only

When the actual placement is not the same as the arrangement

in HWCONFIG, the background of this column will be in red.

Module Error LED

LED of module error; read only

Module Error code

Error codes of module; read only
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9.10.6 Configurations
9.10.6.1 Save Configuration Page

You can save the configurations and download the parameters to your device here.

Save configuration

Save configuration

Saving all applied changes will cause all changes to configuration panels that were applied, but not saved, to be saved, thus retaining their new values.

PLC Status Run: Run || Stop

w
2
@

Item Description

“Save” BRI aREE228 M EERE

LED of PLC running status; read only

PLC Status Green light: RUN

LED Not Lit: STOP

Click “RUN" to set the running status to RUN
“Run” / “Stop”

Click “Stop” to set the running status to STOP

Note: The data monitor table must be downloaded to the device. If not, once you log out, close the page or restart the

PLC, all the temporary saved parameters will be cleared.

9.11 Delta EIP Product Application (with OMRON Products)
9.11.1 Architecture

Delta EtherNet/IP Scanner connects to OMRON EtherNet/IP Adapter through Ethernet communication. PC connects to
Delta EtherNet/IP Scanner through Ethernet communication or USB connection.

Software versions for AS300 and OMRON NJ501-1300:

® AS300 CPU

ISPSoft: V3.02.25

COMMGR: V1.06.05

HWCONFIG: V3.02.20

EIP Builder: V1.03.01

® OMRON NJ501-1300:

Sysmac Studio : V1.15
Network Configurator : V3.59c
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PC
ISPSoft
EIP Builder

T

1

| W (

A .| Delta EIP Scanner OMRON EIP Adapter

Ethernet / USB AS300 J Ethernet L NJ501-1300

(] Operation Steps:
I ‘ Data Mappin | ‘ ’ ‘ i
Network Set UH Ethseé{\ljg/lp Set L?pp ’ Download Cogtnaeiﬁtslon

9.11.2 TAG Connection

EtherNet/IP can use TAGs to exchange data. Here AS300 CPU acts as Master and OMRON NJ501-1300 as a Producer

TAG to establish an EtherNet/IP communication.

® Create Produced TAG
1. Start the OMRON software Sysmac Studio. Select Connect to Device. Configure the parameters and then click

Connect.
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2. After the connection is successfully established, click Tools on the menu bar. And then select EtherNet/IP
Connection Settings to access the EtherNet/IP connection settings.

3. Right-click the cell of the Node Address you'd like to edit its EtherNet/IP settings and then select Edit to open
the EtherNet/IP communication setting window.

4. Double-click Global Variables under Programming - Data in the Multiview Explorer. Right-click in the global

variable table and select Create New from the menu.

5. Right-click in the global variable table and select Create New from the menu.

*Click Controller on the menu bar and change the Project to Disconnected before creating a new global

6. Set the Network Publish to Output.
And then with this attribute, you can access a variable from external devices through CIP communications or a
tag data link. For tag data links, this can be a variable for data output (from the local Controller to another
Controller).

7. Select the tab of Built-in EtherNet/IP Connection Settings and select the Tag Set from the left. Right-click in
the editing area and select Create New Tag Set from the menu and then name the tag set as ToAS .
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8. Right-click on the created Tag Set and select Create New Tag from the menu.

9. The tag is added in the created tag set.
[ ] Bit-in Etheriiet..ection ... |

P Device Information

nrH ¥ Tag Sets

Aax: 1 f 32 Tags/Max 1 / 256 Registration All

Tag Set Name Bit Selection Size (Byte) Instance ID Controller Status |Output at Fatal Enl

10. Click Controller and then Synchronize...from the menu bar to synchronize the setting with OMRON Scanner.
| @

veata Name cormuter: Up - - yete | Controller: Da Compare

lues of variables it

n is changed.

Transfer To Controller Transfer From Controller
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11. Create Tag sets in Network Configurator. Open Network Configurator and select Option-> Select Interface->
Ethernet I/F.

Tools | Option Help
4|

| & ‘ | Edit Configuration File

CJ2 USB/Serial Port

CS/CI1 Serial Port -> EIP Unit I/F
v
/ Setup Monitor Refresh Timer Etheret -> C$/CJ1 ETM-EIP Unit I/F

MNI/NX Series Ethernet Direct /F
Install Interface Maodule PIPLTS EeTe LE eit

Install Plugin Module

Update Parameter automatically, when Configuration was changed

Update Device Status automatically, when it was connected on Metwork

12. Select Network -> Connect
£} Untitled - Network Configurator
File Edit View | Metwork Device EDSFile Tools

Option Help
A= A= I comnec.__ Culew  [gIEN
B Disconnect... Ctrl+0 —
IR oy
a7 Change Connect Netwark. . ———

|

13. Select Interface and click OK to confirm the setting.

Select Interface

Helect Interface Card.

Broadeom Netlink (T} Gigabit Ethernet [192.168 250 .88]
Broadcom Netlink (Th) (rigabit Ethemet [192.1685
Intel(R) Diual Band Wireless-M 7260 [10.110.114 73]
InteliR) PROAOOD 3T Deskiop Adapter [192.168.1 99]

Vidweare Virtual Ethernet &dapter for Vidnet] [192.165.174.1]

S

Select Connect Metwork Port X
Select a network port that won would like to connect.
Broowse
= TCR:2

@ 192.168.250.1 NI501-1200
L 192.168.250.20 AS324MT

Device Information
Vendox ID Product Name :

Device Type Rewizon :
| ok || Came |

9-111



AS Series Operation Manual

14. The blue light indicates the connection is working normally.

B Untitled - Network Configurator

File Edit WView Metwork Device EDSFile Tools Option Help
| DSHE| 28 || iad e < S| LR X|[R6:
| Xplad eV B & 2 &| & R %| 86

4

.@ Wetwork Configurator
-8 EtherMet/TP Hardware

(@) Vendor
=L@ Device Tvpe

@ EtherMet/IP_1

15. Drag OMRON NJ501-1300 from the EtherNet/IP Hardware section to the network view.

@ Wetwork Configurator
=-&8) EtherNet/TP Hardware
=-L8 Tendar
#-L@), Delta Electromies, Ine.
==, OMRON Corporation
) gy Communications Adapter
.....

%| CIIW-EIP21
CIW-ETP214{CI2)
CNW-EIP21(NT
CIZB-EIF21
CI2M-EIP21
CEIW-EIF21
Nnaol

A

X @ Etherhet/IP_1

1921682501
M.J501-1300

o

Usmge of Device Bandwidth

16. Right-click OMRON NJ501-130 (the scanner) and select Parameter -> Edit from the menu.

| Ded 28 & ailew ¢ S saax|P

| %5 &

| Ky ad ey Bl & 2 &

IR

@ Wetwork Configurator A
=-£%] EtherMet/TP Hard ware
EI-- Vendor
G-[m, Delts Electoomics, Tne.
=-(@ OMRON Corporation
EI ﬁ Cu:ummumcaﬁuns Adapter

¥l [5] CTLW-EIP21
-[F]| CIW-EIP21{CI2)
- [3] CTIW-EIP21(NT)
m =1 rmEoRTE

> | @ EtherNet/IP_1

24 Open...
#a Save as...
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17. Click Edit Tags on the Tag Sets tab and click New on the Out-Produce tab to create a new tag with the same
name and length as the one from the “output” tag set in Sysmac .

18. The new tag is created as shown below.
Edit Device Parameters : 192.168.250.1 MJ501-1300 hod

Connections Tag Sets

In - Consume Chut - Produce

Mame Fault... Size Bit D
| ToAS 200Byte Auto
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19. After setting, click Network -> Download.

20. After downloading, the Network Configurator dialog box is displayed.

ER Untitled - Network Configurator

EI Vendor | ¢ Upload

Verify Structure

File Edit Wiew | Metwork Device EDSFile Tools Option Help
J M= n| ] B Connect... Ctrl-+\V
R —| 8 Disconnect... Ctrl+Q
|Xeldd
iy Change Connect Network_ .
ER Network Confizl  Wireless Network 4
=-£8) EtherNet/T]
Ctrl+U

Ctrl+E

T I ET

8 o T TN
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° Create a Consumed TAG
1. Start ISPSoft and click Tools -> Communication Settings and select a driver with Ethernet communication.
% Before setting the communication, make sure COMMGR is working normally and save the driver settings.

2. Click Global Symbols to expand the tree node and see the options. Double-click EtherNet/IP Table (Consumed
Tag) from the Project section on the left. Right-click the blank area and select Add a Symbol.
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3. Set the data type to ARRAY[200] OF WORD and then click OK to confirm the setting.
% Data size should be the same as the Produced Tag data size

A symbol is added, as the image shown below.

4, Go to PLC-> Transfer -> Download to download the parameters to the Scanner.
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5. Double-click HWCONFIG from the Project section on the left to start HWCONFIG.

6. Right-click the PLC and select Communication Software - > EIP Builder to start EIP Builder.

7. Click Tool-> DDF(EDS) Manager to import the EDS File.
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8. Drag and drop the device from the Product List on the right to add have it added in the Network View.
% You can select the device and click the Information tab to edit its IP address.

Network 0 —

9. Drag and drop the red spare to have the Ethernet communication port connected to the network.
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10. Right-click the CPU’s communication port and select Data Mapping to create a data mapping table.

Delete the Station

Data Mapping

11. Make sure the data below CPU Address/TAG and Adapter/TAG is correct.
% CPU Address/TAG: Consumed TAG
Adapter /TAG: Produced TAG, created by Producer
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12. Click Operate-> Downloader to download the parameters to the Scanner.

) Connection Check

1. Click to have the project in On-line Mode and see if the network lines are solid ones.
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2. The solid network lines indicate the data mapping is being monitored successfully.

° Data Mapping

1. Start Sysmac Studio and make sure the project is in Online Mode. Go to View -> Watch Tab Page on the menu
bar. Click Watch Tab Page to monitor.

2. Select Watch (Table) 1 and input a name for the tag.
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3. Modify the values according to the display format. Make sure the value in the Online Value column is the same as
the value in the Modify column.

4.  Start ISPSoft, and select Device Monitor Table -> New to create a new device monitor table.

--------- & Used Device Report
......... & HWCONFIG
......... B CARD Uiility
--------- T ASILT (Untitled()

......... G DUT

5. Double click the blank area in the Monitor Table and then select the Identifier tab. Set up the Object (variable
name) and the Name (source) and then click OK to confirm the setting.
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6.  After setting up, switch to Online Mode.

7. Make sure the values in Consumed Tag are the same as the ones in Produced Tag.

9.11.3 IO Connection

° Set up an IO Connection from a slave station
1. Create two variables and set the rule of one variable as input and set the rule of the other variable as output. Set

the data type and length as Array[0..99] of word.
ol Varissies > |

Data Type W Initial Value | | Retain | Constant | Network Publish | Comment |
FromAS_ 10 ARRAY[0..29] OF WORD O [0 [nput
ToAS 10 ARRAY[0..99] OF WORD O | {Cutput

2. Go to Tools -> Export Global Variables -> Network Configurator on the menu bar.

3. Start Network Configurator and then add and edit NJ501-1300 from the Ethernet Hardware List on the left.
Select Parameter -> Edit and click To/From File -> Export to File on lower right corner of the Tag Sets page.

Edit Device Parameters - 192.168.250.1 NJ501-1300 X
Connections  Tag Sets
In - Consume  Out - Produce
Name Fault. Size  Bit D
New Edit Delete Expand All | | Collapse Al
Edit Tags. Delete all of unused Tag Sets | Usage Count: 0/32 Import To/From File
Exportto File...
i+ Import from File...
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4.  After the file is imported, make sure the input and output variables are imported in In-Consume and Out-Produce
sections.
Connections Tag Sets

In - Consume  Qut - Produce

Marme Fault... Size Bit [0}
FramAS_|O 200Byte Auto
Connections Tag Sets
In - Consume Cut - Produce
Fault... Size Bit n}

Mame

5. Click the variable in In-Consume section and select Edit.
Connections Tag Sets

In - Consume  Qut - Produce

Mame Fault... Size Bit 0]
FromAS_|O 200Byte 100
Edit Tag Set *
Fromis 10 Controller 3tatuz
Nee ;| Fromie. @ NotInclde (O Include
Tag List Candidate Tag List
Warmne Fanlt ... Rize Bit JUET Fault .. Rize Eit
200E...
Ers
B
hid
.
Advanced Cancel

MNew... Delete Expand All Collapse All

Edit Tags... Delete all of unused Tag Sets | Usage Count: 2/32 Import To/From File
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6.

Click Advanced button in the Edit Tag Set window and set the Instance ID to Manual and then input the Instance
ID you'd like to use for IDs in In-Consume section.

Controller Statoz
(@ NotInclude () Include

Wame : | Fromad_ 10

Tag List Candidate Tag List
ame Fanlt ... Size Bit Wame Fanlt ... Size Bit
%=1 From. .. 200E...

==

Advanced Setting >

Instance ID

() Auto
Fange : 100-199

Coner
ok | [ Come

Use the same method to set the Instance ID manually for IDs in In-Consume section as you have set for IDs in
Out-Produce section.
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8. When the settings for Instance ID are done, click OK to confirm the settings on Edit Device Parameter.

9. Click Network -> Download to download the parameters to the slaves.

£} Untitled - Network Configurator

File Edit View MNetwork Device EDSFile Tools Option Help
J D) wp i | &|Connect.. Col+Wh g X |
o _ Disconnect... Ctrl+Q
IR K Al %
Change Connect Network...
@ Wetwork Configt  \Wireless Netwark k
- E8) EtherNet/I]
EI Vendor | Upload Ctrl+U
" R Download Ctrl+
(@ OME
EI DeviceT: Verify Structure Ctrl+E
ﬁ oy |/C Connection L3 —
ﬁ Crene
[ty Prog Update Maintenance Information

] Set up an IO Connection from a Master station
1. Start EIP Builder and drag and drop a General Device into the Network View area and set up network connection.

2. Click slave icon and set up its IP address and then configure the parameters in the EIP Parameter tab.
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» W

Set up the slave IO connection:
Master Output Instance ID = Slave Input (In-Consume) Instance ID

Master Input Instance ID = Slave Output (Out-Produce ) Instance ID

% Refer to slave’s operation manual for more information on Instance IDs.

Set up the connection and start data mapping.
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5. Download the EIP parameters to the master.

) Connection status

1.

After the parameters are downloaded, change the project to Online Mode. And make sure the monitoring on
the network and the data mapping table is normal.
Network View
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Data mapping status

° Data Mapping
1. Start ISPSoft and create a new Monitor Table. Add devices that correspond to the master in the table.

2. Change the project to Online Mode and start to monitor the data mapping.
Monitoring from the master
El Monitor Table o Tm | =]
Object Identifiers Device Name Status Data Type Value (16bits) | Value (32bits) Float Radix Comment...
| | |po | | | ss85 | 00005555 | 0.000 |Hexadecimal | |
by \ D500 | | [ 7cB6 | 00007CB6 | 0.000 |Hexadecimal _ + | ]
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Monitor from the slave

Master_Address

Slave_Address

o ToAS_IO
( Instance ID=110)
FromAS_10O
D500

( Instance ID=100 )
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10.1 Introduction to CANopen

1.

Because of its simple wiring, immediate and stable communication, strong debugging ability, and low
cost, the CANopen network is widely used in fields such as industrial automation, the automotive industry,
the medical equipment industry, and the building trades.

The AS300 Series PLC is compatible with CANopen when using the AS-FCOPM function card for the
CAN port, and can work in master mode or slave mode. The CAN port conforms to the basic
communication protocol CANopen DS301. It supports master and slave modes.

AS200 Series PLC is built with CAN communication port. The CAN port conforms to the basic
communication protocol CANopen DS301. It supports master and slave modes.

This chapter explains the functions of CANopen. In master mode, CANopen can support up to 64 slaves.

CANopen Builder is the CANopen network configuration software for the AS Series. You set the
CANopen station address and the communication rate with this software. ISPSoft is the programming
software for the AS Series.

This chapter mainly focuses on the CANopen functions. Refer to Section 10.3 for more information.

10.1.1 CANopen Function Descriptions

The CAN port has the following functions when acting as a master.

It supports the standard CANopen protocol DS301 V4.02.
It supports the NMT (network management object) service.
[ It supports NMT state control.
Use NMT state control to control the state of a slave in the CANopen network.
[ It supports NMT error control.

Use NMT error control detect the disconnection of a slave. The NMT error control is classified into
two types; Heartbeat and Node Guarding. The AS Series PLC does not support Node Guarding.

It supports the PDO (process data object) service.
) Use PDO messaging to transmit immediate input and output data.
) It supports up to 256 RxPDO and 1894 bytes.
) It supports up to 256 TxPDO and 1894 bytes.
) It supports synchronous and asynchronous modes for the PDO transmission type.
It supports the SDO (Service Data Object) service.
° Use SDO to read, write, or configure the slave parameters.
) It supports standard SDO transmission mode.
) It supports automatic SDO functions. You can write up to 20 pieces of data to a slave.

) It supports using the SDO service in a PLC ladder diagram to read the data from a slave or write
the data to a slave.
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5. It supports the reading emergencies from a slave service.
[ Use this service to read an error or an alarm from a slave.
° You can store up to 5 emergencies in a slave.
[ You can read emergencies from a slave through a PLC ladder diagram.
6. It supports the SYNC object (synchronous object) service.
7. Several devices can operate synchronously through the synchronous object service.
8. The supported CANopen communication rates are: 20K, 50K, 125K, 250K, 500K, and 1Mbps.

The supported mapping data types are:

Storage Data type
8-bit SINT USINT BYTE
16-bit INT UINT WORD
32-bit DINT UDINT REAL DWORD
64-bit LINT ULINT LREAL LWORD

The CAN port has the following functions when acting as a slave.
® |t supports the standard CANopen protocol DS301 V4.02.
® |t supports the NMT (network management object) service.
® |t supports the NMT state control.
The state of the AS series in the CANopen network is controlled by a master.
® |t supports the NMT error control.
The AS Series supports Heartbeat but not Node Guarding.
® |t supports the PDO (process data object) service.
® The PDO message transmits the immediate input data and output data.
® |t supports up to 8 TXPDO and 8 RxPDO.
® The PDO transmission type: synchronous mode and asynchronous mode
® |t supports the emergency service.

If an error or an alarm occurs in the AS series, the master is notified through the emergency service.

10.1.2 The Input/Output Mapping Areas

The following table lists the CANopen DS301 specifications for the AS series PLC.

Type Item Description
Maximum slave nodes Up to 64 nodes
Master Maximum transfer size of

a PDO (Read + Write) Up to 2000 Bytes (including some system configurations)

Maximum transfer size of | Up to 8 PDOs; each PDO with up to 8 bytes can be transferred

Slave a PDO (Read + Write) atatime
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The output mapping areas are D25000-D25999, and the input mapping areas are D24000-D24999, as the
following table shows.

Device in the PLC Mapping area Mapping length
D25000-D25031 SDO request informgtion, NMT service information, and 64 bytes
Emergency request information
D24000-D24031 | SDO reply information, and Emergency reply information 64 bytes
D25032-D25978 | RxPDO mapping area 1894 bytes
D24032-D24978 | TxPDO mapping area 1894 bytes

If an AS Series functions as a slave, the output mapping areas are D25032—-25063, and the input mapping
areas are D24032-24063 as the following table shows.

Device in the PLC Mapping area Mapping length
D24032~24063 | RxPDO mapping area 64 bytes
D25032~25063 | TxPDO mapping area 64 bytes

10.2 Installation and Network Topology

This section introduces the physical dimensions of AS-FCOPM function card, the HWCONFIG settings of the
AS Series, the CAN interface, the CANopen network framework, and the maximum communication distance.

10.2.1 The Dimensions of AS-FCOPM

= =
i [

=) =
59.3 |
61.3
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10.2.2 AS-FCOPM on AS300 PLC

Note: the AS-FCOPM card can only be installed in the Card 2 slot in the AS series

10.2.3 Configure the AS-FCOPM with HWCONFIG

Before using the AS-FCOPM card in an AS300 Series PLC, use HWCONFIG in ISPSoft to configure the
AS-FCOPM card. If you are using an AS200 Series PLC, the first two steps can be ignored.

1. You can only install the AS-FCOPM in the card 2 slot as marked in red below. Double click the function
card 2 slot to go to the Device Setting dialog box.

2. Select Manual for Card 2 Detect mode and select AS-FCOPM Card for Manual Select Card.
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3. Select the working mode, node ID and the bit rate for AS-FCOPM.

* Working mode: CANopen DS301

*Node ID: 1

* Bit rate: 125k bps (the default, or you can select your own bit rate)

4. When finished, click the Download button on the toolbar to download the settings to the PLC.

10.2.4 The CAN Interface and Network Topology

10.2.4.1 Definitions of the CAN Signal and Data Types

The CAN signal is a differential signal. The voltage of the signal is the voltage difference between CAN+ and
CAN-. The CAN+ and CAN- voltages take SG as a reference point. The CAN network can be in one of two
states. One state is a dominant level, and is indicated by the logical “0". The other state is a recessive level,
and is indicated by the logical “1”. The CAN signal level shows below.

25V

1.5V

oV —

CAN+=2.5V
CAN-=2.5V

Recessive

CAN+=3.5V

CAN-=1.8Y i
Dominant
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The following picture shows the data frame format. The CAN nodes transmit the CAN messages to the
network from left to right.

Flr|r OLC Deta i 15

nodes O~8 CRO

O m

=
] 11 idertifiers
F

a -
=
-

10.2.4.2 The CAN Network Endpoint and the Topology Structure
In order to make the CAN communication more stable, the two endpoints of the CAN network are connected
to 120 ohm terminal resistors. The topology structure of the CAN network appears below.

CaMN node 1 AN node 2

CAMN node 3

10.2.4.3 The Topology Structure of the CANopen Network

1) Use standard Delta cables when wiring the CANopen network. These cables are the thick cable
UC-DNO01Z-01A, the thin cable UC-DN01Z-02A, and the thin cable UC-DN01Z-02A. Separate the
communication cables from any power cables to avoid interference.

2) Connect the CAN+ (white) and CAN- (blue), which are at the endpoints of the network, to 120 ohm
resistors. The AS-FCOPM card is equipped with a 120 ohm resistor switch; you can enable the resistor
with the switch. Purchase the standard Delta terminal resistor for use with the other devices and the RJ45
connecter.
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3) Note the limitation on the length of the CANopen network. The transmission distance of the CANopen
network depends on the transmission rate of the CANopen network. The following table shows the
relation between the transmission rate and the maximum communication distance.

Transmission rate 20K 50K 125K 250K 500K M
(bit/seconds)

Maximum

communication distance 2500 1000 500 250 100 25
(meters)

4) The list below shows the Delta network products for the CANopen network.

Product Model Function
AS332T-A
AS332P-A The AS300 series PLC can function as the
AS324MT-A CANopen master or slave when you install an

AS-FCOPM function card. The AS-FCOPM is

AS320T-B equipped with a 120 ohm resistor controlled
AS320P-B by a switch.
AS300N-A
AS228T-A AS200 Series PLC is built with CAN
AS228P-A communication port. The CAN port conforms
) to the basic communication protocol
22;?2?;;\ CANopen DS301. It supports master and
) slave modes. The CAN communication
AS218PX-A terminal is equipped with a 120 Q resistor.
AS218RX-A You can use a short circuit to use this resistor.
DVP32ES200RC The E?VP-ESZ-C series PL.C has a built-in
CAN interface. It can function as the
DVP32ES200TC CANopen master or slave.
DVPCOPM-SL is a module connected to the
left side of an S series PLC. It can function as
DVPCOPM-SL the CANopen master or slave. The PLCs that

you can connect to the DVPCOPM-SL are the
DVP-28SV, DVP-28SV2, DVP-SX2,
DVP-SA2, and DVP-EH2-L.

The IFD9503 gateway converts CANopen to
Modbus, and connects a device (with an
IFD9503 RS-232 or RS-485 interface) that conforms to
the standard Modbus protocol to a CANopen
network. You can connect up to 15 devices.

10-8



Chapter

10 CANopen Function and Operation

Product Model Function
The CANopen slave module is connected to
DVPCP02-H2 the right side of an EH2 series PLC. It can

connect the EH2 series PLC to a CANopen
network.

IFD6503

This analyzes CANopen network data, and
has ports both ends for a CAN interface and a
USB interface. Use it to monitor CAN network
data, or allow CAN nodes to transmit the
data. The product is used with the Netview
Builder software.

ASD-A2-xxxx-M
servo driver

This servo driver has a built-in CANopen
interface. It controls positioning, speed, and
torque.

VFD-C2000/CP2000/C200
series AC motor drives

This AC motor drive has a built-in CANopen
function, and controls positioning, speed,
and torque. For the C2000/CP2000 series AC
motor drives, you must purchase a
CMC-COPOL1 to provide the CAN interface.
Only the C200 series AC motor drive has the
built-in CANopen interface.

VFD-EC series AC motor
drive

The EC series AC motor drive has a built-in
CANopen interface. It controls speed and
torque.

TAP-CNO1

This CANopen network topology distribution
box has a 120 ohm resistor enabled with a
switch.
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Product Model Function
This CANopen network topology distribution
TAP-CNO2 box has a 120 ohm resistor enabled with a
switch.
This CANopen network topology distribution
TAP-CNO3 box has a 120 ohm resistor enabled with

switch.

UC-CMCO003-01A
UC-CMCO005-01A
UC-CMCO010-01A
UC-CMCO015-01A
UC-CMCO020-01A
UC-CMCO030-01A
UC-CMCO050-01A
UC-CMC100-01A
UC-CMC200-01A

These CANopen sub cables have RJ45
connectors at both ends.
UC-CMCO003-01A: 0.3 meters
UC-CMCO005-01A: 0.5 meters
UC-CMCO010-01A: 1 meter
UC-CMCO015-01A: 1.5 meters
UC-CMCO020-01A: 2 meters
UC-CMCO030-01A: 3 meters
UC-CMCO050-01A: 5 meters
UC-CMC100-01A: 10 meters
UC-CMC200-01A: 20 meters

UC-DNO01Z-01A
UC-DNO01Z-02A

CANopen network cable
UC-DNO01Z-01A: CANopen main cable
UC-DNO01Z-02A: CANopen sub cable

TAP-TRO1

This 120 ohm resistor has an RJ45
connector.

10.3 The CANopen Protocol

10.3.1 Introduction to the CANopen Protocol

The CAN (controller area network) fieldbus only defines the physical layer and the data link layer of a network.
See the 1S011898 standard for information. The CAN fieldbus does not define the application layer. In
practice, the hardware contains the physical layer and the data link layer. The CAN fieldbus itself is not

complete, and needs a superior protocol to define the use of 11/29-bit identifier and 8-byte data.

The CANopen protocol is the superior protocol based on the CAN fieldbus. It is one of the protocols defined
and maintained by CiA (CAN-in-Automation) and was developed on the basis of the CAL (CAN application

layer) protocol, using a subset of the CAL communication and service protocols.

The CANopen protocol contains the application layer and the communication profile (CiA DS301). It also
contains a framework for programmable devices (CiA 302), recommendations for cables and connectors (CiA
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303-1), and Sl units and prefix representations (CiA 303-2).

In the OSI model, the relation between the CAN standard and the CANopen protocol is described in the
following diagram.

Device profile CiA Device profile CiA  Device profile CiA

OSI seventh layer

o Communication profile CiA DS-301
Application layer

OSI second layer CAN controller CAN 2.0A

Data link layer

A\
OsSil first layer ISO 11898
Physical layer | I

1. The object dictionary

CANopen uses an object-based method to define a standard device. Every device is represented by a
set of objects and can be visited by the network. The diagram below illustrates the CANopen device
model. The object dictionary is the interface between the communication program and the superior
application program.

The core concept of CANopen is the device object dictionary (OD). It is an orderly set of objects. Every
object has a 16-bit index for addressing and also defines an 8-bit subindex. Every node in the CANopen
network has an object dictionary that includes the parameters that describe the device and the network
behavior. The object dictionary of a node is also described in the electronic data sheet (EDS) for the

device.
Communication Application
object object
= |g—tp Communication Object E
= ohject dictionary 2
ki
o
- Communication . N Pp.plicati-:-n -+
object Il L object
L Communication specifications | Device specifications N
" Ll ol
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10.3.2 The CANopen Communication Object
The CANopen communication protocol contains the following communication objects.
1. PDO (process data object)

® The PDO provides the direct channel for the device application object, and transmits the real-time data.
It has high priority. Every byte in the PDO CAN message data list transmits data, and the message
usage rate is high.

® There are two kinds of uses for PDOs; data transmission and data reception. They are distinguished
by Transmit-PDOs (TxPDOs) and Receive-PDOs (RxPDOs). Devices supporting TxPDOs are called
PDO producers, and devices that receive PDOs are called PDO consumers.

® The PDO is described by the “producer/consumer mode”. The data transmits from one producer to one
or many consumers. The data that can be transmitted is limited to between 1-byte and 8-byte data.
After the producer transmits the data, the consumer does not need to reply to the data. Every node in
the network detects the transmitted data and decides whether to process the received data .

® Every PDO is described by two objects in the object dictionary: the PDO communication parameters
and the PDO mapping parameters

PDO communication parameters: the COB-ID used by PDO, the transmission type, the prohibition
time, and the counter cycle

PDO mapping parameters: the object list in an object dictionary. These objects are mapped into the
PDO, including the data length (in bits). To explain the contents of the
PDO, the producer and the consumer both have to understand the

mapping.
The PDO transmission modes: synchronous and asynchronous
Synchronous mode: synchronous periodic and synchronous non-periodic

Asynchronous: The producer transmits the PDO when the data changes, or after a trigger.

The following table lists supported transmission modes.

Type PDO transmission
Periodic Non-periodic | Synchronous | Asynchronous RTR
0 X X
1-240 X X
254 X
255 X

Mode 0: The PDO information is transmitted only when the PDO data changes and the synchronous
signal is received.

Modes 1-240: One piece of PDO information is transmitted every 1-240 synchronous signals.

Mode 254: The trigger is defined the manufacturer. The definition in the PLC is the same as mode

Mode 255: The PDO is transmitted when the data changes, or it is transmitted after a trigger.

All the data in the PDO has to be mapped from the object dictionary. The following diagram shows an
example of PDO mapping.
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Object dictionary

xxxxh

xxh Application object A

yyyyh

yyh Application object B

PDO_1

Application object B_ Application object A

PDO_1 mapping

0 3

1 yyyyh yyh | 8

3 xxxxh xxh | 8

The following table shows the data format for RxPDO and TxPDO.

COB-ID

Byte O

Byte 1 Byte 2

Byte 3

Byte 4 Byte 5 Byte 6 Byte 7

Object
identifier

Data

2. SDO (service data object)

The SDO builds the client/server relation between two CANopen devices. The client device can read

the data from the object dictionary on the server device and write the data into the object dictionary on
the server device. The SDO visit mode is “client/server” mode. The mode which is visited is the SDO
server. Every CANopen device has at least one service data object that provides the visit channel for
the object dictionary of the device. SDO can read all the objects in the object dictionary, and write all
objects into the object dictionary.

The SDO message contains the index and subindex information used to position the objects in the
object dictionary, and the composite data structure can easily be passed by the SDO visit. After the
SDO client sends the reading/writing request, the SDO server replies. The client and the server can

stop SDO transmission. The requested message and the reply message are separated by different

COB-IDs.

The SDO can transmit the data in any length. If the data length is more than 4 bytes, the data must be
transmitted by segment. The last segment of the data contains an end flag.

The following table shows the structures of the SDO requested message and reply message.

The format of the requested message:

COB-ID | ByteO |Bytel Byte2 Byte3 | Byted Byte5 Byte6 | Byte7
600 (hex) | Requested | Object index Object Requested data
+Node-ID code LSB \ MSB | subindex | pit7-0 \bit15-8 \bit23-16\ bit31-24
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The definition of the requested code in the requested message:

Request code (hex) Description
23 Writing 4-byte data
2B Writing 2-byte data
2F Writing 1-byte data
40 Reading data
80 Stopping the current SDO function

The format of the reply message:

COB-D | ByteO|Bytel | Byte2 | Byte3 | Byte4 | Byte5 Byte6 | Byte7
580 (hex) | Reply Object index Object Reply data
+Node-ID | code | LSB \ MSB | subindex | pit7-0 \bit15-8 \bit23-16\ bit31-24

The definition of the reply code in the reply message:

Reply code (hex) Description
43 Reading 4-byte data
4B Reading 2-byte data
4F Reading 1-byte data
60 Writing 1/2/4-byte data
80 Stopping the current SDO function

3. NMT (network management object)

The CANopen network management conforms to the master/slave mode. Only one NMT master exists in
the CANopen network, and all other nodes are considered to be slaves. NMT includes three services:
module control, error control, and boot-up services.

® Module control services

The master node in the CANopen network controls the slave by sending commands. The slave
receives and executes the command, and does not need to reply. All CANopen nodes have internal
NMT states. The slave node has four states: initialization, pre-operational, operational, and stop
states. The following diagram illustrates the device states.
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Initialization
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Initializing

1

1

1

1

1

' v (15)
1 Reset application
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1

1

1

1

1
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» Reset communication

(N mpeepepeepes e --- (12)

Pre-operational ,\(z\ (20)
(3) (4) 5)

(13) Stopped

' ®) %)

(12) Operational

(1) After power is supplied, the device automatically enters the initialization state.

(2) After the initialization is complete, the device automatically enters the pre-operational state.
(3)(6) The remote node starts.

(4)(7) The device enters the pre-operational state.

(5)(8) The remote node stops.

(9)(10)(11) The application layer resets.

(12)(13)(14) The communication resets.

(15) After the initializing is complete, the device automatically enters the reset application state.

(16) After the reset application state is complete, the device automatically enters the reset
communication state.

The following table shows the relation between the communication object and the state. You can only
execute the communication object service in the correct state. For example, you can only execute
SDO in the operational state and pre-operational states.

Initialization | Pre-operational | Operational Stopped

PDO X

SDO X X

SYNC X X

Time Stamp X X

EMCY X X

Boot-up X

NMT X X X
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The control message format for the node state:

COB-ID Byte 0 Byte 1
- Slave address
0 Command specifier (CS)
(0: Broadcast)

The command specifiers:

Command specifier .
Function
(hex)

01 Start the remote node

02 Stop the remote node

80 Enter the pre-operational state
81 Reset the application layer
82 Reset the communication

® Error control services

The error control service detects the disconnection of a network node. The error control services are
classified into two types: Heartbeat and Node Guarding. The AS Series PLC only supports Heartbeat.
For example, the master can detect the disconnection of the slave only after the slave enables the

Heartbeat service.

The following illustrates the Heartbeat principle. The Heartbeat producer transmits the Heartbeat
message according to the set Heartbeat producing time. One or many Heartbeat consumers detect the
message transmitted by the Heartbeat producer. If the consumer does not receive the message
transmitted by the producer within the timeout period, there is a problem in the CANopen

communication or the producer is disconnected.

Heartbeat producer

Request

Heartbeat
producing
time

Request

Heartbeat consumer

Receiving
Receiving
Receiving
Heartbeat

timeout
period

Heartbeat
timeout
period

Heartbeat event
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® Boot-up services

After the slave completes the initialization and enters the pre-operational state, it transmits the
Boot-up message.

1. Other predefined CANopen communication objects (SYNC and EMCY)
® SYNC Object (Synchronous object)

The synchronous object is the message that the master node periodically broadcasts on the CANopen
network. This object recognizes the network clock signal. Every device decides whether to use the
event use synchronous communication with other network devices depending on its configuration. For
example, when controlling a driving device, the devices do not act immediately after they receive the
command sent by the master. They do act when they receive the synchronous message. This makes
multiple devices act synchronously.

The format of the SYNC message:

COB-ID
80 (hex)

® Emergency object

The emergency object is used by a CANopen device to indicate an internal error. When an emergency
error occurs in the device, the device sends the emergency message (including the emergency error
code), and the device enters an error state. After the error is eliminated, the device sends another
emergency message with emergency error code 0, and the device enters the normal state.

The format of the emergency message:

COB-D | ByteO | Bytel | Byte2 |Byte3 Byte4 Byte5 Byte6 Byte7

Emergency error
code

LSB | wmsB

Error
register

80 (hex)

Factory-defined error code
+Node-ID

Note: The value in the error register is mapped to index 1001 (hex) in the object dictionary. If the value is
0, no error occurred. If the value is 1, a normal error occurred. If the value is H'80, an internal error
occurred in the device.

10.3.3 The Predefined Connection Set

In order to decrease the configuration workload of the network, CANopen defines a default identifier. In the
predefined connection set, the structure of the 11-bit identifier is as follows.

Bit10 Bit0

. L »

Function code Node ID
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The following tables list the objects that are supported and the COB-IDs that are assigned to the objects.

1. The broadcast object in the predefined connection setting

Object Function code COB-ID In.dex. of the
communication parameter
NMT 0000 0 -
SYNC 0001 128 (80h) 1005h, 1006h, 1007h
Time stamp 0010 256 (100h) 1012h, 1013h

2. The corresponding object in the predefined connection set

Object Function code COB-ID commulr?i?:?t(icc))rfl t:aerameter
Emergency 0001 129 (81h)—255 (FFh) 1014h, 1015h
PDO1 (TX) 0011 385 (181h)-511 (1FFh) 1800h
PDO1 (RX) 0100 513 (201h)-639 (27Fh) 1400h
PDO2 (TX) 0101 641 (281h)-767 (2FFh) 1801h
PDO2 (RX) 0110 769 (301h)—-895 (37Fh) 1401h
PDO3 (TX) 0111 879 (381h)-1023 (3FFh) 1802h
PDO3 (RX) 1000 1025 (401h)-1151 (47Fh) 1402h
PDO4 (TX) 1001 1153 (481h)-1279 (4FFh) 1803h
PDO4 (RX) 1010 1281 (501h)-1407 (57Fh) 1403h
SDO (TX) 1011 1409 (581h)-1535 (5FFh) 1200h
SDO (RX) 1100 1537 (601h)-1663 (67Fh) 1200h

NMT Error Control 1110 1793 (701h)-1919 (77Fh) 1016h, 1017h

10.4 Sending SDO, NMT and Reading Emergency Message
through the Ladder Diagram

You can edit the request message mapping area to affect the transmission of SDO, NMT and Emergency

messages. The following table shows the corresponding relations between the request message mapping

area, response message mapping area, and PLC device.

PLC device

Mapping area

Mapping length

D25000-D25031

SDO request message, NMT service message and
Emergency request message

64 bytes

D24000-D24031

SDO response message and Emergency response message

64 bytes

The CANopen master can only send one SDO, NMT, or Emergency request message to the same device at a

time. Clear the request message mapping area to zero when sending SDO, NMT, or Emergency request
message through the WPL program.
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10.4.1 Data Structure of SDO Request Message
Sending SDO through the ladder diagram reads or writes the slave parameter.
1. The data format of the SDO request message:
BLE e -Request message
High byte Low byte

D25000 ReqlD Command (Fixed to 01)

D25001 Message Header| Reserved Size

D25002 Type Node ID

D25003 High byte of main index Low byte of main index

D25004 Reserved Sub-index

D25005 Message Data | Datum 1 Datum 0

D25006 Datum 3 Datum 2

D25007 - D25031 Reserved

® ReqlD: the request ID. Whenever an SDO request message is sent out, the message is given a ReqlD
for CANopen master to identify. When reading/writing another SDO message, the original ID number

must be changed. In other words, reading/writing SDO is triggered by changing of the value of “ReqID".

The ReqID range is between 00—FF (Hex).

® Size: the length of the message data. The counting starts from D6253 with a byte as the unit. When
reading, it is fixed to four and when writing, it is four plus the byte number of data types of index and
subindex and the maximum value is eight. But when writing, if the data type of the index and subindex
is word, the data length is six. The data length is file if the data type is byte.

® Node ID: the node address for the target equipment on a CANopen network.

® Type: 01 indicates the read access; 02 indicates the write access.

The following table shows the data format of the SDO response message.

S Gerfiee R.esponse message
High byte Low byte
D24000 ResID Status code
D24001 Message Header | Reserved Size
D24002 Type Node ID
D24003 High byte of main index Low byte of main index
D24004 Reserved Sub-index
D24005 Message Data Datum 1 Datum O
D24006 Datum 3 Datum 2
D24007~D24031 Reserved

® Status code:

The following table lists the status code values in the response message.

Status code Explanation
0 No data transmission request
1 SDO message transmission succeeds.
2 SDO message is being transmitted.
3 Error: SDO transmission time-out
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Status code Explanation
4 Error: lllegal command code
5 Error: the length of the transmitted data is illegal.
6 Error: the length of the response data is illegal.
7 Error: Equipment to be sent messages is busy.
8 Error: lllegal type
9 Error: Incorrect node address
0A Error message (See the error code for SDO response message)
OB-FF Reserved

® ResID: the same as the request ID in the request message.

® Size: the length of the message data, maximum of 20 bytes. The unit is bytes. When writing, the

maximum is four; the data length is decided by the data type of index and subindex when reading.

® Node ID: the node address of the target equipment on CANopen network.

® Type: in the SDO response message, 43 (Hex) refers to reading four bytes of data; 4B (Hex) refers to
reading two bytes of data; 4F (Hex) refers to reading one byte of data; 60 (Hex) refers to writing 1/2/4

byte(s) of data; 80 (Hex) refers to stopping SDO command.

Example 1: write 010203E8 (hex) to (Index_subindex) 212D _0 in slave of No. 3 through SDO; the data type of

(Index_subindex) 212D_0 is double words (32 bits).

® Request data:

Request message
PLC device ]
High byte(Hex) Low byte(Hex)
D25000 ReqID=01 Command =01
D25001 Message Reserved =0 Size =8
Header
D25002 Type =02 Node ID =03
D25003 Main index high byte =21 Main index low byte =2D
D25004 Message | Reserved =0 Subindex =0
D25005 data Datum 1=03 Datum 0=E8
D25006 Datum 3=01 Datum 2=02
) Response data:
. Response message
PLC device :
High byte(Hex) Low byte(Hex)
D24000 ResID =01 Command =01
D24001 Message Reserved =0 Size =4
Header
D24002 Type =60 Node ID =03
D24003 Main index high byte =21 Main index low byte =2D
D24004 Message | Reserved =0 Subindex =0
D24005 data Datum 1=00 Datum 0=00
D24006 Datum 3=00 Datum 2=00
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Example 2: read the value of (Index_subindex) 212D 0 in slave of No. 3 through SDO; the data type of
(Index_subindex) 212D _0 is double words (32 bits).

° Request data:

, Request message
PLC device -
High byte(Hex) Low byte(Hex)
D25000 ReqID =01 Command =01
D25001 Message | poserved =0 Size =4
Header
D25002 Type =01 Node ID =03
D25003 Main index high byte =21 Main index low byte =2D
D25004 Message | Reserved =0 Subindex =0
D25005 data Datum 1=0 Datum 0=0
D25006 Datum 3=0 Datum 2=0

10.4.2 Data Structure of NMT Message

Use the NMT service to manage the CANopen network such as start, operation, reset of nodes, etc.

The following table shows the data format of the NMT request message.

Request message
PLC device
High byte Low byte
D25000 ReqID Command (Fixed to 01)
Message . .
D25001 Reserved Size (Fixed to 04)
Header
D25002 Type (Fixed to 03) Node ID
D25003 Message Reserved NMT service code
D25004 data | Reserved Node ID

® Command: Fixed to 01.

® ReqlD: the request ID. Whenever an NMT request message is sent, the message is given a ReqID for

the CANopen master to identify. Before another NMT request message is sent out, the original ID

number must be changed. In other words, change the value of ReqID. The ReqID range is between

00—FF (Hex) to trigger sending the NMA request message.

® Node ID: the node address for the target equipment on the CANopen network (0: Broadcast).

® NMT service code:

NMT service code (Hex)

Function

01 Start remote node

02 Stop remote node

80 Enter the pre-operational state
81 Reset application

82 Reset communication

10-21



AS Series Operation Man

ual

The following table shows the data format of the NMT Response message.

) Response message
PLC device .
High byte Low byte
D24000 ResID Status code
D24001 Message Reserved Reserved
header
D24002 Reserved Node ID

® \When status code is 1, the NMT operation has succeeded. When status code is not equal tol, the

NMT operation has failed and you should verify that the data in NMT request message is correct.

® Node ID: the node address for the target equipment on the CANopen network.

Example 1: Stop slave of No. 3 through NMT

) Request data:

) Request message
PLC device -
High byte(Hex) Low byte(Hex)
D25000 ReqlID =01 Command =01
D25001 Message Reserved =0 Size =04
header
D25002 Type =03 Node ID =03
D25003 Message | Reserved NMT service code =02
D25004 data Reserved Node ID =03
) Response data:
) Response message
PLC device .
High byte(Hex) Low byte(Hex)
D24000 ResID=01 Status code =01
D24001 Message Reserved =0 Reserved =0
header
D24002 Reserved =0 Node ID =03

10.4.3 Data Structure of EMERGENCY Request Message

The Emergency request message communicates the slave error and alarm information.

The following table shows the data format of the Emergency request message.

Request message

PLC device :
High byte Low byte
D25000 ReqID Command (Fixed to 1)
D25001 Message Reserved Size (Fixed to 0)
header
D25002 Type (Fixed to 04) Node ID
D25003~D25031 Message Reserved
data

® Command: Fixed to 01.

® ReqlD: the request ID. Whenever an Emergency message is sent, the message is given a ReqID for

the CANopen master to identify. Before another Emergency request message is sent out, the original

ID number must be changed. In other words,

change the value of ReqID. The ReqID range is

between 00—FF (Hex) to trigger the sending the Emergency request message.
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Node ID: the node address of the target equipment on CANopen network.

The following table shows data format of the Emergency response message.

S S | Response message
High byte(Hex) Low byte(Hex)
D24000 ResID Status code
D24001 Message | poserved Size Fixed to 2A
header

D24002 Type (Fixed to 04) Node ID

D24003 Total number of data Number of data stored

D24004 Datum 1 Datum O

D24005 Datum 3 Datum 2

D24006 Datum 5 Datum 4

D24007 Message Datum 7 Datum 6
D24008-D24011 data Emergency2
D24012-D24015 Emergency3
D24016-D24019 Emergency4
D24020-D24023 Emergency5
D24024-D24031 Reserved

Command: Fixed to 01(Hex).

When status code is 1, reading the Emergency message has succeeded. When status code is not
equal tol, reading the Emergency message has failed and you should verify that the data in the
Emergency message is correct.

Node ID: the node address for the target equipment on the CANopen network.

Total number of data: the total number of Emergency messages CANopen master receives from the
slave.

Number of data stored: the latest number of Emergency messages CANopen master receives from the
slave (5 messages at most).

An Emergency 1 consists of the data in D6004-D6007 and every Emergency message consists of 8
bytes of data.

The following table shows the data format of Emergency messages on the CAN bus. Datum 0—-datum
7 in Emergency response message correspond to byte O—byte 7 respectively.

COB-ID | Byte0 | Bytel Byte 2 Byte3 | Byte4 | Byte5 | Byte6 | Byte 7

80 Chex) Emergency error | Error storage

. Vendor custom error code
+Node-ID code register

Example 1: read the Emergency message from the slave No.2, and the Emergency messages the slave
sends out successively.

COB-ID Byte 0 Byte 1 Byte 2 Byte 3 Byte 4 Byte 5 Byte 6 Byte 7
82 (hex) 43 54 20 14 0 0 0 0

COB-ID Byte O Byte 1 Byte 2 Byte 3 Byte 4 Byte 5 Byte 6 Byte 7
82 (hex) 42 54 20 15 0 0 0 0
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) Request data:

) Request message
PLC device .
High byte Low byte
D25000 ReqID=01 Command =01
D25001 Message Reserved Size =0
header
D25002 Type =04 Node ID =03

®  Emergency response data

) Response message
PLC device .
High byte Low byte
D24000 ResID=01 Status code =01
D24001 Message Reserved =0 Size =2A (Hex)
header

D24002 Type =04 Node ID =03
D24003 Total number of data =1 Number of data stored =1
D24004 Datum 1=54 Datum 0=42
D24005 Mzs:tzge Datum 3=20 Datum 2=14
D24006 Datum 5=0 Datum 4=0
D24007 Datum 7=0 Datum 6=0

10.4.4 Example of Sending SDO through the Ladder Diagram

1. Control Requirement:

Read the value of P0-09 from the servo through SDO.

2. Hardware Connection:

3. The Corresponding Relation between Slave Parameter and Index/Subindex

The index_subindex corresponding to P0-09 in servo is 2009 _0. In the CANopen Builder network
configuration software, right click the servo icon, and then click Parameter Edit. In the Parameter Edit
dialog box, you can see the index_subindex corresponding to the servo parameter.

For more details on how to operate the network configuration interface, refer to Section 11.1.1 in the
CANopen Builder software help file
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001

AS300 Series , Master | UnitID 1 | Node Address 1 .

=
Index: [All Paramete = | Beed | | Wte | [Uostor| | Defaute | [anvates =]
Index | Sublndex | ParamName | value [rw | |
2004 0 PO 0 = =
2005 0 PO0S 0 o
2006 0 PO-06 0 o
2007 0 PO-07 0 o
2008 0 P0-0S 0 r

200a

o
I O Y S (R P
o

PO-10

5
IS

0 0
Cut Ctl+X 200b 0 PO-11 0 ro
e CHlC ‘ 00 0 PO-12 0 ro
Eeste Celts —i:i:lemfm:aﬁnn — : - LI
Delete Del Indeses: 2008 M o
Sublndex(Hex): 0 Min: 0
Value: 0 Default: 0
’7 Properties... ]—|01( Cancal
4.  The Structure of the Request Message Devices:
. Content Explanation
PLC device -
(Hex) High byte(Hex) Low byte(Hex)
SDO D25000 0101 ReqID =01 Command =01
request D25001 0004 Reserved Size = 04
message | D25002 0102 Type =01 Node ID =03
mapping | D25003 2009 Index high byte = 20 Index low byte = 09
area | p25004 0000 Reserved Subindex = 00
5. Editing the Ladder Diagram in ISPSoft
SIM4[IIIZ ZRST
b D25000 —{C1
025031 —{D2
ZRST
D24000 —|D1
D24031—{D2
MOV
1640101 —{S —D100
M2 MOV
N £
D100 {3 —D25000
MOV
16#0004 —{S —D25001
MOV
16%#0103 -3 —D25002
MOV
16%#2009 —{S —D25003
MOV
1640000 —{S —D25004

When M2=0N, after reading succeeds, the program stores the data from the target device in
D24000-D24005. The value of D24005: 100 (hex) is the value read from P0-09.
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6. The Structure of the Response Message Devices:

i Content Explanation
PLC device -
(Hex) High byte(Hex) Low byte(Hex)
D24000 0101 ResID = 01 Status code = 01
SDO D24001 0006 Reserved Size = 08
response | p24002 4303 Type = 43 Node ID = 03
message — - - -
mapping D24003 2009 Main index high byte = 20 Index low byte = 09
area D24004 0004 Reserved Subindex = 00
D24005 0100 Datum 1= 01 Datum 0= 00

10.5 Troubleshooting

10.5.1 CANopen Network Node State Display

1. In the AS Series PLC, while you enable the CANopen function, it uses SR825-893 as the special
registers as shown in the following table.

Special register Function
SR825 Displays the state of AS300 series PLC.
SR830-SR893 Displays the state of 64 nodes in the network

SR826 Flag for the state of the slave 1-16

SR827 Flag for the state of the slave 17-32

SR828 Flag for the state of the slave 33-48

SR289 Flag for the state of the slave 49-64

SR821 Version of CANopen DS301

SR822 Displays the CANopen baud rate (unit: 1kpps)

2. As a master, the AS series PLC supports a maximum of 64 slaves ranging from node 1 to node 64. You
can use SR826—829 to monitor the state of the nodes in the network. The 16 bits in SR826 correspond
to 16 slaves and their corresponding relations are shown in the following table.

Bit b7 b6 b5 b4 b3 b2 bl b0
Node Node 8 Node 7 Node 6 Node 5 Node 4 Node 3 Node 2 Node 1
Bit b15 b14 b13 b12 b11 b10 b9 b8
Node Nodel6 | Nodel5 | Nodel4d | Nodel3 | Nodel2 | Nodell | NodelO | Node 9

When the node in the master node list is normal, the corresponding bit is OFF; when the node in the
master node list is abnormal (for example, initializing fails or the slave is offline for some reason), the
corresponding bit is ON.

3. The error code of every node is displayed through the corresponding special register (SR830-893) and
the relations between special register and corresponding node (1-16) is shown in the following table.
(You can also judge for other correspondings that are not listed here.)
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Special
i SR830 SR831 SR832 SR833 SR834 SR835 SR836 SR837
register
Node Node 1 | Node 2 Node 3 Node 4 Node 5 Node 6 Node 7 Node 8
Special
i SR838 SR839 SR840 SR841 SR842 SR843 SR844 SR845
register
Node Node 9 | Nodel0 | Nodell | Nodel2 | Nodel3 | Nodeld4 | Nodel5 Nodel6

Node codes displayed in SR830-893 when the ASSeries PLC is the master:

Code Indication How to correct
0 The nod.e is error free or the node is N/A
not configured.
ASSeries PLC master module
EO receives the emergency message Read the relevant message with the PLC program
sent from slave.
PDO data length returned from the
. 9 . ) Set the PDO data length of the slave and
El slave is not consistent with the
. . re-download.
length set in the node list.
E2 PDO of slave is not received. Check and ensure the setting is correct.
E3 Downloading auto SDO fails. Check and ensure auto SDO is correct.
Configuration of PDO parameter _
E4 fails 9 P Ensure that the PDO parameter setting is legal.
Ensure that the connected slave device is
E5 Error in key parameter setting. consistent with the configured slave in the
software.
The slave does not exist in the ]
E6 network Ensure that the power supply of slave is normal
— and slave is correctly connected to the network.
E7 Slave error control is timed-out.
E8 The node IDs of master and slave Set the node ID of the master and slave again and

repeat.

ensure their node IDs are unique.

Codes displayed in SR825 when the AS300 Series PLC is the master:

Code Indication How to correct
In CANopen DS301 mode: the PLC
works as master and is working
normally.
0 ) N/A
Not in CANopen DS301 mode: the
master mode function is not
activated.
. . Add slave into the node list and then re-download
F1 No slave in the list . .
the configuration data.
The data are being downloaded to . - . . .
F2 AS Series PLC Wait to finish downloading the configuration data.
The configuration receiving error in ) . .
F3 AS Series PLC Download parameter configuration again.
Check that the CANopen bus cables are properly
F4 Bus-OFF is detected. connected and ensure that all the node devices run

at the same baud rate before you reboot.
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Code Indication How to correct
AS Series PLC setting error such as | The node address in the AS300 Series PLC should
F5 .
incorrect node address be between: 1-127.
Fs Internal error; the error is detected in | If the same error occurs after cycling the power,
the internal memory replace it with a new AS300 PLC.
FB The sending buffer in the AS Series | Check that the CANopen bus cable is properly
PLC is full. connected and then reboot.
The receiving buffer in the AS Series | Check that the CANopen bus cable is properly
FC .
PLC is full. connected and then reboot.

6. Codes displayed in SR825 when the AS Series PLC is the slave:

Code Indication How to correct
N/A
Note: When the heartbeat alam function is not
0 Working normally activated, if the connection is normal before a

disconnection occurs, the code for the slave will
still be working normally after the connection is
back on.

A0 AS Series PLC is being initialized.

Al AS Series PLC is pre-operational.

Check if the CANopen bus cable is properly
connected. If the master communication is not
activated, no handling is needed.

The data are being downloaded to

A3 AS Series PLC

Wait to finish downloading the configured data.

BO Heartbeat message time-out

Check if the CANopen bus cable is properly
connected.

PDO data length returned from the
B1 slave is not consistent with the
length set in the node list.

Reset the PDO data length in the slave and
download the new setting to the AS Series PLC.

F4 BUS-OFF state is detected.

Check if the CANopen bus cables are properly
connected and ensure that all the node devices run
at the same baud rate before you reboot.

The sending buffer in the AS Series

FB PLC is full.

Check if the CANopen bus cable is properly
connected and then reboot.

The receiving buffer in the AS

FC Series PLC is full.

Check if the CANopen bus cable is properly
connected and then reboot.

10.6 Application Example

The AS300 Series PLC can control Delta A2 servo rotation, and monitor the actual rotation speed of the motor
in real time. It does this by mapping the relevant servo drive parameters to the corresponding PDO, and reads

or writes the relevant servo drive parameters through the CAN bus.
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1. Connectting the Hardware

Note:

® Use a standard communication cable such as UC-DN01Z-01A / UC-DN01Z-02A / UC-CMC010-01A.
and connect the terminal resistors (Delta standard terminal resistor TAP-TRO01) to both ends of the

network when you construct the network.

® M of ASD-A2-xxxx-M refers to the model code and currently only the M-model servo supports

CANopen communication.

2. Setting Servo Parameters:

® Set servo parameters as shown in the following table.

Parameter Setting Explanation
3-00 03 Node ID of the A2 servo is 2
3-01 400 CAN communication rate is 1Mbps.
1-01 04 Speed mode
0-17 07 Drive displays the motor rotation speed (r/min)
2-10 101 Set DI1 as the signal for Servo On
2-12 114 Set DI3 as the signal _SPDO for speed selection
2-13 115 Set DI4 as the signal _SPD1 for speed selection

3. Setting the CANopen Baud Rate and Node ID of AS300 Series PLC

The AS300 Series PLC uses the default setting values: Node ID: 1 and baud rate: 1Mbps.

You set the CANopen Node ID and baud rate for the AS300 series PLC in the CANopen Builder software,

as shown in the following steps.
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A. Right click the AS300 Series PLC icon in HWCONFIG, then click Communication Software, and
then click CANopen Builder.

B. IFAS300 is in master mode, you can skip this step. If not, you can go to Properites and set it in
Master mode. After that download the parameter to AS300. Set AS300 Power off for 2 seconds
and supply power again and then proceed to the next step.

001
' it 1 | Node Address 1 .
Cut Ctrl+X
Copy Ctrl+C
Paste Ctrl+V
Delete Del

Parameter Edit

Properties...

Master Configuration... p4

Node 1 Baud rate:  125Kbps
Name: | AS300 Series Master |

Work Mode: | Master Mode ~
Synchromzation Object{SYNC)
COBEID: 123
Cycle Period: %1000us
Heattbeat Pratocal

Ifmaster's heartbeat time 1s (), then the
heartbeat function is disabled.

Master's heartbeat time: ms
Cancel
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C. Click the Online JE button on the Toolbar to enter on-line mode.

T,?_ Delta CANopen Builder - DE301 cop
File Edit View MNetwork Tools Setop Help

lecE® Y8000/l mo::yE=|

: [Ondine (F10} |
=[] Project 00

------ Bl AS300 Series . Master, Un

AS300 Series |, Master , UnitID 1 | Node Address 1 .

D. Click the Scan Network = button on the Toolbar to scan the network.

“?_ Delta CANopen Builder - DS301 cop
File Edit WView Network Tools Setop Help

ML Y -1 EEG] EEEIEE =

EID Project 001 Sean Network

------ [l A3300 Series . Master, Un
AS300 Series , Master , UnitID 1, Node Address 1.

E. Onthe Network menu, click Master parameter to display the Master Configuration dialog box.

ﬂ?_ Delta CANopen Builder - DE301 cop

File Edit View MNetwork Tools Setop Help

TR T R EERI L T ERE

E—— ﬂ
i 001

E AS300 Series . Master. Un Node I . Bail i Il‘\'ﬂjps j
AS300 Series | Master | UnitfTD 1 | Node Address 1 .
Name: | AS300 Series Master

Work Mode: Il.\rlastarMcde j B
r~ Synchronization Object(SYNC)
COBID: 128
CyclePesiod= [30  xl000us

ASDA-A2 i Heartbeat Protocol

Drive If master's heartbeat time is (. then the
heartbeat function is disabled.

Master's heartbeat time: | 200 ms
‘ OK |  Cancel |
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Iltem Explanation Default
Node ID Node ID of AS300 series PLC on the CANopen 1
network
Baud rate CANopen communication rate 1M bit/second
Work mode CANopen master/slave mode Master
Cycle period Cycle time for sending one SYNC message 50ms
Master heartbeat time Interval time for sending the master heartbeat 200ms
message

Configure the CANopen communication stations and rates in HWCONFIG.

. . 0
F. After you complete the previous steps, click the Download —|-| button on the Toolbar to download
the parameters to the PLC.

"= Delta CANopen Builder - DE301 .cop
File Edit View Network Tools Setop Help

R T R B EREE R EEE =R

Diovwrdoad

=[] Project 001

.. [ AS300 Series , Master, Un
AS300 Series , Master , UnitID 1 , Node Address 1 .

ASDA-A2
Drive

Note: you must reboot the AS300 Series PLC to enable the downloaded parameters.

4. Scanning the Network:

On the Network menu, click Online or click the & button to scan for the master and slaves on the
CANopen network. The master and slave found by the scan appear in CANopen Builder. For more
information, refer to Section 11.1.1 in the CANopen Builder software help file.

“f_, Delta CANopen Builder - D3301 cop
File Edit View Network Tools Setup Help

[EEEE L L R EER] EEFIEE =R

ED Project 001 [Sean Network
* [Hl AS300 Series . Master, Un
AS300 Series , Master , UnitID 1 , Node Address 1 .

ASDA-A2
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5. Configurating Nodes:
Double click the slave icon in CANopen Builder to display the Node configuration dialog box.
® Error Control Protocol
Sets the error control protocol for the master to monitor if the slave is offline.
® Auto SDO Configuration

Perform one write action to the slave parameter with SDO. The write action is finished when the
slave enters the operational state from the pre-operational state. You can configure up to 20 SDOs by
clicking Auto SDO configuration.

® PDO Mapping and Properties
Sets the mapping parameter and transmission type for the PDO.

For more details on the function of these buttons, refer to Section 11.1.1 in the CANopen Builder
software help file.

Node Configuration... x|
Node ID: |3 Name: [ ASDA-A2 Drive
[ Node jon(Hex)

Error Control Protocol |

v Vendor ID: |000001DD

7 Device Type:  [04020192
¥ Product Code: Iowoam
W Revision  [omoooor

Auto SDO Configuration |

Emergency COBID: |83

Nodeguard COBID: | 703

( PDO from EDS file
Index | PDO Name | Type | mbibit | Event | =] ExportEDSfile
1400 Receive PDO Communic... 233 -
1401 | Receive PDO Communic 253 -
1402 | Receive PDO Communic... 253 - Add
1403 | Receive PDO Communic_ 253 -
1800 TransmitPDO Commumi.. 255 0 0 Delete
18 | TransmitPDO Communi_ 255 0 0 | | ———
1802 TransmitPDO Communi.. 2535 0 0
1803 Transmit PO Commumni 255 0 n LI
| Configured PDO
Index | COBID | R/T [ Len | Type | Description [ [P0 Wagyig |
1400 | 203 Rx 4 255 PR«PDOI Properties
1401 303 Rs 4 255 R«PDO2
1800 | 183 T= 4 1 T:PDO 1

Cancel

® PDO Mapping:

RxPDO1: mapping parameter P1-09; transmission type 255.

RxPDO2: mapping parameter P3-06, P4-07; transmission type 255.

TxPDO1: mapping parameter P0-09; transmission type 1.

3 Rx 4

r Confizured PDO

Indez | COBID | R/T | Len | Type | Description [ el Ul e
1400 | 203 Rx 4 235 RaPDO1 Properties |
1401 30 255  R«PDO2

Cancel
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® PDO transmission type :

PDOs can be classified into RxPDO or TxPDO. RxPDO data are sent from master to slave and
TxPDO data are sent from slave to master.

The PDO transmission types can be synchronous or asynchronous. In synchronous transmission, the
master sends out the SYNC message in a fixed cycle. You set the length of the cycle in the Master
Properties dialog box (default is 50ms). In asynchronous transmission, the message is sent out when
the PDO mapping parameter changes.

The following table describes the PDO Transmission types.

Transmission Type Description Remark

When any change in the mapped data happens,
RxPDO data is sent out immediately. The data
RxPDO the slave receives is valid only when receiving
the next SYNCH message. RxPDO data is not
sent out if there is no change in the data. SYNCH

0 When any change in the mapped data happens non-cycle
and the slave receives the SYNC message, the
data are sent out immediately. The TxPDO data
are valid immediately after master receives them.
TxPDO data is not sent out if there is no change
in the data.

TxPDO

After N messages are sent out, and regardless of
whether the mapped data changes, the data that
the slave receives is valid only when receiving SYNCH
the next SYNCH message. cycle

RxPDO
N

(N:1-240)

After N messages are sent out and regardless of
TXPDO whether the mapped data is changed, the data
that the master receives is valid at once.

The mapped data is sent out immediately when it
changes and is valid when the slaves receives it.
RxPDO data is not sent out if there is no change
in the data.

RxPDO

The slave sends out the data once every one

Event timer time. After that, the TxPDO data is
254 not allowed to be sent out within an inhibit timer ASYNCH
time.

TxPDO When the Event timer and Inhibit timer are both
equal to 0, the slave sends TxPDO data to the
master immediately when the data changes, and
the data that master receives is immediately
valid.

255 Same as Type254

Note:
® Synchronous transmission type can fulfill multi-axis motion at the same time.

® If you monitor a real-time changing parameter such as the actual rotation speed of the motor, set
the TxPDO to the synchronous transmission type; otherwise the frequent change in the slave data
can block the CANopen network.
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After you finish setting the above parameters, double click the master device to display the Node List Setting
dialog box. Select ASDA-A2 Drive, and click > to move the A2 drive to the right-side list, and then download
the configured data.

Node List Setting x|
r List Setting
Available Nodes: Node List:
Node [D Node Name I Node ID I Node Name I

003 ASDA-A2 Drive

r~ Output Table r~ Input Table
Device | Device Mapping | 3 Device | Device Mapping |ﬂ
D23032_L [003]R:PDO-P1-09 D24032_L [003]TxPDO-P0-09 =
D235032_H [003]R:PDO-F1-09 D24032_H [003]TxPDO-P0-09
D25033_L [003]R«PDO-P1-09 D24033_L [003]T<PDO-P0-09
D23033_H [003]R:PDO-P1-09 D24033_H [003]T:PDO-P0-09
D25034_L [003]R:PDO-P3-06 D24034 L
D23034_H [003]R:PDO-P3-06 D24034_H
D23035_L [003]RsPDO-P4-07 D24035 L
D25035_H [003]R<PDO-P4-07 D24035_H
The mapping relation between master and slave:
. . Data transmission on CANopen .
AS300 Series PLC master register ! blus P A2 device
D25032 Low word of P1-09 of
servo
D25033 :> High word of P1-09 of
servo
D25034 P3-06 of servo
D25037 P4-07 of servo
Low word of P0-09 of
D24032 <:| cervo
High word of P0-09 of
D24033 senvo

Program control: D25032 is given the value 256 in ISPSoft; that is, the speed command is set as
256r/min in the following diagram.
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Network 1
SM402 MoV
| | £
1T n
16#000F —S D[—D25034
Network 2
Mo DMOV
|1~] E
1T "
256 —5 D} D25032
Network 3
M MoV
i S
16#0005 —S D[{—D25035
Network 4
M MoV
111 £
1l n
16#0003 —S D[—D25035

7. Program explanation
When the AS300 Series PLC runs for the first time, set the parameter P3-06 for servo drive to F.

) When MO switches from OFF to ON, the instruction writes 256 to D25032 and then writes the value to
the servo parameter P1-09 through RxPDOL1.

) When M1 switches from OFF to ON, change P4-07 to 5. DI1 and DI3 are ON. DI1 means the SERVO is
ON and DI3 calls the speed specified by parameter P1-09 for servo rotation.

) When M1 switches from ON to OFF, the speed command becomes 0 and the motor stops running.

10.7 Object Dictionary

The following table lists the communication objects in the object dictionary.

. . . Default
Index Subindex Object name Data type Attribute
value
H’1000 H’00 Device type Unsigned 32 bits R 0x00000000
H’1001 H’00 Error register Unsigned 8 bits R 0
H'1005 H'00 COB-ID SYNC Unsigned 32 bits RW 0x00000080
, , . ] . AS300
H’1008 H’00 Manufacturer device name Vis-String R Series PLC
. . 0x80 +
H'1014 H'00 COB-ID EMCY Unsigned 32 bits R
Node-ID
- Consumer heartbeat time
H'1016 H00 Number of valid subindex Unsigned 8 bits R 1
H01 Consumer heartbeat time Unsigned 32 bits RW 0
H'1017 H’00 Producer heartbeat time Unsigned 16 bits RW 0
-- Identity Object
H'1018 . . . .
H'00 Number of valid subindex Unsigned 8 bits R 3
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) . ) Default
Index Subindex Object name Data type Attribute
value
H01 Vendor-ID Unsigned 32 bits R 0x000001DD
H'02 Product code Unsigned 32 bits R 0x00000055
H'03 Revision number Unsigned 32 bits R 0x00010002
RxPDO1 communication
parameter
H'00 Number of valid subindex Unsigned 8 bits R 3
H'1400
H01 COB-ID of RxPDO1 Unsigned 32 bits RW 0x00000200+
Node-ID
H'02 Transmission mode Unsigned 8 bits RW OxFF
H'03 Inhibit time Unsigned 16 bits RW 0
B RxPDO2 communication
parameter
H'00 Number of valid subindex Unsigned 8 bits R 3
H'1401
H01 COB-ID of RxPDO2 Unsigned 32 bits RW 0x80000000
H'02 Transmission mode Unsigned 8 bits RW OxFF
H'03 Inhibit time Unsigned 16 bits RW 0
B RxPDO3 communication
parameter
H'1402 H'00 Number of valid subindex Unsigned 8 bits R 3
H01 COB-ID of RxPDO3 Unsigned 32 bits RW 0x80000000
H'02 Transmission mode Unsigned 8 bits RW OxFF
H'1402 H'03 Inhibit time Unsigned 16 bits RW 0
RxPDO4 communication
parameter
H'00 Number of valid subindex Unsigned 8 bits R 3
H'1403
H01 COB-ID of RxPDO4 Unsigned 32 bits RW 0x80000000
H'02 Transmission mode Unsigned 8 bits RW OxFF
H'03 Inhibit time Unsigned 16 bits RW 0
RxPDO5 communication
parameter
H'00 Number of valid subindex Unsigned 8 bits R 3
H'1404
H01 COB-ID of RxPDO5 Unsigned 32 bits RW 0x80000000
H'02 Transmission mode Unsigned 8 bits RW OxFF
H'03 Inhibit time Unsigned 16 bits RW 0
RxPDO6 communication
parameter
H'1405
H'00 Number of valid subindex Unsigned 8 bits R 3
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. . . Default
Index Subindex Object name Data type Attribute
value
H01 COB-ID of RxPDO6 Unsigned 32 bits RW 0x80000000
H'02 Transmission mode Unsigned 8 bits RW OxFF
H'03 Inhibit time Unsigned 16 bits RwW 0
B RxPDO7 communication
parameter
H00 Number of valid subindex Unsigned 8 bits R 3
H'1406 . .
H'01 COB-ID of RxPDO7 Unsigned 32 bits RW 0x80000000
H'02 Transmission mode Unsigned 8 bits RW OxFF
H'03 Inhibit time Unsigned 16 bits RW 0
B RxPDO8 communication
parameter
H'00 Number of valid subindex Unsigned 8 bits R 3
H'1407
H'01 COB-ID of RxPDO8 Unsigned 32 bits RW 0x80000000
H'02 Transmission mode Unsigned 8 bits RW OxFF
H'03 Inhibit time Unsigned 16 bits RW 0
H'1600 -- RxPDO1 mapping parameter
H'00 Number of valid subindex Unsigned 8 bits RW 4
H01 The first mapped object Unsigned 32 bits RW 0x20000110
H'1600 H01 The second mapped object Unsigned 32 bits RW 0x20000210
H'02 The third mapped object Unsigned 32 bits RW 0x20000310
H'03 The fourth mapped object Unsigned 32 bits RW 0x20000410
-- RxPDO2 mapping parameter
H'00 Number of valid subindex Unsigned 8 bits RW 0
H'01 The first mapped object Unsigned 32 bits RW 0
H'1601
H'01 The second mapped object Unsigned 32 bits RW 0
H'02 The third mapped object Unsigned 32 bits RW 0
H'03 The fourth mapped object Unsigned 32 bits RW 0
-- RxPDO3 mapping parameter
H'1602 H'00 Number of valid subindex Unsigned 8 bits RW 0
H'01 The first mapped object Unsigned 32 bits RW 0
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Index Subindex Object name Data type Attribute Default
value
H01 The second mapped object Unsigned 32 bits RW 0
H'02 The third mapped object Unsigned 32 bits RW 0
H'03 The fourth mapped object Unsigned 32 bits RW 0
-- RxPDO4 mapping parameter
H'00 Number of valid subindex Unsigned 8 bits RW 0
, H01 The first mapped object Unsigned 32 bits RW 0
11603 H01 The second mapped object Unsigned 32 bits RW 0
H'02 The third mapped object Unsigned 32 bits RW 0
H'03 The fourth mapped object Unsigned 32 bits RW 0
-- RxPDO5 mapping parameter
H'1604
H'00 Number of valid subindex Unsigned 8 bits RW 0
H01 The first mapped object Unsigned 32 bits RW 0
H01 The second mapped object Unsigned 32 bits RW 0
H'1604 H'02 The third mapped object Unsigned 32 bits RW 0
H'03 The fourth mapped object Unsigned 32 bits RW 0
-- RxPDO6 mapping parameter
H'00 Number of valid subindex Unsigned 8 bits RW 0
H01 The first mapped object Unsigned 32 bits RW 0
H’1605
H01 The second mapped object Unsigned 32 bits RW 0
H'02 The third mapped object Unsigned 32 bits RW 0
H'03 The fourth mapped object Unsigned 32 bits RW 0
-- RxPDO7 mapping parameter
H'00 Number of valid subindex Unsigned 8 bits RW 0
, H01 The first mapped object Unsigned 32 bits RW 0
11606 H01 The second mapped object Unsigned 32 bits RW 0
H'02 The third mapped object Unsigned 32 bits RW 0
H'03 The fourth mapped object Unsigned 32 bits RW 0
-- RxPDO8 mapping parameter
H'00 Number of valid subindex Unsigned 8 bits RW 0
H01 The first mapped object Unsigned 32 bits RW 0
H1607
H01 The second mapped object Unsigned 32 bits RW 0
H'02 The third mapped object Unsigned 32 bits RW 0
H'03 The fourth mapped object Unsigned 32 bits RW 0
B TxPDO1 communication
H’1800 parameter
H'00 Number of valid subindex Unsigned 8 bits R 5
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Index Subindex Object name Data type Attribute Default
value
H01 COB-ID of TxPDO1 Unsigned 32 bits RW Ox?uoffgllgm
H'02 Transmission mode Unsigned 8 bits RW OxFF
H'03 Inhibit time Unsigned 16 bits RW 50
H’1800 H'05 Timer Unsigned 16 bits RW 100
B TxPDO2 communication
parameter
H'00 Number of valid subindex Unsigned 8 bits R 5
H’1801 H'01 COB-ID of TXPDO2 Unsigned 32 bits RwW 0x80000000
H'02 Transmission mode Unsigned 8 bits RW OxFF
H'03 Inhibit time Unsigned 16 bits RW 50
H'05 Timer Unsigned 16 bits RW 100
B TxPDO3 communication
parameter
H'00 Number of valid subindex Unsigned 8 bits R 5
H’1802 H'01 COB-ID of TXPDO3 Unsigned 32 bits RwW 0x80000000
H'02 Transmission mode Unsigned 8 bits RW OxFF
H'03 Inhibit time Unsigned 16 bits RW 50
H'05 Timer Unsigned 16 bits RW 100
B TxPDO4 communication
parameter
H’00 Number of valid subindex Unsigned 8 bits R 5
H'1803 H01 COB-ID of TxPDO4 Unsigned 32 bits RW 0x80000000
H'02 Transmission mode Unsigned 8 bits RW OxFF
H'03 Inhibit time Unsigned 16 bits RW 50
H'05 Timer Unsigned 16 bits RW 100
B TxPDO5 communication
parameter
H’00 Number of valid subindex Unsigned 8 bits R 5
H’1804 H01 COB-ID of TxPDO5 Unsigned 32 bits RW 0x80000000
H'02 Transmission mode Unsigned 8 bits RW OxFF
H'03 Inhibit time Unsigned 16 bits RW 50
H'05 Timer Unsigned 16 bits RW 100
B TxPDO6 communication
parameter
H'1805 H’00 Number of valid subindex Unsigned 8 bits R 5
H'01 COB-ID of TXPDO6 Unsigned 32 bits RW 0x80000000
H'02 Transmission mode Unsigned 8 bits RW OxFF
11805 H'03 Inhibit time Unsigned 16 bits RW 50
H'05 Timer Unsigned 16 bits RW 100
H'1806 B TxPDO7 communication
parameter
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Index Subindex Object name Data type Attribute Default
value
H'00 Number of valid subindex Unsigned 8 bits R 5
H'01 COB-ID of TXPDO7 Unsigned 32 bits RW 0x80000000
H'02 Transmission mode Unsigned 8 bits RW OxFF
H'03 Inhibit time Unsigned 16 bits RW 50
H'05 Timer Unsigned 16 bits RW 100
B TxPDO8 communication
parameter
H'00 Number of valid subindex Unsigned 8 bits R 5
H’1807 H'01 COB-ID of TXPDO8 Unsigned 32 bits RW 0x80000000
H'02 Transmission mode Unsigned 8 bits RW OxFF
H'03 Inhibit time Unsigned 16 bits RW 50
H'05 Timer Unsigned 16 bits RW 100
-- TxPDO1 mapping parameter
H'00 Number of valid subindex Unsigned 8 bits RW 4
, H01 The first mapped object Unsigned 32 bits RW 0x20010110
FAQ H'02 The second mapped object Unsigned 32 bits RW 0x20010210
H'03 The third mapped object Unsigned 32 bits RW 0x20010310
H'04 The fourth mapped object Unsigned 32 bits RW 0x20010410
-- TxPDO2 mapping parameter
H'00 Number of valid subindex Unsigned 8 bits RW 0
H01 The first mapped object Unsigned 32 bits RW 0
H'1A01
H'02 The second mapped object Unsigned 32 bits RW 0
H'03 The third mapped object Unsigned 32 bits RW 0
H04 The fourth mapped object Unsigned 32 bits RW 0
-- TxPDO3 mapping parameter
H'00 Number of valid subindex Unsigned 8 bits RW 0
H'1A02
H01 The first mapped object Unsigned 32 bits RW 0
H'02 The second mapped object Unsigned 32 bits RW 0
H'03 The third mapped object Unsigned 32 bits RW 0
H'1A02
H'04 The fourth mapped object Unsigned 32 bits RW 0
-- TxPDO4 mapping parameter
H'00 Number of valid subindex Unsigned 8 bits RW 0
H'1A03 H01 The first mapped object Unsigned 32 bits RW 0
H'02 The second mapped object Unsigned 32 bits RW 0
H'03 The third mapped object Unsigned 32 bits RW 0
-- TxPDO5 mapping parameter
H'1A04 H'00 Number of valid subindex Unsigned 8 bits RW 0
H01 The first mapped object Unsigned 32 bits RW 0
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Index Subindex Object name Data type Attribute Default
value
H'02 The second mapped object Unsigned 32 bits RW 0
H'03 The third mapped object Unsigned 32 bits RW 0
H04 The fourth mapped object Unsigned 32 bits RW 0
-- TxPDO6 mapping parameter
H'00 Number of valid subindex Unsigned 8 bits RW 0
H01 The first mapped object Unsigned 32 bits RW 0
H'1A05
H'02 The second mapped object Unsigned 32 bits RW 0
H'03 The third mapped object Unsigned 32 bits RW 0
H'04 The fourth mapped object Unsigned 32 bits RW 0
-- TxPDO7 mapping parameter
H’00 Number of valid subindex Unsigned 8 bits RW 0
H01 The first mapped object Unsigned 32 bits RW 0
H'1A06 H'02 The second mapped object Unsigned 32 bits RW 0
H'03 The third mapped object Unsigned 32 bits RW 0
H'04 The fourth mapped object Unsigned 32 bits RwW 0
H'1A07 -- TxPDO8 mapping parameter
H'00 Number of valid subindex Unsigned 8 bits RW 0
H01 The first mapped object Unsigned 32 bits RW 0
H'1A07 H'02 The second mapped object Unsigned 32 bits RW 0
H'03 The third mapped object Unsigned 32 bits RW 0
H'04 The fourth mapped object Unsigned 32 bits RW 0
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11.1 CPU Module Operations

11.1.1

Procedure

The following diagram describes the operation of the CPU module.

The CPU module is supplied with power.

v

The system enables the initialization.

® The non-latched memory is initialized.

The downloaded program is checked.

The parameters in the CPU module are checked.

The parameters in the module table are checked.

The module table in the CPU module is compared

with the actual I/O configuration.

The 1/O setting is downloaded to the 1/0 module.

® If the memory card is installed, whether to execute
the system copy procedure or not is checked.

A\ 4

Diagnosis processing:

® The memory card and other setting are checked.
® The I/O bus is checked.

® The system parameter is checked.

A 4

The data sent to the I/O module is refreshed.

® The data sent to the digital I/O module is refreshed.
® The data sent to the analog I/O module is refreshed.
® The data sent to other modules are refreshed.

Program execution:
® The user program is executed.
® The interrupt subroutine is executed.

A 4

The data sent from the I/O module is refreshed.

® The data sent from the digital I/O module is
refreshed.

® The data sent from the analog I/0O module is
refreshed.

® The data sent from other modules are refreshed.

Communication service:

® The communication through the CPU module

® The communication through other 1/O modules

® The internal communication between the CPU
module and the 1/O module
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11.1.2 I/0 Refreshing and Communication Service
® Refreshing I/O

The CPU module reads external I/0 data periodically or outputs data to an external I/O. Refreshing the m

I/O includes the following.
B Refreshing data in a digital I/O module
B Refreshing data in an analog I/O module
B Refreshing data in a network module

All I/O refreshing executes in the same loop. The data in an input device refreshes before a program

executes, and the data in an output device refreshes after the program executes.

Unit Maximum data exchange Data exchange area

Depends on the number of input/output
Digital /0 module Input relay/Output relay
channels in the unit.

Depends on the number of input/output

Analog 1/0 module Data register
channels in the unit.

Network module Depends on the unit. Data register

® Communication service

Communication service is the unscheduled communication service for a network module. It includes the

communication requests sent from external equipment to a CPU module, and the communication requests

sent from the CPU module to the external equipment.

11.2 CPU Module Operating Modes
11.2.1 Operating Modes

There are two operating modes. They can be used to control a user program and all tasks.

STOP mode: A program is not executed under this mode. Users can download a module table, initialize CPU

configuration and other setting, download a program, check a program, and force a bit ON/OFF.

RUN mode: A program is executed under this mode. Users can not download a module table, and initialize

CPU configuration and other setting.
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11.2.2 Status and Operation under Different Operating Modes

The following table lists the status and operation states for RUN and STOP modes.

Basic operation

Program memory
CPU I/0
Program External output Non-latched Latched
mode refreshing
area area
OFF. If you set the I/O
module so that the final
The execution state of the external output
1/0 refreshing The data in the program
STOP | of the program on the I1/O module is
executes. memories is retained.
stops. retained, the final state of
the external output on the
I/O module is retained.
The program I/O refreshing | The program controls the The program controls the
RUN
executes. executes. external output. program memories.

Relationship between the operating modes and tasks

Mode Loop task Interrupt task
Execution of an interrupt task
STOP Execution of a loop tasks stops.
stops.
® The tasks that have not been executed are in the
HALT state.
® If a task is active, or the instruction TKON is If the condition of the interrupt is
RON executed, the task executes. met, the interrupt task executes.
® |f a task is not active, or the instruction TKOFF
executes, the task does not execute.

Relationship between changing modes and the program memory

Change of the mode

Non-latched area

Latched area

STOP—RUN

Data is cleared or retained depending

on your setting.

The data is retained.

RUN—STOP

The data is retained.

The data is retained.
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12.1 Troubleshooting
12.1.1 Basic troubleshooting steps
This chapter includes the possible errors the can occur during operation, their causes, and corrective actions.
(1) Check the following:
® The PLC should be operated in a safe environment (consider environmental, electronic, and vibration safeties).

® Connect power supply correctly to the PLC.

Secure the module, terminal, and cable installations.

All LED indicators show correctly.
® Set all switches correctly.

(2) Check the following operational functions:

Switch the RUN/STOP state

® Check the settings for the AS Series to RUN/STOP

® Check and eliminate errors from external devices

® Use the System Log function in ISPSoft to check system operation and logs
(3) Identify possible causes:

® AS Series or external device

® CPU or extension modules

® Parameters or program settings

12.1.2 Clear the Error States

Use the following methods to clear the error states. If the error source is not corrected, the system continues to show
errors.

(1) Switch the CPU model state to STOP and then to RUN.
(2) Turn off the CPU and turn it on again.
(3) Use ISPSoft to clear the error logs.

(4) Reset the CPU to the default settings and download the program again.
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12.1.3 Troubleshooting SOP

Anerror
occurred

Basic
troubleshooting
steps
done

No

Module
CPU module erro error
Qr modules erro
CPU module
error
Yes
ERRORLEDON —p
No

ERRORL EDb linking Yes
normally —P
(every0.5sec.)
ERRORLEDbIlinking Yes
fast —Pp

(every0.2sec.)

ERROR LED blinking
slowly (every 1 sec.,
stop for 3 sec.)

Refer to section 12.1.1for
Basic troubleshooting steps

1.
.Refertosection12.4for error codes and

w

Refertosection12.1.4for thesystem log

LED indicators for CPU modules

.Refertosection12.3for troubleshooting for

1/0 modules

Il

w

Refertosection12.1.4for the system log

.Refertosection12.4for error codes and

L ED indicators for CPU modules

.Refertosection12.2for troubleshooting for

CPU modules

N -

w

.Refertosection12.1.4for the system log
.Refertosection12.4for error codes and

LED indicators for CPU modules

.Refertosection12.2for troubleshooting for

CPU modules

N -

w

.Refertosection12.1.4forthesystem log
.Refertosection12.4for error codes and

L ED indicators for CPU modules

.Refertosection12.2for troubleshooting for

CPU modules

N =

w

.Refertosection12.1.4for the system log

.Refertosection12.2for troubleshooting for

Refertosection12.4for error codes and
LED indicators for CPU modules

CPU modules

N e

w

.Refertosection12.4for error codes and

.Refertosection12.2for troubleshooting for

Refertosection12.1.4for the system log
L ED indicators for CPU modules

CPU modules

L Yes
Other LED blinking —p
No v
After going through Yes

troubleshooting steps,
theissuesarestillnot
resolved.

Ifthe problem persists, please contact
support.

The system runs normally.
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12.1.4 System Log

If ISPSoft is connected to an AS Series, you can view actions and errors in the AS Series by clicking System Log on the
PLC menu. The CPU can store up to 20 error log sets. After the 20 sets are stored, the 1% log is replaced with the 215t if
there are new logs coming in, and the old logs are replaced with the new ones sequentially. When the memory card is
installed in the CPU module, 20 sets of the old logs are backed up in the memory card and up to 1000 logs can be
recorded. If the stored logs exceed 1000, the oldest 20 logs are replaced with the newest 20 logs in the memory card.

(1) On the PLC menu, click System Log.

T

LC | Tools Window Help

=1

Transfer 3
Systemn Seourity ]
Fon Ctrl+F11
Stap Cirl+F12

Cnline Maode Ctrl+Fd
Hewr Devices Table

EmY 09

Fonnat PLC Memory...

System Log |

Srstemn Informmaly \1+A1t+1

(2) The System Log window appears. Click Clear Log to clear the error log in the window and the error log in the CPU
module, and reset the CPU module.

System Log x|
EmorLog | Program Change Log I Status Change Log I
Group No | Module No | PLC/Module Name | Error Code Date & Time
1 0 AS332P 1626012 0-1-1 0:0:14 3001Er6012
1 0 AS33P 1622003 16-8-31 17297 3001Ee2003
| | >
Befresh Cancel

® Group No.: The number 1 indicates that the error occurred in the CPU module or the right-side module 1. The
numbers 2-16 indicate the error occurred in the remote modules 1-15.

® Module No.: The number 0 indicates that the error occurred in the CPU module or the remote module. The
numbers 1-32 indicate the error occurred in the right-side module of the CPU module / remote module.
The number 1 represents the closest module to the CPU module or the remote module. This number
increases from the closest to the furthest from the CPU module or the remote module. Note: up to
eight extension modules can be connected to the right-side of the remote module.

® PLC/Module name: Model names of the CPU, remote, and extension modules.
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® Error Code: Error codes in the error log.

® Date & Time: The date and time the error occurred. The most recently occurring error is listed on the top.

® The last column shows the descriptions for the error.

12.2 Troubleshooting for CPU Modules

Check the LED indicators and the error codes from the CPU module and refer to the following table for troubleshooting. V

in the Log column indicates the error is recorded in the log. X in the Log column indicates the error is not recorded in the

log. H in the Log column indicates whether or not you can set recording the error in the log in HWCONFIG.

12.2.1 ERROR LED Indicators Are ON

Error

Code Description Solution Flag | Log

(16#)

) 1. Check the setting of the watchdog timer in HWCONFIG.
000A |Scan timeout . SM8 | V
2. Check whether the program causes a long scan time
12.2.2 ERROR LED Indicators Blinking Every 0.5 Seconds

Error

Code Description Solution Flag | Log

(16#)

0ooC The program in the PLC is Download the program again. SM9 | V
damaged.

0010 CPU memory is denied. Contact the factory. SM9 | V

002E CPL_J external memory access is Contact the factory. SM9 | V
denied.

002F P!'C programs are not consistent Download the program again. SM34| V
with the system logs.
The ar.rangement. of the functlon Check whether the settings in HWCONFIG are consistent

0070 cards is not consistent with the . . SM10| V

) with the arrangement of the function cards.

settings.
The interrupt number exceeds the Check the program, compile the program again, and

0102 . SM5 | X
range. download the program again.
The MC instruction exceeds the Check the program, compile the program again, and

0202 . SM5 | X
range. download the program again.
The MCR instruction exceeds the Check the program, compile the program again, and

0302 . SM5 | X
range. download the program again.
The operands used in DHSCS are Check the program, compile the program again, and

0DO03 . SM5 | X
not used properly. download the program again.
The operands HCXXX used in Check the program, compile the program again, and

OEO05 . SM5 | X
DCNT are not used properly. download the program again.

1300 . . . .
Errors occurred in the remote Refer to Section 12.3.4 for more information on the error

- SM30| V
130F modules codes for the remote modules.
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Error
Code Description Solution Flag | Log
(16#)
The arrangement of the /0 modules| Check whether the settings in HWCONFIG are consistent
1402 . : i ) ) SM10| V
is not consistent with the settings. with the arrangement of the 1/0 modules.
1408 More than four communication Check the tqtal number of communication modules smio! v
modules. (maximum is four).
140D More than 32 extension modules. iCsth?)ezc)k the total number of extension modules (maximum smio! v
140E More than eight remote modules on | Check the total number of remote modules on the right sm3o | v
the right side of the CPU module. side of the CPU module (maximum is 8).
Th tensi dule ID d 1. Make sure the module is properly connected to the
1600 theerz)r(1 eensmn module [L exceeds CPU module and turn the modules on again. SM10| V
ge- 2. If the error still occurs, contact the factory.
Th tensi dule ID b 1. Make sure the module is properly connected to the
1601 sete extension moduie 1L cannot be CPU module and turn the modules on again. SM10| V
' 2. If the error still occurs, contact the factory.
Th tensi dule ID i 1. Make sure the module is properly connected to the
1602 due"i);tzgslon module I 1S CPU module and turn the modules on again. SM10| V
P ' 2. If the error still occurs, contact the factory.
Th tensi dul b 1. Make sure the module is properly connected to the
1603 o Zrz(e?jns'on module cannot be CPU module and turn the modules on again. SM10| V
P ' 2. If the error still occurs, contact the factory.
Extensi aul icati 1. Make sure the module is properly connected to the
1604 tirﬁsgjlon module communication CPU module and turn the modules on again. SM10| V
2. If the error still occurs, contact the factory.
1605 Hardware failure Contact the factory. SM10| V
Errors on the communication Make sure the function card is properly connected to the
1606 ; . SM10| V
module function card CPU module and turn the modules on again.
1607 The external voltage is abnormal. Check whether the external 24 V power supply to the SM10| V
module is normal.
1608 The Ihternal factory calibration or the Contact the factory,. smio! v
CJC is abnormal.
1609
- Reserved (Error codes for the extension modules)
160F
200A Invalid instruction Check the program, compllg the program again, and sms | v
download the program again.
6010 The number of MODBUS TCP Check the number of superior devices (maximum is 32). SM \%
connections exceeds the range. 1092
6011 The ”””.‘be' of EtherNeIP Check the number of connections (maximum is 16). SM \%
connections exceeds the range. 1093
C000 )
L Save the PLC program and hand the file to the company
- The program syntax is incorrect. g
CFFF or the technicians.
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12.2.3 ERROR LED Indicators Blinking Rapidly Every 0.2 Seconds

This happens when the power supply 24 VDC of the CPU module is disconnected, or the power supply is not sufficient,
not stable or abnormal.

Error
Code Description Solution Flag | Log
(16#)

Check whether the external 24 V power supply to the

. SM7 |V
module is normal.

002A The external voltage is abnormal.

12.2.4 ERROR LED Indicators Slow Blinking Every 3 Seconds and
Lighting up for 1 Second

Error
Code Description Solution Flag | Log
(16#)
1500 Connection lost in the remote Check the network connection cable. SM30 | V
modules
1502 . . . .
Errors occurred in the remote Refer to Section 12.3.4 for more information on the SM30 |V
150F modules remote module error codes.
1800 . . . . .
Errors occurred in the extension Refer to Section 12.3 for more information on the SM10 |V
180F modules extension module error codes.
1900 1. Check the CANopen connection cable.
i Heartbeat errors occurred in the 2. Check if the specific slave is working properly. . v
191C slave for the Delta ASD-A2 control. | Note: The last 2 digits of the error code represent the 1D
number of the slave (convert hexadecimal to decimal).

12.2.5 BAT. LOW LED Indicators Are ON

This happens when there is no battery (CR1620) or the power is low. Turn this option off in the HWCONFIG > CPU >
Device Setting > Show Battery Low Voltage Error CPU when you don't need the RTC function to keep track of the current
time (default is enabled).

Error

Code Description Solution Flag | Log
(16#)

0027 Battery Low Change battery or turn this option off SM219| X

12.2.6 BAT. LOW LED Indicators Blinking Every 0.5 Seconds

This happens when RTC cannot keep track of the current time.

Error

Code Description Solution Flag | Log

(16#)

0026 | RTC cannotkeep track of the Contact the factory. SM218| V
current time
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12.2.7 The LED RUN and ERROR Indicators are Blinking Simultaneously
Every 0.5 Seconds

This happens when the firmware of the CPU module is being upgraded. If this happens once the power is supplied to the
CPU module, it means errors occurred during the previous firmware upgrade. Users need to upgrade the firmware again
or contact your point of purchase.

12.2.8 The RUN and LED Indicators are Blinking One After Another Every
0.5 Seconds.

This happens when the CPU module memory card is backing up, restoring, or saving.

12.2.9 Other Errors (Without LED Indicators)

Error
Code Description Solution Flag |Log
(16#)
0011 | The PLC ID is incorrect. Check the PLC ID. SM34 \%
0012 | The PLC password is incorrect. Check the PLC password. SM34 \%
002D The PLC maximum password attempts Rgset the CPU module or restore the CPU module SM34 Vv
exceeded. to its factory settings.
1. Reset the CPU module or restore the CPU
The memories in the latched special module to its factory settings, and then download
0050 . . SM6 \%
auxiliary relays are abnormal. the program and the parameters again.
2. If the error still occurs, contact the factory.
1. Reset the CPU module or restore the CPU
The latched special data registers are module to its factory settings, and then download
0051 . SM6 \%
abnormal. the program and the parameters again.
2. If the error still occurs, contact the factory.
1. Reset the CPU module or restore the CPU
The memories in the latched auxiliary module to its factory settings, and then download
0052 . SM6 \%
relays are abnormal. the program and the parameters again.
2. If the error still occurs, contact the factory.
1. Reset the CPU module or restore the CPU
module to its factory settings, and then download
0054 | The latched counters are abnormal. . SM6 \%
the program and the parameters again.
2. If the error still occurs, please contact the factory.
1. Reset the CPU module or restore the CPU
The latched 32-bit counters are module to its factory settings, and then download
0055 . SM6 \%
abnormal. the program and the parameters again.
2. If the error still occurs, contact the factory.
1. Reset the CPU module or restore the CPU
The latched special auxiliary relay is module to its factory settings, and then download
0056 . SM6 \Y,
abnormal. the program and the parameters again.
2. If the error still occurs, contact the factory.
1. Reset the CPU module or restore the CPU
The latched data registers are module to its factory settings, and then download
0059 . SM6 \%
abnormal. the program and the parameters again.
2. If the error still occurs, contact the factory.
005D | The CPU module does not detect a Check that the memory card is inserted correctly SM453 | V
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memory card.

into the CPU module.

The memory card is initialized

005E | . Check whether the memory card is broken. SM453 | V
incorrectly.
0063 An error occurs when data is written to | Check whether thg file path I-S cprrect or whether sMas3 | v
the memory card. the memory card is malfunctioning.
0064 A file in the memory card cannot be Che(_:k Yvhether the file path is correct, or whether sMas3 | v
read. the file is damaged.
The initialization of the Delta ASD-A2 1. Check the CANopen connection cable.
1950 control has not yet been completed, the | 2. Check if the specific slave is working properly. v
CANopen instructions cannot be 3. If nothing is wrong, initialize the Delta ASD-A2
executed. again.
Not using the FCOMP card or not in the
right mode for the ASDA-A2 while using | Use the FCOMP card in the function card slot to
2001 L . . . SMO \Y,
the CANopen communication check if the operation mode is correct.
instruction.
The device used in the program Check the program, compile the program again,
2003 . . SMO \Y,
exceeds the device range. and download the program again.
The operand n or the other constant Check the program, compile the program again,
200B . SMO \Y,
operands K/H exceed the range. and download the program again.
200C | The operands overlap. Check the program, compile thg program again, SMO v
and download the program again.
The binary to binary-coded decimal Check the program, compile the program again,
200D ST . SMO \Y,
conversion is incorrect. and download the program again.
200E | The string does not end with 00. Check the program, compile th? program again, SMO \%
and download the program again.
2012 | Incorrect division operation Check the program, compile th? program again, SMO \%
and download the program again.
The value exceeds the range of values Check the program, compile the program again
2013 | that can be represented by the program, P . prog gan, SMO Y,
. . and download the program again.
floating-point numbers.
The task designated by the TKON or Check the program, compile the program again,
2014 | YKOFF instruction is incorrect or and download the program again. SMO \Y
exceeds the range.
2017 The instruction BREAK is written outside| Check the program, compile the program again, SMO v
of the FOR-NEXT loop. and download the program again.
1. Check the program, compile the program again,
No such position planning table number prog P _p g g
2027 L and download the program again. SMO \V/
or the format is incorrect. . o .
2. Check the settings of the position planning table.
High speed output |r?struct|9n Is being Refer to SR28 for the record of the axis number and
2028 | executed. Only one instruction can be - \%
. rearrange the output control procedures.
executed at a time.
_— . Set the Ethernet parameter for the CPU module in
6004 | The IP address filter is set incorrectly. HWCONFIG again. SM1108| X
600D | RJ45 port is not connected. Check the connection. SM1100| X
1. Check if there are devices using the same IP
i i address.
6012 There are devices using the same IP : . sMm1101| VvV
address. 2. Check if there is more than 1 DHCP or BOOTP
server on the network.
Retry the email connection later. This error does not
6100 | The email connection is busy. cause the PLC to stop running. Solve the problem |SM1113| X

by means of the related flag in the program.
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The trigger attachment mode in the

6103 - .
email is set incorrectly.

Set up the trigger attachment mode in HWCONFIG
> CPU Module > Device Setting > Options >
Ethernet Port Advanced > Email > Trigger Setting >
Trigger Attachment Mode.

SM1113

The attachment in the email does not

6104 .
exist.

Check whether the attachment exists in the
memory card.

SM1113

The attachment in the email is

6105 )
oversized.

Check the size of the attachment. If the size is over
2 MB, the file cannot be sent as an attachment.

SM1113

There is an SMTP server response

6106 .
timeout.

Check for the correct address and set up the SMTP
server in HWCONFIG > CPU Module > Device
Setting > Options > Ethernet Port Advanced >
Email again.

SM1113

There is an SMTP server response

6107 .
timeout.

1. Check whether the status of the SMTP server is
normal.

2. Retry sending of the email later. This error does
not cause the PLC to stop running. Solve the
problem by means of the related flag in the
program.

SM1113

6108 SMTP verification failed

Check for the correct ID/Password and set up in
HWCONFIG > CPU Module > Device Setting >
Options > Ethernet Port Advanced > Email again.

SM1113

The remote communication IP address

6200 set in the TCP socket function is illegal.

1. Check the program and the related special data
registers.

2. Set the Ethernet parameter for the CPU module
in HWCONFIG CPU Module > Device Setting >
Options > Ethernet Port Advanced > TCP
Socket.

The local communication port set in the

6201 TCP socket function is illegal.

1. Check the program and the related special data
registers.

2. Set the Ethernet parameter for the CPU module
in HWCONFIG CPU Module > Device Setting >
Options > Ethernet Port Advanced > TCP
Socket.

The remote communication port set in

6202 the TCP socket function is illegal.

1. Check the program and the related special data
registers.

2. Set the Ethernet parameter for the CPU module
in HWCONFIG CPU Module > Device Setting >
Options > Ethernet Port Advanced > TCP
Socket.

The device from which the data is sent

6203 in the TCP socket function is illegal.

1. Check the program and the related special data
registers.

2. Set the Ethernet parameter for the CPU module
in HWCONFIG CPU Module > Device Setting >
Options > Ethernet Port Advanced > TCP
Socket.

The device which receives the data in

6206 the TCP socket function is illegal.

1. Check the program and the related special data
registers.

2. Set the Ethernet parameter for the CPU module
in HWCONFIG CPU Module > Device Setting >
Options > Ethernet Port Advanced > TCP
Socket.
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6208

The data received through the TCP
socket exceeds the device range.

1. Check the program and the related special data
registers.

2. Set the Ethernet parameter for the CPU module
in HWCONFIG CPU Module > Device Setting >
Options > Ethernet Port Advanced > TCP
Socket.

6209

The remote communication IP address
set in the UDP socket function is illegal.

1. Check the program and the related special data
registers.

2. Set the Ethernet parameter for the CPU module
in HWCONFIG CPU Module > Device Setting >
Options > Ethernet Port Advanced > UDP
Socket.

620A

The local communication port set in the
UDP socket function is illegal.

1. Check the program and the related special data
registers.

2. Set the Ethernet parameter for the CPU module
in HWCONFIG CPU Module > Device Setting >
Options > Ethernet Port Advanced > UDP
Socket.

620C

The device from which the data is sent
in the UDP socket function is illegal.

1. Check the program and the related special data
registers.

2. Set the Ethernet parameter for the CPU module
in HWCONFIG CPU Module > Device Setting >
Options > Ethernet Port Advanced > UDP
Socket.

620F

The device which receives the data in
the UDP socket function is illegal.

1. Check the program and the related special data
registers.

2. Set the Ethernet parameter for the CPU module
in HWCONFIG CPU Module > Device Setting >
Options > Ethernet Port Advanced > UDP
Socket.

6210

The data received through the UDP
socket exceeds the device range.

1. Check the program and the related special data
registers.

2. Set the Ethernet parameter for the CPU module
in HWCONFIG CPU Module > Device Setting >
Options > Ethernet Port Advanced > UDP
Socket.

6212

There is no response from the remote
device after the timeout period.

Make sure that the remote device is connected.

6213

The data received exceeds the limit.

1. Check the program and the related special data
registers.

2. Set the Ethernet parameter for the CPU module
in HWCONFIG CPU Module > Device Setting >
Options > Ethernet Port Advanced > UDP
Socket.

6214

The remote device refuses the
connection.

Make sure the remote device operates normally.

6215

The socket is not opened.

Check whether operational sequence in the
program is correct.

6217

The socket is opened.

Check whether operational sequence in the
program is correct.

6218

The data has been sent through the
socket.

Check whether operational sequence in the
program is correct.

6219

The data has been received through the

Check whether operational sequence in the
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socket.

program is correct.

Check whether operational sequence in the

621A | The socket is closed. .
program is correct.
. L ) 1. Check the communication setting in the master
The device communication function
7011 . o and the slave.
code in COML1 is incorrect. L
2. Check the communication cable.
. L 1. Check the communication setting in the master
The device communication address
7012 . . and the slave.
used in COML1 is incorrect. L
2. Check the communication cable.
. ) 1. Check the communication setting in the master
The device used in COM1 exceeds the
7013 . and the slave.
device range. N
2. Check the communication cable.
. L 1. Check the communication setting in the master
The device length of the communication
7014 . L and the slave.
data in COM1 exceeds the limit. L
2. Check the communication cable.
The device checksum for the 1. Check the communication setting in the master
7017 | communication serial port of COM1 is and the slave.
incorrect. 2. Check the communication cable.
. L . 1. Check the communication setting in the master
The device communication function
7021 . . and the slave.
code in COM2 is incorrect. L
2. Check the communication cable.
. L 1. Check the communication setting in the master
The device communication address
7022 . . and the slave.
used in COM2 is incorrect. L
2. Check the communication cable.
. . 1. Check the communication setting in the master
The device used in COM2 exceeds the
7023 . and the slave.
device range. L
2. Check the communication cable.
) L 1. Check the communication setting in the master
The device length of the communication
7024 } o and the slave.
data in COM2 exceeds the limit. L
2. Check the communication cable.
The device checksum for the 1. Check the communication setting in the master
7027 | communication serial port of COM2 is and the slave.
incorrect. 2. Check the communication cable.
. L . 1. Check the communication setting in the master
The device communication function
7031 . . and the slave.
code in the Ethernet is incorrect. L
2. Check the communication cable.
. L 1. Check the communication setting in the master
The device communication address
7032 . L and the slave.
used in the Ethernet is incorrect. L
2. Check the communication cable.
. . 1. Check the communication setting in the master
The device used in the Ethernet
7033 . and the slave.
exceeds the device range. N
2. Check the communication cable.
. L 1. Check the communication setting in the master
The device length of the communication
7034 - . and the slave.
data in the Ethernet exceeds the limit. L
2. Check the communication cable.
The device checksum for the 1. Check the communication setting in the master
7037 communication serial port of the and the slave.
Ethernet is incorrect. 2. Check the communication cable.
. L ) 1. Check the communication setting in the master
The device communication function
7041 and the slave.

code in the USB is incorrect.

. Check the communication cable.
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. L . Check the communication setting in the master
The device communication address
7042 . . and the slave. H
used in the USB is incorrect. L
2. Check the communication cable.
. . 1. Check the communication setting in the master
The device used in the USB exceeds
7043 . and the slave. H
the device range. L
2. Check the communication cable.
) L 1. Check the communication setting in the master
The device length of the communication
7044 . o and the slave. H
data in the USB exceeds the limit. o
2. Check the communication cable.
The device checksum for the 1. Check the communication setting in the master
7047 communication serial port of the USB is and the slave. H
incorrect. 2. Check the communication cable.
. L ) 1. Check the communication setting in the master
The device communication function
70B1 ) . o and the slave. H
code in function card 1 is incorrect. L
2. Check the communication cable.
. L 1. Check the communication setting in the master
The device communication address
70B2 ) . o and the slave. H
used in function card 1 is incorrect. L
2. Check the communication cable.
. ) . 1. Check the communication setting in the master
The device used in the function card 1
70B3 . and the slave. H
exceeds the device range. N
2. Check the communication cable.
. L 1. Check the communication setting in the master
The device length of the communication
70B4 - . . and the slave. H
data in function card 1 exceeds the limit. L
2. Check the communication cable.
The device checksum for the 1. Check the communication setting in the master
70B7 | communication serial port of function and the slave. H
card 1 is incorrect. 2. Check the communication cable.
. L ) 1. Check the communication setting in the master
The device communication function
70C1 ) . o and the slave. H
code in function card 2 is incorrect. L
2. Check the communication cable.
. L 1. Check the communication setting in the master
The device communication address
70C2 . ) . and the slave. H
used in function card 2 is incorrect. L
2. Check the communication cable.
. . . 1. Check the communication setting in the master
The device used in function card 2
70C3 . and the slave. H
exceeds the device range. L
2. Check the communication cable.
) L 1. Check the communication setting in the master
The device length of the communication
70C4 . ) . and the slave. H
data in function card 2 exceeds the limit. L
2. Check the communication cable.
The device checksum for the 1. Check the communication setting in the master
70C7 | communication serial port of function and the slave. H
card 2 is incorrect. 2. Check the communication cable.
1. Refer to the function codes defined by the
communication protocols.
. Check if the product firmware and the software
7203 Invalid communication function code used are the most update.d Versions. H
. Make a note of the operation procedures and
screenshots of the error windows and hand this
note to the company or the technicians from the
agents.
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1. Download the program and parameters again.

The contents of the program 3. gheck Itlhicommunlcatlcdm cable. ) '

8105 | downloaded are incorrect. s ave all the projects ap compress the prc.)JeF:ts i H

The program svntax is incorrect into one compressed file and then hand this file
prog 4 ' to the company or the technicians from the

agents.

N

1. Download the program and parameters again.

The contents of the program . .
2. Save all the projects and compress the projects

downloaded are incorrect.

8106 . into one compressed file and then hand this file - H
The length of the execution code .
L to the company or the technicians from the
exceeds the limit.
agents.

1. Download the program and parameters again.
The contents of the program Ith . q h .
downloaded are incorrect. 2. .Save all the projects ap compress the prcl)je.cts
8107 into one compressed file and then hand this file - H
The length of the source code exceeds .

- to the company or the technicians from the

the limit.
agents.

1. Check if the product firmware and the software
used are the most updated versions.

Errors occur between software and 2. Make a note of the operation procedures and

PLC. screenshots of the error windows and hand this

note to the company or the technicians from the

agents.

8000

8FFF

12.3 Troubleshooting for I/0 Modules

o Introduction to troubleshotting modules

Digital I/O, analog 1/O, temperature measurement, load cell, and network modules can be installed in an AS Series
system. There are 2 types of error codes; error and warning. The CPU module and its modules stop operating when
errors occur. The CPU modules and its modules do not stop operating when warnings are triggered.

12.3.1 Troubleshooting for Analog Modules (AD/DA/XA) and
Temperature Modules (RTD/TC)

12.3.1.1 ERROR LED Indicators Are ON
You can set up HWCONFIG to have the following errors appear as warnings when they occur. Otherwise, when an error
occurs, only an error message appears.

Error . .
Description Solution
Code P
16#1605 Hardware failure Contact the factory.
16#1607 The external voltage is abnormal. Check the power supply.
1641608 The factory calibration or the CJC is Contact the factory.
abnormal.
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12.3.1.2 ERROR LED Indicators Blinking Every 0.5 Seconds
The following errors are specified as warnings to ensure that the CPU module can still run even when the warnings are

triggered by its AIO modules. The following first 4 error codes are set as warnings by default in HWCONFIG; CPU must

STOP running immediately when the first 4 errors occur.

Error o .
Code Description Solution

16#1801 The external voltage is abnormal. Check the power supply.

16#1802 Hardware failure Contact the factory.

16#1804 The factory calibration is abnormal. Contact the factory.

16#1807 The CJC is abnormal. Contact the factory.

16#1808 The signal received .by channel 1 exceeds Check the signal received by channel 1
the range of analog inputs (temperature).

16#1809 The signal received _by channel 2 exceeds Check the signal received by channel 2
the range of analog inputs (temperature).

16#180A The signal received _by channel 3 exceeds Check the signal received by channel 3
the range of analog inputs (temperature).

16#180B The signal received _by channel 4 exceeds Check the signal received by channel 4
the range of analog inputs (temperature).

16#180C The signal received _by channel 5 exceeds Check the signal received by channel 5
the range of analog inputs (temperature).

16#180D The signal received _by channel 6 exceeds Check the signal received by channel 6
the range of analog inputs (temperature).

16#180E The signal received _by channel 7 exceeds Check the signal received by channel 7
the range of analog inputs (temperature).

16#180F The signal received .by channel 8 exceeds Check the signal received by channel 8
the range of analog inputs (temperature).

12.3.2 Troubleshooting for the Load Cell Module AS02LC

12.3.2.1 ERROR LED Indicators Are ON

You can set up HWCONFIG to have the following errors appear as warnings when they occur. Otherwise, when an error

occurs, only an error message appears.

Error . .
Code Description Solution
16#1605 Hardware failure (that is, the driver board) Contact the factory.
16#1607 The external voltage is abnormal. Check the power supply.

12.3.2.2 ERROR LED Indicators Blinking Every 0.5 Seconds
The following errors are specified as warnings to ensure that the CPU module can still run even when the warnings are
triggered by its AIO modules. The following first 3 error codes are set as warnings by default in HWCONFIG; CPU must

STOP running immediately when the first 3 errors occur.

(E:Lrg(; Description Solution
16#1801 The external voltage is abnormal. Check the power supply.
16#1802 Hardware failure Contact the factory.

16#1807 Diver board failure Contact the factory.
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Error o .
Code Description Solution
The signal received by channel 1 exceeds . .
1641808 the range of analog inputs or the SEN Check the signal received by channel 1 and the cable
. connections.
voltage is abnormal.
1641809 The signal received by channel 1 exceeds Check the value input to channel 1 and the maximum
the weight limit. weight setting.
16#180A The factory calibration in channel 1 is Check the weight calibration in channel 1.
incorrect.
The signal received by channel 2 exceeds . .
1641808 the range of analog inputs or the SEN Check the signal received by channel 2 and the cable
. connections.
voltage is abnormal.
The signal received by channel 2 exceeds Check the value input to channel 2 and the maximum
16#180C - o . .
the weight limit. weight setting.
16#180D ;ii:::tfry calibration in channel 2 is Check the weight calibration in channel 1.

12.3.3 Troubleshooting for the Module ASO0OSCM as a Communication

Module

12.3.3.1 ERROR LED Indicator Are ON
The following error codes identify possible errors when the ASOOSCM module is installed on the right side of the CPU

module and acts as a communication module.

CE::;); Description Solution
1641605 | Hardware failure 1. Check that the module is securely installed.
2. Install a new ASOOSCM or contact the factory.
1. Check if the function card is securely installed.
2. Install a new function card or contact the factory.
16#1606 | The function card setting is incorrect. 3. Check if the setting in HWCONFIG is consistent with
the function card setting.
4. Install a new ASOOSCM or contact the factory.

12.3.3.2 ERROR LED Indicators Blinking Every 0.5 Seconds
The following error codes identify possible errors when the ASO0OSCM modaule is installed on the right side of the CPU
module and acts as a communication module.

Error L. .
Description Solution
Code P
1641802 | Incorrect parameters Check the para_lmeter in HWCONFIG. Download the
parameter again.
1. Check whether the communication cable is properly
connected.
1641803 | Communication timeout 2. Check if the station number and the communication
format are correctly set.
3. Check if the connection with the function card is
working correctly.
. L 1. Check the settings of the UD Link.
16#1804 | The UD Link setting is incorrect. ! .g . ] I
2. Check the warning settings in the PLC.
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The following error codes can only be viewed with SCMSoft; when the following errors occur, they are not shown on the
LED indicators and the system does not send the error messages to the CPU module.

Error A .
Description Solution
Code P
The settings in HWCONFIG and manual Check the settings in HWCONFIG and manual settings
16#0107 settings are not consistent with function card | for function card 1.
1.
The settings in HWCONFIG and manual Check the settings in HWCONFIG and manual settings
16#0108 settings are not consistent for function card for function card 2.
2.

Check the parameter in HWCONFIG. Download the

parameter again.

1. Check if the station number and the communication
format are correctly set.

2. Check if the connection with the function card is
working correctly.

16#0201 | Incorrect parameters

16#0301 | Function card 1 communication timeout

1. Check if the station number and the communication
format are correctly set.

2. Check if the connection with the function card is

working correctly.

Check the UD Link settings.

Check the warning settings in the PLC.

Check the UD Link settings.

Check the warning settings in the PLC.

Check the UD Link settings.

Check the warning settings in the PLC.

Check the UD Link settings.

Check the warning settings in the PLC.

16#0302 | Function card 2 communication timeout

16#0400 | Invalid UD Link Group ID for function card 1

16#0401 | Invalid UD Link Group ID for function card 2

16#0402 Invalid UD Link Command for function card 1

16#0403 | Invalid UD Link Command for function card 1

A I S L A

12.3.4 Troubleshooting for the Module ASOOSCM as a Remote Module

Errors from the remote modules are regarded as warnings for AS Series CPU modules. The LED indicator of the CPU
module blinks and the CPU module can still operate. Use flag SM30 to manage error presentation in the remote modules.

12.3.4.1 ERROR LED Indicators Are ON
Error codes:

Error R .
Description Solution
Code .
1. Check if the module is securely installed.
16#1301 | Hardware failure 2. Change and install a new ASOOSCM or contact the

factory.

1. Check if the function card is securely installed with
the AS-FCOPM card.

2. Change and install a new function card or contact the

16#1302 | The function card setting is incorrect. factory.

3. Check if the setting in HWCONFIG is consistent with
the function card setting.

4. Install a new ASOOSCM or contact the factory.
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12.3.4.2 ERROR LED Indicators Blinking Every 0.5 Seconds
Error codes:

Error
Code

Description Solution

16#1502 | Incorrect parameters

Check the parameter in HWCONFIG. Download the
parameter again.

16#1503 Extension module communication timeout

Make sure the module is properly connected to the CPU
module and turn the modules on again.

12.3.4.3 ERROR LED Indicators Blinking Every 0.2 Seconds
This happens when the 24 VDC power supply for the remote module is not sufficient. Check the power supply. If the
power supply is normal, remove the extension module from the CPU module and then check if the SCM remote module is

out of order. Error codes:

Error A .
Description Solution
Code P
24VDC power supply is not sufficient and Check whether the 24 V power supply to the module is
16#1303 | then recovered from low-voltage for less normal.
than 10 ms.

12.3.5 Troubleshooting for ASO1DNET Modules

Refer to sections 12.4.6 and 12.4.7 for more detalils.

12.4Error Codes and LED Indicators for CPU Modules

A. Columns

a.

b.

Error code: If an error occurs in the system, an error code is generated.
Description: The description of the error

CPU status: If the error occurs, the CPU stops running, keeps running, or shows the status you defined for the

error.
» Stop: The CPU stops running when the error occurs.

» Continue: The CPU keeps running when the error occurs.

LED indicator status: If the error occurs, the LED indicator is ON, OFF, or blinks.

» ERROR: System error

° Descriptions

Module Type | LED indicator Descriptions

There are five types of error indicator states for of the CPU module errors, including
LED indicator ON, OFF, blinking fast, blinking normally, and blinking slowly. When
the LED indicator is ON, blinking fast/normally, clear the problems first in order to
run the CPU module. When the LED indicator is blinking slowly, indicating a

CPU Error LED warning type of error codes, it does not require immediate action. Clear the

problems when the module is powered off.

Error type:
ON: A serious error occurs in the module.
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Module Type | LED indicator Descriptions

Blinking fast (every 0.2 seconds): unstable power supply or hardware
Failure.

Blinking normally (every 0.5 second): system program errors or system
cannot run.

Warning type:
Blinking slowly (every one second and off for three seconds): a warning is
triggered, but the system can still run.
OFF: a warning is triggered, but the system can still run. You can modify the rules
of how a warning is triggered, or use the SM/SR to show the warnings.

12.4.1 Error Codes and LED Indicators for CPU Modules

Note: refer to Section 12.3 for the status descriptions of the Error LED indicators.

ERROR LED indicator status
Error o CPU
Description —
code status Blinking | Blinking | Blinking
ON OFF
fast | normally| slowly

000A |Scan timeout Stop \
000C | The program in the PLC is damaged. Stop \%
0010 The access to the memory in the CPU is denied. Stop \%
0011 |The PLC ID is incorrect. Continue \Y,
0012 |The PLC password is incorrect. Continue \Y,

RTC cannot keep track of the current time (the .
0026 battery LED is blinking.) Continue
0027 Battery low (the battery LED is ON.) Continue
002A 24VDC power supply is not sufficient and then is Continue Y

recovered from low-voltage for less than 10 ms.
002D | The PLC maximum password attempts exceeded. Continue \%
002E The. access to the external memory of the CPU is Stop v

denied.
002F PLC programs are not consistent with the system Stop v

logs.
0050 The memories in the latched special auxiliary relays Continue v

are abnormal.
0051 The latched special data registers are abnormal. Continue \%
0052 The memories in the latched auxiliary relays are Continue v

abnormal.
0054 The latched counters are abnormal. Continue \Y
0055 The latched 32-bit counters are abnormal. Continue \Y
0056 The latched special auxiliary relay is abnormal. Continue \%
0059 The latched data registers are abnormal. Continue \%
005D | The CPU module does not detect a memory card. Continue \%
005E The memory card is initialized incorrectly. Continue \%
0063 ﬁ:rsrror occurs when data is written to the memory Continue Y
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ERROR LED indicator status
Error . CPU
Description T
code status Blinking | Blinking | Blinking
ON OFF
fast | normally| slowly
0064 Afile in the memory card cannot be read. Continue \%
0070 The gctual a.rrangemer?t of the function cards is not Stop v
consistent with the settings.
0102 The interrupt number exceeds the range. Stop \%
0202 The MC instruction exceeds the range. Stop \%
0302 The MCR instruction exceeds the range. Stop \%
0D03 The operands used in DHSCS are not used Stop v
properly.
0EO5 The operands HCXXX used in DCNT are not used Stop v
properly.
1300
- Errors occurred in the remote modules Continue \%
130F
1402 The f_irrangernent of the_ I/O modules is not Stop v
consistent with the settings.
1408 Number of communication modules exceeds the Stop v
limit of four.
140D Number of extension modules exceeds the limit of Stop v
32.
Number of remote modules exceeds the limit of
140E . . . Sto \Y,
eight on the right side of the CPU module. P
1500 Connection lost in the remote modules Continue \%
1502
- Errors occurred in the remote modules Continue \%
150F
1600 The ID of the extension module exceeds the range. Stop \%
1601 The ID of the extension module cannot be set. Stop \%
1602 The ID of the extension module is duplicated. Stop \%
1603 The extension module cannot be operated. Stop \%
1604 Extension module communication timeout Stop \%
1605 Hardware failure Stop \%
1606 Errors on the communication module function card Stop \%
1607 The external voltage is abnormal. Stop \%
1608 The Internal factory calibration or the CJC is Stop v
abnormal.
1609
- Reserved (Error codes for the extension modules) Stop \%
160F
1800
- Errors occurred in the extension modules Continue \%
180F
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ERROR LED indicator status

Error . CPU
Description T
code status Blinking | Blinking | Blinking
ON OFF
fast | normally| slowly
1900 .
Heartbeat errors occurred in the slave of the Delta .
§ ASD-A2 control Continue v
191C '
The initialization of the Delta ASD-A2 control has
1950 not yet been completed, the CANopen instructions | Continue \%
cannot be executed.
Not using the FCOMP card or not in the right mode
2001 for the ASDA-A2 while using the CANopen| Continue \%
communication instruction.
2003 The device used in the program exceeds the device Continue Y
range.
200A Invalid instruction Stop \%
200B The operand n or the other constant operands K/H Continue Y
exceed the range.
200C The operands overlap. Continue \%
200D The binary to binary-coded decimal conversion is Continue v
incorrect.
200E The string does not end with 00. Continue \%
2012 Incorrect division operation Continue \%
2013 The value exceeds the rar\ge of.values which can Continue v
be represented by the floating-point numbers.
2014 The ta;k .de.5|gnated by the TKON or YKOFF Continue v
instruction is incorrect, or exceeds the range.
The instruction BREAK is written outside of the .
2017 FOR-NEXT loop. Continue \%
2027 No sut?h_ position planning table number or the Continue Y
format is incorrect.
The high speed output instruction is being
2028 executed. Only one instruction can be executed ata, Continue \%
time.
6004 The IP address filter is set incorrectly. Continue \%
600D RJ45 port is not connected. Continue \%
6010 The number of the MODBUS TCP connections Continue Y
exceeds the range.
6011 The number of the EtherNet/IP connections Continue Y
exceeds the range.
6012 There are devices using the same IP address. Continue \%
6100 The email connection is busy. Continue \%
6103 The trigger attachment mode in the email is set Continue v
incorrectly.
6104 The attachment in the email does not exist. Continue \Y,
6105 The attachment in the email is too big. Continue \%
6106 There is an SMTP server response timeout. Continue \%
6107 There is an SMTP server response timeout. Continue \%
6108 SMTP verification failed Continue \%
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ERROR LED indicator status
Error . CPU
Description T
code status Blinking | Blinking | Blinking
ON OFF
fast | normally| slowly

6200 The remote comlmur.nc.atlon IP address set in the Continue Vv
TCP socket function is illegal.

6201 The Ipca! cpmmunlcatlon port set in the TCP socket Continue Vv
function is illegal.

6202 The remote. cqmmunlcatlon port set in the TCP Continue Vv

m socket function is illegal.

6203 The device from WhICh the data is sent in the TCP Continue Vv
socket function is illegal.

6206 The (_jeV|Fe_ that receives the data in the TCP socket Continue v
function is illegal.

6208 The data that |s_ received through the TCP socket Continue v
exceeds the device range.

6209 The remote com_mur.uc_atlon IP address set in the Continue v
UDP socket function is illegal.

620A The I_oca.l c_ommunlcatlon port set in the UDP socket Continue v
function is illegal.

620C The device Trom v_vhlch the data is sent in the UDP Continue v
socket function is illegal.

620F The (_jeV|F:e_ that receives the data in the UDP socket Continue v
function is illegal.

6210 The data that |s. received through the UDP socket Continue v
exceeds the device range.

6212 Ther.e is no response from the remote device after Continue v
the timeout period.

6213 The data received exceeds the limit. Continue \%

6214 The remote device refuses the connection. Continue \%

6215 The socket is not opened. Continue \%

6217 The socket is opened. Continue \%

6218 The data has been sent through the socket. Continue \%

6219 The data has been received through the socket. Continue \%

621A The socket is closed. Continue \

7011 The device communication function code in COM1 Continue v
is incorrect.

7012 The device communication address used in COM1 Continue v
is incorrect.

7013 The device used in COM1 exceeds the device Continue v
range.
The device length of the communication data in .

7014 COM1 exceeds the limit. Continue v

7017 The device ch.ec.ksum for the communication serial Continue v
port of COML1 is incorrect.

7021 Thg device communication function code in COM2 Continue v
is incorrect.

7022 Thg device communication address used in COM2 Continue v
is incorrect.
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ERROR LED indicator status

Error L CPU
Description T
code status Blinking | Blinking | Blinking
ON OFF
fast | normally| slowly

7023 The device used in COM2 exceeds the device Continue v
range.
The device length of the communication data in .

7024 COM2 exceeds the limit. Continue v

7027 The device ch.ec.ksum for the communication serial Continue v
port of COM2 is incorrect.

7031 The de\(lcg communication function code in Continue v
Ethernet is incorrect.

7032 The deylcg communication address used in Continue Y
Ethernet is incorrect.

7033 The device used in Ethernet exceeds the device Continue Y
range.

7034 The device length of_the communication data in Continue Y
Ethernet exceeds the limit.

7037 The device che(?ks.um for the communication serial Continue Y
port of Ethernet is incorrect.

7041 The device communication function code in USB is Continue Y
incorrect.

7042 The device communication address used in USB is Continue Y
incorrect.

7043 The device used in USB exceeds the device range. | Continue \%
The device length of the communication data in .

7044 L Continue \Y
USB exceeds the limit. inu

7047 The device (.:h(.acksum for the communication serial Continue v
port of USB is incorrect.

70B1 The de.vlcj‘e communication function code in function Continue v
card 1 is incorrect.

7082 The de.vlcj‘e communication address used in function Continue v
card 1 is incorrect.

7083 The. device used in function card 1 exceeds the Continue v
device range.

70B4 The _deV|ce length of the (:_ommunlcatlon data in Continue Y
function card 1 exceeds the limit.

70B7 The device _checksum_fo.r the communication serial Continue Y
port of function card 1 is incorrect.

70C1 The deylt?e communication function code in function Continue Y
card 2 is incorrect.

70C2 The deylt?e communication address used in function Continue Y
card 2 is incorrect.

70C3 The_ device used in function card 2 exceeds the Continue Y
device range.

70C4 The _deV|ce length of the (:_ommunlcatlon data in Continue Y
function card 2 exceeds the limit.

70C7 The device .checksum.fo.r the communication serial Continue v
port of function card 2 is incorrect.

7203 Invalid communication function code Continue \%
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ERROR LED indicator status

Error . CPU
Description T
code status Blinking | Blinking | Blinking
ON OFF
fast | normally| slowly
The contents of the downloaded program are
8105 incorrect. Continue \%
The program syntax is incorrect.
The contents of the downloaded program are
8106 incorrect. Continue \%
The length of the execution code exceeds the limit.
The contents of the downloaded program are
8107 incorrect. Continue \%
The length of the source code exceeds the limit.
8000
- Errors occur between software and PLC. Continue \%
8FFF

12.4.2 Error Codes and LED Indicators for Analog/Temperature Modules

Error code

ERROR LED indicator status

Description AS>D/
D>A/ ERROR
A oD
16#1605 Hardware failure OFF ON
16#1607 The external voltage is abnormal. OFF ON
16#1608 The factory calibration or the CJC is abnormal. OFF ON
16#1801*1 The external voltage is abnormal. OFF Blinking
16#1802*1 Hardware failure OFF Blinking
RUN: Blinkin
16#1804*1 The factory calibration is abnormal. g Blinking
STOP: OFF
16#1807*1 The CJC is abnormal. OFF Blinking
1641808 The S|gr1al received by channel 1 exceeds the range of
analog inputs (temperature).
1641809 The S|gr1al received by channel 2 exceeds the range of
analog inputs (temperature).
164180A The S|gr1al received by channel 3 exceeds the range of
analog inputs (temperature).
The signal received by channel 4 exceeds the range of
16#180B . .
analog inputs (temperature). RUN: Blinking Blinki
inkin
164180C The signal received by channel 5 exceeds the range of STOP: OFF g
analog inputs (temperature).
164180D The S|g_nal received by channel 6 exceeds the range of
analog inputs (temperature).
164#180E The S|g_nal received by channel 7 exceeds the range of
analog inputs (temperature).
164180F The S|g_nal received by channel 8 exceeds the range of
analog inputs (temperature).

*1: The errors are specified as warnings to ensure the CPU module can still run even when the warnings are triggered by

its AIO modules. Set up HWCONFIG to have the following first 4 error codes appear as errors when they occur.
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12.4.3 Error Codes and LED Indicators for Load Cell Module ASO2LC

ERROR LED indicator status
Error code Description
A>D ERROR
16#1605 Hardware failure (the diver board included) OFF ON
16#1607 The external voltage is abnormal. OFF ON
16#1801*1 The external voltage is abnormal. OFF Blinking
16#1802*1 Hardware failure OFF Blinking
16#1807*1 Diver board failure OFF Blinking
1641808 The sigpal received by channel 1 gxceeds the range of
analog inputs or the SEN voltage is abnormal.
16#1809 The signal received by channel 1 exceeds the weight limit.
16#180A The factory calibration in channel 1 is incorrect. RUN: Blinking Blinking
1641808 The sigpal received by channel 2 gxceeds the range of STOP: OFF
analog inputs or the SEN voltage is abnormal.
16#180C The signal received by channel 2 exceeds the weight limit.
16#180D The factory calibration in channel 2 is incorrect.

*1: The following errors are specified as warnings to ensure the CPU module can still run even when the warnings are
triggered by its AIO modules. You can set up HWCONFIG to have the following first 3 error codes appear as errors when
they occur.

12.4.4 Error Codes and LED Indicators for Module ASOOSCM as a
Communication Module

ERROR LED indicator status
Error Code Description
ON Blinking
16#1605 Hardware failure \Y,
16#1606 The setting of the function card is incorrect. \%
16#1802 Incorrect parameters \%
16#1803 Communication timeout Y
16#1804 The setting of the UD Link is incorrect. \%

12.4.5 Error Codes and LED Indicators for Module ASOOSCM as a Remote

Module
ERROR LED indicator status
Error Code Description
o Blinking
N Blink
(0] inking fast
16#1301 Hardware failure \%
16#1302 The setting of the function card is incorrect. \%
16#1303 24 VDC power supply is not sufﬁcner.\t an.d then is recovered v
from a low-voltage less than 10ms situation.

16#1502 Incorrect parameters \%
16#1503 Extension module communication timeout \
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12.4.6 Error Codes and LED Indicators for Module ASO1DNET

(Master/Slave Mode)

Code Explanation Correction
0-63 Node address of ASO1DNET-A (in
normal operation)
80 ASO1DNET-Ais in STOP status. | Turn the PLC to RUN and start I/O data exchange
The node ID of ASO1DNET is the 1. Ensure that the node address of ASO1DNET is unique.
FO same as that of other node or
2. Re-power ASO1DNET.
m exceeds the allowed range.
' . . Configure the scan list and then download the configuration to
F1 No configured slave in Scan List.
ASO1DNET.
F2 Too low voltage of the work power | Check if the power supply for ASO1IDNET and the PLC is normal.
Switch the function switch IN1 from On to Off and re-power
F3 ASO1DNET enters the test mode
ASO1DNET-A.
1. Check if the network cable is normal and the shielded cable is
grounded.
2. Check if the baud rates of all nodes in the network are same.
F4 BUS-OFF .
3. Check if the start and end of the network cable are both
connected with a 121Q terminal resistor.
4. Re-power ASO1DNET-A.
Fs N ootk 1. Check if the network cable is normal.
0 network power 2. Ensure that the network power is normal.
6 Internal error; Flash or RAM If the error still exists after re-power, send ASO1DNET-A back to the
check error factory for repair.
F8 Error produced in factory If the error still exists after re-power, send ASO1LDNET-A back to the
manufacturing factory for repair.
Fo Internal error; EEPROM access If the error still exists after re-power, send ASO1DNET-A back to the
failure factory for repair.
1. Configure the network correctly and re-download it to
_ ] ) ASO1DNET-A.
FA Invalid configuration data 2. Check if the node address of one slave in the scan list is the
same as that of ASO1DNET-A.
o 1. Check if there is any change in node ID of the slave in the
Identification parameters returned
EO | from the slave do not match th network.
rom the slave do not match the ) L .
) . 2. Check if some node device in the network is replaced.
configuration data. )
3. Re-configure the network.
F1 1/0 Data size returned does not Re-configure 1/0O data size of the slave, download the configuration to
match that in the scan list. ASO1DNET-A and run the PLC.
The slave device in the scan list
does not exist .or.is offine when |1 check if there is a change in the node address of the slave.
ASO1DNET-Ais in master mode. |5 check if the communication cable is disconnected or connected
E2 | The I/O connection between the loosely.
slave ASO1DNET-A and the 3. Check if the bus cable length exceeds the maximum transmission
. distance. If so, the system may not be stable.
master is broken when
ASO1DNET-A s in slave mode.
. . Make sure that the connection between ASO1DNET-A and the
ASO1DNET-A fails to transmit .
E3 data network is normal.
' 2. Check if the baud rate of ASO1IDNET-A is the same as that of

12-26




Chapter 12 Troubleshooting

Code Explanation Correction
other node in the network.
Error detected in sequence of
E4 fragmented I/O data from the Check if the slave is operating normally.
slave device.
The slave device returns error
E5 when ASO1DNET-A attempts to Check if the slave is operating normally.
communicate with it.
10 data size returned from the
o Check that the 10 data size of the slave should be the same as that
E6 slave is bigger than that ) . .
) ) . configured in Scan List.
configured in Scan List.
If the code is displayed long, do the troubleshooting according to the
following steps.
1. Make sure that at least two nodes work normally in the network.
2. Check if either end of the network is connected with the terminal
resistor of 121Q.
ASO1DNET-A is checking MAC 3. Check if the baud rates of the node devices in the network are
E7 D same.
) 4. Check if the communication cable is normal so as to avoid that
the cable is disconnected or connected loosely.
5. Check if the bus cable length exceeds the maximum
transmission distance. If so, the system may not be stable.
6. Check if the shielded wire of the network cable is grounded.
7. Re-power ASO1DNET-A scanner module.

12.4.7 Error Codes and LED Indicators for Module ASO1DNET (RTU

Mode)

Code

Indication

How to deal with

Node ID of the scanner module

0~63 (When in RUN state) No correction needed
The node ID is repeated or 1. Ensure _that the node ID (_)f ASOlDNET (RTU) is unique in
FO exceeds allowed range. the DewcgNet network W|t_h|n the range of 0~63.
2. Repower it on after changing the node ID.
No 1/0 module is configured to Add I/O modules in ASO1IDNET (RTU) in the DeviceNet
F1 ASO1DNET (RTU) in the Builder software and download the configuration data to
DeviceNet Builder software. ASO1DNET (RTU) after the configuration is finished.
F2 The wc_)rk voltage of ASOLIDNET | Check if the power supply for ASOIDNET (RTU) works
(RTU) is too low. normally.
F3 ASOIDNET (RTU) enters the Repower ASOLDNET (RTU).
test mode.
1. Check if the network communication cable is normal and
the shielded cable is grounded.
Fa ASO1DNET (RTU) is the 2. Ensure the baud rates of all network nodes are same.

Bus-Off state.

3. Check if the two ends of the network are both connected
with a 120Q) terminal resistor.
4. Repower the scanner module.
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Code Indication How to deal with
1. Check if the network cable is normal.
5 No network power supply for 2. Check if the network power supply is normal. (The external
ASO1DNET(RTU) 24V DC network power supply is connected between red
V+ and black V- of ASO1DNET (RTU) .)
Internal grror, . Return the product to factory for repair if the error still exists
F6 An error in the internal storage after re-power on
units of ASOLDNET (RTU) '
Internal error; . . .
F7 An error in the data exchange Sf?él;rrr;-tggv\%??)lrj\d to factory for repair if the error still exists
units of ASOLDNET (RTU) '
F8 Manufacture error Return the product to factory for repair if the error still exists
after re-power on.
o K];e;?rilr?;rct)k:é access of the :f?é?rrg _tgg v\%?%{:]ct to factory for repair if the error still exists
Flash of ASO1DNET (RTU) '
Check if an error occurs in the modules connected to the right
side of ASO1DNET (RTU);
E4 Modul Check if the module exists;
odule error Check if current module matches that configured in the
software;

Check if the unconfigured module is added.

If the code has emerged for a long time, please shoot troubles

in the methods below.

1. Ensure that there are at least two nodes working normally
in the network.

2. Check if the two ends of the network are both connected
with a 121Q terminal resistor.

3. Ensure that the baud rates of all network nodes are same.

E7 Repeated node ID detection 4. Check if the network cable has a problem such as being
disconnected and loosened.

5. Check if the bus communication cable length exceeds
maximum transmission distance. If the maximum
transmission distance is exceeded, the stability of the
system can not be ensured.

6. Check if the shielded wire of the network communication
cable is grounded.

7. Turn on the power of ASO1DNET (RTU) again.

E9 Igsnglégzet:)ig(?lgl?l%#e(;TU) Check .if the number of I/O modules connected to ASO1IDNET
. (RTU) is more than 8.
exceeds the maximum 8.
1. Check if the RUN/STOP switch of the PLC connected to
80 ASO1DNET (RTU) is in STOP the DeviceNet master is turned to RUN.
state. 2. Check if the value of control word of ASO1IDNET (RTU) is
1. For details, refer to section 10.5.4.3.4.
The .ASOl.DNI.ET (RTU) . Wait until the download of ASO1DNET (RTU) configuration
83 configuration in the software is data i
being downloading. ata is completed.
9 9
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13.1 Data Tracer
13.1.1 About Data Tracer

Data Tracer is used for the real-time collection of variable symbols, values, states in devices, after some trigger condition
is met so as to draw curve charts for analysis of value trends. Refer to Section 22.2 in ISPSoft User Manual for more

details.

Operation 1
] Compile the current project before using the function. Click Wizard> Data Tracer to open the Data Tracer window as
shown below.

° Click the button [ of Symbol Name to open the Add Sample Source window.

Sample Parameter | Measurement

Sample Period Trigger Setting —
Compare Condition
@® System Cycle Time Trigger Position 1 ® BOOL o

() Customized Time (1 ~1000ms) Symbol / Device Iz‘ O Word 0 > 0

Sample Source

Symbel Name Device Name Source Category Comment

" |m100 BOOL
Do VALUE

o Click the button [} of Symbol Name in the Add Sample Source window and select the variable symbol name to
be added in the Choose Symbol window or directly type a device hame in the Device Name box.

Add Sample Source x
Add Sample Source Sample Source
Symbol Name |I| Symbol Name Device Name Source Category Comment
B I e
Device Name |M‘IOC{ | [..]po VALUE

!

‘ Add H Cancel ‘
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° Set up the sample period and trigger setting.

Sample Parameter  Measurement

Sample Period Trigger Setting
Compare Condition

@® System Cycle Time Trigger Position 1 ® BOOL o

(O Customized Time (1~1000ms) Symbol / Device E‘ O Word 0 > 0

Sample Source

Symbeol Name Device Name Source Category Comment
[...]m100 BOOL
Do VALUE

®  After setting up the parameters, click ¢ on the icon toolbar to have the system in the online mode. Then click 8
to download the settings to the PLC.

) After the sample parameter settings in the data tracer are completed and downloaded, any of the following three
modes on the icon toolbar can be used for watching curves in the online mode.

3

® Click on the icon toolbar to export the data to your computer for future use.
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13.1.2 Example

If X0.0 is a signal to open/close externally. Use Data Trace to measure the width of time when X0.0 is ON.
° Steps:

® Open Data Tracer and enter X0.0 for monitoring.

@ Set the Customized Time to 100 ms to take samping, set the trigger device to X0.0, set the trigger position to 10,
and then set the compare condition to ON as the image shown below.

Sample Parameter | Measurement

Sample Period

Trigger Setting
Compare Condition
O System Cycle Time g [Fasflie 10 El @ BOOL oN
(8) Customized Time [100 (1~ 1000 ms) Symbol / Device X0.0 E‘ Woaord 0 >

Sample Source

Symbol Name Device Name Source Category Comment

.. |X0.0 BOOL

.. |x01 BOOL

® Set the mode to One-shot trigger and wait for the trigger (ON). Once it is triggered, it displays the recorded curve
data.

@ The value in | A X1 is 2500 ms, the time measured between two vertical lines, X1 and X2. for X0.0.
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13.2 Data Logger

13.2.1 About Data Logger

Data logger is used for the long-term recording of variable symbols, values, states in devices, and drawing curve charts.
The data is stored in the PLC and the memory card of the PLC for analysis of value trends. Refer to Section 22.3 in
ISPSoft User Manual for more details.

Operation A
L Compile the current project before using the function. Click Wizard> Data Logger to open the Data Logger window

as shown below.

o Click the button [-) of Symbol Name to open the Add Sample Source window.

Sample Parameter | Measurement

Parameters
Sample Points 1000 (1 ~16384pts)
Sampling Method Action When Sample Points Reach
(® Periodical Sampling 1 (1~65535sec) (® Stop Recording
() Triggered Sampling (MO ~ M8191) (O Continue Recording ( Replace the old data)

Sample Source

Symbol Name Device Name Source Category Comment

i O S IR

|...|po VALUE

!

° Click the button [ of Symbol Name in the Add Sample Source window and select the variable symbol name to
be added in the Choose Symbol window or directly type a device name in the Device Name box.

@ Add sample Source *
Add Sample Source Sample Source |Delete
Symbol Name E Symbol Name Device Name Source Category Comment
Device Name |MO( ElMO | BOOL | |
...|DO VALUE

" [ | g
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Oper

After setting up the parameters, click ¢ on the icon toolbar to have the system in the online mode. Then click &

to download the settings to the PLC. And then click e to record data.

Note: From here you can also follow Operation B to complete the recording and saving.

When the recording is done, click the uploade button to update the data for later viewing.

ta

Click on the icon toolbar to export the data to your computer for future use.

Click E on the icon toolbar or use SM and SR to save the data to the SD Card installed on the PLC.

ation B

You can also use SM flags or SR registors to complete the data recording, data saving or set to store data on a SD card
permanently. See the example below for reference.

Example:

Check if the flag SM457 is ON. If the flag SM457 is ON, it indicates the valid recorded parameters are downloaded in
data logger. And that means the operation A is done correctly.

Use inputs to enable/disable or set the flag SM454 to ON for the PLC to start recording. If you need to store data on
a SD card, set SR902=16#5AA5.

When SM455 is ON or when the quantity of data has met the value set in SR900 (32-bit value), the system start
saving data on a SD card.

NOTE: While sending data to the SD card for storage, the PLC needs a period of undisturbing time, approximately
tens of milliseconds. During this period, the PLC is not allowed to execute interrupts. Make sure the PLC is NOT
executing any interrupts, especially the external input ones before starting to send data to the SD card for storage.
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® When SM455 is switching from OFF to ON, set SM456 ON. And the PLC starts to store the recorded data on the SD
card. The default path and the file name are as shown below:

€  Default saving path
AS200: \SDCard\PLC CARD\AS200\Log
AS300: \SDCard\PLC CARD\AS300\Log

L g Default file name
DATA_LOGGER_yyyymmdd_hhmmss.log
EX: DATA_LOGGER_20181108_161901.log

13.2.2 Related SM Flags and SR Registors

SM/ SR Attr. Description
Check here to see if a SD Card is installed in the PLC.
SM450 R | ON: SD card inside

OFF: No SD card

Check here to see if data is being stored on the SD card.
SM452 R | ON: In the operation of storing

OFF: Not in the operation of storing

Check here to see if there is any SD card operational error.
SM453 R | ON: Abnormal

OFF: Normal

Check here to see the last operational error code of the SD card.
Note: Only available when SM453=0ON

Set this flag to ON/OFF to start or stop recording. The system will not set this flag to OFF
automatically even if the space for recording is full. You need to set the flag to OFF manually.

SR453 R

SM454 R/W

Check here to see if the recorded number has reached the set limit.

ON: The quantity of recordings has reached the set number or the SD card is in cycle recording.
Used with SR902 to activate the settings in SR902 for the SD card.

SM456 R/W | Note: Set the flag from OFF to ON and the PLC starts to store the recorded data on the SD card
when SR902=16#5AA5.

Check here to see if there is any valid, downloaded, recorded parameters in the data logger.
ON: The valid recorded parameters are downloaded in data logger.

SM455 R

SM457 R

Check here to see the quantity of the recorded data (32-bit value).

SR900 R Note: It increments the number of the recorded data by 1 for each record.

Control codes for recorded data.

° 16#5AA5: Store data to a default root and specified file name on the SD card.
SR902 R/W |@ 0: The storing is done.

(] Others: Invalid numbers

Note: Used with SM456 to activate this setting.

Note: “R” in the column of attribute (Attr.) indicates the item is read only and the status can be read here.

“W” in the column of attribute (Attr.) indicates you can set, delete or write a value for this item.
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A.1 Installing the USB Driver for an AS Series CPU module in
Windows XP with SP3

The instructions below show how to install the USB driver for an AS Series CPU module on Windows XP. To
install the USB driver on another operating system, refer to the instructions in the operating system for

information on installing new hardware.
Before you install the USB driver, you must install ISPSoft version 3.00 or above on your computer.

(1) Supply power to the AS Series CPU module. Connect the AS Series CPU module to a USB port on your
computer with a USB cable. In the Found New Hardware Wizard, select No, not this time and then click

Next.

Found New Hardware Wizard

Welcome to the Found New
Hardware Wizard

Windows will search for current and updated software by
looking on your computer, on the hardware installation 0, or on
the Windows Update \Web site (with your parmizsion].

Bead our privacy policy
Can 'wWindows connect to Windows Lpdate to search for

software?

(e, thig time only

(e, now and every time | connect a device

(&) Na, nak this time

Click Mest bo continue. ,@

([ Mext » D[ Cancel ]

(2) The wizard displays the name of the detected USB device. Select Install from a list or specific location

(Advanced) and then click Next.
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(3) After you install ISPSoft version 3.00 or above, the driver for the AS CPU module is under the folder where
you installed ISPSoft: ..\ISPSoft\drivers\Delta_PLC_USB_Driver\.

Select Include this location in the search and enter the correct path, or click Browse to browse for the

correct folder. Click Next to continue the installation.

Found New Hardware Wizard

Please choose your search and installation oplions.

(%) Search for the best driver in these locations,

Usze the check boxes below to limit or expand the default search, which includes local
pathz and removable media. The best driver found will be installed.

[ 5earch removable media [floppy, CO-ROM..]

Include this location in the search:
| C:AProgram Files\Delta Industrial Automation')SPSoft w | Browsze

S —

() Don't search. | wil choose the diver b install

Chonse thiz ophion to select the device driver from a list. ‘windows does not guarantee that
the driver pou chooze will be the best match for your hardware.

’ < Back ” Ment > ]’ Cancel

~




AS Series Operation Manual

(4) The system installs the driver. If the Hardware Installation message appears during the installation, click

Continue Anyway.

E

Hardware Installation

] !_. The software pou are installing for this hardware:
L]
Delta PLC

haz not pazsed Windows Loga testing to verify itz compatibility
with Windows *P. (Tl me why thiz besting iz impartant. |

Continuing your installation of thiz software may impair
or destabilize the comrect operation of your system
either immediately or in the future. Microzoft strongly
recommends that you stop thiz installation now and
contact the hardware vendor for software that has

paszzed Windows Logo testing. ﬂ

/
——FK

< Caritiriue Anyway > STOP Installation

(5) Click Finish.

Found New Hardware Wizard

Completing the Found New
Hardware Wizard

The wizard has finizhed instaling the software for:

3 Delta PLC

Click Finish to close the wizard.

TN
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(6) Open the Windows Device Manager window. If the Delta PLC port for the USB device is under Ports
(COM & LPT), the installation of the driver is successful, and Windows assigns a communication port

number to the USB device.

Additional remarks

® If you connect the PLC to a different USB port on the computer, the system may ask you to install the driver
again. Follow the steps above, and install the driver again. After you install the driver, the communication

port number that the operating system assigns to the USB device may have changed.

® |f Windows XP has not been updated to the version SP3 on the computer, an error message stating the

missing files will appear during the installation. Resolve this issue with one of the following steps.

(@) Cancel the installation, install Windows XP SP3 on the computer, and reinstall the driver according to

the steps above.

(b) Get the file needed, and specify the path where the file is stored for the missing file in the error

message window.
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A.2 Installing the USB Driver for an AS Series CPU module in
Windows 7

This section describes the steps to install the USB driver for an AS Series CPU module on Windows 7. To
install the USB driver for an AS Series CPU module on another operating system, refer to the instructions in the

operating system for information about installing new hardware.
Before you install the USB driver, you must install ISPSoft version 3.00 or above on your computer.

Supply power to the AS Series CPU module. Connect the AS Series CPU module to a USB port on the

computer with a USB cable.

(1) Windows detects the module. From the Windows Control Panel, open the Device Manager. The name of

E the USB device appears in the Device Manager window. Double-click the AS300.
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(2) Inthe AS300 Properties dialog box, click Update Driver

(3) Click Browse my computer for driver software.




E
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(4) After you install ISPSoft version 3.00 or later, the driver for the AS Series CPU module is under the folder
where you installed ISPSoft .. \ISPSoft\drivers\Delta_PLC_USB_Driver\. Enter the path to the driver, or

click Browse to browse to the correct folder.

Specify the correct path. If you installed the driver for the AS series CPU module to another location,

specify the corresponding path. Click Next to continue the installation.




Appendix A Installing a USB Driver

(5) Click OK. The system installs the driver. If the Windows Security window appears during the installation,

click Install this driver software anyway.

(6) When the installation completes, click Close.
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(7) Open the Device Manager window again. If the name of the Delta USB device appears under Ports (COM
& LPT), the installation of the driver is successful. The operating system assigns a communication port

number to the USB device.

Additional remarks

® If you connect the PLC to a different USB port on the computer, the system may ask you to install the driver
again. Install the driver again. After you install the driver, the communication port number that the operating

system assigns to the USB device may have changed.
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A.3 Installing the USB Driver for an AS Series CPU module in
Windows 8

Windows 8 driver signature enforcement provides a way to improve the security of the operating system by
validating the integrity of a driver or system file each time it is loaded into memory. Because the Delta PLC USB
driver does not include the driver signature, this section shows you how to disable driver signature enforcement
in Windows 8 to successfully install the Delta PLC USB driver. Once you disable the driver signature

enforcement setting, it returns to its original state after you restart Windows.

Follow these steps to disable driver signature enforcement in Windows 8.

1. Press the Windows button {WIN] + [I] on your keyboard to display the Settings window. Click

Change PC settings.

2. The PC settings window appears. Click General and then click Restart now under Advanced startup.
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3. After the computer restarts, under Choose an option, click Troubleshoot. Under Troubleshoot, click

Advanced options.

4. Onthe Advanced options page, click Startup Settings, and then on the Startup Settings page, click

Restart to restart the computer.

5. Press the 7 or F7 key on your keyboard to choose Disable driver signature enforcement. Press Enter
and the system directs you back to the Windows 8 operating system. Install the Delta PLC USB driver now
by connecting the AS Series CPU module to your computer’s USB port. Refer to Section A2 for the steps

to install the USB driver.

Startup Settings

Press a number to choose from the options below:

Use number or functio s F1-F9.

1) Enable debugging

2) Enable boot logging

3) Enable low-resolution video

4) Enable Safe Mode

5) Enable Safe Mode with Networking

6) Enable Safe Mode with Command Prompt
7) Disable driver signature enforcement

8) Disable early launch anti-malware protection

9) Disable automatic restart after failure

Press F10 for more options
Press Enter to return to your operating system
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A.4 Installing the USB Driver for an AS Series CPU module in
Windows 10

Windows 10 driver signature enforcement provides a way to improve the security of the operating system by

validating the integrity of a driver or system file each time it is loaded into memory. Because the Delta PLC USB
driver does not include the driver signature, this section shows you how to disable driver signature enforcement
in Windows 10 to successfully install the Delta PLC USB. Once you disable the driver signature enforcement

setting, it returns to its original state after restarting Windows.
This section describes the steps to disable driver signature enforcement in Windows 10.
1. Click the Windows Start button and then click Settings.

2. Inthe Settings window, click Update & Security.

A (Setting) B (Update & Security)

admin

Settings

Power

Ask me anything
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3. Inthe Settings window, click Recovery, and then click Restart now.

C (Recovery) D (Restart now)

E

4. After the computer restarts, under Choose an Option, click Troubleshoot, and then click Advanced

options.

5. Onthe Advanced options page, click Startup Settings. On the Startup Settings page click Restart to

restart the computer.
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6. On your keyboard, press 7 or F7 to choose Disable driver signature enforcement, and the system

directs you to the Windows 10 operating system page. Install the Delta PLC USB driver.

Startup Settings

Press a number to choose from the options below:

Use numbes

1) Enable debugging

2) Enable boot logging

3) Enable low-resolution video

4) Enable Safe Mode

5) Enable Safe Mode with Networking

6) Enable Safe Mode with Command Prompt
7) Disable driver signature enforcement

8) Disable early launch anti-malware protection
9) Disable automatic restart after failure

Press F10 for more options
Press Enter to return to your operating system

7. Install the USB driver for the AS Series CPU module by connecting the AS Series CPU module to your

computer’s USB port. Refer to Section A2 for the steps to install the USB driver.
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B.1 Standard Modbus Device Addresses

Applicable to AS300 and AS200 series PLC

Modbus address

AS Address

Device Type Format Device range
(Decimal number) (Hexadecimal number)

Bit DD.DD X0.0-X63.15 124577-125600 6000-63FF

§ Word DD X0-X63 332769-332832 8000-803F
Bit DD.DD Y0.0-Y63.15 040961-041984 AO00-A3FF

Y Word DD Y0-Y63 440961-441024 A000-AO03F
M Bit DDDD MO0-M8191 000001-008192 0000-1FFF
SM Bit DDDD SMO0-SM4095 016385-020480 4000-4FFF
SR Word DDDD SRO0-SR2047 449153-451200 C000-C7FF
D Word DDDDD D0-D29999 400001-430000 0000-752F
S Bit DDDD S0-S2047 020481-022528 5000-57FF
Bit DDD TO-T511 057345-057856 EOOO-E1FF

! Word DDD TO-T511 457345-457856 EOOO-E1FF
Bit DDD C0-C511 061441-061952 FOO0O-F1FF

© Word DDD CO0-C511 461441-461952 FOO0O-F1FF
Bit DDD HCO0-HC255 064513-064768 FCO0-FCFF
e DWord DDD HCO0-HC255 464513-464768 FCO0-FCFF
E Word DD EO-E9 465025-465039 FEOO-FEO09
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B.2 Function Codes and Number of Devices Supported
for Modbus Protocols

Applicable to AS300 and AS200 series PLC

Number of devices

Number of devices

Function o supported supported
Name Description
code (FW V1.06.00 or (FW V1.06.10 or
later) later)
01 Read Colil Status X, Y, M, SM, S, T, C, HC |1~256 bits 1~1600 bits
Read Discrete Input
02 X, Y, M, SM, S, T, C, HC |1~256 bits 1~1600 bits
Status
1~100 words, 1~100 words,
03 Read Holding Registers | X, Y, SR,D, T,C, HC, E
(1~50 for HC) (1~50 for HC)
04 Read Input Registers X 1~100 words 1~100 words
05 Force Single Coil Y, M, SM, S, T, C, HC 1 bit 1 bit
06 Preset Single Register Y,SR,D, T,C,HC, E 1 word 1 word
OF Force Multiple Coils Y, M, SM, S, T, C, HC 1~256 bits 1~1600 bits
1~100 words, 1~100 words,
10 Preset Multiple Register | Y, SR, D, T, C,HC, E
(1~50 for HC) (1~50 for HC)
Read/Write Multiple 1~100 words, 1~100 words,
17 Y,SR,D, T,C,HC, E

Register

(1~50 for HC)

(1~50 for HC)
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